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Preface
Welcome to Windows XP for Power Users: Power Pack, the book for the power user
like yourself. Since the early days of Windows XP’s release, the operating system
has received a lot of praise, as well as a lot of complaints. No doubt, Windows XP
is the best version of Windows that Microsoft has produced to date. It does more,
works better, and is more versatile than any previous versions of Windows. With its
millions of lines of code, however, Windows XP is certainly not perfect. It has its
share of problems and aggravations, many of which have to do with hardware and
application compatibility.

Overall, though, I believe Windows XP is a great operating system and it works
great if you give it the right resources and hardware and/or software that are devel-
oped for this new breed of operating system. As a power user, you want to do more
with Windows XP. You want to get more from the operating system features and
functions, and you want to be able to control the system and customize it to meet
your needs. Look no further; this book is written specifically with you in mind.

In these pages, you’ll see how to do some helpful tasks as well as many lesser-
known tasks that you will find useful as you work with Windows XP. You’ll see
how to manage the interface, work with hardware and software, configure operat-
ing system services, manage users, create a home network, manage security fea-
tures, and much, much more. I don’t cover common, everyday tasks that you
already know how to do, but I’ll show you how to use the features you want to
learn about, and I’ll show you how to use them to the best of your advantage.

This book is written on a topic-by-topic basis. Each chapter stands on its own, so
you can read the book from cover to cover, or you can skip around and find the
information you need. The choice is completely up to you.

Along the way, you’ll find some sidebars and other icon material. The sidebars
are extra items. You don’t have to read them, but they all contain good information
you may find helpful, so I encourage you to check them out. Also, the icons you’ll
see along the way show you how to do something more easily or how to avoid a
common problem.

I hope you enjoy the book! Feel free to visit me on the Internet or drop me an 
e-mail. I look forward to hearing from you.

Curt Simmons
www.curtsimmons.com
curt_simmons@hotmail.com

v
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vi Preface

Icons to Watch For
The following icons indicate special information throughout each session:

These icons indicate special information relating to the current section that

you may find useful.

These icons indicate information that tells you the best way to do some-

thing or alert you to special considerations you should be aware of when

performing a routine task.

This icon indicates a reference to related information in another session.

This icon indicates cautionary information, alerting you to potential hazards

encountered within the tasks at hand.
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Chapter 1

Configuring the Windows
XP Interface
IN THIS CHAPTER

◆ Configuring the Start menu

◆ Configuring the taskbar

◆ Managing the Recycle Bin

◆ Managing the Control Panel appearance

◆ Managing the Display

AT FIRST GLANCE, THE Windows XP interface is radically different than the typical
Windows interface used in the past. In fact, the first boot of Windows XP often
leaves new users a bit shocked when they see a virtually empty desktop. The good
news is the sleek Windows XP interface is easy to use, and it provides you with
plenty of configuration options so that you can make Windows XP look just the
way you want. This first chapter takes a look at the Windows XP interface. It shows
you how to configure all of the interface items and features so that Windows XP
meets your needs.

Configuring the Start Menu
The Windows XP Start menu is a bit different than the Start menu found in previ-
ous versions of Windows. The Start menu still provides you with access to different
programs and portions of Windows XP, and its goal has not changed. The purpose
of the Start menu is to . . . well . . . start something. It provides you with access to
documents and programs, but also operating system features and easy access to the
things you use most of the time.

The Start menu in Windows XP provides you with a two-column design, shown
in Figure 1-1. At the top of the Start menu, you see your username and photo icon
configured for use with your username. In the left column, you see access to several
programs, and the right column gives you access to files and other portions of the
operating system.

1
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2 Windows XP for Power Users

For more information on configuring the photo icon for use with your user-

name, refer to Chapter 2.

Figure 1-1: The Start menu gives you access to commonly used items.

The left side of the Start menu lists programs you commonly access. By default,
Internet Explorer and your default e-mail client always appear in this list. The rest
of the programs appear here according to your actions. For example, if you open
Microsoft Word, the application icon is added to the Start menu for easy access. If
you do not use Word again for a long period of time, it is dropped from the Start
menu due to inactivity. So, the Windows XP Start menu is rather dynamic in that it
tries to guess what programs you might need by keeping frequently used programs
available on the Start menu for you.

I mentioned that Internet Explorer and your default e-mail client are always
listed on the Start menu. What happens if you don’t use these for a period of time?
Nothing. Internet Explorer and your default e-mail client are pinned to the Start
menu by default, which means they are permanently placed there unless you decide
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to remove them. You can pin any application or document to the Start menu so that
it is always available to you. To pin an item to the Start menu, right-click the item
in the left column and click Pin to Start menu. You can also remove a pinned appli-
cation or document by right-clicking the icon on the Start menu and clicking
Unpin from Start menu, as shown in Figure 1-2.

Figure 1-2: You can pin or unpin items simply by right-clicking.

Notice the small divider bar that appears on the left side of the Start menu,

as shown in Figure 1-1. This bar divides pinned and unpinned Start menu

items so you can easily keep track of what is pinned and what is not. Also,

Internet Explorer and your default e-mail client have some quick access

options when you right-click their icons.You can quickly browse the Internet

or check e-mail this way.

On the right side of the Start menu, you see common Windows items that you
will need to access, including the following:

Chapter 1: Configuring the Windows XP Interface 3
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◆ My Documents, My Pictures, and My Music — The My Documents folder
is the default storage location for files of all kinds, including pictures,
music, and movies. My Documents contains the following default 
subfolders:

■ My Music

■ My Pictures

■ My Videos

■ Remote Desktops

◆ My Computer — My Computer is the default folder that stores information
about drives connected to your computer. You can quickly access System
properties by right-clicking My Computer on the Start menu and clicking
Properties.

◆ My Network Places — My Network Places contains information about
other computers and shared folders on your network. You can learn more
about My Network Places in Chapter 8.

◆ Control Panel — Control Panel is the default location for managing all
kinds of programs and services on your XP computer. Control Panel con-
figuration is explored later in this chapter.

◆ Network Connections/Connect To — Network Connections is a folder that
contains your dial-up and/or broadband connections, as well as local area
network (LAN) connections. If you have configured connections, you’ll see
a Connect To option where you can quickly access and start a connection.

◆ Help and Support — Windows XP includes a help and support feature that
can answer your questions and even locate answers on the Internet.

◆ Search — The Search feature enables you to find items on your computer
or items on the Internet.

◆ Run — You can use the Run dialog box to quickly start programs or con-
nect to network shares.

◆ Log Off/Turn Off Computer — These standard icons enable you to log off,
shut down, or restart the computer.

You can add just about anything to your Start menu by simply dragging the icon
to the Start menu. Also, notice that the items on the right side of the Start menu
can’t be removed by right-clicking them. However, you can manage what is on the
Start menu by accessing Taskbar and Start Menu Properties. To further configure
the Start menu, just right-click an empty area of the taskbar and click Properties, or
right-click the Start menu button and click Properties. The Properties dialog box
appears with Taskbar and Start Menu tabs, as shown in Figure 1-3.
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Figure 1-3: Taskbar and Start Menu Properties.

You have the option on the Start Menu Properties page to use either the current
Start menu, or the Classic Start menu, which is simply the Start menu found in pre-
vious versions of Windows. Because the two are different, the following two sec-
tions explore the configuration of each.

XP Start Menu
To continue using the XP Start menu, click the Customize button. This takes you to
a Customize Start Menu window where there is a General and Advanced tab. On the
General tab, shown in Figure 1-4, there are three different customization options:

◆ Icon size — You can choose to use large or small icons in the Start menu.
Small icons may be harder to see, but you can put more shortcut icons
directly on the Start menu. Large icons are selected by default.

◆ Programs — By default, your Start menu will make five program shortcut
icons appear in viewing range when you click Start. You can change this
number by using the drop-down menu. The Start menu can display up to
30 shortcut icons. Basically, this customization option makes your Start
menu larger to accommodate all of the 30 programs you can place on it.

◆ Show on Start menu — This option allows you to show Internet and
e-mail on the Start menu, and then provides a drop-down menu to select
the application (Internet Explorer and Outlook Express by default). If you
have other browser or e-mail clients installed on your computer, you can
use the drop-down menu and select a different browser and/or e-mail
client, or just clear the check boxes if you don’t want these items dis-
played at all.
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Figure 1-4: General tab.

On the Advanced tab, you have some additional options that you may find use-
ful, as shown in Figure 1-5.

Figure 1-5: Advanced tab.

First, you see two check boxes collectively called Start menu settings:
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◆ Open submenus when I pause on them with my mouse — By default,
folders such as My Documents, My Computer, and so on are stored as a
link on the Start menu. You can click them to open the folders in a differ-
ent window. However, you can use a menu option so that a menu appears
where you can choose subfolders. For example, say you have a folder
called Work in the My Documents folder. Without using the menu option,
you have to click My Documents, and then open Work. Using the menu
option, if you point to My Documents on the Start menu, a pop-out menu
appears showing your other folders, including Work, and you can just
click on Work to directly open it. This check box simply asks you if you
want the pop-out menu to appear when you put your mouse over the
item, or if you want to have to click the item to see the pop-out menu.

◆ Highlight Newly Installed Programs — When applications are installed on
your XP computer, they are highlighted until you use them for the first
time. This serves as a simple reminder that you have new stuff you
haven’t used. Just clear the check box if you don’t want to use the feature.

The second part of the Advanced tab gives you a scroll window where you can
select the folder and Windows items that appear on the Start menu and choose how
those items are displayed. For example, by default, Control Panel is shown on the
Start menu as a link. You can change this behavior so that it is shown as a menu,
or not all. Simply scroll through the list and click the desired check boxes and radio
buttons to determine what Windows items you want to include and how those
items are presented (link or menu). You may want to experiment with these settings
until you find the combination that is right for you; remember, you can make
changes to these settings as many times as you like.

The last part of this configuration window allows you to show recently used
documents on the Start menu. For example, say that you’re writing your life story.
Once you open the document and then close it, the Start menu will put it in Recent
Documents, which is a folder that will now appear on the Start menu. You can eas-
ily access the document from the Start menu the next time you need it.

Classic Start Menu
You can use the Classic Start Menu by selecting the Classic Start Menu option on
the Start menu tab of Taskbar and Start Menu Properties. This option allows you to
use the Start menu that was seen in previous versions of Windows. If you want 
to use the Classic Start Menu, select the Radio button and click the Advanced 
button, which gives you a single Customize Classic Start Menu interface, as seen
in Figure 1-6.
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Figure 1-6: Classic Start Menu option.

You’ll see that you have the same basic Start menu options, just in a different
format. If you want to add items to the Classic Start Menu, click the Add button and
a wizard will help you select items on your computer to add. Use the Remove but-
ton to remove items, and use the Advanced button to open Windows Explorer so
you can manually add and remove items. You can also resort the items and clear
recent documents, programs, Web sites, and so on. The Advanced window option
that you see enables you to display a number of Windows items, use expandable
(menu) folders, and so on. These items are self-explanatory; again, feel free to
experiment and try new configurations.

Configuring the Taskbar
The taskbar is the handy bar that runs along the bottom of your screen. Minimized
programs, along with the Notification Area and Quick Launch (if you choose to dis-
play it) are found on the taskbar. You have a few quick customization options,
which you can access by opening Taskbar and Start Menu Properties, then clicking
the Taskbar tab, shown in Figure 1-7. In the Taskbar appearance area, you have a
few check box options that enable certain features:

◆ Lock the taskbar — You can drag the taskbar to different places on your
desktop. For example, if you want the taskbar at the top of the screen
instead of on the bottom, just drag it to the top. If you use the Lock the
taskbar check box, the taskbar will be locked on the bottom of the screen
and you will not be able to move it.
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◆ Auto-hide the taskbar — This feature keeps the taskbar out of your way.
When you are not using the taskbar, it disappears below your screen view.
When you need it, just point your mouse to the location of the taskbar
and it will reappear.

◆ Keep the taskbar on top of other windows — As you are using various
windows, they may cover up portions of the taskbar. This setting always
keeps the taskbar on top.

◆ Group similar taskbar buttons — This feature keeps similar items together.
For example, if you open two Web pages, then minimize both, they will
appear next to each other on the taskbar.

The Notification area, formerly called the System Tray, is the small icon area on
the right side of your taskbar. It tells you a number of functions that are working
on your computer and can notify you of certain application functions. You have
two simple check box options here. You can choose to show the clock in the System
Tray, and you can choose to hide inactive icons. The Hide inactive icons feature
simply cleans up the System Tray area so that only active icons are seen. You can
try both of these settings to see if you like them.

Figure 1-7: Taskbar properties.

You can make some additional changes to the interface using the 

Microsoft PowerToy — TweakUI — which is available for free download.

See Chapter 20 for details.
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Managing the Recycle Bin
By default, Windows XP provides you with only one desktop icon, the Recycle Bin.
The Recycle Bin is the catch-all location for files, applications, and other items you
no longer need. This primarily includes files, but you can also drag zipped files and
other kinds of information into the Recycle Bin. The Recycle Bin doesn’t actually
delete the items from your system until you choose to empty the Recycle Bin or the
Recycle Bin starts to become full. Only then is the item deleted forever.

You can open the Recycle Bin and see what is inside by double-clicking the
Recycle Bin icon on your desktop (you can also right-click the icon and click
Explore). You can see the items in the Recycle Bin that are waiting to be deleted, as
in Figure 1-8. In the View menu, you can select thumbnails, tiles, icons, list, or
details. With these choices, you can see large icons, small icons, a list of files, or
even a detailed list telling you the item’s original location and the date it was
moved to the Recycle Bin.

Figure 1-8: Recycle Bin contents.

You see that you have two buttons available in the Recycle Bin Tasks pane,
found on the left side of the Recycle Bin. Click the Empty the Recycle Bin icon to
permanently delete the items in the Recycle Bin from your computer. You can also
empty the contents of your Recycle Bin by simply right-clicking the Recycle Bin
icon on your desktop and clicking Empty Recycle Bin on the menu that appears.
You cannot recover these items after they have been emptied from the Recycle Bin.

You also have a Restore all items icon in the Recycle Bin Tasks pane. Use this
button to move the file back to its original location on your computer. What if you
have 30 files you have deleted and you want to restore only one of them? No 
problem — just select the file in the list by clicking it. The Restore all items icon
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changes to a Restore this item icon. Click the icon and the file is put back in its
original location. You can also move an item out of the Recycle Bin by just drag-
ging it to the desktop. The item will now reside on your desktop.

You can’t open an item that is held in the Recycle Bin. For example, if you

have a file named 05421.doc and you’re not sure what the file is, you’ll have

to either restore it or drag it to the desktop before you can open and read it.

You can also change the Recycle Bin’s properties, which basically changes the
way it behaves. Right-click the Recycle Bin on your desktop and click Properties on
the contextual menu that appears. A Recycle Bin Properties window appears that
has Global and Local Disk tabs, as shown in Figure 1-9.

Figure 1-9: Recycle Bin Properties.

You see two radio buttons that enable you to either configure your drives inde-
pendently or use the same settings for all drives. This feature applies to you only if
you have more than one hard disk in your computer. In most cases, the default set-
ting that configures all of your drives the same way is all you need. Next, you see
a check box that tells your computer to delete items immediately instead of moving
them to the Recycle Bin. As you can guess, this feature automatically deletes items
when you click Delete. This provides you with absolutely no protection in the event
that you accidentally delete a file you want. I strongly recommend that you do not
click this check box to enable this option. No matter how good your computing
skills, you will make a mistake from time to time and accidentally delete something.
The Recycle Bin is your safety net.
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Next, you see a sliding bar that represents the maximum size the Recycle Bin can
grow. Like everything else on your computer, the Recycle Bin stores items in a
folder on your hard drive. The sliding bar enables you to set a limit for how big the
Recycle Bin can grow before it forces you to empty the contents and permanently
delete items from your system. By default, this setting is configured for 10 percent.
This means that 10 percent of your hard drive’s space can be used before the
Recycle Bin tells you to empty it. Under most circumstances, this 10 percent setting
is all you need, but you can change it to a higher or lower percentage if you want.
Keep in mind that you do not have to wait until your Recycle Bin is full to empty
it. Some people empty it every time they put documents in it, while others empty it
on a weekly basis after they have reviewed its contents to make sure nothing was
accidentally deleted. There is no right or wrong approach; just find what works best
for you.

Finally, you see a Display delete confirmation dialog check box at the bottom of
the Global tab. This tells Windows to give you that aggravating Are You Sure? mes-
sage every time you delete something. This option is selected by default, and
although the configuration message is sometimes a pain, it is a good safety check.

Aside from the Global tab, you have a Local Disk tab — you may have several of
these tabs if your computer has more than one hard drive. You can’t do anything
on these tabs if you selected the Use one setting for all drives radio button on the
Global tab. If you want each drive to have different settings and you selected this
option on the Global tab, you can configure each drive independently. The tabs
have the same options, such as the slider bar for the percentage of the hard drive
you want to use for the Recycle Bin.

Managing Control Panel Appearance
The Windows XP Control Panel provides a different look than previous versions of
Windows, and not exactly to the joy of some power users. The default XP Control
Panel, shown in Figure 1-10, uses a category view, where Control Panel features 
are organized by different categories. After you click a category, you are given a
number of task options that you can complete. The reason Microsoft created the
category-based Control Panel was to make life easier on users. With the category
view, users can more quickly find what they need to do, rather than having to
understand the various Control Panel icons. You are free to use the category view if
you like, but I find it is a bit tedious for most power users. You end up wading
through categories and lists of tasks, rather than quickly accessing the Control Panel
applet you need. Never fear, however; you can go back to the classic Control Panel
view by simply clicking Switch to Classic View in the Control Panel task list, as you
can see in Figure 1-10. This simple switch makes the Control Panel look like the
classic Control Panel you saw in Windows 2000 and earlier systems so that you can
more quickly access applet options.
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Figure 1-10: Category view Control Panel.

Managing the Display
If you access Display Properties in Control Panel (use Classic View) or simply right-
click an empty area of your desktop and click Properties, you can access the prop-
erties pages that determine the display settings and overall appearance you see on
your monitor. A number of different options here allow you to configure Windows
XP to look and feel the way you want; the following sections explore the configu-
ration options available to you on each tab.

Themes
A theme is a group of settings that are applied to Windows XP under a single name.
The settings usually relate to each other, creating a theme of some kind. Themes
became very popular in Windows 98, and Windows XP now provides a Themes tab
(shown in Figure 1-11) in  Display Properties. The themes option is placed here in
Windows XP because the default Windows XP interface is simply a theme.

You can use the XP interface, or you can change to a different theme, or even
use a Windows Classic theme, which basically gives you the plain Windows inter-
face you saw in Windows 9x, Me, and 2000. Simply use the drop-down menu to
select a desired theme and click Apply to see all of the settings the theme has to
offer. You can also modify any theme (including the default XP interface theme) by
making changes to the other tabs available in Display Properties.

If you want to use additional Windows themes from previous versions of
Windows, such as Aquarium, Space, and so forth, you can purchase and install the
Plus! Pack for Windows XP, available at local and Internet computer stores. 
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Figure 1-11: Themes tab.

Desktop
The Desktop tab, shown in Figure 1-12, gives you the option to configure the
Windows XP desktop area with pictures, graphics, background colors, and even dif-
ferent texture appearances. Windows XP gives you several built-in options that
you can choose for your background in the list on the Desktop tab. If you scroll
through the list, you see that there are two kinds of files present. Some files give
your desktop a pattern while others give your desktop a picture.

Figure 1-12: Desktop.
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If you look in the provided list on the Desktop tab, you see that each file has a
name and an icon picture next to it. Background patterns and pictures are simply
JPEG, BMP, GIF, and related picture file formats that you commonly see on the
Internet, as well as HyperText Markup Language (HTML) files. On the Desktop tab,
you can select one of the files and it will appear in the test monitor window on the
Background tab. By default, pictures are set up to stretch across your screen so that
they take up the entire desktop area, and patterns are set to tile so that they repeat
until the entire desktop area is used. This causes the pattern to fill the entire test
screen so you can see how it looks before you decide to use it. You can also use the
Center option in the drop-down menu to center the pattern in the middle of the test
screen, which will give you a different look. If you like what you have selected,
click the Apply button at the bottom of the window and the new pattern will be
applied to your desktop. If you don’t like it, just pick something else on the Desktop
tab. You can look at all of the patterns and even reapply different patterns until you
find the one you want.

If you choose to center a picture or pattern, you’ll have an area of your desktop
still showing. Windows XP enables you to alter the remaining desktop area to your
preference by using a color. For example, say you choose a wallpaper from the list
on the Background tab and you center the picture. You will have additional leftover
background space. You can use the color drop-down menu and select a color for
the remaining portion of the desktop area. After you have finished your back-
ground pattern and selected anything else from the Background tab you want to
use for the main pattern, just click Apply and click OK.

You can also find a Customize Desktop button toward the bottom of the Desktop
tab. If you click this button, you are taken to the Desktop Items properties page,
which contains General and Web tabs. On the General tab, shown in Figure 1-13,
you can choose which desktop icons you want to display, such as My Documents,
My Computer, My Network Places, and Internet Explorer. None of these items are
selected by default, but you can add them to your desktop by selecting them if you
like. You’ll also see a window showing the default icons that are used for each of
these items. If you want to use different icons, just click the Change Icon button
and select different icons from the provided list. 

At the bottom of the tab is the option to use the Desktop Cleanup Wizard. The
cleanup wizard is configured to run every 60 days by default, but you can run it at
any other time by clicking the Clean Desktop Now button. This wizard simply
removes old shortcuts and puts them in a folder called Unused Shortcuts. If you
create a lot of shortcuts and don’t use them very often, this wizard can help keep
your desktop free of clutter. Otherwise, it can remove items you intend to keep, so
you may choose not to use it.
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Figure 1-13: Desktop Items, General tab.

The Desktop Items Web tab, shown in Figure 1-14, allows you to place a com-
plete Web page on your desktop. You can use the wallpaper feature to place an
HTML file on your desktop, but if you choose the Web option, you can place an
actual Web page there that can be synchronized with the real Web page on the
Internet.

Figure 1-14: Desktop Items, Web tab.

To place a Web page on your desktop, click the New button and enter the URL in
the New Desktop Item dialog box, as shown in Figure 1-15. You’ll need an Internet
connection to complete the addition of the Web page.
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Figure 1-15: Enter the URL.

After you click OK, a confirmation message appears. If the Web site requires you
to enter a password, click the Customize button and enter it; otherwise, just click
OK. When you choose the Web page option, the entire Web site is downloaded and
stored on your computer so that you can use the site, just as if you are actually
using a browser. If you later want to remove the Web page from your desktop, just
return to the Web tab and clear the check box next to the Web page in the Web
Pages dialog box.

Screen Saver
The Screen Saver tab provides two functions (see Figure 1-16): It enables you to
configure a screen saver for your computer and to configure power management
options. A screen saver is a simple program that runs after your computer has been
idle for a certain period of time. In the past, the screen saver protected monitors
from screen burn. When a monitor was left unattended for too long and one con-
tinuous picture or window was displayed, the image could burn itself onto the
monitor and always be sort of floating in the background. Monitors today aren’t
really susceptible to this problem, so screen savers are more for decoration pur-
poses. Use the Screen Saver drop-down menu to select the screen saver you want.
You can see a preview in the test monitor on the tab, or click the Preview button to
see a full-screen option. You can also click the Settings button (see Figure 1-17) to
see what configurable options there are for the screen saver. Typically, you can use
the Settings option to speed up a screen saver or slow it down.

To find out more about the Power configuration options, refer to Chapter 5.
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Figure 1-16: Screen Saver tab.

Figure 1-17: Use the Settings option to customize your slideshow.

Appearance
The Appearance tab, shown in Figure 1-18, enables you to configure specific
options on Windows XP, including color schemes, font sizes, and effects. Basically,
this feature allows you to customize the Windows XP theme, or any other theme
you choose to use.

18 Windows XP for Power Users

549987 ch01.qxd  11/20/03  11:38 PM  Page 18



Chapter 1: Configuring the Windows XP Interface 19

My Pictures Screen Saver
The My Pictures Screen Saver Options dialog box uses the photos found in the My
Pictures folder to create a slideshow screen saver. This is a fun way to personalize
Windows XP. You have some helpful customization options with the slideshow itself. If
you select My Pictures from the screen saver drop-down menu, you can click the
Settings button and configure how often the pictures should change, how big the
pictures should be, as well as some additional options that allow you to stretch
photos, use transitions, and so forth. Also, you can use the Browse button to select a
desired folder to use, rather than My Pictures. This way, if you have photos stored in
individual folders, you can simply use those folders for the screen saver slideshow,
rather than having to move everything to My Pictures.

Figure 1-18: Appearance tab.

You have a few standard options here, which are explained in the following list:

◆ Windows and Buttons — You can use the drop-down menu to either
choose XP style or Windows Classic style.

◆ Color Scheme — A number of color schemes are available. Use this drop-
down menu to select one you like. You can experiment with this setting
and change it at any time.

◆ Font Size — You can choose Normal, Large, or Extra Large from the drop-
down menu.
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◆ Effects — Click the Effects button to open the Effects window, which gives
you some basic check box options such as fade, shadows under menus,
and so on.

◆ Advanced — If you click the Advanced button, you can make specific font
and color changes to different Windows components, such as menus, but-
tons, active title bar, and a host of others. Under most circumstances, you
will not want to edit all of the settings, but if you want to change some-
thing specific, just select it using the drop-down menu and configure the
available options for it.

Settings
The final Display Properties tab is the Settings tab. You use this tab to manage the
actual video card hardware that resides within your computer, and you have a few
basic options, as shown in Figure 1-19. First, you see a Color quality drop-down
menu. This menu enables you to select the number of colors Windows XP can use
to generate all of the graphics and pictures that appear on your monitor. True Color
(24-bit) is the highest color scheme that you can use, and, depending on the qual-
ity of your video card, you may have only a few color options available. The higher
resolution provides the best color performance.

Figure 1-19: Settings tab.

You also see a Screen resolution slider bar. You can adjust the screen area to suit
your needs, and as you adjust it, you will see that your desktop area gets either
larger or smaller (including your icons), depending on what option you select. The
best setting is generally 800 × 600.
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You also have an Advanced button. This option opens the properties pages for
your video card. The default settings are generally all you need, but a few options
can help solve particular problems. Click the button, and you will see a new win-
dow with additional tabs.

On the General tab, you can change the Dots Per Inch (DPI) setting, which is typ-
ically set around 96, by default. Increasing this value can increase the size of the
items found on the screen. However, this setting increases all items. If you only
want to change the font size, use the Appearance tab in the Display Properties dia-
log box.

On the Monitor tab, you can adjust the screen refresh rate. If the screen seems to
respond slowly to keyboard strokes, increasing this rate may improve performance,
depending on the quality of your monitor. Again, as a general rule, the default set-
ting is best.

On the Troubleshoot tab, you can change the rate of hardware acceleration for
the video card. If you are having no problems, this setting should be left at Full.
However, if you are experiencing performance problems, try reducing the accelera-
tion value in slight increments to attempt to resolve the problem.

You can also configure the appearance of your folders, and some great cus-

tomization options are available to you. See Chapter 8 for details.
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Chapter 2

Managing Users
IN THIS CHAPTER

◆ Managing users

◆ Managing groups

◆ Using Group Policy

WINDOWS XP IS A true multiuser system, meaning different users can log on to the
computer and run Windows, all the while keeping private documents and settings
private. As such, you’ll need to manage user and group accounts in Windows XP
and configure them in a manner that is effective for your multiuser environment.
Along with user configuration, you might also want to use Group Policy, a feature
that allows you to enforce a number of systemwide settings and features that apply
to both the computer and the local user. This chapter explores all of these features
and shows how to make the most of user management in Windows XP.

Managing Users in Windows XP
Windows XP is a multiuser system, from both a home and professional perspective.
In the Windows 9x days, multiple people could use the same computer, but all users
could easily access others’ files and folders. In other words, there wasn’t much pro-
tection; any user could basically make any configuration changes to the computer
that he or she desired. This naturally caused a lot of problems for Windows 9x in
work environments, and some home environments as well. (If you let your children
use the computer, there was no way to control what they did to it.)

Windows XP leaves that legacy behind. With Windows XP, an administrator
account can manage the entire computer, but limited accounts have restrictions.
Regardless of the account, each user’s settings, files, and folders are kept separate
from other users and are completely protected by passwords (if you so choose).
Users log on to the local machine using a username and password, and each user’s
private files stay that way.

23
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You are probably also aware that user management can refer to a domain model,
where Windows XP Professional computers are used in a larger networking envi-
ronment. In this case, users do not (typically) log on to the local machine, but to a
Windows server. The server identifies the user and enables the user to log on to the
domain so that network resources can be used. Network administrators who work
with Windows 2000/XP servers handle user management in this kind of environ-
ment. In this chapter, user management and users always refer to local user man-
agement on your machine.

Because of the need for solid user management, Windows XP organizes itself
somewhat differently, based on the user. User accounts on your Windows XP com-
puter have their own folder, found in Documents and Settings folder under the
username. Using these profiles, Windows can easily store different configuration
settings, files, Internet Explorer Favorites and History, and a number of other items.
After a user logs on, he or she can access the information in his or her folders but
cannot access information in other users’ folders, unless the user is an administrator.

When you install Windows XP, there are two default accounts — administrator
and guest. The administrator account is automatically created, and it cannot be
deleted, disabled, or removed from the Local Administrators group (groups are cov-
ered later in this chapter). The guest account, on the other hand, is designed for
people who do not actually have a user account on the computer. A user can log on
with the guest account, but he or she essentially has no rights to do anything. You
can disable the guest account if you have no need for it, and in terms of security,
it’s a good idea to do so unless you are actively using it.

Working with User Accounts
Windows XP gives you two tools that can be used to set up user accounts on your
local computer — User Accounts in the Control Panel and Computer Management.
For experienced users, Computer Management is faster and easier to use than the
sometimes too friendly graphical user interface (GUI) of User Accounts, but some
important options are found in User Accounts that are not present in Computer
Management.

User Accounts in the Control Panel
The User Accounts option in the Control Panel presents you with a simple interface
(shown in Figure 2-1) for creating and managing user accounts on your computer.
You can see the current accounts and the icons associated with those accounts on
this screen as well.
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Figure 2-1: User Accounts in the Control Panel.

You can take three different actions from the User Accounts interface. 

◆ Change an account.

◆ Create a new account.

◆ Change the way users log on or off.

The following sections explore these options.

CREATE A NEW ACCOUNT
The User Accounts feature enables you to easily create new accounts with the help
of a miniature wizard that appears when you click Create an account option on the
main page. The following steps walk you through an account creation:

1. When you click the Create an account option, you are prompted to enter a
username and click Next. The user account name is the name that will
appear on the Welcome Screen and the Start menu, so you should use the
person’s real name as a general rule — there is no security reason to use
usernames other than the user’s actual name unless you do not want a
user to know who else logs on to the computer.
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2. On the next window, shown in Figure 2-2, you are prompted to choose an
account type, either Computer administrator or Limited. Select the desired
radio button and click Create Account. Before doing so, you have to deter-
mine the kind of account you are creating. The computer administrator
account gives the user total control over the computer. The administrator
can add and remove accounts, configure system components, install pro-
grams, and format and reconfigure hard drives; the administrator can do
anything — he or she has total control over the computer. You can have
more than one computer administrator, but you should be very careful to
whom you give this level of control. The limited account user can change
his or her password and desktop settings, create and view files, and view
items in the Shared Documents folder. Limited users may not be able to
install programs, and it is important to note that some pre-Windows XP
or Windows 2000 programs might not work well on limited accounts.
Basically, the limited user can use the operating system, but can’t make
any harmful configuration changes to it. When you have made your
selection, click the Create Account button.

Figure 2-2: Pick an account type.

CHANGE AN ACCOUNT
You can change an account at any time by clicking the Change an Account button
on the User Accounts interface. This opens a window where you simply click the
account you want to change.
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A window appears with a list of tasks that you can perform, such as change the
name, create a password (delete a password), and change the account type. You can
change anything you configured when you created the account, and you can
change the picture, create a password, and delete the account.

Windows XP’s theme uses pictures to represent user accounts, along with the
account name. A default, unique picture is assigned to each user. If you click the
Change Picture option, a window appears (shown in Figure 2-3) where you can
select a new picture icon from the provided list, or you can browse your computer
and locate another picture. You can use just about any kind of picture format
(JPEG, GIF, BMP, and so on). You might want to use company icons, or in a home
setting, you might actually use a photograph of the person to represent the user
account. Simply choose a desired picture and click the Change Picture button.

Figure 2-3: Change Picture option.

The Create a Password option enables you to create a password for the user.
Windows XP gives you the freedom to have users log on with passwords, or to not
use them. A password ensures that only the person to whom the account belongs
can log on to the computer, assuming the password is kept secret. Again, in a very
small office or home situation, you may not want to use passwords, but if security
for some accounts is a concern, you need to assign a password. To meet security
standards, passwords should be at least seven characters long and use both letters
and numbers. Common names, phone numbers, and related information should not
be used. Keep in mind that if you do not use passwords, any user will be able to
click any account on the Welcome screen and log on; so even in a home situation
where you want to keep other family members out of your personal folders, use a
password.
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When you click the Create a password option, a window appears where you can
enter the password, reenter it for confirmation, and type a word or phrase as a pass-
word hint, as shown in Figure 2-4. The password hint is descriptive text that
reminds you of the password, but the hint can be viewed by anyone, so you have to
be careful.

Figure 2-4: Create password.

Finally, you can also delete an account. When you delete an account, Windows
will save all of the user’s desktop contents and the My Documents folder to a folder
named with the username on the desktop. This enables you to easily place the con-
tents on a disk and give it to the user who will no longer be accessing the computer.
If you want to use this option, click Keep Files — if not, click Delete Files.

CHANGE THE WAY USERS LOG ON OR OFF
The log on and off setting is a global setting that applies to all users. You have only
two check box options here:

◆ Use the Welcome screen — The Welcome screen provides the accounts cre-
ated on this computer so that a user can click on his or her account and
enter a password if necessary. Essentially, this is a graphical logon screen.
If you want a more secure environment, turn this feature off. A standard
Windows logon prompt will appear where the user must enter the actual
username and password and will not be able to see the usernames of the
other local users.
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◆ Use Fast user switching — Fast user switching enables quickly changing
users without closing any programs, which can be really helpful in a col-
laborative situation where several people are working on a project
together at one computer. The caveat here is that Fast user switching is
not compatible with offline files.

Creating a Password Reset Disk
One thing that users can and should do is access the User Accounts option in the
Control Panel and create a password reset disk. The password reset disk allows a
user to reset his or her password should the password be forgotten, rather than the
computer administrator having to take over and change it for the user. Once the
user creates his or her password reset disk, he or she should keep it in a safe, secure
place until it is needed. Follow these steps to create a password reset disk:

1. Open User Accounts in the Control Panel.

2. On the User Accounts window, click your user account icon.

3. On the next window, click the Prevent a Forgotten Password link option
in the Related Tasks box.

4. A wizard begins. Click Next on the Welcome screen.

5. On the Create Reset Disk window, choose the drive where you want 
to save the password key, such as your computer’s floppy disk drive.
Click Next.

6. On the next window, enter your current user account password and 
click Next.

7. The password key is recorded on your disk. Click Next, and then 
click Finish.

Creating User Accounts with
Computer Management
The Computer Management console also allows you to create and manage user
accounts and group accounts. With a little experience under your belt, this will
probably be the console you prefer to use. You can do everything here (and more)
that you can do with the Users option in the Control Panel, except assign pictures
to accounts and choose whether or not to use the Welcome screen and fast user
switching. Beyond that, Computer Management is faster and gives you more
options for user account configuration.

Computer Management is available in Administrative Tools in the Control Panel.
If you open Computer Management → System Tools → Local Users and Groups, you
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can click on Users and see a listing of the user accounts on your computer. You’ll
notice in Figure 2-5 that some of the listed accounts, aside from Administrator and
Guest, were not created by you. These accounts are used by Microsoft support,
Internet Information Server (IIS) (if it is installed), and for Remote Desktop help
assistance.

Figure 2-5: Computer Management.

Notice that you cannot assign new accounts as Administrator or Limited

here, but you can configure the account properties, which will be discussed

in the next section.

Using the Computer Management console, you can easily create new users and
manage existing user accounts. The following steps show you how to create a new
user with the Computer Management console.

1. Open Computer Management → System Tools → Local Users and
Computers. Right-click the Users container and then click New User.

2. The New User window appears, as shown in Figure 2-6. Complete the
information in the text boxes. If you want to assign a password, enter and
confirm the password and choose one of the following check boxes:

■ User must change password at next logon — This option enables you
to provide a default password to the user so he or she can log on to the
computer, but once logged on, the user must create his or her own
password that is used from that point on.

30 Windows XP for Power Users

549987 ch02.qxd  11/20/03  11:38 PM  Page 30



■ User cannot change password — If you prefer to provide passwords
instead of allowing the users to create them, choose this option.

■ Password never expires — If you have Group Policy configured to
expire passwords after a certain length of time, you can check this box
to override the expiration policy, if necessary. See the Group Policy
section later in this chapter to learn more about Group Policy.

■ Account is disabled — You can disable an account here if you want to
stop the user from logging on with the account, but you won’t delete
the account.

3. When you are done, click the Create button. The new account appears in
the Users container.

Figure 2-6: New user creation.

Managing User Accounts
Just as you can create a new user account with the Computer Management console,
you can easily manage the accounts that you create. If you select Users in the left
pane, a list of users configured on your computer appears in the right pane. If you
select a user in the right pane and right-click the icon (or use the Action menu), you
can choose to reset the account’s password, in which case a dialog box appears.
This action is the same as using the User Accounts interface — if you have to reset
an account’s password, all Effective Field Size (EFS) encrypted files, Web pass-
words, and related settings are lost. Because of this, it is best for users to create
their own password backup disks so that data isn’t lost when a user forgets his or
her password.
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You can also delete and rename the account, and you can click Properties to
access the Properties sheets. On the Properties sheets, you see three tabs. On the
General tab, you can make the same changes that were presented when you created
the account. You can configure the password never to expire, choose an option so
that the user must change the password at next logon, a combination of these, and
so on. An additional check box you will see here is the Account is locked out
option. Depending on the Group Policy settings, a user’s account may lock after so
many unsuccessful password attempts. This is a security feature that keeps someone
from trying to break the password by entering guesses over and over. In environ-
ments where security is an issue, “three tries and you are locked” is often the pol-
icy. You can’t lock the user’s account here; you can only unlock it if it is locked
from failed password attempts.

The Member of tab provides a place to add the user to groups that are configured
on your computer. Group membership determines what the user is able to do on the
computer (or not do). To add a user to a group, click the Add button and select the
desired group from the list that appears. You can learn more about the default
groups and group usage in the next section.

Finally, you also see a Profile tab. If a profile or logon script is used with the
user, you can point to the location of the profile or logon script here. Because you
are dealing with local users, you probably will not use this tab, and most profile
information is now configured in Group Policy, which is also explored later in this
chapter.

Managing Groups
Windows XP configures several default group accounts for you. The purpose of
groups is to organize users so that they have certain permissions. With local user
configuration, groups are not such a big deal because your users are typically either
administrators or those with limited accounts, which are provided by default. This
group structure is the same as that used by network administrators to organize net-
work users and assign permissions. Group configuration and assignment can get
very complex if you are a server administrator, but for the local computer, you’ll
spend little to no time worrying about groups. The important thing to realize is that
each user account needs to be assigned to at least one group that has the permis-
sions that you desire.

There are several default groups, with the three primary groups being
Administrators, Power Users, and Users. Table 2-1 outlines each of these groups and
the other groups that might appear on your system.
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TABLE 2-1 DEFAULT WINDOWS XP GROUPS

Group Explanation

Administrators Computer administrators have complete control
over the computer. Administrators can add and
remove users and groups, configure the system,
install and remove hardware, reconfigure hard
drives, install applications, and perform any other
action that is available under Windows XP.

Power Users Power Users can perform most actions that
administrators can perform, but they can only
modify and delete accounts that they create. Also,
they can only modify group memberships that they
have created. They can remove users from Power
Users, Users, and Guests groups. They cannot
modify the administrators and backup operators
groups, take ownership of files, or perform backup
and/or restore functions. They cannot change
device drivers or manage security or log and/or
auditing.

Users This is the default limited user account. Users can
configure the desktop systems and create files, but
they cannot make any configuration changes to
the system, add or remove accounts, or access
other users’ folders.

Backup Operators Backup Operators can back up and restore files on
the computer, regardless of which user owns those
files. Backup operators cannot be changed.

Guests This enables a guest to log on to the computer.
Guests can perform basic computing actions, but
do not have all of the abilities given to the limited
user accounts.

Network Configuration Operators This provides some basic administrative privileges
for the configuration of Windows XP’s networking
features. Typically, under local usage, the
administrator would handle these functions.

Remote Desktop Users If Remote Desktop is configured, this group is
provided for remote desktop users to access the
remote access connection.

Continued
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TABLE 2-1 DEFAULT WINDOWS XP GROUPS (Continued)

Group Explanation

IIS Groups If IIS is installed, you’ll see additional groups, such
as administrators for the Web site, authors for the
Web site, and so on.

Help Services Group This is provided for the Help and Support Center.

Along with the default groups, you can also create your own group. Just right-
click the Groups container and click New Group. Then name the new group and add
the desired users, as shown in Figure 2-7. Organizing a group this way enables you
to add this new group to the default security groups, as provided. Of course, you
can simply add individual users to the default security groups, and if only a few
people use the Windows XP computer, this is probably your easiest choice. If you
double-click a desired group in the console pane, you can see the current members
of the group and adjust the members, as desired.

Figure 2-7: New Group.

Using Group Policy
One of the biggest problems in networking environments and on a standalone,
multiuser computer is managing other users. Say you are the administrator for a
local computer, and your family members also use the computer. You control what
the other users can do with user accounts, but you wish you had more power to
fine-tune their capabilities on Windows XP. Well, you can use a tool called Group
Policy.
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Group Policy is used to invoke certain settings on computers and user accounts
and control what users are able to do. On a network, network administrators can
use Group Policy to automatically install and manage software on their users’ com-
puters, enforce settings, and even automatically remove software when it is no
longer needed.

If you have read anything about Group Policy, you may think of it as a network
feature. While it is true that the main focus of Group Policy is the configuration of
network clients by network administrators, you can also use it to administer your
local computer so that settings you configure affect the users logging on to the
computer. This is a powerful way to standardize settings for all users.

Group Policy is not available to you as a tool in any folder, but it is available as
a Microsoft Management Console (MMC) snap-in. You can add the snap-in to a
new or existing console and begin using Group Policy as a management tool on
Windows XP. To use Group Policy, you must be using Windows XP Professional,
and you must log on as an administrator. The following steps show you how to
open the Group Policy console.

Refer to Chapter 10 for more information on the MMC.

1. Click Start → Run. Type MMC and click OK.

2. In the MMC console, click File → Add/Remove Snap-in.

3. In the Add/Remove Snap-in window, click Add.

4. In the Add Standalone Snap-in window, select Group Policy, as shown in
Figure 2-8, and click Add.

Figure 2-8: The Add Standalone Snap-in window.

Chapter 2: Managing Users 35

549987 ch02.qxd  11/20/03  11:38 PM  Page 35



5. In the Welcome to the Group Policy Wizard window, shown in Figure 2-9,
leave the default selection, Local Computer, selected, then click Finish.

Figure 2-9: Group Policy window.

6. Click Close on the Add Standalone Snap-in window and click OK on the
Add/Remove Snap-in window.

7. The snap-in appears in the Console. Click File → Save As to save the con-
sole. Name the console group policy and save it to a desired location.
From now on, all you have to do is double-click the new console to open
Group Policy.

Group Policy Features
After you have the Group Policy snap-in loaded, you see the Local Computer Policy
node. This expands into the Computer Configuration node and the User
Configuration node. The Computer Configuration node contains settings that you
want to impose on the computer system when users log on. For example, you can
use the Computer Configuration node to automatically enable disk quotas for users
on your computer. On the other hand, the User Configuration node provides you
with settings you can apply to the user. If you click through the options in either
container, you’ll notice that they are largely the same. This is because computer set-
tings apply to a computer whereas user settings apply to the user, regardless of
what computer he or she is logged onto. Because you are only configuring the local
user on the local computer, settings are rather redundant. I’ll help you explore your
options later in this chapter.
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If you expand each category, you see Software Settings, Windows Settings, and
Administrative Templates. Each of these nodes then further expands into different
categories of settings, which may also expand into different categories as shown in
Figure 2-10. Once you expand into a category, the different available settings you
can apply from within that category appear in the details pane.

Figure 2-10: Group Policy settings.

Configuring Group Policy Settings
Once you navigate through the policy options in the left-hand pane, you can locate
the desired policy you want to implement in the right-hand pane. You can config-
ure a desired setting by double-clicking it to open the category. This opens the set-
ting window for the desired item. For example, you can see in Figure 2-11 that I
have opened the Enable Active Desktop Properties window. At this point, I can use
the Setting tab to enable the active desktop, disable it, or leave it unconfigured. 
If you click the Explain tab, you learn more about the particular entry. The large
dialog box that appears in the middle of the window may become active, depend-
ing on your selection and entry. If it does, another setting becomes available for
you to configure for your policy. What you see here all depends on the policy you
are configuring.
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Figure 2-11: The Enable Active Desktop Properties window.

Before using Group Policy, it is important that you have a firm understanding of
the Not Configured, Enabled, and Disabled options. To make sure you configure
Group Policy to meet your needs, make sure you understand the following:

◆ Not Configured — The setting is simply not configured — in other words,
no setting is written to the registry. Whatever the setting is by default,
that is what is used.

◆ Enabled — The setting is enabled and written to the registry.

◆ Disabled — The setting is disabled and written to the registry.

Let’s return to the Active Desktop example I used earlier. Those settings would
mean the following:

◆ Not Configured — Nothing is changed and the default setting is used.
Active Desktop is not enabled by default, so it would not be enabled. 
The user can enable it if he or she wants, assuming he or she has proper
permission to do so.

◆ Enabled — Active Desktop is turned on and functional. Users cannot turn
it off.

◆ Disabled — Active Desktop is turned off and not functional. Users cannot
turn it on.
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The last two settings require registry entries while the first simply says, “Do
nothing.” As you are configuring Group Policy, remember that you should not
enable or disable any setting that doesn’t apply to you — leave the setting to Not
Configured. Otherwise, you are creating unneeded registry entries that can bog
down the computer’s loading time.

At the bottom of each policy window, you see the Supported on setting, which
will tell you if the setting applies to at least Windows 2000 or Windows XP. In later
revisions of Windows, this at-least setting will be more useful because more ver-
sions will support Group Policy. You can also navigate through the settings in the
category by simply using the Previous Setting and Next Setting buttons.

For the most part, the configuration windows you see within Group Policy look
the same as the examples shown here. However, depending on the settings, some
windows will have differences. For example, some of the security-setting dialog
boxes do not use an Enabled/Disabled appearance, but they provide you with 
a configuration option, such as the logon attempt lockout setting, shown in 
Figure 2-12.

Figure 2-12: Account Lockout Group Policy.

Regardless, the configuration windows you see in Group Policy are easy and
self-explanatory. Configuring Group Policy is as easy as locating the setting that
you want to change, adjusting the setting as desired, and clicking OK. When users
log on to the Windows XP computer, the setting in Group Policy will be applied.

To use Group Policy, you have to find the setting that you want to configure,
and then choose an enforcement option to invoke that policy. Locating what you
want can be a little challenging at times because you have so many potential set-
tings to choose from. It is also important to remember that a number of settings
that are found in the Group Policy console do not apply to local computer config-
uration. The Help files are also full of references to Windows 2000 domain config-
urations and other networking issues that do not apply to the local computer. This
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is because the Group Policy snap-in tool is a global tool used on both servers and
workstations. The following section reviews the major settings found in the differ-
ent nodes and points out the settings you are most likely to use. You can use this
information when you sit down to work with Group Policy as a sort of filter to help
you get to the settings you most likely need.

Computer Configuration
The following sections explore the containers found under the Computer Configuration
node. Keep in mind that Computer Configuration and User Configuration, though
useful, are designed for networked computers in a domain where users may log on
to the network at different workstations. User Configuration enables the users to
receive the same configuration regardless of the computer they are using, whether
there is a computer policy applied or not. Because you are configuring a local com-
puter with local users, most of your configuration is going to be focused in the
Computer Configuration node.

Software Settings
The Software Settings container provides a place where network administrators can
configure software packages that are delivered to computers on a network. It is a
way to automatically roll out software and manage it from one central location.
Because you are configuring a local computer, this setting does not apply to you.

Windows Settings
Windows settings contain Group Policy objects for startup and shutdown scripts, as
well as a variety of security settings. If you want to use startup and shutdown
scripts with users on your network, you can apply the scripts by opening the
startup or shutdown properties window and adding a script to the policy. Then the
script will be used each time the computer is started or shut down.

Under Security Settings, you see a number of additional containers. The follow-
ing sections and tables point out setting options on your computer that you might
find useful.

ACCOUNT POLICIES
Account Policies refer to password policy and account lockout policy for users.
Table 2-2 reviews the options you can configure here. I have listed the ones that
apply to the local computer only.

40 Windows XP for Power Users

549987 ch02.qxd  11/20/03  11:38 PM  Page 40



TABLE 2-2 ACCOUNT POLICIES

Policy Explanation

Enforce password history When enabled, requires Windows XP to remember
passwords for users. You can choose the number of
passwords that should be remembered.

Maximum password age The default setting is 42 days. You change it here.
Also, if you choose the “password never expires”
setting on a user’s account properties, the maximum
setting is overwritten so that it never expires.

Minimum password age When enabled, requires that a password be used for a
certain amount of time until it is changed. By
default, 0 is the setting.

Minimum password length You can use this setting to enforce a minimum
password length, creating more secure user accounts.
This setting is set to 0 by default.

Passwords must meet complexity Disabled by default, this setting requires both
requirements numbers and letters in the password.

Account lockout duration Specifies the amount of time that an account will
stay locked once it has been locked due to password
failure. This is not configured by default.

Account lockout threshold Specifies the amount of time a user can attempt to
log on before the account is locked. This setting is 0
by default.

Reset account lockout counter Specifies the amount of time that passes before the
account lockout counter is reset.

LOCAL POLICIES
Local Policies include a section of settings concerning audit policy, user rights
assignment, and security options. Audit Policy contains a number of individual set-
tings, such as audit account logon events, audit account management, audit policy
change, and so on. Some of these apply to the local computer, while some are spe-
cific to networking. If you want to enforce auditing on your Windows XP
Professional computer, these settings can be enabled so that auditing always
occurs. The User Rights container contains a number of settings showing the
groups that have permission to perform a certain action.
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There are quite a few of these settings, and Table 2-3 points out the ones that
you are likely to find helpful. The policy and the default settings are listed.

TABLE 2-3 USER RIGHTS ASSIGNMENT

Policy Defaults

Back up files and directories Administrators/Backup operators

Change the System Time Administrators/Power Users

Create pagefile Administrators

Increase scheduling priority Administrators

Load and unload device drivers Administrators

Manage auditing and security logs Administrators

Modify firmware environment variables Administrators

Perform volume maintenance Administrators

Profile single processes Administrators, Power Users

Profile system performance Administrators

Restore files and directories Administrators, Backup Operator

Shut down the system All groups

Take ownership of files and other objects Administrators

The final container under Local Policies is Security Options. The Security
Options container holds individual options for various security options, such as
accounts, auditing, devices, and so on. Table 2-4 points out the options under each
division.

TABLE 2-4 SECURITY OPTIONS

Policy Options

Accounts Provides individual settings for Windows accounts.
Configure administrator account status, configure guest
account status, limit local use of blank passwords,
rename administrator account, and rename guest
account.
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Policy Options

Audit Provides individual settings for auditing permissions.
Configure audit access of global system objects, audit the
use of Backup and Restore, and shut down the system
immediately if unable to log security events.

Devices Provides individual settings for devices, such as allow
undock without logon, allow format and eject removable
media, prevent users from installing print devices, restrict
CD-ROM access to locally logged-on user only, restrict
floppy access to locally logged-on user only, and unsigned
driver installation behavior.

Domain Controller Settings apply to domain controllers; not applicable for
Windows XP Professional.

Domain Member Settings for domain members; not applicable for
Windows XP Professional.

Interactive Logon Provides interactive logon settings, such as do not display
user last name, do not require CTRL+ALT+Del, message
text for users attempting to log on, and others.

Microsoft Network Client Provides machine configuration for networking, such as
digital signatures, and unencrypted password usage.

Microsoft Network Server Not applicable for Windows XP Professional.

Network Access Provides a number of network access settings, including
permissions and security models.

Recovery Console Provides settings for recovery console.

Shut Down Allows system shutdown without logon and clear virtual
memory pagefile options.

System Cryptography Provides encryption settings.

System Objects Provides default owner and internal system settings.

PUBLIC KEY POLICIES
This container holds the Encrypting File System container, which may not contain
any settings on your Windows XP computer.
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SOFTWARE RESTRICTION POLICIES
Software Restriction Policies allow you to set a default policy that enables or dis-
ables software usage, according to the user’s group membership. By default, the
unrestricted setting is configured, which you will probably want to change. If any
additional software restriction rules are available, those appear here as well.

IP SECURITY POLICIES ON LOCAL COMPUTER
If Internet Protocol (IP) Security is used on your network, the default client and
server policies reside here. A network administrator typically configures these set-
tings on an enterprisewide basis.

Administrative Templates
The final major container in the Computer Configuration node is Administrative
Templates. These are a collection of template settings from a number of Windows
Operating System (OS) divisions, such as Windows Components, System, Network,
and Printers. There are many available settings here, virtually all of which are not
configured. The following sections address these settings one container at a time.
While I do not address every possible configuration option, I do point out the ones
that are more likely to be useful from a local computer perspective.

WINDOWS COMPONENTS
The Windows Components division provides settings for NetMeeting, Internet
Explorer Task Scheduler, Terminal Services, Windows Installer, and Windows
Messenger. Under NetMeeting, your only option is to disable remote Desktop
Sharing. Under Internet Explorer, you have the configuration options as presented
in Table 2-5:

TABLE 2-5 INTERNET EXPLORER OPTIONS

Policy Description

Security Zones: Use only machine settings Applies the same zone settings to all
users. By default, each user can define his
or her own.

Security Zones: Do not allow users to Users cannot change security zone
change policies settings.

Security Zones: Do not allow users to add or Users cannot add or delete security sites.
delete sites

Make proxy settings per machine Proxy settings are applied to all users, not
configured on a user-by-user basis.
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Policy Description

Disable automatic install of Internet Explorer Prevents Internet Explorer (IE) from
components automatically installing new components.

Disable periodic check for IE software updates Disables IE from automatically checking
the IE update site for new downloads.

Disable software update shell notifications on If enabled, users will not be notified if IE
program launch updates their programs using the Microsoft

Software Distribution Channel.

Disable showing the splash screen The IE splash screen does not appear
when the user starts the browser.

The next option is Task Scheduler, which contains the setting options listed in
Table 2-6.

TABLE 2-6 TASK SCHEDULER

Policy If Enabled . . .

Hide Property Pages Users cannot view or change the properties of an existing
task.

Prevent Task Run or End Users cannot manually stop or start a task.

Prohibit drag and drop Users cannot add or remove tasks by copying them into
the Scheduled Tasks folder.

Prohibit new task creation Users cannot create new tasks.

Prohibit task deletion Users cannot delete tasks.

Remove advanced menu Users cannot change or view the properties of newly
created tasks.

Prohibit browse Users cannot change the schedule program for existing
tasks and are limited to the task items on their Start
menu.

The next section is Terminal Services. If you are using Terminal Services in
Windows XP to connect to Windows 2000 terminal servers, a network administra-
tor would typically configure these settings. You can easily review them if you like,
but unless you are a network administrator, you are unlikely to use these settings.
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Next, you can invoke settings for Windows Installer. Windows Installer helps
you add programs to and remove programs from Windows with ease, but you can
change some settings that can help you better control the Windows XP computer.
Table 2-7 outlines these for you.

TABLE 2-7 WINDOWS INSTALLER 

Policy If Enabled...

Disable Windows Installer Disables the use of Windows Installer.

Always install with elevated privileges Any programs are installed using system
permissions.

Prohibit rollback Stops Windows from creating rollback files so
that an install can be reversed.

Remove browse dialog box for new source Disables the Browse button in Windows
Installer.

Prohibit Patching Windows Installer patches cannot be used.

Disable IE security prompt for Windows Allows Web-based programs to install
Installer scripts software on the computer without having to

notify the user.

Enable user control over installs Enables users to change installation options
that are normally available to administrators
only.

Enable user to browse for source while Users can search for installation files during
elevated privileged installations.

Enable user to use media source while Allows users to install programs from
elevated removable media during privileged installations.

Enable user to patch elevated products Programs can be upgraded during privileged
installations.

Allow administrators to install from  Allows administrators to install from Terminal
Terminal Services sessions Services sessions.

Cache transforms in secure location on Saves copies of transform files on the local
workstation computer.

Logging Determines the kinds of events that Windows
Installer logs.
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Policy If Enabled...

Prohibit User Installs Enables you to prohibit or limit user installs.

Turn off creation of System Restore Stops System Restore from functioning
Checkpoints because check points are not created.

Finally, under the Windows Message container, you have two options. You can
choose not to allow Windows Messenger to be used or not to automatically start
Windows messenger.

SYSTEM
The System container contains a number of different subcontainers with settings on
a variety of options pertaining to the Windows XP system. These settings are easy
to use and you can implement a number of interesting controls (detailed in the list
below). I suggest you spend a little time learning more about this portion of Group
Policy.

◆ User Profiles — Contains user profile settings, such as the following:

■ Do not detect network settings

■ Wait for remote user profile

■ Prevent roaming profile changes from propagating to the server

■ Only allow local user profiles

◆ Scripts — Provides settings for logon and logoff scripts.

◆ Logon — Provides logon settings, including the following:

■ Always use classic logon

■ Do not process the run once list

■ Do not process the legacy run list

■ Always wait for the network at computer startup

◆ Disk Quotas — Provides disk quota settings, such as the following:

■ Enable disk quotas

■ Enforce quota limit

■ Default quota limit and warning level

■ Log event when quota is exceeded

■ Apply policy to removable media
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◆ Net Logon — Provides logon settings when logging on to a Windows
domain. These setting are typically set on client computers by network
administrators.

◆ Group Policy — The Group Policy settings determine how Group Policy is
refreshed on client computers and other network administration issues.
Most of these settings are used by network administrators for network
client computer configuration.

◆ Remote Assistance — Provides two settings where solicited and offer
remote assistance can or cannot be used.

◆ System Restore — You can choose to turn off system restore and 
configuration.

◆ Error Reporting — Provides advanced error reporting settings and error
notification.

◆ Windows File Protection — Provides Windows File Protection settings,
such as the following:

■ Hide file scan progress window

■ Limit Windows file protection cache size

■ Specify Windows File protection cache location

◆ Remote Procedure Calls (RPC) — Enables RPC troubleshooting state infor-
mation and propagation of extended error information.

◆ Windows Time Service — You can enable global configuration settings
here that apply to all local users.

NETWORK
The Network settings provided under Administrative Templates may be useful for
local user and computer configuration, although a number of these are more appro-
priately used by network administrators. The following list reviews these options.

◆ Domain Name Server (DNS) Client — Provides DNS client settings. These
are typically configured by network administrators.

◆ Offline Files — If users on your computer use offline files, you can enforce
a number of settings here, including the following:

■ Allow or disallow offline files

■ Prohibit user configuration of offline files

■ Allow default cache size
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■ Do not allow files to be cached

■ Turn off reminder balloons

■ Assure even logging level

■ Encrypt the offline file cache

■ Configure slow link speed

◆ Network Connections — Contains settings for Internet Connection Sharing
(ICS) and Internet Connection Firewall (ICF)

◆ QoS Packer Scheduler — Provides Quality of Service (QoS)-enforced set-
tings. These are normally configured by network administrators.

◆ Simple Network Management Protocol (SNMP) — SNMP is used and con-
figured by network administrators.

PRINTERS
The Printers container holds settings that network administrators configure to
determine how and if users can publish printers on the Active Directory on a
Windows 2000 network. Nothing can be configured here for the local machine.

User Configuration
As I mentioned earlier, many of the settings under User Configuration are the same
as those under Computer Configuration. Keep in mind that on a network, Computer
Configuration applies to a group of computers and User Configuration applies to a
group of users. Computers receive their policy and users receive their policy —
regardless of what computer is logged on to or whether that computer is managed
by Group Policy.

You can invoke a number of user-specific settings. You may find these helpful,
especially if you need to tightly control users who log on to your computer (such as
your children or co-workers). I’ll not repeat information covered in the previous
section, but I do want to point out some of the interesting options available to you.

INTERNET EXPLORER
If you expand Windows Settings, you’ll see a container for Internet Explorer
Maintenance. If you open this up, you’ll find a number of fun items. For example,
as you can see in Figure 2-13, you can create your own custom title for Internet
Explorer. You can also access options to create a custom logo and animated
bitmaps, and you can even customize the toolbar background. These settings are
primarily provided for companies who want to provide company branding on IE,
but you can play around with them too and create your own custom look.
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Figure 2-13: IE custom title bar option.

Additionally, you can use the categories provided under Internet Explorer
Maintenance to customize the following:

◆ The connection

◆ Favorites

◆ The home page

◆ Security settings

◆ Default programs

Using Group Policy, you can configure most of the items you find on Internet
Options so that they are enforced for all users on your computer.

START MENU AND TASKBAR
You can configure the Start menu and taskbar and force desirable configurations
on other users. If you expand Administrative Templates, you see the Start Menu
and Taskbar node. There are a number of settings here; the following list points out
some of the more interesting ones:

◆ Remove links and access to Windows Update

◆ Remove My Documents from the Start menu

◆ Remove Programs from the Settings menu

◆ Remove Network Connections from the Start menu

◆ Remove Search from the Start menu (in fact, you can remove just about
anything)
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◆ Add Logoff to the Start menu

◆ Prevent changes to the Start menu and taskbar

◆ Turn off personalized menus

◆ Do not keep history of recently opened documents

◆ Prevent grouping of taskbar items

◆ Lock the taskbar

◆ Force Classic Start menu

◆ Remove balloon help

◆ Remove and disable the Turn Off Computer button

◆ Hide the Notification Area

DESKTOP
As with the Start menu and taskbar, you can customize the desktop as well. Again,
a number of configuration options are available; the following list points out some
of them:

◆ Hide and disable all items on the desktop

◆ Remove the Recycle Bin from the desktop

◆ Prevent adding, dragging, dropping, and closing the taskbar toolbar

◆ Don’t save settings at exit

◆ Prohibit adjusting desktop toolbars

◆ Remove the Desktop Cleanup Wizard

CONTROL PANEL
Finally, you can customize the Control Panel settings and keep users out of config-
uration areas where they should not be. For example, you can do the following:

◆ Prohibit access to the Control Panel

◆ Hide specified Control Panel applets

◆ Force Classic Control Panel style

◆ Prevent the addition and/or deletion of printers

◆ Remove Display in the Control Panel

◆ Hide the Screen Saver tab
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◆ Hide the Appearance and Themes tabs

◆ Hide desired themes

◆ Remove Add/Remove Programs

◆ Hide Add/Remove Windows Components page

◆ Remove Support information

As you can see, you can configure many, many different policies on your

local machine. The important point to remember is that you should only

enable policies that you really want to enforce. Be wary of enabling too

many settings that cause too many user restrictions and too many registry

entries. They have a tendency to bog down your computer and be ineffec-

tive. Just because you can enable a policy doesn’t mean you should, so your

best approach to using Group Policy is to keep things simple and effective.
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Chapter 3

Working with Applications
IN THIS CHAPTER

◆ Installing and Removing Applications

◆ Working with Application Compatibility

◆ Managing Applications

APPLICATIONS ARE AN OPERATING system’s mainstay. Without applications to per-
form the tasks you need, your operating system doesn’t do a whole lot on its own.
You can surf the Internet, network with other computers, and perform standard
kinds of operating system functions, but applications are the major reason to own
a computer. Fortunately, installing and running applications on Windows XP is
easier than on any other Windows operating system. Unfortunately, not all applica-
tions are compatible with Windows XP, and some of the older applications from
your Windows 9x days simply are not going to work well. However, Windows XP
includes more tools and features for installing and managing applications than ever
before, and this chapter explores those tools and features.

Installing and Removing
Applications
You can find just about any application you might want to use on Windows XP,
from word processing to games. Just visit your local or online computer store and
start browsing through the variety of titles available. However, the greatest mistake
people often make is assuming that all software applications will work with
Windows XP. Just because a software package says, “compatible with Windows” on
the box does not mean that it is actually compatible with Windows XP. Software
written for Windows 9x might not work with Windows XP at all, or if it does work,
it may work intermittently. So, the number one rule of using applications on
Windows XP, or any operating system for that matter, is to use applications that are
written for Windows XP. This almost guarantees that you will have few, if any,
problems. Fortunately, even if your favorite software is not explicitly written for
Windows XP, Windows XP gives you a few tools and options that can help you
manage it.
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Like Windows 2000, Windows XP does not allow programs to alter operating
system files or run in the operating system’s memory space. Windows 9x sort of
took an anything goes approach to software, making the operating system much
more susceptible to aggravating system lockups. In Windows XP, lockups can still
occur, but they are less frequent and usually easier to recover from than they were
in Windows 9x.

Installing Software
Software is installed by launching a setup program, such as setup.exe. The setup
program copies the software’s files from a source to a folder on the computer’s hard
drive. The setup program can be launched from an Internet download or from an
installation CD. Most software sold today has an autostart feature on the CD that
walks you through the installation process. If an installation CD does not automat-
ically start the installation, you can simply browse the CD and locate the setup
program.

You can also use Add/Remove Programs in the Control Panel to install a pro-
gram. You’ll see an Add New Programs button on the left side of the screen, as
shown in Figure 3-1. After you click the Add New Programs button, you can click
the CD or Floppy button to begin an installation from a floppy disk or CD-ROM.
You can also install programs that are available from a network share. If you want
to download something from the Windows Update site, click the Windows Update
button. Essentially, the Install option found here looks for setup.exe on the floppy
disk or CD.

Figure 3-1: Add/Remove Programs.
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There are two ways to remove a program from your computer. Some programs
come with their own uninstall option. You just put the CD-ROM into the CD-ROM
drive, let it automatically begin, and a window appears that allows you to install
additional components or remove existing components — or the entire program.
Microsoft Office is an example of a program that uses this feature. Some programs
also have a built-in uninstall routine. You can click Start → Programs, and then
point to the program’s folder and a menu pops out with an uninstall option.

If you have a program that doesn’t help you with the uninstall, you can use
Add/Remove Programs in the Control Panel. When you open Add/Remove
Programs, you see a list of programs. The programs listed in this window are
installed on your computer. To remove one of them, simply select it and click the
Change/Remove button. Follow any additional prompts that appear.

Some programs give you a Change button and a Remove button, while

some only give you a Change/Remove button. If you have programs that

can be upgraded, or if additional parts of the program can be installed, you’ll

see both Change and Remove. This allows you to install additional portions

of the program, or simply remove the program from your computer.

What do you do if you simply can’t get rid of a program? There is no uninstall
option on the CD-ROM, and the program is not listed in Add/Remove Programs as
an option you can uninstall. Although this normally does not happen, you can still
remove the program by deleting its folder. This is not a recommended action
because you may experience problems due to leftover application files. For exam-
ple, if other applications use the application files you want to delete, you might
have problems with other applications working after these files are deleted, and this
action does not remove registry settings. However, this option can be used when
absolutely necessary. Just follow these steps:

1. Open My Computer, then double-click your C: drive icon.

2. Locate a folder called Program Files and double-click it. You may need to
click the View All Contents link as prompted.

3. Look through the folders and find the one that has the program you want
to uninstall. Typically, the name of the folder will say the program’s name
or the manufacturer’s name.

4. When you have found the folder, right-click it and click Delete to remove
it from your computer. Make sure you are deleting the correct folder
before completing the action.
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Using Applications Not Written for
Windows XP
Windows XP includes a new feature, called Compatibility Mode, that allows
Windows XP to act like a previous version of Windows (specifically, Windows 95,
98, Me, NT, or 2000). The purpose of Compatibility Mode is to allow you to use
older applications that might not work with Windows XP. When in Compatibility
Mode, Windows XP acts like the version of Windows you select so that the appli-
cation is tricked into thinking it is installed on the correct operating system. In this
way, you can use older applications that are not 100 percent compatible with XP.

It is important to note that Compatibility Mode is intended for standard applica-
tions and even games. However, Compatibility Mode is not designed for use 
with programs that run portions of your system configuration. For example,
antivirus programs that are incompatible with Windows XP should not be used
because the program might damage your system in Compatibility Mode. The same
is true for disk management utilities and backup software. In other words, if the
application is used to manage the operating system or a portion of the operating
system, it should not be used with Compatibility Mode — you need to upgrade and
get the compatible version of the software.

Windows XP’s compatibility functions use application database files that inter-
act with programs that you install. Because programs are outside of the operating
system kernel, the application database files are used as a translator for the pro-
gram and the operating system. These fixes, which are also called shims, are held in
this database file, which contained about 200 at the time of XP’s release. Shims can
be used by any application, but third-party developers cannot write new shims for
Windows XP. This is a security protection feature that Microsoft implemented.
What you get out of the box is all you get. The compatibility modes and shims pro-
vided with Windows XP support around 100 of the most popular programs so they
can work with Windows XP. However, they do not support everything, and they
certainly don’t support any custom applications. However, you can still try to use
one of these applications with Compatibility Mode and you might have good
results. Be sure to use Windows XP’s dynamic update and Windows update from
time to time to ensure that your XP system has all of the available shims in its
database.

With shims, Windows XP can invoke several compatibility modes. Essentially, a
compatibility mode enables XP to use the identified shims for that category and fix
the application compatibility problems that the program has with Windows XP.
These shims emulate the operating system that is needed by the program. For
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example, if an application is written for Windows 98, the shims can emulate the
structure of the Windows 98 registry, the location of certain system and user fold-
ers, file paths, and related changes in the operating system that the application
would not be able to handle. The compatibility modes available in Windows XP are
as follows:

◆ Windows 95 — Emulates the Windows 95 environment.

◆ Windows 98/Me — Emulates the Windows 98/Me environment.

◆ Windows NT 4.0 — Emulates the Windows NT 4.0 environment.

◆ Windows 2000 — Emulates the Windows 2000 environment.

◆ 256 colors — Reduces video card color to 256 colors for applications that
can only handle 256 colors.

◆ 640 × 480 Screen Resolution — Restricts screen resolution to 640 × 480
for applications that can only handle that screen resolution.

◆ System Modes — A few other modes are available that power users and
administrators can invoke. These modes are used to limit or manage secu-
rity and profiles for the user to run programs that require a limited secu-
rity context.

◆ Custom Modes — You can create a custom mode for a particular applica-
tion, based on the application’s needs using the Compatibility
Administrator tool, explored later in this chapter.

Using the Program Compatibility Mode Wizard
You can easily configure a program to run in Program Compatibility Mode with the
help of the Program Compatibility Mode Wizard. The following steps show you
how to use the wizard:

1. Click Start → All Programs → Accessories → Program Compatibility Wizard.

2. The Program Compatibility Mode Wizard appears. Click Next on the
Welcome screen.

3. In the next window, choose the desired radio button to locate the pro-
gram, shown in Figure 3-2. Make your selection and click Next.
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Figure 3-2: Choose a program option.

4. In the next window, choose the operating system that you want to emu-
late, such as Windows 95, NT 4.0, Windows 98/Me, and so on.

5. In the next window, you can choose the screen resolution that the pro-
gram works best under, or you can choose to disable Windows visual
themes, which can interfere with some older programs. However, the set-
tings here typically apply to games and educational programs that use a
lot of graphics. If you do not want to use any of the settings, simply click
Next without selecting any items.

6. In the next window, click Next to test the compatibility settings with the
program.

7. The program opens and runs. Use the program for a few minutes to see 
if the program works correctly. Then close the program to return to the
wizard.

8. The wizard asks you if the program works correctly. If so, click Yes to
continue, or No to try different compatibility settings. Click Next.

9. The Program Compatibility Wizard collects information about your pro-
gram and provides you with a dialog box so that you can send compati-
bility information to Microsoft. Click Yes or No and click Next.

10. Click Finish. To change settings at a later time, simply rerun the wizard.
You can now open the program and use it normally.
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You can avoid having to use the Program Compatibility Wizard and more easily
apply a compatibility mode to a program by right-clicking the program’s exe-
cutable file and clicking Properties. You see a Compatibility tab, as shown in
Figure 3-3. Simply choose to run the program in compatibility mode, choose an
operating system to emulate, and apply any display settings, as needed.

Figure 3-3: The Compatibility tab.
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Running 16-bit and MS-DOS Applications
Windows XP has the capability to run old 16-bit applications and MS-DOS
applications (which are also 16-bit applications) that were originally developed for
Windows 3.x. Basically, all programs sold today are 32-bit applications, but your
environment may have a custom application that was developed years ago that
management still wants to use on Windows XP. To run 16-bit applications, Windows
XP starts a virtual machine, which is a subsystem designed to mimic the Windows 3.x
environment so that these applications can run. The subsystem places the 16-bit
application in its own virtual machine, or memory space, so that the application runs
without interfering with other applications on Windows XP, in theory anyway.
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Using Additional Compatibility Tools
Aside from using the basic program compatibility settings to run an application,
you can also configure some custom settings, or at least attempt to use a few com-
patibility tools that can make an application or program work with Windows XP,
namely the Compatibility Administrator tool. The tools explored in the following
sections are designed for administrators, and they can be complicated. However,
with a little work, you may be able to solve compatibility problems with trouble-
some programs.

To access the additional compatibility tools, you’ll need to download the
Application Compatibility Toolkit (version 3.0 at the time of this writing) from
http://msdn.microsoft.com. After you download and install the toolkit, you’ll
see an HTML page that outlines the documents and tools in the toolkit. If you click
on the Application Compatibility Tools link, you’ll be able to see the three tools
summarized in the following sections. Be sure to use the Help files within each tool
to learn more.

Application Compatibility Analyzer
The Application Compatibility Analyzer is a tool that collects application informa-
tion from computers, along with identifying machine information. Its main purpose
is to automate the process of collecting an inventory of applications used across all
of the machines in an organization; therefore, it is primarily used by IT administra-
tors managing Windows networks. Once data is collected, the tool can generate
reports about application data by departments or computers, or can locate the num-
ber of instances of a certain application across an organization. The tool contains
two pieces: the Collector tool (collector.exe), which is run on the client computers
to gather and log the data, and the Analyzer Tool (analyzer.exe), which merges all
of the data collected. The tools are HTML-based and work like Web page wizards.

Application Verifier
The Application Verifier tool, which was designed for developers, is used to locate
difficult problems with applications. Specifically, it helps software developers iden-
tify subtle or minor problems with an application. Because this tool was designed
for software developers, it doesn’t provide any direct help to users.

Compatibility Administrator
The Compatibility Administrator is designed for administrators and gives you 
the ability to determine the correct combination of compatibility fixes needed to
support an application on Windows XP. The fixes are then applied through the
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single-compatibility interface. In short, this is the tool you need to use if you are
having problems getting a certain application to work on Windows XP. Note that
this tool doesn’t guarantee compatibility, but it can give you a greater chance for
application compatibility when the Program Compatibility Wizard has not helped.
This tool can do the following:

◆ Test applications with compatibility modes

◆ Test individual compatibility fixes

◆ Create custom compatibility modes and databases and related tasks

To run the Compatibility Administrator, click Start → All Programs → Microsoft
Windows Application Compatibility Toolkit → Compatibility Administrator Tool
(see Figure 3-4).

Figure 3-4: Compatibility Administrator.

The left pane lists all of the applications that are supported by fixes in Windows
XP. As you scroll through the list by expanding applications, you can see there are
quite a number of them. In the right pane, you can select one of the applications
and see the executable file the fix applies to and the actual compatibility fixes that
are applied to this application by default. You also see the file-matching results
ensuring that the executable is the correct one for the application, as shown in
Figure 3-5.
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Figure 3-5: Applications and fixes.

If you are having a hard time browsing the applications and fixes, you can con-
trol how much information is displayed using the View menu. By default, compat-
ibility fixes, compatibility modes, Apphelp entries, and applications patches are all
displayed. If you just want to see how patches are applied, you can clear the check
next to the other items and the view will be a lot easier to work with.

You can perform several important actions with the Compatibility Administrator.
First, you can disable fixes. Keep in mind that the application databases provide
information about applications Microsoft has determined fixes for and the fixes
that should be applied. When a user invokes the Application Compatibility Wizard,
a match for that application under the desired Windows version is attempted.
However, you may need to change this behavior for a particular application. You
can use the default fixes assigned by the database and overlayed with the chosen
operating system, you can remove them and apply your own, or you can simply
add to the existing one. You can also disable the default database fix for an appli-
cation, and then use the tool to create your own fix. Then that fix can be run or
even deployed. Disabling a fix disables it on the local system but does not delete it;
you can easily reenable the fix at a later time.

One of the most powerful options that Compatibility Administrator provides is to
enable you to create custom databases and custom fixes for the applications, as
needed. When you first open Compatibility Administrator, a new database is cre-
ated for you and appears in the lower-left portion of the screen. By default, this
database is named New database(1).sdb. You can use the Database menu to rename
the database, as desired. You can also perform a few additional actions using the
Database menu that specifically allow you to create custom fixes for your new
database.

Aside from creating custom fixes from this window, you can also create your
own compatibility mode. For example, say that your environment has several cus-
tom applications. You could create a custom fix for those applications by creating
your own custom compatibility mode. Then the mode could more easily be applied
to the desired applications.

62 Windows XP for Power Users

549987 ch03.qxd  11/20/03  11:38 PM  Page 62



Once you have created the custom fixes and/or compatibility modes for your
custom database, you can deploy that database to other Windows XP machines. In
a sense, this is misleading because the console doesn’t actually help you deploy the
SDB database file that you created. You save it in the console, and then simply copy
the SDB database file to the desired Windows XP computers. You can deploy the
file using a simple network share, floppy disk, or whatever works best for you. The
point is that the console doesn’t provide a delivery method. After the file is located
on the other XP machines, simply run the SDB file on those machines, and
Windows XP will register the new database.

Obviously, the Compatibility Administrator is a complex tool, so if you are inter-
ested in using it, make sure you study the Help files, which will give you detailed
instructions and steps for completing various tasks.

Managing Application Performance
Aside from getting applications to work with Windows XP, perhaps one of the
greatest program issues you are likely to be concerned with is performance. Certain
applications run slowly on Windows XP, or, generally, all applications run slowly.
Fortunately, the potential performance problems are usually easy to spot, but solv-
ing them can be another story because you are limited in what you can do.

First of all, it is important to check hardware requirements. As with most other
things in the computing world, you can’t run software on a computer that does not
have the required system hardware; at least you can’t run software effectively. In
truth, many applications and even games today require fast processors and plenty
of RAM. This is especially true of photo and video production applications that
have become so popular in the past few years. The simple reality is that the com-
puter should exceed any minimum hardware requirements as posted by the soft-
ware manufacturer. If the hardware requirements are not met, the application may
run, but probably very slowly. In this scenario, your only real option is to upgrade
the computer’s hardware.

Another issue concerning performance comes back to compatibility. You might
be able to get an incompatible application to run using the Program Compatibility
Mode, but that application still might not run as fast or perform as well as you
would like. This is simply a problem with compatibility for which there is no good
solution, except to upgrade to a compatible application.

Windows XP does have a couple of settings to make sure Windows XP is opti-
mized for applications. The correct settings are actually configured by default, but
if you are having a lot of performance problems with programs, you should check
these settings. Right-click My Computer, click Properties, and then click the
Advanced tab. Click the Settings button under Performance and the Performance
Options dialog box appears. Click the Advanced tab, shown in Figure 3-6. The
Processor scheduling and Memory usage settings should both be set to Programs. If
they are not, select the Programs buttons and click OK.
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Figure 3-6: Performance Options.

Why would anyone change these settings? If you were to use Windows XP

Professional on a network as a file server or print server, you could change

these settings to boost background services and give more memory to the

System Cache (which would be needed in this case). In a normal operating

mode where XP is used as a standard desktop computer, though, this setting

should always be set to Programs.

Managing Applications and Solving
Problems
If you used Windows 9x, you are probably familiar with the common application
lockups and crashes that happened frequently. Unfortunately, Windows XP is not
immune from this behavior, but it happens much less frequently. Once again, if you
are using applications that are not quite compatible with Windows XP, you are
more likely to experience problems than when using applications that are designed
for Windows 2000/XP.
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As with previous versions of Windows, your main tool for controlling applica-
tions and getting control of the operating system when something goes wrong is
Task Manager. To use Task Manager, press CTRL+ALT+DEL. Task Manager should
appear; if it does not, click the Task Manager button. You’ll see the Windows Task
Manager dialog box, as shown in Figure 3-7. On the Applications tab, you will see
all applications that are currently open and their status (running, failed, and so on).
To stop an application from running, select the application in the list and click
End Task.

Figure 3-7: Task Manager.

You can also use the Processes tab found in Task Manager to end application
processes or set application priority. If you click the Processes tab, you can right-
click an executable that is running and point to Set Priority, then select a different
priority for the application. The following priorities are available:

◆ Realtime — The Realtime priority allows an application to have total con-
trol over all system resources. This can make the process run much faster,
but it has the potential to crash your system. As a general rule, avoid this
setting.

◆ High — The High priority gives a process priority over all other applica-
tions. This might make the process run faster, but it could interfere with
other processes running on your computer. Use this setting with caution.
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◆ AboveNormal — This option gives a process slightly more priority than
other processes. This can help speed up an application, but it can slow
other applications down.

◆ Normal — This is the default setting.

◆ BelowNormal — This setting causes the process to run more slowly than
other applications that are open.

◆ Low — This option gives other processes more priority than this process.

Should you adjust the priority settings for applications? As a general rule, the
answer is no. Windows XP does a good job of managing application priority, but if
you have several applications running and you want to make one run a bit faster
than the others, try giving the application an AboveNormal priority to see if this
helps performance. Keep in mind that the priority settings may work differently
with various applications, so you’ll need to experiment to see if you get any real
gains in performance.

Managing Automatic Updates
Windows XP supports the Automatic Updates feature, which allows Windows XP to
check the Windows Update Web site periodically for updates to Windows XP.
Depending on your configuration, Windows XP can automatically download and
install updates without an intervention from the user. However, you might not want
Windows XP performing this task automatically, in which case, you can manage
the updates manually.

If you open System Properties and access the Automatic Updates tab, shown in
Figure 3-8, you can choose one of three options:

◆ Download the updates automatically and notify me when they are
ready to be installed — This option automatically downloads the updates
and prompts you that they are ready to be installed. At this time, you can
choose to install the updates or decline the install.

◆ Notify me before downloading any updates and notify me again before
installing them on my computer — This option lets you know when an
update is available. You can then choose to download and install it.

◆ Turn off automatic updating. I want to update my computer
manually — If you do not want Windows XP checking for updates auto-
matically, use this option. You can then manually check for updates when
convenient by clicking Start → All Programs → Windows Update. Note that
you also have the option to restore updates that you have previously
declined.
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Figure 3-8: System Properties.

Programs and Users
If several people use your computer, you may not want them to have the ability to
add or remove programs. This could be true with a home computer used by several
different people, or one used at your office. As the computer administrator, you can
control the installation and removal of programs using Windows XP user accounts,
as well as local group policy.

Windows XP User Accounts
Windows XP provides local user accounts as Administrator accounts and Limited
accounts. Limited accounts cannot make changes to hardware or system configura-
tions. They are also limited when installing programs. Depending on your needs,
consider giving most users only Limited accounts locally on Windows XP, with
only key users having Administrative accounts on the computer. This can greatly
cut down on problems because Windows XP prevents Limited accounts from doing
anything drastic, including program management. However, some older programs
might not work well when users are logged on with Limited accounts, so keep this
in mind as you experiment with older programs. If you are in a domain environ-
ment, domain administrators can manage domain user accounts in such a way that
users are limited from installing programs as well. See Chapter 2 to learn more
about managing user accounts.
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Local Group Policy
On Windows XP Professional, a local computer administrator can also enforce local
Group Policy on other users who log on to the computer. (See Chapter 2 for more
information about local Group Policy.) This is yet another way to control what
users can and cannot do on the computer, including software installation and
removal. Using local Group Policy, you can invoke a setting that removes
Add/Remove Programs from the Control Panel that will further limit what users can
do. The following steps walk you through this process:

1. Log on to a Windows XP Professional computer with a local administrator
account.

2. Click Start → Run. Type MMC and click OK.

3. In the MMC window, click File → Add/Remove Snap-in.

4. In the Snap-in window, click Add.

5. In the Snap-in dialog box, select Group Policy and click Add. A window
appears asking if you are using local Group Policy. Click OK and click
Close.

6. The Group Policy console is now available, as shown in Figure 3-9.

Figure 3-9: Local Group Policy.
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7. Expand User Configuration → Administrative Templates → Control Panel →
Add/Remove Programs. Open the Remove Add/Remove Programs
Properties and enable it, as shown in Figure 3-10.

Figure 3-10: Add/Remove Programs Policy.

8. Click OK and close the Group Policy console.
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Chapter 4

Using Digital Media on
Windows XP
In This Chapter

◆ Using Windows Media Player 9

◆ Using Windows Movie Maker 2

◆ Managing digital photos

DIGITAL MEDIA HAS BECOME an integrated part of our lives. From digital photos to
movies to music, digital media is here to stay, and consumers are demanding more
from computer operating systems for digital media management. Windows XP pro-
vides some helpful tools for digital media management. This chapter covers
Windows Media Player 9, Windows Movie Maker 2, and several tools for managing
and using digital photos.

Windows Media Player 9
Windows Media Player 9 contains improvements and updates from the previous
version of Media Player included with Windows XP, Media Player 8. If you have
Media Player 8 installed on your Windows XP computer, you can download Media
Player 9 for free from www.microsoft.com/windowsxp and install it on your com-
puter. Like Media Player 8, Media Player 9 provides you with a primary media area,
a list of buttons on the left side of the Media Player window (called Features), and
a standard toolbar. When you first open Media Player, it attempts to connect to
www.windowsmedia.com (called the Media Guide). If successful, you’ll see a media
interface, as shown in Figure 4-1. If you’re not connected to the Internet, you’ll first
see a URL error page.

You use the features of Media Player by accessing the different buttons on the
left side of the interface. The following sections show you what is available.

Now Playing
Now Playing lists or shows the type of media you are currently playing. Most types
of media will automatically launch Windows Media Player. Any media that you
play, such as music or a movie, appears in the Now Playing area. For example, as
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shown in Figure 4-2, if you play music, you’ll see the CD, names of the songs, and
a visualization, which moves to the beat of the music. Note that the CD cover and
the CD music list are downloaded from the Internet, so if you don’t have an Internet
connection, these two items will not appear.

Figure 4-1: Media Player connects to Windows Media.

Figure 4-2: The Now Playing area.
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In the same way, movies that you play are shown in the Now Playing area as
shown in Figure 4-3. If information about the movie clip is available, it will appear
in the Now Playing area as well.

Figure 4-3: Any media appears in the Now Playing area.

You can configure the Media Player window so that it suits your needs, and
you’ll want to get familiar with these controls because they can easily help you
customize the Now Playing area. First, in the lower-right corner of the Media
Player window, you see the following three buttons:

◆ Maximize the Video and Visualizations Pane — This option maximizes
the area of the Now Playing window that displays video or visualizations.
After you click this option, you don’t see the album and song list or
movie info pane.

◆ View Full Screen — This option allows you to view the Now Playing area
full screen on your computer, which can be helpful if you are watching a
movie clip.

◆ Select Playlist Options — This shows or hides the playlist in the Now
Playing window. If you are listening to a music CD, the songs on the CD
are displayed in the Now Playing window if this option is enabled.
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If you look toward the play controls at the bottom left of the player, you also see
the following:

◆ Shuffle — This button shuffles your current playlist. This feature is cool if
you want to play a music CD and hear the songs in a different order.

◆ Change Player Color — This option lets you quickly change the player’s
color.

◆ Switch to Skin Mode — This option switches to skin mode, which is
explored later in this chapter.

A drop-down menu in the upper-right corner can also be used to select different
media to play. Or, you can click the arrow on the Now Playing button and access the
same options. This feature easily helps you access media in your Media Library. Use
the standard buttons at the bottom of the Media Player window to play the media,
stop playing the media, adjust the volume, or use related stereo or video controls.
You can find these same controls in the Play menu at the top of the interface.

Aside from the immediate options on the interface, you can use the View menu
to change a number of items affecting the Now Playing area’s interface. The 
following list tells you what options are available to you and what they do:

◆ Full Mode — The default display is shown to you in full mode. If you
switch to compact mode, use this option to return to full mode.

◆ Skin Mode — This option gives you a smaller interface. You have the same
options, but some of them appear as pop-out menus. This option takes up
less room on your desktop. If you are in full mode, click this option to
move to compact mode.

◆ Now Playing Options — This option provides a pop-out menu where you
can manage the look of the Now Playing window.

◆ Show Title — This is the same as the button option found directly on the
interface. It shows the title and the playlist option.

◆ Show Media Information — This displays title information about the
media (such as the artist and songs, name of the video, and so on).

◆ Show Playlist — For music media, this option shows the list of songs on
the CD or the playlist you have created.

◆ Show Resize Bars — Resize bars appear between the different options you
elect to show in the Now Playing area. The resize bars enable you to
adjust the size of the components, as desired.

◆ Visualizations — You can choose from different visualizations here. You
can also change the visualization directly from the Now Playing area 
by clicking the arrow buttons found under the graphical visualization
window.
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◆ Info Center View — This option displays the info center, which downloads
information about the media being played from the Internet.

◆ Plug-Ins — Some media may require a plug-in, which is a small software
program designed to work with Media Player. The Plug-Ins menu option
allows you to see what plug-ins are installed and gives you some addi-
tional options for locating and managing plug-ins.

◆ Enhancements — The Enhancements option allows you to use some equal-
izer and volume management features, as well as Video Settings when
you are playing video. If you point to Enhancements and click Show
Enhancements, you can see a graphic equalizer in the Now Playing area
so you can adjust the sound, as shown in Figure 4-4.

Figure 4-4: You can add an equalizer using the Enhancements option.

◆ Statistics — When playing videos, access this option to view statistics
about the video transmission quality. The statistics window can be partic-
ularly helpful when troubleshooting problems with streaming media.

◆ Full Screen, Refresh, and Video Size — The final options in the View
menu provide basic viewing capabilities.
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Media Guide
The next feature in Media Player is the Media Guide, mentioned earlier in this
chapter. This option connects you to WindowsMedia.com, where you can download
all kinds of music and movie files. This is a fun Web site, so do check it out. You
must be connected to the Internet for the Media Guide to work.

Copy from CD
The Copy from CD feature, shown in Figure 4-5, gives you information about the
music CD to which you are currently listening. You are given the names of the
songs, their length, and standard information about the album. This information
only appears, however, if you are connected to the Internet.

Figure 4-5: Copy from CD.

In the upper-right corner of the interface, you see the Find Album Info and View
Album Info buttons. You can click these buttons to get additional information from
the Internet about the album. Sometimes this feature gives you additional informa-
tion, sometimes not, depending on how the album is listed, as shown in Figure 4-6.
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Figure 4-6: View Album Info.

You also see a Copy Music button. You can copy any music track from a music
CD to store the track on your hard drive. This feature has two benefits. First, you
can store songs you really like directly on your hard disk so that Media Player can
play them without the music CD. Also, you can generate your own collection of
favorites and create a playlist (which you learn about later in this chapter).

To make a copy of a song from a CD, just follow these steps:

1. In Media Player, click the Copy from CD feature button.

2. In the list of songs, clear the check boxes next to the song(s) you do not
want to copy. In other words, any songs with the check box enabled will
be copied to your hard disk.

3. Click the Copy Music button. Depending on your configuration, you may
be able to hear the song while it is being copied. The feature area shows
you the progress of the copy as it occurs.

4. Once the copy is complete, the song is placed in your Media Library
(explored in an upcoming section).

You can also control how songs are recorded and managed by clicking the Tools
menu in Media Player, and then clicking Options. Click the Copy Music tab, shown
in Figure 4-7. Under most circumstances, the default options configured on this tab
are all you need, but you might encounter instances when you want to change the
default behavior.
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Figure 4-7: Copy Music option tab.

The following options are found on this tab:

◆ Copy music to this location—By default, the location is C:\My Documents\
My Music. If you want to change this default location, click the Change
button and select a different folder on your computer’s hard drive.

◆ Copy settings — You can choose to copy music in either the Windows
Media format or MP3 — the choice is yours. The Copy protect music check
box simply means that Windows Media Player is keeping a license for you
to copy the music and play it on your computer. It is illegal for you to
e-mail copies of music to other people, however. Finally, you can choose
to copy music at different quality settings by adjusting the slider bar. The
higher the quality you copy, the greater the hard drive space that is con-
sumed. Even at a lower quality, several megabytes of storage space will be
needed for only a few songs.

Media Library
The Media Library is a library designed to hold media. All of your saved music and
video files are stored in the library under different categories so you can easily
access them, as shown in Figure 4-8.
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Figure 4-8: Media Library.

On the left side of the interface, you see various categories. Click a category, and
you can see the songs or videos in your library for that category. For example,
when I expand Album, I can select an album and see a list of songs I have copied
to my computer from that album in the right pane. Just double-click a song or
video clip to hear it or see it. Keep in mind that the library’s purpose is to help you
keep track of files that you want. The Media Library is able to detect the type of
multimedia you are using and add it to the appropriate location in the library. You
can search your library by clicking the Search button at the top of the interface,
and you can perform standard add, remove, and delete functions.

You can also use the Media Library to create a playlist of your favorite tunes or
videos. To add a new item to the Media Library, click the Add button (plus sign) on
the interface. A submenu pops out that enables you to add a track that is currently
being played, a file, or media found on the Internet. If you want to add a file, a typ-
ical browse window appears for locating the file you want to add. If you want to
add something from the Web, a window appears in which you can enter the URL of
the media item.

You can also use Media Player to create a playlist. A playlist is a collection of
media that you can use or view on Windows Media Player. The major way media
lists are used is to combine different songs from different sources into one list that
you can then listen to or burn to a CD. To create a media list, follow these steps:
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1. In the Media Library, click the Playlists button and click New Playlist from
the menu that appears.

2. Enter a name for the new playlist in the dialog box that appears, shown in
Figure 4-9.

3. In the left pane, choose to access media in the Media Library by artist,
album, and so on from the drop-down menu. Then, click the desired
media to add it to your playlist. You can simply browse through all of
your media and generate a custom playlist this way. When you’re done,
click OK.

Figure 4-9: You can easily create a playlist.

You can import playlists from other locations, such as those found on Web sites,
by first downloading the playlist to your computer and then using File → Import
Playlist in Windows Media Player. In the same manner, you can export your
playlists using File → Export Playlist so you can share your playlists with others,
as well.

Radio Tuner
The Radio Tuner, shown in Figure 4-10, accesses Internet radio. With a good
Internet connection, you can listen to radio stations all over the world that stream
data over the Internet. Note, however, that dial-up connections will give you 
sporadic results, so Internet radio is a feature best used with broadband Internet
connections.
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Figure 4-10: Radio Tuner.

The Radio Tuner interface has two basic elements — Stations and Search. The
following two sections show you how to use each. In the Stations section of the
interface, you see a drop-down menu where you can select preset options. Windows
Media Player gives you a list of a few popular Internet radio sites to pick from. If
you want to reach one of these, double-click the name in the list to connect to the
site. You can create your own preset radio stations by renaming the drop-down
window My Stations. Use the Edit, Add, and Remove buttons to manage your sta-
tion list. However, you can’t add any stations to the list until you have located one
using the Station Finder.

You locate Internet radio stations using the Station Finder window. To find a
particular station, click the desired category button, or you can browse the stations
by category (such as rock, gospel, jazz, and so on). When you find a station you
want, just double-click it in the list — you will then be connected and be able to lis-
ten to the station. If you want to save the station, click Add to My Stations to add
the station to your presets.

Copy to CD or Device
The Copy to CD or Device feature, shown in Figure 4-11, provides an easy way to
copy files from your Media Library to a portable device, such as a Palm unit, a CD,
or even to a remote storage media, such as a Zip or Jaz disk. Use the drop-down
menu to select the device you want to copy to, and then select the items you want
to copy. Finally, click the Copy button. Your specified items are copied and you can
now use them on your portable device.
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Figure 4-11: Copy to CD or Device.

Premium Services
The Premium Services option is simply a connection to an Internet site where you
can sign up to have digital media, such as music and movies, delivered to you for a
fee. Just click one of the options if you want to get more information. You’ll need
an Internet connection for any of these features to work.

Skin Chooser
Media Player includes a number of different skins — or interface overlays — you can
apply to Media Player. These skins give Media Player completely different looks,
which you may find very appealing. These are just for fun — you still have the same
functionality in Media Player, regardless of what skin you choose to use. To use a
skin, select the one you want and click the Apply button. You can also click More
Skins to connect to the Media Player Web site where you can download other
skins — you’ll find several others available on this site. You can also get more skins
from the Windows XP Plus! pack.

In case you are wondering about additional visualizations, you can down-

load new ones from http://windowsmedia.com/mg/visualizations.
asp?.
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Configuration Options
Along with all of the basic options found in Media Player, you can also click
Tools → Options and configure some of Media Player’s features. Generally, the
default options work great for most people, but you should get familiar with what
is available on the Options properties sheet, because you might need to make some
configuration changes from time to time. The different tabs you see here are rather
easy to use, and the following list gives you a quick overview of what’s available.

◆ Player — This tab contains a number of basic check boxes. By default,
your Media Player checks the Media Player Web site for updates to Media
Player on a monthly basis. This setting is all you need. By default, Media
Player opens and starts the Media Player Guide. You can change that
behavior by clearing the check box on this tab (refer to Figure 4-12).
Notice the Download codecs automatically check box option, which is
selected by default. A codec is a compressor or decompressor mathemati-
cal algorithm that is used for audio, video, and image files. The codec
allows the file to be compressed and then uncompressed so that it can be
read. Media Player must have codecs to be able to play files. If a codec is
used to compress a file, the same codec is used to decompress it. If Media
Player does not have the correct codec, it will attempt to automatically
download it for you. If you clear this check box option, Media Player will
not be able to get the codecs it needs — so leave this check box selected.

Figure 4-12: Player tab.
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◆ Copy Music — This tab enables you to make setting adjustments for
copying CD music.

◆ Devices — This tab lists all devices found on your computer that can be
used for media playback, such as your CD-ROM or DVD drive. If you
select your drive and click Properties, a simple window appears. This tab
allows you to choose whether to use analog or digital playback and copy.
Typically, this tab is set to digital; but if you’re having problems, you can
try the analog setting. The error correction feature, available only with
digital playback, allows Windows to attempt to resolve problems found in
the digital media. This setting can be used, but you might notice a nega-
tive effect on the performance of your system — so I recommend you skip
it unless you’re having problems with digital media.

◆ Performance — These settings affect how Media Player uses your Internet
connection. You do not need to configure anything here, but I will note
that, by default, Windows Media Player can detect your connection speed
to the Internet. This allows Media Player to determine how best to handle
media downloads. Make sure you leave this setting as is, because Media
Player will perform better if it can detect your Internet connection speeds.

◆ Media Library — By default, the Media Library gives other applications
that access the media library read-only access, and no access to anyone
on the Internet. You should leave these settings alone.

◆ Plug-ins — This tab, shown in Figure 4-13, allows you to manage plug-ins
by adding or removing them and accessing any available properties
sheets.

Figure 4-13: Plug-ins tab.
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◆ Privacy — The Privacy settings are designed to protect you while you are
connected to the Internet. You can peruse this list and make any changes
concerning what Media Player can and cannot do, but, in most cases, the
default settings are all you need.

◆ Security — The Security settings you have with Media Player simply deter-
mine whether or not Media Player can run scripts from the Internet and
what Internet Explorer zone Media Player should use. Generally, you do
not need to change these settings.

◆ File Types — The File Types tab lists every file type that Media Player can
read. You don’t need to do anything here unless you want to prevent
Media Player from reading a certain file type. In that case, just clear the
check box next to the file type’s name. This feature can be helpful if you
want to use a player other than Windows Media Player, such as
RealPlayer, to see certain kinds of content.

◆ Network — This tab contains protocol usage settings and proxy server
enabler settings. You don’t need to change anything here unless your
computer is on a network that uses a proxy server. Unless a network
administrator instructs you to make changes, leave this tab alone.

Movie Maker 2
Windows Movie Maker 2 is designed to help you both manage and edit your home
videos and pictures. You can use Windows Movie Maker to organize data, edit it,
save it, and even share it with others. Windows Movie Maker 2 is a basic video edi-
tor. It has some nice features and allows you to combine video, pictures, and audio
tracks into one show. It does not provide you with the many features and options
you’ll find in other video-editing software packages. However, if you need to do
basic video editing, it works great and is certainly a great starter package.

One of the greatest benefits of Windows Movie Maker 2 is that you can take ana-
log video (such as your typical camcorder or VHS tape), import the analog video
into your computer, and then manage it electronically. Another great feature of
Movie Maker is editing. In any given videotaping session, you are likely to have a
lot of dull spots. With Windows Movie Maker, you can easily cut away the boring
section of video and keep the good stuff. This feature makes watching your movies
more interesting and entertaining, as well as shorter. Also, the editing features can
help reduce the amount of storage space, and you can even join together unrelated
clips of video.

Windows Movie Maker 2 also contains a number of transitions and effects that
you can apply to your movies. These effects help dress up the movie and make it
more interesting. You’ll learn all about these features in this section.
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Movie Maker 2 Requirements
Windows Movie Maker is a great tool; but to make it work, you have to spend a lit-
tle time inspecting the hardware requirements. The trick, of course, is to get your
analog or digital video and/or pictures inside your computer and into Windows
Movie Maker. First, consider the basic system requirements you need to run
Windows Movie Maker:

◆ Pentium 600 MHz or equivalent — If you’re using Windows Me on an
older processor that is limping along, I’m afraid it won’t have the power
Movie Maker needs to process graphics and sound.

◆ 128 MB of RAM — You need this minimum amount of RAM for Windows
Movie Maker to function properly. If you want it to function well, you
should have more RAM than 128 MB.

◆ Up to 2 GB of storage space — Movie files use a lot of storage space.
Make sure your computer has plenty of room to store the movies you
create.

◆ A video card or video capture device — Any standard video card will
work fine, or you can use a video card that allows you to capture incom-
ing video data.

◆ A sound card or sound capture device — Movie Maker expects to find
both a video and a sound card, or other capture device. If it doesn’t, you’ll
receive an error message telling you that your computer does not meet the
requirements.

If you are using a digital camcorder, the connection to the computer shouldn’t be
any problem. For the best performance, your computer needs an IEEE 1394 card, so
you can import movies from a digital camcorder into your computer (especially
important if you’ll be using any streaming media devices). This type of card pro-
vides fast transfer from the camcorder to the computer and is highly recommended
by Microsoft. You will need to do a little investigative work to determine whether
your computer has this card, if your digital camcorder supports it, and if this trans-
fer card is right for you. Go back to your computer and camcorder documentation
for more information. Windows Movie Maker can recognize all kinds of graphics
files, from AVI and MPEG to basic Web files such as JPEG and GIF. After the files
are loaded and saved onto your hard disk, you can use Windows Movie Maker to
import and begin working with them.

If you want to use analog pictures or video, you must use capture devices to
move the analog information into your computer, where it is converted to digital
information and saved. To do that, you need some kind of capture device that 
can import the data into your computer. These capture devices are video cards
with video and audio input ports and sound cards with an audio input port. By
connecting your analog camcorder or VCR to a video card, you can receive the

86 Windows XP for Power Users

549987 ch04.qxd  11/20/03  11:38 PM  Page 86



analog data from the camcorder or VCR and convert it to a digital format for use on
your computer. In the same manner, your sound card can convert music and voice
data from an analog device into a digital format that can be used on your com-
puter. You may already have a video card and sound card that support this process.
If not, you can purchase new cards at your local computer store. They’re not terri-
bly expensive, generally anywhere from $100 to $200, but do make sure they are
compatible with Windows XP — check the Windows XP Web site (www.microsoft.
com/windowsxp) for continually updated information about compatible hardware.
Also, if you previously owned one of these cards under Windows 98/Me/2000, you
might need to download new drivers from the card’s manufacturer for it to work
correctly with Windows XP. Check out the manufacturer’s Web site to see if there is
an update.

After you have the card, you can use Windows XP’s Movie Maker 2 to capture
the data. However, if you have problems, consider using the card’s software pro-
gram to capture the data and save it as an MPEG or AVI file, and then you can
import the data into Windows Movie Maker. Also, note that some capture devices
save video files in their own default format, which may include compression not
supported by Windows XP. When you start to save video using the card’s program,
make sure you are saving it in a format that Windows Movie Maker supports.

Opening Windows Movie Maker 2
Before you get started using Movie Maker, you’ll need to take a few moments to
familiarize yourself with the Movie Maker interface. In original versions of
Windows XP, Movie Maker 1 was included, so you may need to visit www.
microsoft.com/windowsxp and download the latest version of Movie Maker
before you get started. You can open Movie Maker by clicking Start → All
Programs → Windows Movie Maker. The basic interface, shown in Figure 4-14,
appears.
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Figure 4-14: Windows Movie Maker.

The Windows Movie Maker interface has four major parts:

◆ Toolbars — At the top of the interface, you see the Windows Movie Maker
toolbars. You first see the menu options, such as File, Edit, View, Clip, and
so on. The menu options contain typical Windows menu features plus
those specific to Windows Movie Maker. You also see the standard toolbar
under the menu options that presents typical toolbar options. Finally, you
see a third toolbar called the Collections/Locations toolbar, which is used
to manage the video collections you are working on at the moment.
Collections are simply file folders used to hold portions of video or 
pictures — a simple way to organize your files.

◆ Tasks area — The middle-left side of the interface is called the Tasks area.
This area is used to view and manage collections of data and view clips
that you are working on at the moment. Clips are pieces of video or 
pictures, and you’ll learn about those in a moment. Clips appear in the
middle portion of the interface.

◆ Monitor — The middle-right side of the interface is called the Monitor.
When you are working with video or still shots, the picture appears here.
You also have standard Start and Stop buttons (along with others) to view
video.
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◆ Workspace — The bottom portion of the interface is called the Workspace.
You use this area to edit video and/or combine still shots. You’ll learn how
to use the Workspace later in this chapter.

Recording and Importing Video
Now that you have taken a look at the interface setup, you are ready to begin
recording or importing video. You record video if you are streaming it live into
your computer. For example, with your digital camcorder, analog camcorder, or
other device (such as a DVD player or VCR), you can begin the streaming process,
which appears in the Monitor in Windows Movie Maker. To record the video as it
appears, just follow these steps:

1. Begin playing the video from the desired device into your computer.

2. Click Start → All Programs → Windows Movie Maker to open the interface.

3. The video appears on the Monitor. Click File → Capture Video. A window
appears where you can change the default recording options. Make sure
the Create Clips check box is selected, and then click the Record button.

4. Windows Movie Maker records the video. Notice that clips are being 
created and appear in the Collections area.

5. When you have finished recording, click File → Stop Capture.

6. Press the Save button on the toolbar, or click the File menu and then click
Save Project As.

7. The Save As window appears. By default, the project is saved in the My
Videos folder found in My Documents. You can select an alternative loca-
tion if you want. The file is saved as a Windows Movie file (.mswmm).

In addition to recording video, you can also import multimedia files — both video
and audio (as well as still pictures). In many cases, you will choose to use the
Import feature simply because you can work with previously saved files. To import
a file that has previously been saved, just follow these steps:

1. In Windows Movie Maker, click File → Import into Collections.

2. The Import File window opens, as shown in Figure 4-15. By default, the
import feature looks in My Videos for a file to import, so you may have to
navigate to another location on your computer where the file is stored.
Windows Movie Maker looks for all kinds of media files — just select the
one you want and click Import. Notice that there is a Create clips for
video files check box. You should leave this check box enabled.
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Figure 4-15: You can browse for and import media files.

Working with Collections and Clips
Collections are basically folders that contain clips of video or audio data. Whenever
you record or import media, Windows Movie Maker creates clips, by default.
Windows XP creates clips to break apart video sequences into manageable chunks.
Windows XP examines the video stream and attempts to segment it when the pic-
ture sequence changes. This doesn’t always work perfectly, but it does work well
enough so that Windows Movie Maker can help you manage and edit your video
more easily.

If you right-click any collection, you can delete the collection (which deletes all
of the clips belonging to that collection), rename it, or import or record more clips
into the collection. Note that you can create collections within collections.
Remember, collections are just folder structures that enable you to organize clips,
so do what works best for you to keep your data organized in a suitable manner.

Assembling Movies
Using Windows Movie Maker, you record or import the clips you want to use, orga-
nize them into collections, edit them as desired, and then save the project. You are
now ready to begin editing your video or still-shot clips. Keep in mind that you can
combine video and still shots into one collection and blend them together as
desired. You can also import background music and narrate a movie by recording
your voice. The following sections show you how to perform all of these tasks.

SPLITTING CLIPS
Windows Movie Maker creates clips for you; however, you may need to split those
clips into more manageable pieces. You can perform this function by using the split
command. The following easy steps show you how:
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1. Select the clip that you want to split in the Collections area.

2. In the Monitor area, click the Play button.

3. When the clip reaches the point at which you want to split it, click the
Split Clip button in the Monitor area. You can also click the Clip menu
and click Split, or simply press Ctrl+Shift+S on your keyboard. In the
Collections area, the clip is split in two — the first part of the clip retains
its original name, while the second clip contains the original name fol-
lowed by (1), as shown in Figure 4-16. You can change the name, as
desired.

Figure 4-16: Split clips appear in the Collections area.

COMBINING CLIPS
Just as you can split a clip into two or more clips, you can also combine clips, as
needed. If you want to combine two or more clips, just follow these steps:

1. In the Collections area, select the clips that you want. Select the first clip,
hold down the Shift key on your keyboard, and select the remaining clips
that you want to combine.

2. Click the Clip menu, and then click Combine. The clips are combined
using the first clip’s name.
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TRIMMING CLIPS
Dead spots often occur in a video where not much is happening. Using Windows
Movie Maker, you can simply trim clips so that you remove boring places in the
video. This will make your movie more exciting with just a little trimming work on
your part. The trim feature is very powerful because it gives you a fine level of con-
trol over your clips. You can use the timeline feature in the Workspace and trim
away seconds of a clip that you do not want to use. To trim a clip, just follow these
steps:

1. In the Workspace, select the clip you want to trim. The first frame of the
clip appears in the Monitor.

2. The trimming process keeps the portion of videotape that you trim and
discards the rest. That seems a little confusing, but think of a piece of
paper. You trim away the pieces you don’t want but keep the primary
piece. With the trim feature, you set a beginning and an end trim point,
and everything outside of the area is trimmed away. To begin trimming,
click Play in the Monitor area.

3. Watch the clip until it reaches the place where you want to begin trim-
ming. Click the Clip menu, and then click Set Start Trim Point. (Remember,
anything previous to the beginning trim point will be discarded.)

4. When the clip reaches the point where you want to stop trimming, click
Clip, and then click Set End Trim Point. All video outside of the trim area
is cut away.

5. If you don’t want to keep the trim points, just click the Clip menu and
click Clear Trim Points.

USING THE WORKSPACE
The Workspace at the bottom of the interface is the area where you assemble
movies and add transitions or effects. If you examine the interface, shown in Figure
4-17, you see a few buttons on the top left of the area that correspond to areas in
the Workspace. You can access volume controls, narration options, zoom controls,
and play and rewind buttons, and you see a button that allows you to toggle
between the timeline view and the storyboard view.

Figure 4-17: Storyboard view.
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You can use the Workspace to create a storyboard or to sequence your clips
together. First, drag clips onto the Workspace area to create the storyboard. Begin
by dragging the first clip in your movie to the video area of the Workspace. Once
in position, you see the first frame of the video displayed in the box. If you change
to the timeline view, you can see how much time is consumed, as shown in 
Figure 4-18. By using the timeline, you can connect pieces of clips together while
keeping a watch over the time frame of the entire movie. However, you will proba-
bly find that the storyboard view is initially easier to use when you are assembling
your movie.

Figure 4-18: Timeline view.

Note the zoom control buttons in the timeline view. While zoomed out, the

storyboard is shown to you in increments of 10 seconds. You can zoom in

and zoom out to see the clips in whatever time measure you want.

Using Transitions and Effects
Transitions are graphical effects that are used to move from one movie clip to the
next. Windows Movie Maker provides several transitions that you can use and you
can get more transitions by installing the Windows Plus! pack. You can easily 
create transitions by using the Workspace. Follow these steps:

1. In the Workspace, make certain that the storyboard view is enabled.

2. Click Tools → Video Transitions. The available transitions appear in the
middle portion of the top pane.

3. Drag the desired transition to the transition box on the storyboard. The
transition boxes appear between each clip.

4. After you drag the transitions to the storyboard, you see an icon for each
of them between each clip, as shown in Figure 4-19. Press Play in the
Monitor to see your movie play with the transitions.
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Figure 4-19: Transition options.

Movie Maker 2 also includes a number of effects you can add to any clip or
photo. As with transitions, you can use the default effects, or you can get more
installed on Movie Maker by purchasing the Windows Plus! pack. Effects cover all
kinds of video and/or photo effects, such as blurring features, lighting features, and
even an old-age film effect. These features are not necessary, of course, but they
can add some cool features to your movies. To add an effect, just follow these steps:

1. Click Tools → Video Effects. The Video Effects appear on the middle por-
tion of the top pane.

2. Scroll through the effects and locate one that you want to use.

3. Drag the effect to the star icon on the desired clip. Repeat this process for
other clips to which you want to add effects.

4. Press Play in the Monitor to see your effect in action.

Using Audio in Your Movies
One of the great things about Movie Maker is you can place audio tracks on your
movie, such as in a music video fashion, or you can even leave the existing sound
track and add background music or narration. After you have placed clips on the
storyboard, trimmed and transitioned as desired, you can add audio to your movie.

In the Workspace area, there is an audio portion of the storyboard at the top left
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side where you can add and manage audio levels and add narration. To record your
voice, or some background music or sounds, click the microphone icon. You should
have your computer microphone connected and tested, or make sure that the other
sound input device that you want to record is ready. Note that if you want to use an
existing audio file, such as music or narration that has already been made, just use
the Import feature and drag the audio file to the storyboard.

To record an audio file, just follow these steps:

1. In the Workspace area, click the microphone icon in the timeline view.

2. A window appears listing the sound device that you will use to record the
audio, as shown in Figure 4-20. If you have more than one sound device
installed on your computer, use the drop-down menu to select a different
device, as desired. When you are ready, click the Start Narration button.

3. Give the file a name and save it. The file now appears in your timeline.

Figure 4-20: Narration option.

After you add audio to your movie, you can adjust the audio level, as needed.
This is particularly helpful if you have two streams of audio — for example, a pri-
mary audio stream, such as voice, and a secondary audio stream, such as back-
ground music. By default, Movie Maker sets both streams to the same audio level,
so you’ll need to adjust them for your movie. To adjust audio levels, just follow
these steps:
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1. In Windows Movie Maker, press the Audio Levels button in the timeline
view on the Workspace.

2. On the indicator bar that appears, move the slider as needed. The video
track contains your primary audio, and the audio track contains the sec-
ondary audio.

When you are finished with your movie, be sure to watch it carefully and

correct any problems. When you’re done, click File → Save Movie. A wizard

appears that helps you through the saving process so that you can save the

movie in a way that is useful (file system, for e-mail, burned to a CD, and so

forth).

Manage Digital Photos
Windows XP provides several helpful features so that you can more easily manage
digital photos on your computer. Make no mistake, Windows XP does not provide
image-editing software — you’ll need to install third-party software to have full
image-editing capabilities — but it does provide a number of quick and helpful fea-
tures for managing digital photos. With the popularity of the digital camera, 
I expect that you will see even more digital photo tools and features in upcoming
versions of Windows.

Most digital cameras today easily connect to Windows XP via Plug and Play.
You may have software provided with your camera that can help in the connection
process, but for the most part, all you need to do is connect your camera or card
reader to a USB port and Windows XP will automatically detect it. You can also use
the camera installation wizard found in the Cameras and Scanners folder in the
Control Panel, but when in doubt, it is a good idea to check out your camera man-
ual for troubleshooting connection problems. After you have your digital photos
on Windows XP, you are ready to use the digital photo features that Windows XP
provides.

Working with Photos and Folders
Windows XP allows you to organize photos in any way that you want, just as you
would any other collection of files. By default, your photos may be downloaded to
the My Pictures folder. However, remember that the My Pictures folder doesn’t have
any special capabilities — it is simply a folder like any folder on Windows XP.
Therefore, you might want to organize your photos in a folder structure by date,
occasion, or some other system that has meaning to you. There is no right or wrong
approach; the idea is for you to be able to find the photos you want quickly and
easily, so develop your own folder system, as necessary.
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Windows XP can detect which folders have photos stored in them, and, as such,
the folder can give you a Picture Tasks box where you can access common features
available on Windows XP. As you can see in Figure 4-21, a folder containing pho-
tos has a Picture Tasks box that gives you several options, as a well as a typical File
and Folder Tasks box that can also be helpful. Use the View menu to choose a View
option that works well for you. In Figure 4-21, I am using the Thumbnails view.
This allows me to see the actual photo along with the filename.

Figure 4-21: Thumbnails view.

You have the following View options:

◆ Filmstrip — This option presents your photos in a filmstrip fashion. You
can select a photo and see a bigger image of it and use the controls to
simply click through all of your photos. You also have controls that allow
you to directly rotate an image. The Filmstrip view, shown in Figure 4-22,
is really helpful if you want to get a good look at your photos.

◆ Thumbnails — The Thumbnails view gives you small photo views (shown
previously in Figure 4-21). This is a good way to see photos and filenames
at the same time.

◆ Tiles — The Tiles option gives you icons (not photos), the filename, image
size, and kind of image file (JPEG, TIFF, and so on).

◆ Icons — This option gives you smaller icons with only the filename.
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Figure 4-22: Filmstrip view.

◆ List — This option gives you even smaller icons and the filename. This
view is useful to see a listing of photos so you can find the one you want
by name.

◆ Details — This option is the same as List, but it gives you more information
about each photo, such as size, type, date modified, and so on.

You also have quick access to some features by simply right-clicking a photo.
When you right-click a photo, you see the basic contextual menu that appears
when you right-click just about anything, but you also see some specific options
that are useful in managing photos. They are as follows:

◆ Preview — This Preview option opens the photo in Windows Picture and
Fax Viewer, as shown in Figure 4-23. Windows Picture and Fax Viewer is
not an image-editing program, but as you can see by the buttons at the
bottom of the viewer, you can perform the following tasks:

■ Look through photo collections

■ View different sizes

■ See a slide show

■ Zoom in or out

■ Rotate an image

■ Delete an image
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■ Print an image

■ Save an image

■ Open an image in whatever default image editor you have installed on
your computer

Figure 4-23: Preview option.

◆ Edit — This option opens the photo in the default image-editing program
installed on your computer. This might be any of the following:

■ Microsoft Paint

■ Photoshop

■ Photoshop Elements

■ Paint Shop Pro

■ Another program you currently have installed

◆ Print — This action opens a photo-printing wizard, which is explored later
in this section.

◆ Rotate — Use the rotate options to quickly rotate your photo.

◆ Set as Desktop Background — This option immediately sets the photo as
your desktop background, which keeps you from having to wade through
Display properties to make the change. You can also set a photo as the
desktop background by selecting it in a folder and clicking the Set as
Desktop Background option found in the Picture Tasks box.
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Viewing a Slideshow
If you have a collection of photos stored in a folder, Windows XP has a built-in
slideshow feature so you can view the photos in the folder as a slideshow. In the
folder, just click the View as a Slideshow option that appears in the Picture Tasks
box. Your photos will come to life as a full-screen, automatically advancing
slideshow. However, if you move your mouse, you’ll see control options to manu-
ally advance or back up during the slideshow. You can also stop the slideshow with
the manual controls, or just press the Esc key on your keyboard. Figure 4-24 shows
an example of a slideshow. Notice that this slideshow function is for screen view-
ing only — you can’t create a running slideshow here that you can burn to a CD, but
this feature does work great for on-screen viewing.

Figure 4-24: Preview option.

Ordering Prints Online
Windows XP helps you print your photos on your home or office printer, and it can
help you order prints online as well. Basically, the process is simply a wizard that
helps you select an online photo printing company. The company prints your pho-
tos for you and mails them to you within a few days. The prices are reasonable, and
this is a great alternative to printing them locally on your printer. Keep in mind
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that you do not have to use the wizard to order prints; you are free to simply access
any Web site that provides prints and follow the site’s instructions, but you might
find the wizard helpful, especially if this is the first time you are ordering prints.

If you are wondering about which sites you should order prints from, keep in
mind that there are many to choose from (just search for “photo printers” on any
search engine, such as www.msn.com), but I recommend the following reputable
printers. This list is not exclusive, but I have personally dealt with the following,
and they provide quality results and service.

◆ www.snapfish.com

◆ www.ofoto.com

◆ www.photoworks.com

◆ www.clubphoto.com

If you want to order prints online using Windows XP’s wizard help, just follow
these steps:

1. If you have a dial-up connection, connect to the Internet.

2. Open the desired folder where your photos reside. In the Picture Tasks
dialog box, click Order Prints Online.

3. The Online Print Ordering Wizard appears. Click Next on the Welcome
screen.

4. In the Change Your Picture Selection window, shown in Figure 4-25,
choose the photos you want to order. Clear the check box of any photo
that you do not want to order. Click Next when you are done.

5. The wizard connects to the Internet and downloads information. This can
take a few moments, depending on the speed of your connection.

6. In the selection window that appears, shown in Figure 4-26, select the
photo company you want to order from and click Next. Note that you
may not directly have access to the company you want to order from
using this wizard. In this case, exit the wizard and access the desired com-
pany’s Web site to order without the wizard.

7. The wizard downloads ordering information from the company you
selected and displays it, as shown in Figure 4-27. Use the ordering win-
dow to select the quantity of each print you want, the size, and so forth.
Scroll to the bottom of the window to see your subtotal when you are
done and click Next.
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8. Depending on the company you selected, you then move through a series
of windows where you establish an account and release your credit card
and shipping information. Follow the remainder of the wizard screens to
place your order.

Figure 4-25: Clear the check boxes next to the prints you don’t want to order.

Figure 4-26: Select a company.
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Figure 4-27: Select print sizes and review your order.

Printing Photos on Your Printer
Printing quality photos on a home or office printer is one of the more frustrating
items with digital photos. A common complaint users voice is that photos do not
print well or they can’t print the desired size. First of all, you can’t print quality
photos on standard typing paper that you use to print text. The paper is not
designed to hold the ink and individual dots of ink run together, giving you a
smeared and dull-looking photo. If you want to print effective photos, you must
use photo paper. Photo paper, which is sold in packs at any office supply store, is
designed to hold the ink and give you the results you want. Photo paper isn’t cheap,
of course, but you’ll need it to print photos.

The next issue is resolution. Resolution refers to the number of pixels in a digi-
tal photo. Digital photos are made of tiny dots of color that create images. The
number of pixels you have in a photo determines the quality of the photo when it
is printed. If there are not enough pixels, the pixels get stretched to make the photo
size you want. For this reason, if you have a low-resolution photo, you can’t print
a quality 5×7 or 8×10 because there is not enough resolution. It is beyond the scope
of this book to fully explore resolution and your camera settings, so I suggest that
you study your camera’s manual or a general digital photography book so that you
understand resolution more fully. The important thing to remember is that you
need to shoot at a high resolution if you want to print larger photos, such as 8×10s.

Once you have quality paper and the right resolution, you can easily print pho-
tos at the size you want using Windows XP’s Photo Printing Wizard. The following
steps show you how to use the wizard.
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1. In the folder containing the photos you want to print, click the Print pic-
tures option in the Picture Tasks box. You can also right-click any photo
and click Print, or select multiple photos by Ctrl-clicking them, then right-
clicking them and clicking Print.

2. The Photo Printing Wizard appears. Click Next.

3. In the Picture selection window, select the photos you want to print. Clear
the check boxes next to any photos that you do not want to print.

4. In the Printing Options window, use the drop-down menu, if necessary, to
select the printer to which you want to print, as shown in Figure 4-28.
Then, click the Printing Preferences button.

Figure 4-28: Choose the printer and printing options.

5. In the Preferences dialog box that appears, make your selections. Make
sure you choose a photo paper option from the Media drop-down menu.
When you are done, click OK. This returns you to the Printing Options
window. Click Next.

6. In the Layout Selection window that appears, choose what you want to
print. You have options from full page, contact sheets, and a variety of
sizes. As you can see in Figure 4-29, I am printing two 4×6 photos on a
single page. Each photo is printed only once. Make your selections and
click Next.

7. The photos are sent to the printer and printed. Click Finish.
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Figure 4-29: Choose a layout option.

E-mailing Photos
One of the great uses of digital photos is e-mail. You can easily e-mail digital pho-
tos to anyone so you can share your photos, but the problem has always been file
type and resolution. If you send a 3-megapixel TIFF file to someone with a dial-up
modem, the download could take an hour or more. In the past, you had to use a
photo-editing program to reduce the size of the photo and save the photo as a
lower-quality JPEG, but Windows XP gives you a quick and handy tool to reduce
the size. Just right-click on a photo you want to e-mail to someone and click Send
To → Mail Recipient. A dialog box appears, as shown in Figure 4-30, that allows
you to make the photo smaller for e-mail purposes. Just make a selection and click
OK; then the copy of the smaller photo is placed in an e-mail message using your
default e-mail program.

Figure 4-30: Choose a size option.
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Burn Your Photos to a CD
As with any file, you can burn photos to a CD to store them. You can use your CD-
burning software as you would with any file, or you can click the Burn to CD link
found in the Picture Tasks dialog box in the folder with your photos (this option
doesn’t appear if you don’t have a CD burner). Overall, burning photos to a CD
works the same as burning any other file — Windows XP just tries to simplify the
process by giving you a direct link in the Picture Tasks dialog box. If you have a CD
burner, you can also just right-click any file and click Send To, then choose your
CD drive from the contextual menu that appears.
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Chapter 5

Startup, Shutdown, and
Power Management
IN THIS CHAPTER

◆ Managing startup

◆ Managing shutdown, log off, and Fast User Switching

◆ Using power options

YOU KNOW THE DRILL; YOU start a computer and sit there in an idle state, waiting for
the computer to finish booting. Or, you configure power options on a PC, only to
find that they tend to lock up the computer and force you to reboot anyway. In the
past, one of the most aggravating things about using Windows operating systems
was boot time and power management.

Windows has come a long way, as has computer hardware. In Windows XP, you
should experience a more moderate boot time, depending on the hardware devices
installed on your computer, and the power management features provided for you
should work consistently. This chapter explores the issues of starting up Windows
XP, shutting down, logging off, Fast User Switching, and power management.
Using the information you gain from this chapter, you can ensure that Windows XP
starts up and shuts down smoothly and that power management works in a manner
that is effective for you.

Startup
Windows XP is designed to boot in a reasonably quick manner. However, this fea-
ture depends on your system configuration and your hardware. If you have a bunch
of programs that are configured to start automatically at bootup, or if you have a
number of devices that must be started, Windows XP may take longer to boot.
Overall, however, you shouldn’t have to wait an unreasonably long period for
Windows XP to start.
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If you are not happy with the way Windows XP is starting, there are two main
actions you can take that might help reduce boot time. First of all, Windows XP is
designed to learn from previous boots. Windows XP can identify code and startup
options and reorganize startup a bit to speed it up. In other words, booting should
become a bit faster as Windows XP learns from previous boots. If you want to help
Windows XP boot faster, you can check your device drivers and also remove any
items from the startup list that you don’t necessarily need at startup.

Device drivers can slow down a system boot. If you are using drivers with hard-
ware devices that were not written for Windows XP, those drivers can cause prob-
lems or simply take more time to load. So use drivers written for Windows XP. If
you are using older hardware, check the manufacturer’s Web site for updated dri-
vers. Also, try to use a driver that is as close to Windows XP as possible. In other
words, use a Windows 2000 driver over a Windows Me driver if one is available.

The second tactic you can take to speed up boot time and manage startup items
is to use the MSCONFIG utility. MSCONFIG, or the System Configuration Utility, is
an older utility still found in Windows XP. To access the System Configuration
Utility, click Start → Run, then type MSCONFIG and click OK. The System
Configuration Utility dialog box appears, as shown in Figure 5-1.

Figure 5-1: System Configuration Utility.

There are three major tabs you can work with here concerning startup:

◆ The General tab is used to make a startup selection, as shown in Figure 5-1.
In most cases, you’ll leave the Normal Startup option selected. With the
normal startup, all device drivers and services are loaded during startup.
You also have the option to use a Diagnostic Startup, where only basic
devices and services are loaded. This feature is helpful if you’re having
problems with startup because it can help you identify the problem by
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only loading basic devices and services. Finally, you have a Selective
Startup option, where you can choose not to process selected startup items,
such as system services. You don’t need to use the Diagnostic or Selective
Startup options unless you are having problems with Windows XP start-
ing normally. Note that you can also launch System Restore from this tab
so that Windows XP can attempt to fix the startup problem automatically.

See Chapter 19 to learn more about Windows XP’s System Restore.

◆ The Services tab, shown in Figure 5-2, shows you all of the services that
start on your computer when it is booted. Naturally, the more services that
have to start, the more time that is required to actually boot Windows. It
is a good idea to look through this list and see what is starting. You may
have a number of application services that start on bootup that you really
do not use. In this case, you can simply clear the check box next to the
service to stop it from starting automatically at bootup. Naturally, you
should exercise care when disabling services because a number of these
services are required for different Windows XP components to work prop-
erly, such as networking, indexing, and so forth. However, look for ser-
vices that you can live without that have been added, especially by other
manufacturers. Reducing the number of services that must start will
reduce the overall boot time.

Figure 5-2: Use the Services tab to disable services at startup.
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◆ Finally, if you take a look at the Startup tab, shown in Figure 5-3, you see
any applications that are configured to start when the computer is booted.
Again, you do not want to disable applications that are configured to start
by the system because this action can cause different Windows XP features
to stop working, but you may have other applications that are configured
to boot that you do not need. For example, in Figure 5-3, you can see that
I have a screen capture utility called SnagIt configured to start when the
computer boots. If I decide that I no longer want this program to start
automatically, I can simply clear the check box here to stop the program
from automatically starting. As with services, the fewer applications that
must automatically start, the quicker your system will boot.

Figure 5-3: Use the Startup tab to disable applications at startup.

If you are serious about startup control, you may consider using a free third-

party utility that will give you more options. Several are available, but I sug-

gest you check out Startup Cop, which you can download from

www.pcmag.com/utilities.

Shutdown, Logoff, and Fast 
User Switching
Windows XP gives you a few different options for managing shutdown or logoff, as
well as a feature called Fast User Switching. These options can easily help you
manage Windows XP from a shutdown or logoff point of view, and they are all
easy to use. The following sections explore your options.
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Shutdown Options
When you click Start → Turn Off Computer, you have three options that appear in
the Turn off Computer dialog box, shown in Figure 5-4.

Figure 5-4: Shutdown options.

The options are as follows:

◆ Hibernate — The Hibernate option saves all of your current desktop set-
tings to the hard disk, including any applications that are currently open
and files that are open, then shuts down the computer. When you restart,
your desktop, applications, and files return as though you had never actu-
ally shut down the computer. Your computer must be configured to sup-
port the Hibernate feature. See the Power Management section later in this
chapter for more details.

◆ Turn Off — This option shuts down Windows and turns off the computer.
If you have any applications currently open, you must save your work
before shutting down or the work will be lost.

◆ Restart — This option restarts Windows. You must save anything you are
working on before restarting, because all applications are closed during
the shutdown. Any unsaved data is lost during a restart.

Log Off Options
When you click Start → Log Off, you see a Log Off Windows dialog box that gives
you two options: Switch User and Log Off. The Switch User option works if you
have Fast User Switching enabled, which is explored in the next section. The Log
Off option closes all programs and brings you back to the Welcome screen so that
another user can log on. Keep in mind that when you log off, all of your applica-
tions are closed. You must save and exit any current work. When the next user logs
on, the settings from his or her user account are then loaded into memory and he or
she can begin using applications and files.
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One quick note concerning logoff: By default, Windows XP uses the Welcome
screen where users can click their usernames and enter a password if one has been
configured for them. If you want a bit more security so that users must type their
usernames and passwords, you can disable the Welcome screen. In this case, users
see only a standard Windows logon dialog box instead of the Welcome screen. To
disable the Welcome screen, open Control Panel → User Accounts. In the User
Accounts window, click the option to change the way users log on or off. In the
Select logon and logoff options window, shown in Figure 5-5, clear the Use the
Welcome screen check box and click Apply Options.

You must use the Welcome screen if you want to use Fast User Switching.

Fast User Switching will not work, and the option is not available, if the

Welcome screen is not enabled.

Figure 5-5: You can disable the Welcome screen in User Accounts.

Working with Fast User Switching
Fast User Switching is a helpful feature in environments where more than one per-
son uses the same computer. When you log off a computer, all of your files and
applications are closed. When using Fast User Switching, all of your files and pro-
grams remaining running. Essentially, you remain logged on to the computer, but
another user can switch the desktop to his or her user account. For example, say
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you are working on several applications at the same time. Another user who
accesses your computer needs to check his or her e-mail. In the past, you would
have to save all of your work, log off, and then the other user would log on. After
that user logged off, you would log back on and restart all of your applications.
With Fast User Switching, you can leave all of your applications open and simply
choose to switch users. The other user accesses his or her desktop and checks his or
her e-mail, and then you can simply switch back to your account. Your work and
applications remain untouched. As you can imagine, the implications of Fast User
Switching are far reaching in environments where several different people use the
same computer.

The Welcome screen must be enabled in User Accounts for Fast User Switching
to work. Refer back to Figure 5-5 and you can see that Fast User Switching is 
disabled in User Accounts, but it cannot be enabled unless the Welcome screen is
also enabled. The computer cannot be joined to a Windows domain. Because of the
security features of a domain, Fast User Switching will not work if the computer is
joined to a domain. Also, offline files must be disabled for Fast User Switching to
work. If offline files are enabled, you can turn off the feature using Folder Options
in the Control Panel. Finally, Fast User Switching requires that the computer have
at least 64 MB of RAM. Of course, because the basic Windows XP RAM requirement
is 128 MB, this typically isn’t an issue.

After you enable Fast User Switching in User Accounts, you can easily begin
using the feature by clicking Start → Log Off, then choosing the Switch User option.
You can also just press the Windows + L keys on your keyboard to switch users, if
your keyboard has a Windows key.

You must consider some other issues when using Fast User Switching with

Remote Desktop. See Chapter 13 to learn more.
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Power Management
Windows XP provides several different configuration options that allow you to
manage power on your computer. More simply put, Windows XP can turn off 
portions of the computer or automatically put itself in a stand-by state when you
are not using the PC. You can also use the Hibernate feature if your computer 
supports it.

Before you get into the configuration of power management options, it is impor-
tant to understand what makes the power features tick. Windows XP supports the
Advanced Configuration and Power Interface (ACPI), which is an industry standard
designed to save power on computer operating systems. Developed by a number of
companies, such as Microsoft, Intel, Compaq, and several others, ACPI enables a
computer to automatically power down system components when they are not in
use, and then automatically power up system components as they are needed.

Along with the use of ACPI, Windows XP also supports the older Advanced
Power Management (APM). APM is an older power management scheme that was
supported under Windows 95 and older computer Basic Input/Output Systems
(BIOS). The idea behind APM is the same as ACPI, but it did not work as well. The
computer could not make accurate inactivity assessments and, as such, the hard-
ware sometimes shut down at inopportune times, such as during a long file down-
load. Also, APM could not detect when a device connected to the computer needed
to be used. For example, say that you had a network printer attached to your com-
puter using APM. Once APM shut the hardware down, the system could not detect
that a network user needed the printer — it remained in a sleep state until someone
physically moved the mouse or touched the keyboard — and even then it sometimes
would not wake up.

ACPI is a much better specification and gives the operating system more control
over hardware power-down states and greater ability to power up hardware, as
needed. For example, say that you use ACPI on 100 Windows XP computers. The
computers power down during the night, but you want to run disk defragmenter
once a month during the middle of the night. Under ACPI, this configuration is no
problem because the system can power up the hard drive when it is needed. After
the utility has run, the system can power down again. This configuration is not
possible under APM because manual mouse and keyboard strokes are required to
wake the computer.

In an ACPI-compliant system, power management is handled throughout the
entire computer system, which includes computer hardware, software, and the
operating system itself. ACPI works in Windows XP through operating system
management and through the BIOS. For ACPI to work, the computer’s BIOS must
support ACPI. In today’s computer market, this typically is not a problem, because
basically all newer computers support ACPI. If the computer does not seem to sup-
port ACPI, you can check the computer’s Complementary Metal Oxide Settings
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(CMOS) and make sure that operating system control is turned on so that Windows
XP can control power management throughout the system. Check your computer
documentation for details about accessing CMOS setup and how to configure the
CMOS settings on your PC.

During Windows XP installation, the operating system detects ACPI compliance
and invokes the ACPI standard. In other words, you can’t manually control whether
or not ACPI is used, but you can manage what ACPI does, and you do that through
Power Options properties.

Power Options properties are available as an icon in the Control Panel, or you
can also click the Power button on the Screen Saver tab of the Display Properties
dialog box. Either way, you end up at the Power Options Properties dialog box,
which gives you several different tabs. The following sections show you what you
can do on these tabs.

Power Schemes
On the Power Schemes tab, you can configure a power scheme for your computer.
As shown in Figure 5-6, the Power Schemes tab provides you with a Power schemes
drop-down menu where you can choose a preconfigured power scheme. You have
the following preconfigured options:

◆ Home/Office Desktop — This option turns the monitor off after 20 minutes
of inactivity, but never turns the hard disk off.

◆ Portable/Laptop — This option turns the monitor off after 15 minutes of
inactivity and turns the hard disk off after 30 minutes of inactivity.

◆ Presentation — This option never turns the monitor or hard disk off,
because you would not want to use the power options during the middle
of a presentation.

◆ Always On — This option provides the same settings as the Home/Office
Desktop feature.

◆ Minimal Power Management — This option turns the monitor off after
15 minutes of inactivity but never turns the hard disk off.

◆ Max Battery — This option turns the monitor off after 15 minutes of
inactivity but never turns the hard disk off.

As you can see, the different power schemes are designed for different needs, but
there is some repetition in them, as well. You can customize any power scheme you
want and create your own. To customize a power scheme, just choose one from the
drop-down menu, and change the monitor and hard disk settings from the drop-
down menu, as desired. For example, if you wanted to increase power saving
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options, you could choose the Max Battery setting, but change the monitor and
hard disk settings so that power down occurs more quickly. After you have config-
ured the scheme to meet your needs, click the Save As button, give your new
scheme a name, and it will be added to your Power schemes drop-down menu.

Figure 5-6: Power Schemes.

Advanced
The Advanced tab, shown in Figure 5-7, gives you two simple options you can use:

◆ Always show icon on the taskbar

◆ Prompt for password when computer resumes from standby

The Taskbar icon option is entirely a personal decision, but do consider using the
second option if your computer is in a place where someone else could access it.
This feature can prevent you from having to log off or lock your computer every
time you leave it idle.

Hibernate
Hibernation is an ACPI feature that stores all of the information that is in memory
on the hard disk, and then shuts down the computer. When you restart the com-
puter, the information is then read from the disk and back into memory. To use
hibernation, your computer needs 1 MB of free disk space per 1 MB of RAM. As
shown in Figure 5-8, a computer with 256 MB of RAM needs at least 256 MB of
free disk space, because the data in RAM is written to the hard disk. To use hiber-
nation, just enable the check box on the Hibernate tab.
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Figure 5-7: Advanced tab.

Figure 5-8: Hibernate tab.

If your computer supports hibernation, you can go back to the Power Schemes
tab, shown in Figure 5-9, and see the hibernation setting available. Then use the
drop-down menu to select the amount of time that should pass before the computer
hibernates.
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Figure 5-9: Hibernation appears on the Power Schemes tab.

APM
If your computer can support Advanced Power Management (APM), you’ll see the
option to enable APM support on this tab. Simply check this tab to see if the com-
puter can support APM, and click the check box to enable it.

ACPI and APM can work together, and on laptop computers you should cer-

tainly enable APM because it can help you to effectively manage battery

power.

UPS
Uninterruptible Power Supply (UPS) is a feature that allows you to attach a UPS
device to your computer. In the event of a power failure, the UPS device provides
enough battery power for the computer to continue running so that you can 
perform an orderly shutdown. If you have a UPS device, you’ll see the option on
the UPS tab, and you can see the status of the UPS device and configure any
options the UPS device provides. See the UPS device’s documentation for further
information.
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Chapter 6

Managing Hardware on
Windows XP
IN THIS CHAPTER

◆ Installing and removing hardware

◆ Working with drivers

◆ Managing driver signing

◆ Working with display devices

◆ Managing removable media drives

INSTALLING AND MANAGING HARDWARE on Windows operating systems has been a
real chore for even experienced users in the past. You had to deal with conflicts,
know your interrupt request lines (IRQs), and overall just hope that things worked
out well. Fortunately, computer hardware has come a long way, and Windows XP is
the easiest operating system so far in terms of installing and managing hardware
on your PC. With the tools Windows XP gives you, hardware no longer needs to be
a major problem. This chapter explores the features and tools Windows XP gives
you to manage computer hardware.

Installing and Removing Hardware
on Windows XP
Windows XP is a plug-and-play system, meaning that Windows XP can detect
hardware changes and adapt to them. For example, you can install a new video
card and, upon reboot, Windows XP will detect the new hardware and attempt to
automatically install it. If the installation is successful, the hardware is automati-
cally ready for use.

If installation is not successful, a prompt appears for the Add Hardware Wizard,
so that you can attempt to manually install the hardware. Under most circum-
stances, Windows XP can automatically install up-to-date plug-and-play hard-
ware. Windows XP has the most extensive device driver database to date, and
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Windows XP can usually locate a basic driver to work with most plug-and-play
devices. The trick is to use hardware that is compatible with Windows XP. When
purchasing and installing new hardware, check for compatibility, and also check
the Hardware Compatibility List (HCL) at www.microsoft.com/hcl to see if the
device is listed. Note, however, that just because a hardware device is not listed on
the HCL does not mean the device will not work with Windows XP — it just means
that Microsoft hasn’t tested the device.

In the event that you need to manually install a hardware device on Windows
XP, you can use the Add Hardware Wizard in the Control Panel, which will help
you install the device. Before installing a device manually, you’ll probably need the
driver for the device. A driver is a piece of software that allows Windows XP and
the hardware device to communicate with each other. As I mentioned, Windows XP
has a large database of generic drivers that will often work, but the specific driver
created for the hardware device (by the hardware vendor) is often your best choice.
If Windows XP is having problems installing the device automatically through plug
and play, you will probably need the device driver. The driver often accompanies
the hardware device on a floppy disk or CD-ROM, or you can usually find it on the
device manufacturer’s Web site. The following steps show you how to use the Add
Hardware Wizard.

1. Click Start → Control Panel → Add Hardware.

2. Click Next on the Welcome screen.

3. The wizard searches for any hardware that has been connected to the
computer. If the hardware is not found, a window appears that asks if the
hardware is connected. Make the correct selection and click Next.

4. You can use the Add Hardware Wizard to troubleshoot a device that is not
working or add a new hardware device. In the provided window, make a
selection.

5. The wizard prompts you to either install the hardware by selecting it from
a list or have Windows search again. Because Windows has not been able
to detect the hardware up to this point, it is usually best to choose the
Install the hardware that I manually select from a list radio button. Click
Next.

6. A hardware-type window appears that allows you to choose the kind of
hardware device you want to install. Choose a desired category and click
Next.

7. Windows XP generates a list of hardware from the category that you
selected. In the selection window, choose the manufacturer and the model
of the hardware that you want to install. If you have an installation disk
for the hardware, you can click the Have Disk button and run the hard-
ware installation routine from the disk. Make a selection and click Next.
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8. The hardware you want to install is listed. Click Next to continue the
installation. Files are copied and the device is installed. Click Finish to
complete the installation.

You can also use the Add Hardware Wizard to troubleshoot problematic devices.
This option essentially provides you with a look at the device’s properties and
attempts to help you discover what is causing the problem so that it can be fixed.
The following steps show you how to use the Add Hardware Wizard to troubleshoot
a device:

1. Click Start → Control Panel → Add Hardware.

2. Click Next on the Welcome screen.

3. Windows XP searches for new hardware. If none is found, you’ll see the
list of devices currently installed on the computer. Devices that are not
functioning properly appear with a yellow exclamation point beside them.
Select the problematic device and click Next.

4. The final screen appears with a status message for the device. Click Finish
and the troubleshooter for the device begins. From this point, you can use
the troubleshooter or attempt to solve the problem on your own.

The Add Hardware Wizard’s troubleshooting feature is helpful, but you can

easily gain the same information using Device Manager, which is explored in

the next section.

Using Device Manager
A helpful tool that you can use to explore the configuration of hardware devices
and make changes to that configuration is the Device Manager. Device Manager
has been around for several iterations of Windows, and it is still an important fea-
ture in Windows XP. You can access Device Manager via the Computer Management
console, or you can simply click the Device Manager option on the System Properties’
Hardware tab.

Either way, the Device Manager interface, shown in Figure 6-1, gives you a list-
ing of hardware categories. If you expand the category, you can see the hardware
devices installed under that category. Using Device Manager, you can easily scan
hardware categories and the installed hardware. If you right-click a hardware
device, you can do any of the following:

◆ Update the driver

◆ Disable the device
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◆ Uninstall the device

◆ Scan for hardware changes

◆ Access the device’s properties

Figure 6-1: Device Manager.

If you right-click the desired device and click Properties, you’ll see a few differ-
ent tabs. As a standard, most devices have the General, Driver, and Resources tabs.
Some devices may have additional tabs specific to those devices. For example,
Mouse properties usually has an Advanced Settings tab where you can configure
how the wheel operates. Because the General, Driver, and Resources tabs are avail-
able for most devices, let’s consider the available options on each.

On the General tab, shown in Figure 6-2, you have a few basic items. First, you
see the following: 

◆ Device name

◆ Device type

◆ Device manufacturer

◆ Physical location of the device on the system
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In the Device status window, you can see any error messages or problems that
apply to the device. If problems exist, you can start the hardware troubleshooter by
clicking the Troubleshoot button. In the Device usage drop-down menu, you have
the enable or disable device options. To disable the device, simple choose the dis-
able device option from the drop-down menu.

Figure 6-2: General tab.

The Driver tab provides you with an easy way to manage a device driver.
Because driver management is overall a big part of hardware management, the next
section devotes more time to the device drivers and the information on this tab.

On the Resources tab, shown in Figure 6-3, you’ll see the following:

◆ Memory ranges

◆ I/O range

◆ IRQ setting

◆ Related hardware resource configuration that has been configured auto-
matically by Windows XP

Note that the settings cannot be changed unless there is a conflict. If a conflict
does exist, the conflicting device will be listed in the dialog box, and the option to
manually change the setting will not be grayed out. You can then try to adjust the
resource settings so that the devices do not conflict with each other.
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Figure 6-3: Resources tab.

Configuring Hardware Profiles
Hardware profiles are nothing new in Windows XP — they have been around since
the days of Windows 9x, but they continue to be an important part of Windows XP
hardware configuration — especially for laptop computers.

The purpose of hardware profiles is to enable a laptop computer to have differ-
ent hardware configurations, without having to install and/or uninstall hardware
every time the computer is in use. Consider an example. Say that you use a laptop
computer in an office setting. While connected to the local area network (LAN) at
the physical office, you use a mouse, keyboard, and desktop monitor with the lap-
top. You also have a local printer. However, when you are on the road, the external
keyboard, mouse, monitor, and printer are not used. Using hardware profiles in this
situation, you could configure a docked and undocked profile so that Windows XP
knows what hardware to use when you are connected to the physical network and
when you are traveling.

The end result is that you save system resources when you are on the road by
not loading additional unnecessary hardware configuration data, and your applica-
tions do not get confused about what device is available. You can easily configure
hardware profiles for a computer, as needed, and the following steps show you
how:

1. Open Control Panel → System Properties.

2. Click the Hardware tab and click the Hardware Profiles button. You see
the Hardware Profiles window appear, as shown in Figure 6-4.
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Figure 6-4: Hardware Profiles.

3. You see the current default profile. If you click the Properties button, you
can see the basic properties of the default profile, as shown in Figure 6-5.
You have two basic options here. You can identify the profile as a profile
for a portable computer, and you can choose to always include the profile
as an option when Windows starts.

Figure 6-5: Profile Properties.

4. To create a new profile, click the Copy button. A Copy Profile dialog box
appears. Enter a desired name for the new profile and click OK. The cur-
rent configuration from the default profile is copied to the new profile.
At this point, you have two profiles that are the same.
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5. You can now select the new profile and click Properties. In the provided
dialog box, you can choose the portable computer option and to always
include the profile option when Windows starts.

6. In the Hardware Profiles window, you now see the two profiles. When you
restart the computer, you’ll see a boot menu so that you can select the
profile that you want. Click OK in the Hardware Profiles window and
restart Windows XP.

7. During bootup, a hardware profile menu appears. Select the new hardware
profile that you want to use and allow Windows XP to boot using that
hardware profile. Log on to the computer.

8. Open System in the Control Panel, click the Hardware tab, and click the
Device Manager option.

9. Now that you are in Device Manager, access the properties pages for the
devices that you do not want to use under the new profile. On the General
tab of those devices, choose the Do not use this device in the current
hardware profile (disable) option. Continue this process until you have
disabled any devices that should not be part of the portable hardware
profile configuration.

10. Close the properties pages for the device. Notice that the devices you have
disabled now appear in the Device Manager with a red X over them, not-
ing that the device is disabled.

11. At any time, you can create additional hardware profiles by following
these steps, or you can delete any hardware profiles by returning to the
Hardware Profiles window.

Working with Device Drivers and
Driver Signing
A device driver is software that allows Windows XP to interact with a hardware
device. The driver determines communication parameters and, essentially, acts as a
bridge between the operating system code and the device driver. The driver, then,
allows the operating system to drive the hardware device, which you then control
through the operating system interface.

Drivers are developed by hardware vendors, and from Microsoft’s point of view,
how well a driver operates with Windows XP is solely the hardware vendor’s
responsibility. When Microsoft releases a new operating system, an updated device
driver generally needs to be created so that the device can communicate with the
new operating system. This is the primary reason that some devices fail to operate
after an upgrade — the driver is incompatible with the new operating system.
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Even though device drivers are the responsibility of hardware manufacturers,
Windows XP still maintains a generic database of drivers so that hardware can
function with Windows XP, even if a manufacturer’s driver is not available. Under
most circumstances, the manufacturer’s driver should be used, if at all possible,
because it is specifically developed for the hardware device’s interaction with
Windows XP. So, the short lesson here is to simply use hardware that is compatible
with Windows XP, and make sure you are using the most current driver designed
by the manufacturer, if possible.

Because driver configuration and management can be difficult, Windows XP
provides you with the Driver tab, found on each device’s properties pages, which
can be accessed from the Device Manager. The Driver tab, as you can see in 
Figure 6-6, gives you a few different button options that you can use to manage the
device’s driver.

Figure 6-6: Driver tab.

If you click the Driver Details button, you see information about the driver, such
as the following:

◆ Location

◆ Provider

◆ File version

◆ Copyright

◆ Digital signer information
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This data can be helpful when you want to gain basic information about the dri-
ver. Because drivers are updated periodically, you should strive to always use the
most current driver. To help with this process, Windows XP uses the Hardware
Update Wizard, which enables you to replace an older driver with a newer one. The
steps are self-explanatory, so if you need to update a driver, just click the Update
Driver button on the Driver tab.

On the Driver tab, you also see buttons for Roll Back Driver and Uninstall. If you
install a new driver for a device and the new driver does not function well, you can
use the Roll Back Driver feature to use the old driver. This feature pulls the old dri-
ver out of a backup file and reinstalls it. If you want to completely remove a driver,
use the Uninstall button. You’ll see a warning message that tells you that you are
about to remove the device from your system. When you uninstall the driver, the
device is uninstalled as well. At this point, Windows XP plug and play will detect
the uninstalled hardware device as new hardware and attempt to reinstall it. In
some cases, this can help you uninstall and reinstall a problematic device, espe-
cially if you are having driver problems.

Aside from the driver management options found on the Driver tab, you can also
manage driver signing in Windows XP. Driver signing, first introduced in Windows
2000 systems, enables you to make certain that you are only installing and using
drivers that have been signed, or certified by Microsoft. This feature makes certain
that the drivers have been tested and will work with specified hardware on
Windows XP. This, however, certainly does not mean that unsigned drivers are
damaging to your system or will not work — it just means that Microsoft has not
approved or tested them, and you are on your own in terms of testing, compatibil-
ity, and troubleshooting. Signed drivers have a digital signature stamp that cannot
be altered without altering the entire driver package. This feature tells you that a
signed driver is, in fact, a signed driver and you can feel safe when using the driver
on your system.

Another advantage of signed drivers, especially concerning Internet download,
is that a signed driver tells you that the package is actually a verified driver — not a
virus or other malicious code acting like a driver. When downloading, the signed
driver feature can certainly give you a measure of protection. Use signed drivers
whenever possible. With the signed driver, you can ensure that the driver has been
tested and has received Microsoft’s seal of approval. Of course, in some cases, using
a signed driver may not be possible. This is certainly fine, but it leaves you doing
your own homework to determine if the driver will work and if the driver is safe 
to use.

You can manage how driver signing works in Windows XP so that Windows
handles driver signatures in a way that works for you and your environment. If you
open System Properties and click the Hardware tab, then  you see a Driver Signing
button.  Click the button to open the Driver Signing Options window, shown in
Figure 6-7.
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Figure 6-7: Driver Signing Options.

You have the following options that you can invoke to determine how Windows
XP handles driver signing:

◆ Ignore — If the driver is not digitally signed, this option tells Windows to
ignore that the software is not signed and install the software anyway.
You will receive no warning messages or prompts when using this setting.

◆ Warn — If the driver is not digitally signed, a warning dialog box appears
so you can choose to install the driver or not. This is the default setting.

◆ Block — If the driver is not digitally signed, the operating system will not
install it.

◆ Administrator option — This check box option enables you to make the
Ignore, Warn, or Block setting that you choose be the default for all users
on this particular Windows XP computer. You must be an administrator
on the local machine to enable or disable this option.

Aside from the basic driver-signing interface, you can also use the File

Signature Verification utility to check existing files on your computer to

make certain they are digitally signed.This is a great way to check and see if

any files have been altered on your computer. You can search for files, and

you can also configure the tool to create a log file. The File Signature

Verification utility is available on the Tools menu of System Information, or

you can start it from the run line using the Sigverif command.
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Managing Display Devices
Display drivers have been a problem for years. When they are installed and config-
ured correctly with the correct driver, they work great. When they are configured
correctly with the wrong driver, you end up in Safe Mode. The trick with displaying
devices, such as all hardware in Windows XP, is simply this: Use video cards that
are compatible with Windows XP, and use the appropriate driver for the video card
you are using.

If you follow these two simple rules, display device management is typically
easy. However, in a not-so-perfect computing world, several different issues can
come into play. Windows XP is the best operating system for display device man-
agement that Microsoft has produced. You can make changes to video cards with-
out rebooting — you can reinstall drivers without rebooting (most of the time) — and
Windows XP supports multiple monitors. Essentially, you are getting everything
from Windows 98, Me, and 2000 in the XP operating system. The following sec-
tions explore the installation, configuration, and management of display devices.

Installing Video Cards
A video card is like any other internal card installed on a computer. Video cards are
typically installed in an Industry Standard Allotment (ISA) or Accelerated Graphics
Port (AGP) slot on the computer. Upon reboot, Windows XP can automatically
detect and install the video card. You can specify a driver for the card using Device
Manager, and, in many circumstances, video cards will have their own setup rou-
tines that you run from a CD. These setup routines install the necessary drivers that
provide features of the card, such as 3-D graphics and related visual technologies.

As previously mentioned, the trick to installation success is to only use video
cards listed on the HCL at www.microsoft.com/hcl. The HCL changes often, so
check the Web site for the latest iteration. Make sure you have the most current dri-
ver and that the driver is compatible with Windows XP. Should the installation of
the video card fail, you can reboot using the Last Known Good Configuration or
Safe Mode/VGA Mode.

Configuring Display Properties
Display properties are configured using Display in the Control Panel, or more easily
by right-clicking an empty area of the desktop and clicking Properties. If you click
the Settings tab, you see a few different options to configure the display properties
and video card performance to meet your needs. The following steps show you how
to configure the display properties:
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1. Right-click an empty area of the desktop and click Properties. Click the
Settings tab. You see the basic settings options, as shown in Figure 6-8.

Figure 6-8: Settings tab.

2. In the left portion of the tab, you see the option to adjust the screen reso-
lution. To change the screen resolution, drag the slider bar to a different
location. Click Apply. A Monitor Settings window appears where you can
choose to keep the new settings or not (you have 15 seconds before the
setting reverts to the previous setting).

3. You can next adjust the color quality settings by using the drop-down
menu. Generally, you want to use the highest-quality color settings that
the video card can support (such as 32-bit).

4. Click the Advanced button on the Settings tab. Several additional tabs
appear. The standard tabs you see are as follows:

■ General

■ Adapter

■ Monitor

■ Troubleshoot

■ Color Management

You may see additional tabs, as well. These tabs are specific to the com-
puter’s video card and are determined by the video card software that you
install.
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5. On the General tab, shown in Figure 6-9, you have two sections: Display
and Compatibility. Under Display, you can change the Dots Per Inch (DPI)
setting to compensate for small screen items under your current resolu-
tion. The default is 96. This feature, however, does not adjust font or color
sizes. Under Compatibility, you can have the computer restart after
changes are made to display settings. This feature is available because
some programs may not work correctly if no reboot occurs after setting
changes. The default setting is to Apply the new display settings without
restarting, but you can choose a different radio button option, depending
on your needs.

Figure 6-9: General tab.

6. On the Adapter tab, you can read basic information about your video
adapter. You can also click Properties to access the Device Manager’s
properties pages for the video card. If you click the List All Modes button,
you see all screen resolution modes that the video card supports, as shown
in Figure 6-10.

Figure 6-10: List All Modes.
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7. On the Monitor tab you can access the Device Manager properties for the
monitor by clicking the Properties button. You can also adjust the screen
refresh rate. Higher refresh rates reduce flicker that may appear on the
screen; you’ll need a quality video card to use a higher refresh rate.
Default settings typically fall around 75 to 85 Hz. Also note the setting
that allows you to hide modes that the monitor doesn’t support. This
ensures that an incompatible setting cannot be accidentally selected on
the Settings tab.

8. On the Troubleshoot tab, you have two setting options. The first enables
you to adjust the hardware acceleration of the video card. The typical set-
ting is Full, but you can gradually decrease the setting to troubleshoot
performance problems with the video card. Of course, lower acceleration
settings also mean lower performance. When you move the slider bar down,
you’ll see a description of the impact the lower setting will have on video
performance. You also have the option to use Write Combining. Write
Combining provides graphics data to your screen faster, which improves
performance. However, some video cards cannot keep up with this setting.
If you are having distortion problems, try clearing this check box.

9. The Color Management tab allows you to choose a color profile if your
computer needs to use one. If you click the Add button, you see a list 
of profiles that are available by default. You can choose a color profile
specific for your monitor’s make and model, and this might improve
color performance. As a general rule, unless you have color-specific prob-
lems, do not use a color profile, as this may limit your monitor’s color
capabilities.

Using Multiple Monitors
Windows 98 introduced support for multiple monitors, and Windows XP continues
that support. With more than one monitor, you can run different applications on
different screens and, essentially, increase work productivity. Multiple monitors are
useful to many different people, especially those working with multiple documents
and graphics files. With Windows XP and the right hardware, you can connect up
to 10 individual monitors to a single PC.

When using multiple monitors, you can place different applications or files on
different monitors, and you can stretch items between monitors. For example, say
you have a spreadsheet with many columns. You could use two monitors to stretch
the file so that all columns are visible across the two monitors.

When using multiple monitors, one monitor serves as the primary monitor
where older applications and the Windows logon screen will appear. You can use
multiple video cards with different settings, or you can use a single video card that
has multiple outputs where you can connect the monitors. Regardless of the con-
figuration you choose, you use Display properties to adjust the appearance of each
monitor.
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Windows XP also supports a dual-view feature. Basically, this is the same thing
as multiple monitors, but it is used on laptop computers where the liquid crystal
display (LCD) screen is always the primary monitor, and the attached monitor
serves as a second viewing area.

When setting up multiple monitors, keep a few basic rules in mind:

◆ If the computer has a video adapter built into the motherboard, the built-
in adapter must be used as the VGA device.

◆ Monitors in the multiple monitor setup must use either Peripheral
Component Interconnect (PCI) or AGP slots.

◆ The PCI and AGP cards cannot use VGA resources.

◆ Only Windows XP-compatible drivers can be used on the monitors.

To set up a multiple monitor configuration, just follow these steps:
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Working with Multiple Processors
As with Windows 2000, Windows XP supports multiprocessor computers. The use of
multiple processors on one computer increases the computer’s ability to handle tasks
and is particularly useful for Windows XP computers that function as network file and
print servers, increasing the processor speed; and with two processors available to
Windows XP, it can work faster and meet the needs of local and network processes.

Essentially, Windows XP must be able to divide the workload between the processors
into even pieces to utilize the processors. This process, called multitasking, enables the
operating system to juggle processor requests between the two processors. Windows
XP Professional is a true multitasking operating system that uses a type of multitask-
ing called preemptive multitasking. Preemptive multitasking systems have the ability
to manage and control applications and processor cycles. Because the Windows XP
kernel remains in control of all resources, the operating system can halt applications
or make them wait, or preempt them. With this kind of power and control, Windows
XP can divide tasks between processors and determine what processor performs which
task. 

Windows XP Professional can support two Intel-based processors. Windows XP does
not support other processor types, such as Alpha or MIPS, so for multiprocessor
functionality to work, two Intel-based processors must be used. If you install Windows
XP Professional on a computer with two Intel-based processors, the processors should
be detected and installed during Windows XP setup.
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1. Turn off the computer. Follow the manufacturer’s instructions to install
the new PCI or AGP video card.

2. Attach a monitor to the new card and boot the computer.

3. Windows XP plug and play will detect the new card and install it.

4. Right-click an empty area of the desktop and click Properties. Click the
Settings tab. You’ll see two monitor icons on the tab. Select the monitor
that you want to use as the secondary monitor. If a monitor is an onboard
video adapter built into the motherboard, it must be the primary monitor.

5. Click the Extend my Windows desktop onto this monitor check box.

6. Adjust the resolution and color scheme settings as desired for the monitor.
Click OK.

7. To add additional monitors to the configuration, repeat Steps 1 through 6.

Working with Disk Devices
Disk management in Windows XP provides you with a number of configuration
options that are more flexible than ever before. Building on volume management
first introduced in Windows 2000, you can use multiple hard disks and create vir-
tually unlimited numbers of volumes. 

Windows XP hard disk configuration and management are covered in

Chapter 7, so refer to that chapter to learn more about volume and disk

management.

This section, however, focuses on removable drive management, specifically,
CD/DVD-ROM drives and other removable media drives (such as tape drives). CD
and DVD-ROM drives (or combo drives) are standard on computers today and, in
many cases, computer systems now have multiple CD/DVD drives and CD
read/write drives. Like any hardware device, internal CD/DVD drives must be
attached to the system and detected by plug and play. You can then install the
manufacturer’s driver, and often you’ll get additional software, such as third-party
media players and CD burner software. CD/DVD-ROM drives and CD read/write
drives work better than ever before with Windows XP, and plug and play makes
them easily identified. With DVD drives, you can watch movies on your Windows
XP screen. Standard playback features, such as Dolby Digital, are supported and
used for DVD playback. For CD-ROM drives, the CD-ROM File System (CDFS) is
used. For DVD discs, the Universal Disk Format (UDF) file system is used. CDFS and
UDF are industry standards natively supported in Windows XP.
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As with all hardware, the trick when installing new internal or external CD-ROM
devices is to use devices that are listed on the HCL and make sure you have the
most current driver. A secondary note about installation concerns audio playback.
If you expand the CD/DVD category in Device Manager, you’ll see your CD/DVD-
ROM drives listed. If you right-click the desired CD/DVD-ROM drive and click
Properties, you’ll see a Properties tab. As you can see in Figure 6-11, you can adjust
the AutoPlay options here, and you can also determine whether or not the drive is
allowed to play CD music. If you are having problems with a CD-ROM drive not
playing music, be sure to check the setting on this tab.

Figure 6-11: CD Drive Properties tab.

You can also check the Volumes tab and see the CD’s partition setup, its capac-
ity, status, and other general information about the state of the disc.

Aside from these configuration options, you can also right-click the disk in My
Computer and click Properties. This gives you the same tabs you see with other
hard disks. For removable discs, however, you’ll also see an AutoPlay tab. This tab,
which is new in Windows XP, enables you to select a default action that should
occur when a certain type of file is opened from the removable disc. You can select
from a list of possible programs that can open the disc (such as Windows Media
Player) and you can also use the prompt option to choose which action you want to
take for a particular file.

Refer to Chapter 7 for more information on the Properties tabs you’ll find

with other hard disks.
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Other types of removable media drives function in the same basic way, including
the following: 

◆ Zip

◆ Jaz

◆ Tape drives

You can install them by connecting them to an appropriate port and allowing
plug and play to detect the drives. From that point, you can install an appropriate
driver. Concerning tape drives for backup purposes, Windows XP supports a num-
ber of industry standard drives, and you can support them using Windows XP’s
Removable Storage Console found in Computer Management.
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Chapter 7

Managing the Hard Disk
IN THIS CHAPTER

◆ Exploring FAT and NTFS

◆ Using dynamic disks

◆ Managing disks with disk properties

AT FIRST GLANCE, CONFIGURING and managing a computer’s hard disk might not
seem like an exciting event. After all, the purpose of a hard disk is simply to store
information. This includes everything from operating system files to your personal
files and folders that you create on Windows XP. However, that storage system,
much like an efficient filing cabinet, can make your work with Windows XP much
more effective. In fact, several helpful hard disk solutions are available in Windows
XP that you should consider taking advantage of. This chapter explores those fea-
tures and explains how to use them.

Working with File Systems
Every computer disk must have some kind of file system. The file system makes the
hard disk usable by the operating system so that the operating system can store
data on the disk. Windows XP supports both the File Allocation Table (FAT32) file
system and the NT file system (NTFS).

Before exploring the two file systems supported by Windows XP, consider the
basics of how a file system works. Hard drives are typically installed in a computer
in an unformatted state, meaning that the operating system is unable to write and
read data from the hard disk. Without file folders, there is no way to organize and
store information on the hard disk. So, to use the hard disk, Windows XP
Professional must write a signature to a hard disk and format it with a file system
to be able to read and write to that disk.

When the hard disk is formatted, magnetic rings are created on the disk and the
disk is divided into circular areas called sectors. Sectors are then grouped together
in clusters. Clusters are logical areas of the disk that the operating system uses to
write data to. Depending on how the operating system handles cluster size, the disk
can hold more or less data due to space that is lost on cluster size configuration.
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FAT and FAT32
When formatting the disk, the operating system writes a file system to the disk,
which is a way to organize and manage data on that disk. The first file system sup-
ported by Windows XP is the File Allocation Table (FAT) file system. FAT16 was
first developed, with a 32-bit version appearing a few years later. FAT16 is a basic
file system that was designed to support small disks. Under Windows XP
Professional, the FAT16 file system can grow up to 4 GB in size, and supports file
sizes up to 2 GB. In other words, 4 GB is the maximum amount of cluster storage
space and management functionality that FAT16 provides. This, of course, is hope-
lessly small in today’s computing environments. FAT16 is supported on Windows
3.1 and higher Microsoft operating systems. Under most circumstances, FAT16
would never be used on a Windows XP Professional operating system (or even ear-
lier systems, such as Windows 98) unless you needed to dual-boot with an older
operating system, such as Windows 3.1 and the original version of Windows 95.
Since few of us are using Windows 3.x or Windows 95 any longer, there is simply
no need to use FAT16.

FAT32 is significantly different from FAT16 in several ways. First available for
Windows 95b, FAT32 supports larger hard drives and smaller file clusters. In other
words, you can make use of a large hard drive while simultaneously conserving
disk space due to the small cluster size. Less room is wasted on the hard disk. FAT32
supports 32-GB drives. For these reasons, FAT32 is the operating system of choice
for Windows 95b, Windows 98, and Windows Me operating systems.

NTFS
NTFS is supported under Windows XP and is considered the file system of choice.
NTFS has been around since the earlier days of Windows NT, but the new version
first supported in Windows 2000 (NTFS v5) provides additional features and func-
tions. NTFS is virtually unlimited because it supports up to 2 terabytes of data,
which is a theoretical number because hard disks are not yet capable of supporting
this much data. Essentially, there are no limitations with NTFS in terms of drive
size. Additionally, NTFS supports many features that are not available under the
FAT (16 or 32) file system.

For example, NTFS supports both folder-level and file-level security. You can
individually configure files and folders with their own security features, as well as
individual security settings for users. NTFS natively supports data encryption. You
can encrypt a folder so that no one else can read it, yet continue to use the data in
that folder as normal. NTFS also natively supports data compression and logging.

Formatting and Converting Drives to NTFS
With Windows XP, you can format unformatted drives with NTFS, and you can also
convert existing FAT drives to NTFS. Keep in mind that this discussion refers to the
computer’s hard disks. Most removable disks, such as Zip, floppy, and writeable
CDs, do not support the NTFS file system. When you install Windows XP, you have
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the option to choose with which file system you want to format the disk; however,
what about existing drives? You can easily convert them, but you should keep two
basic rules in mind:

◆ You can convert a FAT or FAT32 drive to NTFS while preserving your
data. Conversion is a one-way process, however. Once you convert to
NTFS, you cannot revert back to FAT without reformatting the disk.

◆ You cannot convert an NTFS drive to FAT or FAT32 without reformatting
the drive. This means that all of your data on the hard disk will be
destroyed during the formatting process. You will have to restore all of
the data from backup.

Refer to Appendix A for more information on installing Windows XP.

So, the issue to keep in mind is simply that converting to NTFS is a one-way
process. Although the conversion process is safe and effective, volumes that are
converted lack some of the performance benefits of drives that were initially 

Chapter 7: Managing the Hard Disk 141

When to Use FAT32
Although NTFS is the best file system, containing numerous features not found in FAT,
there are some reasons for implementing FAT. The first and foremost reason concerns
dual-boot systems. Windows 9x and Me do not support the NTFS file system. So, if you
want to dual boot between Windows 9x/Me and Windows XP Professional, the
Windows 9x/Me system will not be able to read any data on the Windows XP
Professional partition. In dual-boot cases, it is usually best to find the common-
ground file system between the two operating systems; in this case, that is FAT32. 

One other reason for using FAT concerns small hard drives. NTFS has a complex
structure and some overhead associated with it. Drives that are 2 GB or smaller are
best used with FAT. NTFS consumes too much disk space in overhead on drives this
small and simply does not work that well. In most cases, the small drive issue is
unimportant because the majority of drives today are much larger.

It is important to note here that you do not have to use the same file system on each
partition in a dual-boot scenario. The issue is simply that downlevel versions of
Windows (Windows Me or earlier) will not be able to access data stored on the NTFS
partition. Depending on your needs, however, that may be perfectly fine. Just think in
terms of data access when you are considering file systems in dual-boot scenarios.
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formatted with NTFS. Also, the Master File Table is different on converted volumes,
which also affects performance to a degree. Still, conversion is the easiest way to
change a FAT drive to NTFS without reformatting and having to restore data cur-
rently held on the FAT volume. Converting to NTFS is easy, and the following steps
show you how:

1. Click Start → Run. Type command and click OK.

2. At the command prompt, you will use the convert command to convert
the FAT drive to NTFS. Keep in mind that the conversion process is com-
pletely safe and all of your data will remain as it is. The command and
syntax are as follows:

convert driveletter: /FS:NTFS.

Press Enter.

3. Conversion may take several minutes, depending on the size of the drive.
When the process is complete, simply exit the command interface. If 
you converted the boot partition, you will be prompted to reboot the
computer.

Managing Hard Disks
Windows XP continues the tradition of dynamic disks that first began in Windows
2000. The goal of disk management in Windows XP is to give you flexibility and
disk management options that are easy to work with. As such, Windows XP gives
you a disk management console found in Computer Management, which is avail-
able in Start → Control Panel → Administrative Tools → Computer Management.
Select Disk Management in the left console pane and you can see the disks and
their configuration in the right console pane, as shown in Figure 7-1.

Converting a Basic Disk to a Dynamic Disk
Windows XP Professional supports two kinds of disks: basic and dynamic. A basic
disk is a standard hard disk that supports standard configurations. A basic disk can
have a primary partition and extended partitions that make up logical disk drives.
For example, you can configure the basic disk so that it has a C drive (primary) and
a D drive (extended). You can use the D drive for storage or other purposes (or to set
up a dual-boot configuration). On a basic disk, you can have up to four primary
partitions, or alternative configurations, such as three primary partitions and one
extended partition, and so on. One of the primary partitions is considered active
and is used to start the computer. This active partition contains your boot files and
the master boot record. Basic disks behave just as disks have in the past and do not
provide the advanced management features supported under Windows XP
Professional. Disks are always basic when first installed, but you can convert them
to dynamic to take advantage of all that Windows XP Professional has to offer.
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Figure 7-1: Disk Management console.

As a general rule, you should always convert a Windows XP computer’s hard

disks to dynamic disks so you can take advantage of the management fea-

tures explored in the rest of this chapter. Of course, if you are dual booting

with a downlevel operating system, you should keep the disk a basic disk.

A dynamic disk is a drive configured by the Disk Management console so that
it can support volume management. A volume is simply a logical organization of
a disk for storage purposes. With volume management, you are not limited to a
primary partition and a few extended partitions. Volumes give you the flexibility to
divide up a disk in any way that is helpful to you. Volumes are much more flexible
and much easier to work with. The Disk Management utilities configure the drive so
that it can make use of Windows XP Professional’s disk management features. In
essence, if you want to take advantage of volume management and lose the parti-
tion restrictions placed on basic disks, you need to convert the disk to a dynamic
disk. (If not, no performance features are associated with dynamic disks, so there
are no reasons to convert.) You can easily convert your existing drives to dynamic
disks. The following steps show you how to convert a basic disk to a dynamic disk:

1. In Disk Management, right-click the Disk number in the graphical portion
of the Disk Management display, and click Convert to Dynamic Disk. You
can also click Action → All Tasks → Convert to Dynamic Disk.

2. In the Convert to Dynamic Disk window, shown in Figure 7-2, select the
disk that you want to convert and click OK.
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Figure 7-2: Convert to Dynamic Disk dialog box.

3. In the Disks to Convert window, review the settings, as shown in 
Figure 7-3. Click Convert to continue.

Figure 7-3: Conversion summary.

4. You will see a message telling you that other operating systems will not
be able to start from the disk once the conversion has taken place (this
means all other operating systems such as NT, 9x, and Me). Click OK to
continue.

5. You might see a message telling you that any mounted disks need to be
dismounted. Click OK to continue.

6. The conversion process occurs and you are prompted to reboot the com-
puter. After you reboot, you can see that the disk’s status has changed
from basic to dynamic in the Disk Management console.

Working with Dynamic Disks
After a basic disk has been converted to a dynamic disk, you can begin taking
advantage of the features of dynamic disks. Dynamic disks give you information
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about the status of the disk, and you can create various types of volumes, as
needed. The following sections explore these features.

DYNAMIC DISK STATES
Dynamic disks are capable of displaying several different states. This information
tells you the current status of the disk and helps you understand problems that may
exist. The following list explains the states that a dynamic disk might display:

◆ Online — The disk is online and functioning with no errors.

◆ Online (Errors) — The disk is online, but errors have occurred. These errors
are usually minor and can be fixed by running the Error Checking tool
found on the Tools menu of the disk’s properties.

◆ Offline — The disk is not accessible. This problem can occur because of
corruption or an input/output (I/O) problem. Try right-clicking the disk
and clicking Reactivate Disk to bring the disk back online.

◆ Missing — The disk is not accessible, is disconnected, or corruption has
caused the disk to be unreadable. Try right-clicking the disk and clicking
Reactivate Disk to bring the disk back online.

◆ Initializing — This message occurs when the disk is temporarily unavail-
able because of a conversion to dynamic state.

◆ Not Initialized — This message occurs when you’ve installed a new disk
and the disk does not have a valid signature. When the Disk Management
utility appears, the disk appears as Not Initialized. To write a valid signa-
ture so that you can format and begin using the disk, simply right-click
the disk and click Initialize.

◆ Foreign — This status appears when a physical, dynamic disk is moved
from a Windows 2000/XP Professional computer to another Windows
2000/XP Professional computer. When this message appears, right-click
the disk and click Import Foreign Disk.

◆ Unreadable — This status appears when I/O errors keep the disk from being
readable. Go to Action → Rescan Disks to fix the problem.

◆ No Media — This status appears on removable drives when no media is
inserted into the drive.

CONFIGURING DRIVE LETTERS AND PATHS
Windows XP makes drive letter and path configuration easy. You can assign a drive
any alphabet letter, and you can also assign a drive to an empty NTFS folder. If you
want to make a change to a dynamic disk volume, simply right-click the volume in
the Disk Management console, and click Change Drive Letter and Paths. A Change
Drive Letter and Paths window appears, as shown in Figure 7-4.
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Figure 7-4: Change Drive Letter and Paths window.

From this window, you can perform the following actions:

◆ Add — If you click the Add button, a second window appears where you
can mount the drive to an empty NTFS folder (which is discussed later in
this section). You cannot assign multiple drive letters for the same drive.

◆ Change — If you click the Change button, the Change Drive Letter or Path
window appears, as shown in Figure 7-5. You can choose a different drive
letter from the drop-down menu.

Figure 7-5: Change option.

◆ Remove — You can also remove the drive letter. Dynamic disks do not
require that a drive letter or path identify a drive. However, some pro-
grams might not function if you remove the drive letter, nor will you be
able to access the drive.

Aside from assigning a different drive letter, you can also mount a volume to a
local, empty NTFS folder. The purpose is to give you freedom and flexibility beyond
the 26-letter alphabet limitation. When you mount a volume to an empty NTFS
folder, a drive path is used instead of a drive number. For example, say that you
have a local volume that is only used for storage. You could create an NTFS folder
called Storage, and mount the drive to the empty storage volume. You can then
access the drive by simply accessing C:\Storage, just as you would a folder. The
end result is that you can have an unlimited number of drives and use them like
folders rather than standard drive letters that you must keep track of. You can use
both a drive letter and a mounted volume on the same drive, if you like. Keep in
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mind that the drive must be mounted to an empty folder. After the mount takes
place, you can move data to that folder to store it on the volume.

Remember that the mounting option only works on NTFS folders. You 

cannot mount to a folder on a FAT drive.

To mount a drive to an empty NTFS folder, just follow these steps:

1. In the Disk Management window, right-click the volume that you want to
mount to an empty NTFS folder and click Change Drive Letter and Paths.

2. In the Change Drive Letter and Paths window, click the Add button.

3. In the Add Drive Letter or Path window, shown in Figure 7-6, select the
mount radio button, and then enter the path to the folder that you want
to mount, or click the Browse button to select the folder.

Figure 7-6: Folder mount option.

4. If you Browse for the folder, a browse window appears, as shown 
Figure 7-7. You can locate the folder or create a new one by clicking 
the New Folder button. Make your selection and click OK.

Figure 7-7: Browse for or create a new NTFS folder.

5. Click OK again in the Add Drive Letter or Path window.

Chapter 7: Managing the Hard Disk 147

549987 ch07.qxd  11/20/03  11:39 PM  Page 147



Working with Disk Volumes
Using dynamic disks, you open a world of management possibilities, and you lose
the restrictions you often faced with basic disks. When a disk is first converted to a
dynamic disk, it will appear in the disk console as unallocated space. This means
that the disk has no volumes and has not been formatted. The disk is not usable by
the operating system in its current state. Figure 7-8 shows you an unallocated disk
in the Disk Management console. This disk has been converted to dynamic, but has
no volumes and no file system. To use a dynamic disk, you’ll need to create and
format disk volumes. The following sections show you the different kinds of 
volumes that are available to you and how to create them.

Figure 7-8: Browse for or create a new NTFS folder.

Creating Simple Volumes
A simple volume is a standard disk volume. It is a unit of disk space that has been
configured and formatted so that it can be used to store data. A hard disk can be
formatted as one volume, or you can format a portion of it so that you can use
multiple disk volumes. The following steps show you how to create a simple disk
volume.

1. In the Disk Management console, right-click the dynamic disk’s unallo-
cated space and click New Volume.

2. The New Volume Wizard appears. Click Next to continue.

3. In the Select Volume Type window, shown in Figure 7-9, click the Simple
radio button and click Next.

4. In the Select Disks window, shown in Figure 7-10, select the disk that you
want to configure (which is already selected for you under this wizard),
then enter the size of the volume (in megabytes) that you want to create.
The maximum amount of space available is listed here for you, as well.
Click Next.

5. In the Assign Drive Letter or Path window, choose a drive, assign an
empty NTFS folder, or do not assign either. Click Next.

6. In the Format Volume window, shown in Figure 7-11, you can choose to
format the volume or not, and you can choose to use the quick format
feature and enable file and folder compression for the volume. Make your
selections and click Next.
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Figure 7-9: Choose the Simple volume option.

Figure 7-10: Select the disk and the desired megabyte space for the volume.

Figure 7-11: Format volume.
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7. Click Finish. The new volume is created and appears in the Disk
Management window.

Extending a Simple Volume
Say that you create a simple volume with a certain amount of space. You still have
extra free space on the same disk. At a later time, you decide that the volume
should have been larger. You do not have to remove your data from the volume and
create a new one; you can simply extend the existing volume by grabbing some of
the additional unallocated space on the disk. This feature allows you to quickly
gain additional space without any harm to your data currently stored on the exist-
ing volume. For example, say you have a 10-GB volume and 2 GB of free space
available on the same disk. You can extend the 10-GB volume and include the 2 GB
of free space to create a 12-GB volume. You can do all of this without damaging
the data stored on the original 10-GB volume.

To extend a volume, right-click on the volume and click Extend Volume. The
Extend Volume Wizard appears. The wizard basically works in the same way as 
the New Volume Wizard. Simply walk through the wizard steps and determine the
amount of space you want to add to the existing volume. The extended volume will
appear as a new volume in the Disk Management console, but it is actually an
extension of the existing volume.

Creating a Spanned Volume
Aside from the simple volume, Windows XP Professional also supports spanned
volumes. A spanned volume combines areas of unallocated space on multiple disks
into one logical volume. You can combine between 2 and 32 areas of unallocated
space from different drives. For example, say that a computer has three hard drives.
On each drive there is about 500 MB of unallocated free space. A 500-MB volume
is rather small and not very practical for everyday use. However, using the spanned
volume option, you could combine all three 500-MB areas of unallocated space to
create a 1.5-GB volume. You can then use the volume, as if the storage was located
on a single disk. Essentially, this configuration gives you more flexibility and fewer
volumes (and drive letters to keep up with), and makes good use of leftover space.

After the spanned volume has been created, you see it as any other volume in
My Computer or Disk Management. It is important to note, however, that spanned
volumes are storage solutions only — they do not provide any fault tolerance. If one
disk in the spanned volume fails, all data on the spanned volume is lost. However,
you can back up a spanned volume just as you would any other volume.

Like a simple volume, you can easily extend a spanned volume at any time by
adding existing free space. However, you cannot remove a volume from a spanned
volume without losing the entire volume, so keep this issue in mind as you plan
your disk configuration.

To create a spanned volume, follow these steps:
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1. In the Disk Management console, right-click one of the areas of unallo-
cated disk space on one of the disks and click New Volume.

2. The New Volume Wizard appears. Click Next to continue.

3. In the Select Volume Type window, shown in Figure 7-12, click the
Spanned option, and then click Next.

Figure 7-12: Create a spanned volume.

4. In the Select Disks window, the current disk appears in the selected dialog
box. Choose the free space on the desired disk(s) that appears on the
Available window and click the Add button. Repeat the process until all
unallocated areas that you want to use appear in the Selected box. Click
Next.

5. In the Assign Drive Letter or Path window, choose a drive letter or mount
the drive to an empty NTFS folder. You can also choose not to assign a
drive letter or path at this time. Click Next.

6. In the Format Volume window, choose whether or not to format the vol-
ume at this time and whether or not to perform a quick format and enable
file and folder compression. Click Next.

7. Click Finish. The volume is created and now appears in the Disk
Management console.

Creating Striped Volumes
Striped volumes are similar to spanned volumes in that they combine areas of free
disk space (between 2 and 32 areas of unallocated space on different drives) to cre-
ate one logical volume. However, the big difference is that striped volumes write
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data across the disks instead of filling one portion of free space first, then the next
portion, and so on. You are likely to see faster read and write performance than you
will with a simple spanned volume. Like a spanned volume, you can create a striped
volume by right-clicking one of the areas of unallocated space and clicking Create
Volume. In the Create New Volume Wizard, choose to create a striped volume, and
follow the same steps that appeared in the previous section.

Another important point concerning striped volumes is that the areas of unallo-
cated free space must be the same size. For example, say that you want to use 500-
MB, 800-MB, and 900-MB areas of unallocated disk space to create a striped set.
Since the areas have to be the same size, Disk Management will configure 500 MB
from each disk, which means that you will still have some unallocated space left
over. This configuration enables data to be written evenly across the disks.

Finally, keep in mind that striped volumes are storage solutions designed to pro-
vide better performance. They do not, however, provide any fault tolerance. If one
disk in the stripe fails, all of your data stored on the stripe will be lost. So, make
sure you have an effective backup plan.

See Chapter 17 to learn more about backing up your data.

Using Hard Disk Properties
As with most elements of the Windows XP operating system, hard disks also contain
properties pages that you can access from My Computer by simply right-clicking
on the disk and clicking Properties. The properties pages give you a few important
feature tabs that you should keep in mind as you manage hard disks on Windows XP,
including the following:

◆ General

◆ Tools

◆ Hardware

◆ Sharing

◆ Quota

◆ Security
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The following sections review these tabs in greater detail.

General Tab
The General tab, shown in Figure 7-13, gives you a quick way to view information
about the disk, such as disk type, file system, used space, and free space. You can
also launch the Disk Cleanup Wizard here, which inspects the drive for items that
can possibly be deleted to free up space on the disk. Notice at the bottom of the
window that you can compress the entire disk to conserve space, and you can index
the drive so that searches work better and faster. These features have no negative
effect on your data.
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Where is the fault tolerance?
As you have been working with the Add Volume Wizard, you may have noticed
references to some additional volume solutions that are fault tolerant. In reality,
Windows XP Professional does not support any kind of disk fault tolerance, unlike
Windows 2000/.NET Server. The references refer to Microsoft’s overall disk
management solutions, even though the fault tolerant options are not available on
Windows XP Professional or even Windows 2000 Professional, for that matter.

As an FYI, the two types of fault tolerance available on Microsoft server software are
Disk Mirroring and RAID 5. Disk mirroring, which is supported on dynamic disks in
Windows 2000 Server (also called RAID 1), requires two physical disks. When a disk
mirror is configured, one disk volume maintains an exact copy of the first disk. In the
event that one of the disks fails, you always have a redundant copy. The good feature
of disk mirroring is that you have a redundant disk copy that can be easily used in the
event that a single disk failure occurs. The bad news about disk mirroring is the
megabyte cost. Because you are maintaining an exact copy of a volume, everything
you save requires twice as much storage space as it normally would. Still, for critical
servers that must be up and running quickly, disk mirroring is a great choice.

The second type of fault tolerance supported under Windows 2000/.NET Server is RAID
5 volumes. RAID stands for Redundant Array of Inexpensive Disks, and it is a standard
that uses three or more dynamic disks to store data. Using a parity bit, which is a
mathematical formula, data is written across the disks in stripe fashion. Should a
single disk fail, the data can be regenerated from the remaining disks. You can use up
to 32 physical drives for a RAID 5 volume, but RAID 5 volumes cannot hold the system
or boot partition.
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Figure 7-13: General tab.

Tools Tab
The Tools tab, shown in Figure 7-14, gives you three different tools that you can
use to administer and manage the physical disk. The first tool is the Error-checking
tool, formerly called ScanDisk. Error-checking inspects the disk for file system
problems and disk surface problems. When you choose to use the Error-checking
tool, you have the option to fix file system errors and scan for and fix bad disk sec-
tors. This tool can be very helpful if you are experiencing disk problems, but it
does need exclusive access to the disk, which may require you to reboot before it
can run.

Figure 7-14: Tools tab.
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The next tool is the disk defragmenter. The disk defragmenter is able to correct
fragmentation in the file system, which occurs over time, and files are saved,
changed, and moved.

Because disk defragmentation is a performance issue, this tool is examined

in more detail in Chapter 18.

The final tool is the Backup utility, which can also be accessed from the Computer
Management console. Using the backup utility, you can perform a number of differ-
ent system, application, and data backups on your computer, and you can also
restore data in the event that it is lost due to hardware failure or another mishap.

Refer to Chapter 17 for more information on the backup features provided

in this utility.

Hardware Tab
The Hardware tab, shown in Figure 7-15, gives you a listing of all disk drives on the
computer. You can select a disk and click Properties to access the Device Manager
properties sheets for the disk, or you can click the Troubleshoot button if you want
Windows XP to try and help you solve problems with the disk.

Figure 7-15: Hardware tab.
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Sharing Tab
The Sharing tab enables you to share the entire disk and configure permission and
caching settings allowed when the disk is shared.

You can learn all about resource sharing in Chapter 15.

Security and Quotas
If simple file sharing is not in use, you’ll see a Security tab, which is the standard
Security tab you see on all shared resources. Using the Security tab, you can con-
figure access to the disk and permissions for local and domain users.

You also see a Quota tab. Disk quotas allow network users to store data on your
computer, as in the case of a file server. Using disk quotas, you can determine how
much data they can store along with storage warnings.

See Chapter 15 to learn more about security, and see Chapter 16 to learn

more about disk quotas.
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Chapter 8

Working with Folders and
Files
IN THIS CHAPTER

◆ Managing folders

◆ Configuring encryption and compression

◆ Working with offline files

FILES AND FOLDERS ARE the mainstay of Windows; after all, you spend most of your
time working with various files and folders. Windows XP Professional provides a
number of helpful tools and features that make files and folders easier to use, man-
age, and customize to meet your needs. This chapter explores these features and
options.

Working with Folders
In terms of managing files, folders are your best friends. As a storage location, a
folder is simply a holding place where you can organize all kinds of data on your
computer, from documents, photos, and spreadsheets, to application files. Windows
XP gives you more configuration and customization options, along with some great
management features that make folders more flexible and useful than they ever
have been on Windows. In this section we take a look at what you can do with
folders.

Configuring Folder Options
Folder Options, which is a Control Panel icon, is a centralized place where you can
configure how all of your folders on Windows XP generally behave and look. You
can access Folder Options from either the Control Panel or by clicking the Tools
menu in any folder and clicking Folder Options. Either way, you arrive at the Folder
Options properties dialog box. It is important to note here that no matter how you
access Folder Options, the configuration changes you make in the Folder Options
properties dialog box affect all folders on Windows XP. You cannot individually
configure these settings for different folders. With that said, the following sections
show you what options are available on Folder Options properties.
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GENERAL TAB
The General tab, shown in Figure 8-1, contains three major sections that affect
folder appearance and functionality.

Figure 8-1: The Folder Options General tab.

◆ Tasks — This option enables you to display Web content in your folders.
This includes the blue links you have seen on the left side of your folders
(which jump to another location when you click them). Web content also
enables your folders to display HTML documents and graphics files, such
as thumbnails. To use the Web view, just click the Show common tasks in
folders radio button. My Computer and the Control Panel are always dis-
played with the Web page view, even if you do not select this option. If
you want to use the old Windows look, click Use Windows classic folders.

◆ Browse folders — This option enables you to choose how your folders are
displayed when you are browsing through a folder structure. For example,
say you open My Computer, and then you open the Control Panel. You
can have My Computer open in a window, and then have the Control
Panel open in a separate window. Or, you can choose to use the same win-
dow; so you open My Computer, and when you open the Control Panel, it
appears and replaces what you see in My Computer.

◆ Click items as follows — You can have your mouse clicks act as though
your Windows XP interface is the Internet. On the Internet, you simply
click your left mouse key to open any item because all Internet movement
is performed through hyperlinks that connect Web pages and Internet sites
together. You can have your computer act this way so that you only have
to point to an item to select it and left-click it one time to open it.
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VIEW
The View tab contains a number of check boxes that enable you to make a number
of different decisions about files and folders, as shown in Figure 8-2. The options
found here concern the display of certain file types, folder views, and other lower-
level settings. Windows XP does a good job of configuring the common settings for
you, but different settings here can be helpful. The following list points out some of
the more common options and whether those options are enabled by default.

◆ Do not show hidden files and folders and Hide protected operating
system files — These two separate options, both of which are enabled by
default, do not show hidden files and folders in Windows XP. Windows
XP hides many of the files and folders that hold operating system files
that make Windows XP run. You don’t need to do anything with these
files, so Windows XP hides them to help prevent tampering or accidental
deletion.

◆ Hide extensions for known file types — This option hides file extensions.
For example, say you type a Microsoft Word document called Development.
The document’s official name is Development.doc. The hide extensions
option hides the .doc extension and all other extensions for files that
Windows recognizes. This makes your folder files cleaner and easier to
read. This option is enabled by default.

◆ Remember each folder’s view settings — You can use the View menu in a
particular folder to determine how the folder appears and what you can
view (you will learn about these options later in this chapter). This setting
tells Windows to remember each folder’s view settings. This option is
enabled by default, and you should keep it enabled.

Figure 8-2: Folder Options — View Tab.
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FILE TYPES
The File Types tab provides you with a window that lists every type of file sup-
ported in Windows XP. Your operating system and applications do a great job of
managing this list, so you do not need to perform any configuration here unless
explicitly instructed to do so by some application. However, removing file types
from this list can prevent certain application files from functioning in Windows XP.

OFFLINE FILES
Offline Files allow Windows XP to store network files locally on your computer and
then synchronize your local copy with the network copy. The Offline Files tab
enables you to turn on offline file support and configure some basic functions for
offline files. You will learn more about using Offline Files later in this chapter.

Configuring Folder Views and Toolbars
Folder Options govern the overall appearance and functionality of folders, yet you
can use some additional folder features to customize folders so that they look and
behave in a manner that works well for you. In fact, Windows XP has more folder
features than ever before, and this section takes a look at your options.

VIEW MENU
The View menu, shown in Figure 8-3, gives you a quick and easy way to view file
information. Although the View menu seems readily obvious, do take note, because
there are more options here than you might at first think. In the past, you were
stuck using icons and wondering what was hiding behind those icons. However, for
digital media, the View menu can be very helpful because you can view thumbnails
and even use a Filmstrip view, which makes digital picture viewing really helpful.

TOOLBARS
On the View menu, you also see a Toolbars item. If you point to this item, another
submenu pops out. This submenu allows you to select the toolbar items you would
like to use in the folder. Some of these are enabled by default, but you can enable
or disable then by clicking them with your mouse. You have these options:

◆ Standard Buttons — Enabled by default, this option provides you with the
standard toolbar buttons, such as Back, Forward, Up one level, Search,
and so forth. You need these, so keep this option enabled.

◆ Address Bar — Enabled by default, this gives you the address bar so you
can move to different areas of your computer or even the Internet. For
example, you could access a folder on your computer by typing the path
to the folder (such as C:\My Documents) or an Internet address.
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◆ Links — This option, which is enabled by default, gives you a Links button
on your toolbar so you can link to resource locations that you commonly
access.

Aside from these standard options, you can also lock the toolbars and click
Customize. This option opens a Customize Toolbar window, as shown in Figure 8-4,
where you can add and remove various toolbar buttons and options. The following
steps show you how to create a customized toolbar.

Figure 8-3: View menu.

Figure 8-4: View menu.
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1. In a desired folder, click View, point to Toolbars, and then click
Customize.

2. In the Customize Toolbar window, select any item in the left portion of the
window that you want to add to your toolbar, and then click the Add but-
ton. Continue this process until you have moved all options that you
want.

3. In the right portion of the window, select any item that you do not want
to use on your toolbar, and then click Remove. Continue this process until
you have removed any options you do not want.

4. In the right portion of the window, select a desired item and use the Move
Up or Move Down buttons to adjust the order of the toolbar, as desired..
You can also choose to show text labels, use selective text to the right of
the icon, or show no text with the icons at all.

5. Click Close when you are done.

On the Toolbars menu option, notice that you can lock the toolbars. When

the toolbars are locked, you can’t drag them around or reorganize them on

the folder.

STATUS BAR
The Status bar is the small bar that runs along the bottom of your window. It tells
you what is going on when you are trying to use or connect to other resources. This
bar works just like the Status bar in Internet Explorer, and you can choose to use it
or not by clicking Status Bar on the View menu.

EXPLORER BAR
This option has an additional pop-out menu that lists various Explorer items you
can select, such as Search, Favorites, and so forth. If you select one of these items,
an additional pane appears in the window to provide the Explorer Bar option. For
example, if you select the Search option, the window provides a search section. You
can experiment with these settings to find ones that are useful to you.

ARRANGE ICONS
The Arrange Icons by option on the View menu lets you arrange icons in a number
of ways, including the following:

◆ By name

◆ By size
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◆ By type

◆ When they were last modified (and so on)

Depending on the icons in the folder, you may see additional arrangement
options. For example, if you have pictures in the folder, you’ll see an option to
arrange photos by when the pictures were taken.

CHOOSE DETAILS
The Choose Details option allows you to choose the details that you want displayed.
As you can see in Figure 8-5, a simple dialog box appears when you select the
option where you can choose the details you want to show, and you can also adjust
the order of the details as desired.

Figure 8-5: Choose Details.

CUSTOMIZE THIS FOLDER
This option opens the folder’s properties pages to the Customize tab, as shown in
Figure 8-6. You have several options to customize the folder. You can choose a
folder template, such as Photo Album, Documents, Pictures, Music, and so forth.
Windows XP tries to choose the best template for you based on the kinds of files
that are located in the folder. However, you can easily change the template option
here.
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You also have the option to choose folder pictures and change the folder icon if
you like. The folder pictures option simply places pictures on the outside of the
folder as a sort of preview to what the folder contains.

Figure 8-6: Customize options.

Managing File Associations
A commonly frustrating aspect of using files concerns the programs that open
them. For example, you may have several JPEG images; those images always open
with Windows Picture and Fax Viewer, but you want Internet Explorer to open the
JPEG images by default. Different file types have different applications associated
with them. However, you can easily change the association so that the file opens
with the desired program by following these steps:

1. Right-click the desired file and click Properties.

2. On the General tab, click the Change button.

3. In the Open With dialog box, shown in Figure 8-7, select the program
with which you want to open the file. If you want to always open this
kind of file with the selected program, click the check box for this option.
Click OK.
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Figure 8-7: Open With options.

Using File and Folder Encryption
Windows XP Professional also provides built-in encryption so that you can encrypt
files and folders. Once files or folders are encrypted, other users cannot read them.
For example, if several different people use a Windows XP Professional computer,
each user can encrypt his or her own private data so that the other computer users
cannot read it. Encryption is seamless and easy to use, and it is a feature of the NT
file system (NTFS). You do not have to be aware of any keys or the underlying
encryption technology. You simply select to encrypt data, but you can open the
data and use it seamlessly without any kind of manual decryption. If another user
attempts to access the encrypted data, that user’s key will not decrypt the data and
it will not be readable.

Before using the Encrypting File System (EFS), you should consider a few issues.
First, EFS is a feature of NTFS and only works on NTFS drives. However, encryption
and compression are not compatible — you can either encrypt a file or folder or
compress it, but you cannot do both. Also, encryption tends to slow access down —
using encrypted files is slower than using regular files because Windows XP
Professional must encrypt and decrypt files as they are opened or closed.

A new encryption feature in Windows XP enables you to give several users
access to the same encrypted file or folder. To give additional users access to the
encrypted file or folder, click the Details button in the Advanced dialog box and use
the Add/Remove buttons to manage the users who can access the encrypted file or
folder.
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To use encryption, simply right-click the file or folder that you want to encrypt,
click Properties, and then click the Advanced button on the General tab. The
Advanced Attributes window, shown in Figure 8-8, gives you an encryption check
box that you can use to turn on EFS. Note that you cannot encrypt any files that
have the system attribute or any files located in %SystemRoot%. At any point, you
can permanently decrypt the file or folder by returning to the Advanced Attributes
window and clearing the check box.

Figure 8-8: Encryption option.

As you might imagine, encryption can be helpful, but several situations can arise
that can cause you some problems. For example, what if you need to access your
encrypted data over the network from several different workstations? You can do
so in a couple of ways. First, if you set up a roaming user profile, the key will be
available no matter where you log on. If not, you can copy your key and carry it
with you on a floppy disk. Then, you can use the key to open your encrypted data.
This export process is rather easy; the following steps show you how.

1. Click Start → Run. Type MMC and click OK.

2. In the MMC, click File → Add/Remove Snap-in.

3. In the Add/Remove Snap-in window, click Add. In the snap-in list that
appears, click Certificates and click Add.

4. In the Certificates snap-in window, select My User Account and click
Finish. Then click Close in the Snap-in window and OK in the
Add/Remove Snap-in window.

5. In the MMC, expand Certificates — Current User.

6. Expand the Personal folder, and then select the Certificates folder. In the
right pane, select the desired certificate.

7. Click Action → All Tasks → Export, which starts the Export Certificate
Wizard.
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8. Follow the wizard’s simple steps. Make sure that you select to send your
private key with your digital certificate. If you are moving to another
Windows XP or 2000 system, choose the Enable Strong Encryption
option.

9. Choose a password, which you will need to import the certificate in the
new location.

10. The wizard saves your certificate and private key to a file (*.pfx, which is
a Personal Information Exchange file). You can now copy this file to a
floppy disk and move it to a new computer.

11. After you have copied your certificate and private key, you can import the
certificate and private key to another computer. Open the Certificates
MMC.

12. Open Certificates — Current User. Expand the Personal folder and select the
Certificates folder.

13. Click Action → All Tasks → Import. This begins the Import Wizard.

14. Use the Browse option to select the file that you want to import and com-
plete the wizard steps. You will need to provide the password you
assigned to the file when you were exporting.

Another issue that can occur regarding encryption is the recovery of encrypted
data. For example, say a user who shares your computer encrypts his or her data,
but the recovery key is lost. Or, in the case of a company computer, the user leaves
the company without decrypting the data. Aside from using the private key to
encrypt/decrypt data, Windows XP Professional also provides Recovery Agents for
this purpose. You can assign Recovery Agents so that data can be recovered in the
event that the user’s private key is lost or corrupted, or if the user abandons the data.
This prevents data from being hopelessly lost in encryption. However, the agent can
only decrypt data — not reencrypt it.

To configure a Recovery Agent, you must be logged on to Windows XP
Professional as an Administrator, and you need to know the location of the certifi-
cate of the person who will become the Recovery Agent. If you are part of a
domain, a network administrator will need to assist in this process because certifi-
cates are most often stored in the Active Directory in Windows domain networks.
Follow these steps to configure a Recovery Agent.

1. Click Start → Run. Type MMC and click OK.

2. In the console window, click File → Add/Remove Snap-in.

3. In the snap-in window, click Add. In the Add Standalone Snap-in window,
click Group Policy and click Add.

4. In the Group Policy Object window, leave the Local Computer option
selected and click Finish.
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5. Click Close in the Add Standalone Snap-in window and OK in the Snap-in
window. You now see the Local Computer Policy in the MMC. Expand
Local Computer Policy → Computer Configuration → Windows Settings →
Security Settings → Public Key Policies → Encrypting File System.

6. Right-click the Encrypting File System folder and click Add Data Recovery
Agent. This starts the Add Recovery Agent Wizard. Click Next on the
Welcome screen.

7. Using the wizard, locate the desired user certificate. You can select the
certificate from the Active Directory. If the certificate is not located in the
Active Directory, you need to choose a local *.cer file. The certificate must
be saved as a *.cer file.

Using File and Folder Compression
There are two ways to use compression in Windows XP. First, you can use NTFS file
and folder compression, or you can use standard folder compression, which utilizes
the WinZip technology. The following two sections explore these options.

Using NTFS Compression
Using NTFS compression, you can compress individual files, folders, and even dri-
ves on your local computer. Naturally, NTFS compression only works on drives that
are formatted with NTFS (see Chapter 7 to learn more about the NTFS file system
and how to convert drives to NTFS).

NTFS compression is fast and easy, and it gives you a lot of compression
options. All compressed items remain in a compressed state unless you move the
contents to a file allocation table (FAT) volume. FAT does not support NTFS com-
pression, so compression is lost when the file or folder is moved. If you move the
files to a different NTFS volume, the files inherit the state of the destination folder.
If you want to work with a compressed file, Windows XP automatically decom-
presses it for you while the file is in use. When you close the file, Windows XP
automatically compresses the file again. If you move or copy a file into a com-
pressed folder, it is compressed automatically. If you move a file from a different
NTFS drive to a compressed folder, it is also compressed. However, if you move a
file from the same NTFS drive into a compressed folder, it retains its original state,
either compressed or decompressed.

You cannot encrypt an NTFS-compressed file nor can you compress a file

that has been encrypted.
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As a general rule, NTFS compression reduces drive, file, and folder size by about
50 percent. Applications are reduced by about 30 percent. The following steps show
you how to compress a drive, or a folder or file:

1. Click Start → My Computer.

2. In My Computer, right-click the desired NTFS drive and click Properties.

3. On the General tab, shown in Figure 8-9, click the Compress drive to save
disk space check box to compress the entire drive. Click OK.

Figure 8-9: Compress an entire NTFS drive.

4. To compress a folder or specific file, browse to the desired file or folder.
Remember that the file or folder has to reside on an NTFS drive for com-
pression to be available.

5. Right-click the desired file or folder and click Properties.

6. On the General tab, click the Advanced button.

7. In the Advanced Attributes window, click the Compress contents to save
disk space check box and click OK.

If you prefer to use the command line, you can access Compact.exe to manage
compressed files and volumes in Windows XP. Using Compact.exe, you can com-
press, decompress, and view the compression attributes of a folder, file, or drive.
The syntax for Compact.exe is as follows:
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Compact.exe [/c] [/u] [/s[:dir]] [/a] [/i] [/f] [/q] [filename
[...]]

An explanation of the switches appearing in the Compact.exe syntax is provided
in Table 8-1.

TABLE 8-1 SWITCHES

Switch Explanation

C Compresses the specified file

U Decompresses the specified file

S Performs the specified operation on the files in the given folder and all
subfolders

A Displays file with hidden or system attributes

I Continues performing the specified operation even after errors have
occurred

F Forces the compress operation on all specified files, including currently
compressed files

Q Reports only the most essential information

Filename Specifies a pattern, file, or folder

Compressed (Zipped) Folders
Folder compression, which is built on WinZip technology, gives you a quick and
easy way to copy files to a compressed folder, which can then be e-mailed or
stored. Windows XP also contains a built-in compression feature so that you can
compress folders on either FAT or NTFS partitions. At first glance, you might not
think there is a need for zipped folders when NTFS compression is available, but
there are several advantages and issues to keep in mind.

Compressed folders can reside on either NTFS or FAT volumes, unlike NTFS
compression, which only works on NTFS volumes. Files that reside in a compressed
folder can be directly opened without unzipping them, and some applications can
also run in a zipped state. Zipped folders can be moved to any drive or folder on
your computer, another computer, the Internet, or be sent via e-mail and remain
in their compressed state. Files cannot be individually compressed using the zip
feature. You must place them in a compressed folder to compress the files. Also,
compressed folders can be password protected.
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To compress a folder, simply right-click the folder and click Send To →
Compressed Folder. This creates the zipped folder with all of the original folder’s
contents compressed, but the original folder remains. In other words, you’ll see
your original folder and a copied, compressed folder of the same contents. If you
want to create an empty compressed folder to which you can copy items, simply
click File → New → Compressed Folder from within the desired folder or Windows
Explorer. If you want to create the new compressed folder on your desktop, 
right-click an empty area of the desktop and click New → Compressed folder. Any
items you store in the folder will be compressed. If you want to decompress a
folder, right-click the compressed folder and click Extract All. A wizard appears to
help you decompress the folder.

Offline Files and Folders
Offline Files is a networking feature that uses a computer as a server to store a par-
ticular network file. Other users can then access that file from the network and use
the file as if the file were stored locally. This kind of configuration works well in
environments where file collaboration takes place, or where users need to regularly
access a collection of documents that are centralized on a server. Using Offline
Files, the offline file is downloaded and stored locally on the user’s computer. The
user can then make changes to the file, as needed, and those changes can be syn-
chronized with a server. Offline Files allows several people to make changes to a file
without maintaining multiple copies of the same file. The server recognizes the new
changes and incorporates them. Virtually any type of file, from documents to Web
pages, can be made available offline. Windows XP Professional makes setting up
offline files easy using a wizard tool that helps the user connect with the desired
network file. The following steps show you how:
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If you want to be able to easily keep track of what items are compressed and what
items are not compressed, Windows XP gives you an option to make compressed items
appear in a different color. This setting also applies to encrypted files and folders. To
configure color for compressed folders, just follow these steps:

1. Open the Control Panel and double-click Folder Options.

2. Click the View tab.

3. Scroll and locate the Show encrypted or compressed NTFS files in color check
box. Select the check box, and then click OK.
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1. Log on as an administrator.

2. Open the Control Panel and open Folder Options. Click the Offline Files
tab. If you see a message telling you that Fast User Switching is enabled,
you’ll need to change the option in User Accounts so that Fast User
Switching is disabled. Offline Files are not compatible with Fast User
Switching.

3. On the Offline Files tab (see Figure 8-10), click the Enable Offline Files
check box. You can then set some other offline file options, including the
following:

■ Synchronize all offline files when logging on

■ Synchronize all offline files before logging off

■ Display a reminder every X minutes

■ Create an Offline Files shortcut on the desktop

■ Encrypt offline files to secure data

Figure 8-10: Offline Files tab.

4. By default, offline files use 10 percent of your hard drive’s disk space for
storage. You can increase or decrease this amount, as desired, by moving
the slider bar.

5. Using the Delete Files button, you can delete previously stored offline
files. Using the View Files button, you can view currently stored offline
files.
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6. If you click the Advanced button, you see an Advanced Settings window.
This option enables you to be notified when a network connection has
been lost so that you can begin working offline. You also have the radio
button option to never go offline. You can also generate an exception list.
Make any desired configuration changes and click OK.

7. Now that Offline Files is enabled, you can choose what file or folder you
want to make available offline. Using My Network Places or any desired
window, browse to the network resource, right-click it, and click Make
Available Offline.

8. The Offline Files Wizard appears. Click Next on the Welcome screen.

9. The Synchronization window appears. If you want to automatically syn-
chronize when you log off and log on, leave the check box selected and
click Next. If not, clear the check box and click Next.

10. The final window, shown in Figure 8-11, allows you to enable reminders
and create a shortcut to the desktop. You can enable these if you like.
Click Finish.

Figure 8-11: Enable Reminders option.

11. The files are copied to your computer.

After you’ve set up offline files, simply use the file as desired. Depending on
your settings, the file is automatically synchronized with the original file. You can
manually enforce synchronization at any time by right-clicking the file or folder
and clicking Synchronize. You can further manage offline files by accessing the
Synchronization tool. The following steps show you how:

1. Log on as an administrator.

2. Click Start → All Programs → Accessories → Synchronization.
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3. The Items to Synchronize window appears, as shown in Figure 8-12. Any
current offline files or folders appear here. You can select any items that
you want to manually synchronize and click the Synchronize button.

Figure 8-12: Synchronization tool.

4. You can also click the Setup button to change the synchronization set-
tings, which you can change at any time (see Figure 8-13). You have a
Logon/Logoff tab, On Idle tab, and a Scheduled tab. These tabs are self-
explanatory, and you can use them to determine the way synchronization
occurs and when synchronization occurs. Make any desired changes and
click OK.

Figure 8-13: Synchronization Settings.
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Chapter 9

Working with the Registry
IN THIS CHAPTER

◆ Exploring the Registry

◆ Editing the Registry

THE REGISTRY IS ESSENTIALLY a large database of information Windows XP uses to
manage hardware, programs, settings, and just about anything else you want to do
with Windows XP. The Registry stores information, then Windows XP uses the
Registry to determine how it should respond to different requests, input, and appli-
cation and hardware management. When you work with Windows XP, the items
that you configure are stored in the Registry.

You can directly edit the Registry and make changes to it. Although not a rec-
ommended strategy by Microsoft, the Registry continues to be an effective way to
fix problems and change features of Windows XP that you are having trouble with.
However, when you think of editing the Registry, it is important to keep in mind
that the Registry is also a dangerous tool. Changes made to the Registry are effec-
tive immediately, and incorrect changes can cripple your operating system and
leave it unbootable. So, Registry editing is a useful skill, but one that requires
respect and care.

With the warning out of the way, this chapter explores the Registry and shows
you how to manage it through Windows XP’s built-in Registry Editor.

Understanding the Registry
The Registry has been around since the days of Windows 3.x. In Windows XP, it
continues to be an effective way to manage configuration data, and each time you
configure your system, changes are written to the Registry so that Windows XP can
use your configuration data to make the system run as you wish.
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In the days of 16-bit Windows, configuration information was kept in .INI

files. The operating systems used WIN.INI and SYSTEM.INI to hold specific

information. Third-party software often added their settings to these files,

and they often created their own .INI files, either in the Windows directory or

in the application’s home directory. If you wanted to back up your vital con-

figuration information, the settings were always spread all over your com-

puter’s hard disk in many different files.The Registry was Microsoft’s attempt

to bring all this information together into a single place.

Over the years, the Registry has become quite large, and the primary reasons for
its expanding size are more configuration options in Windows and more applica-
tions that write directly to the Registry. Every time you use the Windows XP setup
program, install additional hardware, or install 32-bit Windows software, data gets
stored in the Registry. However, some programs still use .INI files to save their set-
tings. Windows XP supports this practice to maintain backward-compatibility with
older applications.

Getting to Know the Registry’s Structure
The Registry is structured in a top-down fashion, similar to how folders on your
hard drive are organized. The Registry consists of five subtrees, each of which is
devoted to holding a certain kind of information. Each subtree begins with the
word HKEY (see Table 9-1). HKEY denotes a standard key for software developers
who need to write programs that can write settings to the correct Registry subtree.

TABLE 9-1 WINDOWS XP REGISTRY SUBTREES

Root Key Name Description

HKEY_CLASSES_ROOT Contains the associations between applications and file
types, OLE Registry information, and file-class associations.

HKEY_CURRENT_USER Contains the user profile for the individual who is currently
logged on. It also contains environment variables, desktop
settings, application preferences, network connections, and
printer information.

HKEY_LOCAL_MACHINE Contains information about the local computer system.
Settings for hardware and operating system features such
as bus type, system, memory, device drivers, and startup
control data are located here.
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Root Key Name Description

HKEY_USERS Contains all the actively loaded user profiles. This includes
the HKEY_CURRENT_USER and the default Admins profile.

HKEY_CURRENT_CONFIG Contains the configuration information for the current
hardware profile.

Keys
Each subtree within the Registry holds individual keys. A key might contain sub-
keys, or it might actually hold data. Subkeys can, in turn, hold additional subkeys.
A subkey might only have one value entry, or it might have many. A Registry key’s
value entry has three parts: 

◆ The name of the subkey

◆ The subkey’s data type

◆ The subkey’s actual value

There are five data types, as shown in Table 9-2

TABLE 9-2 WINDOWS 2000 REGISTRY DATA TYPES

Data Types Description

REG_BINARY Raw binary data that will typically be displayed in hexadecimal
notation, making it difficult for you to read.

REG_DWORD A four-byte-long number that will be displayed in binary,
hexadecimal, or decimal format. This data type is often used for
device drivers and services.

REG_EXPAND_SZ An expandable data string that holds a variable that will be
replaced when it is called by an application. It will often look
something like %systemroot%, which will be replaced by the
actual folder name containing your Windows XP files.

REG_MUTLI_SZ A multiple string that usually holds a list of values, which are in a
human-readable form, rather than being in binary or hexadecimal
notation. The values are separated by a NULL character.

REG_SZ A text string in a human-readable form.
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Hives
Unlike Windows 95, Windows 98, and Windows NT 3.x, which stored the Registry
in two files called System.dat and User.dat, the Windows XP Registry is patterned
after the Windows NT 4.0 and 2000 Registry. When the Registry has been saved to
disk, it is actually split into many additional parts, which are referred to as hives.
According to Microsoft, a hive is a “discrete body of keys, subkeys, and values
rooted at the top of the Registry hierarchy.” Actually, not all of the Registry is
stored in hives. Hives are those Registry keys that are permanent components of the
Registry, not the dynamic parts, such as HKEY_LOCAL_MACHINE\Hardware, which
is built only when Windows XP boots. Most of the hives are stored in the C:\
windows\system32\config folder, as shown in Figure 9-1 and listed in Table 9-3.

Figure 9-1: You can view hives in the config folder.

TABLE 9-3 REGISTRY HIVES IN \SYSTEM32\CONFIG

Registry Segment Related Files

HKEY_CURRENT_CONFIG system, system.alt, system.log, system.sav

HKEY_LOCAL_MACHINE\SAM sam, sam.log, sam.sav

HKEY_LOCAL_MACHINE\Security security, security.log, security.sav

HKEY_LOCAL_MACHINE\Software software, software.log, software.sav

HKEY_LOCAL_MACHINE\System system, system.alt, system.log, system.sav

HKEY_USERS\.Default default, default.log, default.sav

HKEY_CURRENT_USER ntuser.dat, ntuser.log 
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In addition to the files listed in Table 9-3, you will also find userdiff and

userdiff.log files in system32\config. Although these are not associated with

a particular part of the Registry, they are used when you upgrade your oper-

ating system (for example, from Windows 2000 or Me to XP).

As you can see from Table 9-3, each hive might have either three or four files
associated with it. If the file has no extension, it is a copy of the hive. If the file has
a .log extension, it is a transaction log showing changes to keys and value entries
in the hive. The Software, SAM, Security, System, and Default hives also have .sav
files. These are copies of the hive created at the end of the text mode stage of the
Windows XP setup. Therefore, they should have file dates corresponding to the date
you installed or upgraded Windows 2000.

One hive — HKEY_LOCAL_MACHINE\System — plays such a critical role that an
extra backup is created with the filename System.alt. (The other hives do not have
.alt files.) If you want to see a list of files that go with each hive, you can explore
in a Registry key at HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\
hivelist. You’ll learn how to navigate to this Registry key using the Registry Editor
tool in the upcoming sections.

Restoring the Registry
Although it may appear that the most important task you can learn is to edit the
Registry, the most important aspect of working with the Registry is actually restor-
ing it should you boot your computer and receive an error message telling you that
the Registry has been corrupted. Fortunately, each time Windows XP successfully
starts, it backs up the Registry. In the event that you cannot boot Windows due to
a corrupted Registry, you can use the last known good version of the Registry from
backup. This provides you with a record of your computer’s configuration the last
time it started successfully. You can also back up the Registry manually using the
Windows Backup tool and backing up System State Data. The following steps show
you how to restore the Registry using the last known good version.

See Chapter 17 to learn more about System State Data and Windows

Backup.
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Any changes that you have made since the last successful boot will not

appear once you use the last known good configuration to boot your com-

puter. Because the last known good option boots from the previous

Registry’s backup, any changes since that last boot will not be recorded in

the backup file.

1. If your computer will not boot, and you see the error message that the
Registry is corrupted, shut down your computer.

2. Wait about 10 seconds, and then turn the power back on.

3. When the computer starts, hold down the F8 key.

4. The Safe Mode menu appears. Use your arrow keys to move your cursor
down and select the following choice: Last Known Good Configuration.
Press the Enter key.

5. Follow the remaining instructions on your screen.

Using the Registry Editor
Windows XP contains a Registry editor called RegEdit. RegEdit can help you find a
configuration setting, troubleshoot problems, and make technical changes in
Windows XP, as well as in applications that use the Registry to store preferences. I
reiterate the big warning here — editing the Registry is serious business. Changes
you make go into effect immediately, and if you make a mistake, there is no undo
option, so always edit the Registry as a last resort to problem solving. Using Control
Panel applets and other Windows properties pages to manage Windows XP and fix
problems is best. However, RegEdit can be a valuable and effective tool.

If you have used previous versions of Windows, you may wonder what has hap-
pened to Regedt32. In the past, Windows operating systems provided RegEdit and
Regedt32, but in the new version of the Registry Editor included with Windows, the
features of Regedt32 have been incorporated to create a single Registry Editor.

The RegEdit tool is a bit hidden in Windows XP, by design. However, you can
easily access it by typing RegEdit in the Run dialog box on the Start menu and
clicking OK. As you can see in Figure 9-2, the Registry Editor looks like any other
MMC console. You see the Registry keys in the left pane, and whatever you select
appears in the right pane.

180 Windows XP for Power Users

549987 ch09.qxd  11/20/03  11:39 PM  Page 180



Figure 9-2: Registry Editor.

For each value entry that appears in the right console pane, you see three parts:

◆ The name, which generally defines the value contained by the key

◆ Data types, which show you the kind of data that is allowed in the value

◆ Data, which gives you the value of the entry

As you can imagine, each key contains a lot of values, but you can use a quick

little trick to expand an entire key. Just select the key in the left pane, then

hold down the ALT key on your keyboard, and press the asterisk (*) key on

the number keypad. This action expands the entire key. To collapse it, just

double-click the key. To make a key return to the default action of only

expanding one subcategory at a time, just collapse the key, then press F5 on

your keyboard.

Exploring the Subtrees
As you learned earlier in this chapter, the Registry is made up of distinct subtrees,
all of which are used to classify and hold information about different system com-
ponents, applications, and so forth. Using RegEdit, you can take a look at each sub-
tree and explore the content found in that subtree. The following sections give you
a brief overview of each subtree.
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HKEY_CLASSES_ROOT
The HKEY_CLASSES_ROOT tree holds the information that relates file types to
applications, as well as data types and COM objects, as shown in Figure 9-3. Given
the large number of associations that a computer might have, this subtree is usually
quite large when it is first expanded, and it will grow as you install more software
on your computer. This subtree is also where COM object information is stored,
which tells Windows XP how to find and run software components.

Figure 9-3: HKEY_CLASSES_ROOT.

HKEY_CURRENT_USER
The HKEY_CURRENT_USER subtree holds the information about the user profile
for the person who is currently logged on to the computer. Most of the user inter-
face settings that you set through the Control Panel are stored here, as shown in
Figure 9-4. As you explore the Registry, you may note that some settings you find
in HKEY_CURRENT_USER are also found in HKEY_LOCAL_MACHINE. However,
HKEY_CURRENT_USER settings are always given priority over HKEY_LOCAL_
MACHINE settings.

When a user logs on to a Windows XP computer, his or her user profile is taken
from the HKEY_USERS key and copied into the CURRENT_USER key. If no user
profile exists for the user who is logging on to the computer (for example, a guest
or a new user), Windows XP uses the Default User profile. Table 9-4 explains the
subkeys you see.
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Figure 9-4: HKEY_CURRENT_USER.

TABLE 9-4 HKEY_CURRENT_USER SUBKEYS

Subkey Information the Key Contains

AppEvents Application events that you assign to certain .WAV sound
files using the Sounds and Multimedia applet in the Control
Panel.

Console Sets the window size, along with options for any console
tools.

Control Panel Many of the options that you can choose using the Mouse,
Keyboard, and Display Options applets in the Control Panel
are stored in this subkey.

Environment Environment settings that are set using the System applet
in the Control Panel are stored in this subkey.

Identities Multiple identities in Outlook Express 5 are stored in this
subkey. Under each subkey, you can find the actual
username belonging to the identity.

Keyboard Layout Keyboard language information relating to the Input Locales
you choose in the Regional Options applet in the Control
Panel are stored in this subkey.

Continued
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TABLE 9-4 HKEY_CURRENT_USER SUBKEYS (Continued)

Subkey Information the Key Contains

Printers Printer information is stored in this subkey. Information
about each physically installed printer can be found here,
but no information is contained in this subkey for software-
based devices such as fax modems.

SessionInformation Contains data relating to the current user’s Windows
session.

Software Application-specific settings are stored in this subkey. These
entries are usually created when you install software. Much
of the data here will have a similar structure to the data in
the HKEY_LOCAL_MACHINE\Software subkey.

System This subkey contains information about system settings.

Unicode Program Group Starting with Windows NT 4.0, this key is no longer used. It
is left in place for compatibility reasons.

HKEY_LOCAL_MACHINE
The HKEY_LOCAL_MACHINE key contains the configuration information for your
computer. Some of the data in this key is created each time the computer boots up.
The data in this key cannot be edited directly, even using the Registry Editor. Five
subkeys are located in HKEY_LOCAL_MACHINE, as shown in Figure 9-5.

Figure 9-5: HKEY_LOCAL_MACHINE.
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HARDWARE
The HKEY_LOCAL_MACHINE\HARDWARE subkey holds the dynamic hardware
configuration data for the computer. This subkey is refreshed each time the com-
puter boots up, and the data is then discarded when the system shuts down (it is not
stored in a hive file).

SAM AND SECURITY KEYS
The Windows XP Security Account Manager (SAM) and Security keys handle secu-
rity information, and they play a big role when a Windows XP computer is con-
nected to a Windows network server using the Active Directory services.

SOFTWARE
The data contained in the HKEY_LOCAL_MACHINE\SOFTWARE subkey is configu-
ration information about the software installed on the computer. The subkeys under
this key will differ depending on what applications have been installed, but there
will always be common subkeys among computers.

Note that toward the end of the Microsoft subkey, you will find a subkey called
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion, as
shown in Figure 9-6. This isn’t an error, even though you are a long way from
Windows NT with Windows XP. The Windows NT name is left due to similar archi-
tecture between the Windows NT system and Windows 2000 and XP. This subkey
holds information about Windows XP services, as well as information about the
installed version of Windows XP.

Figure 9-6: The CurrentVersion gives you information about your computer configuration.

SYSTEM
The HKEY_LOCAL_MACHINE\SYSTEM subkey holds all the data that Windows
needs but that can’t be initialized during the startup process. Instead, the information
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is stored here in the System subkey. Recognizing the importance of this informa-
tion, this is the one subkey that also has an extra backup file called System.alt. This
data is crucial to starting the system; if you make changes with unintended conse-
quences, you can back your changes out, because Windows XP automatically keeps
a safe backup of this information.

The startup data is kept together in subkeys called Control Sets. While there can
be up to four control sets — which would be labeled ControlSet001, ControlSet002,
and so on — there are usually only two: the current control set plus one backup.
This backup is done automatically by the system and normally requires no user
intervention. Information on the various control sets is tracked in the HKEY_
LOCAL_MACHINE\SYSTEM\Select subkey, as shown in Figure 9-7. Four value
entries in this subkey track the following:

◆ Default — This is the number of the control set that will be used at the
next system startup, unless the LastKnownGood configuration is manually
selected. 

◆ Current — This is the control set that started the system for the current
session.

◆ Failed — This control set was replaced when the LastKnownGood control
set was used to start the system.

◆ LastKnownGood — This set is an unmodified copy of the last set that was
used to successfully start the system.

Figure 9-7: The HKEY_LOCAL_MACHINE\SYSTEM\Select subkey keeps track of the control set.
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If you had a problem starting your computer, the presence of both the bad

and the good control set might give you a clue as to what problem occurred.

You can view the failed set with the Registry Editor, and then compare it to

the functional control set. Make sure, however, that you do not tamper with

the LastKnownGood control set. Doing so may cripple your LastKnownGood

configuration, preventing you from a system recovery if needed.

HKEY_USERS
The HKEY_USERS subtree usually holds two user profiles: 

◆ The first profile is for the user who is actually logged on to the computer.
The key name for the active user shows the Security ID for that user.

◆ The second profile is the default user profile, located in the subkey
HKEY_USERS\.DEFAULT, which is used when no one is logged on to the
computer (for example, when the Login prompt is displayed on the desk-
top). The structure of the .DEFAULT subkey is similar to the structure of
the HKEY_CURRENT_USER section in the Registry.

HKEY_CURRENT_CONFIG
The HKEY_CURRENT_CONFIG key was added to the Windows NT 4.0 Registry —
and is also contained in the Windows XP Registry and the Windows 2000
Registry — to achieve compatibility with the Windows 95 Registry. It duplicates the
information in the HKEY_LOCAL_MACHINE\System\CurrentControlSet\Hardware
Profiles\Current subkey, which is the current hardware profile data. According to
Microsoft, programs written for Windows 95 (which may look for information in
these keys) will also be able to run under Windows XP/2000.

Using the Registry Editor
As you learned in earlier sections of this chapter, the Registry Editor is your
Windows XP tool that enables you to make changes to Registry values. Once again,
keep in mind that if at all possible, you should make configuration changes using
Control Panel applets and other desktop tools before using Registry Editor.

To learn how to edit the Registry, it helps to get to a location that has some use-
ful keys, constants, and values. Editing the Registry consists of adding or deleting
keys, adding new constants and their values to be associated with the keys, and
modifying those constants and their values. The trick is knowing what keys, con-
stants, and values to add, rename, or delete. The following steps give you an exam-
ple of editing the desktop.
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1. Click the plus sign (+) to the left of HKEY_CURRENT_USER. Click the plus
sign to the left of the Control Panel folder icon, and then the one next to
the Desktop folder icon.

2. Highlight the WindowMetrics name next to its folder icon. Notice that the
right pane is now filled with constant names (Name) and values (Data), as
shown in Figure 9-8.

Figure 9-8: Select the WindowMetrics folder.

3. Right-click in the Registry Editor’s right pane (but not on a constant name
or value). A New button, as shown in Figure 9-9, appears. Point to the
New button, and a menu appears. You can choose to create any of the
following:

■ A key

■ A string value

■ A binary value

■ A DWORD value

The key and/or any of the constants will be attached to the
WindowMetrics key.

4. Right-click the Desktop key in the Registry Editor’s left pane. The context
menu will give you the choice of doing the following:

■ Collapsing this expanded branch of the Registry

■ Creating a new key, string value, or binary value

■ Finding a text or numerical string in the local branch

■ Deleting or renaming the key
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It is not a good idea to delete or rename a key unless you know exactly
what you are doing. Adding a new key or value (actually, a constant that
has a value, which the Registry Editor refers to as Data) might change the
way Windows operates, but it won’t do any damage.

5. Right-click a constant in the Name column in the right pane of the
Registry Editor. A Context menu appears, allowing you to modify the con-
stant’s value, delete the constant and its value, or rename the constant.

6. The Edit menu provides similar choices to those that appear on the
Context menu when you right-click a key or a constant. The Edit menu
changes depending on whether you have highlighted a key or a constant.
You can’t highlight a value (or Data).

7. If you want to edit a string, just double-click it in the right console pane
and you’ll see the Edit String dialog box, as shown in Figure 9-10. As you
can see in the figure, the PowerOffActive value is set to 0, meaning it is
not turned on. You can change this to a 1 to activate it. Depending on the
string, you might have different editable value options available.

Figure 9-9: Insert a new key or value in the Registry.

Figure 9-10: Insert a new key or value in the Registry.
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Editing the Registry with reg Files
You can also edit and update a Registry using reg files. Most often, you edit the
Registry by changing settings in dialog boxes, without being directly aware that the
changes you make are being recorded in the Registry. Another way that you can
switch between Registry settings is to create and use reg files. 

1. Choose one of the settings you want in the Registry.

2. Export the small branch of the Registry that contains this setting to a text
file and save the file with the .reg extension.

3. Use the reg file and import it to another Registry for updating.

4. If you now place a shortcut to the reg file on your desktop, you can
quickly switch back and forth between the settings by clicking the file
instead of by interacting with a dialog box.

Exporting and Importing Registry Files
You can export a branch of the Registry or the entire Registry to a text file that can
be opened in an editor such as NotePad or WordPad. You might want to do this so
that you could search for values or perform some involved editing (to take advan-
tage of the advanced editing tools in WordPad, such as Search and Replace), or to
import some of the exported data into another Registry file.

1. Click Start → Run, and then type regedit in the Open text box. Press Enter
or click OK.

2. Navigate to the branch of the Registry that you wish to export (for example,
select HKEY_CURRENT_USER\Control Panel\Appearance\Schemes key).

3. Click File → Export Registry File. This opens the Export dialog box.

4. Unless you want to export the entire Registry, choose Selected branch in
the Export range section in the lower portion of the dialog box.

5. Choose the subfolder to which you want to save the file, and then provide
a name for your file, such as Schemes.

6. If you want to be able to import this data back into this or some other
Registry file, use the default file extension of .reg.

7. Click Save, which will save the file and then close the dialog box.
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After you have exported the Registry branch, any text editor, such as NotePad or
WordPad, can read it. You can start WordPad, and then use its File, Open command
to load the file. You also can find the file in Windows Explorer, right-click the file,
and click the Open With option on the context menu to select a program with
which to open the file, such as WordPad or NotePad. You do not want to click (or
double-click) the .reg file, nor do you want to select the Open command from the
context menu. Doing so will cause the file to be merged back into the Registry.
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Chapter 10

Working with the
Microsoft Management
Console
IN THIS CHAPTER

◆ Using the MMC

◆ Creating custom MMCs

◆ Creating Taskpad views

THE MICROSOFT MANAGEMENT CONSOLE (MMC), a GUI interface, first came onto the
scene with a few Microsoft BackOffice products such as Internet Information
Server, Proxy Server, and Systems Management Server in the days of Windows NT.
The MMC provides a streamlined way to use a variety of administrative tools, and
it is now fully integrated with Windows 2000 and Windows XP operating systems.
The MMC gives you a quick and easy way to access certain tools and even create
your own custom consoles. In this chapter, you’ll learn how to work with the MMC
and how to customize it.

Microsoft Management Console
The MMC is a stripped-down GUI interface that looks similar to an Explorer win-
dow. The MMC is just a simple console that enables you to control various admin-
istrative tools. Administrative tools are called snap-ins — they snap into the MMC.
Without any snap-ins, the MMC has no functionality. In other words, the MMC’s
purpose is to enable you to use administrative tools. The MMC does not do any-
thing on its own. The MMC provides you with the controls to manage the snap-in.
I like to think of the MMC and snap-ins as a car and a motor. The inside of the car
is the MMC — you have a steering wheel, accelerator, brakes, gearshift, and so forth.
The snap-in is the car’s motor. Without the motor, the steering wheel, brakes, and
so on do not have any purpose. Those components enable you to control the car’s
motor; the MMC enables you to control and use snap-ins.
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All of the standard tools in Windows XP are MMC snap-ins. This includes
Computer Management, Event Viewer, Performance console, and so forth. When
you launch one of these tools, the MMC is opened and the appropriate snap-in is
loaded. For example, if you click Start → Control Panel → Administrative Tools →
Computer Management, the MMC opens and the Computer Management snap-in is
automatically loaded, as well.

However, you can manually load snap-ins and create custom consoles that you
can save and use later. You can open an empty MMC by clicking Start → Run, then
typing mmc in the dialog box and clicking OK. Figure 10-1 shows you an empty
MMC with no snap-in loaded. As you can see, there really isn’t anything you can
do without a snap-in.

Figure 10-1: An empty MMC.

Why did Microsoft integrate the MMC so heavily with Windows XP? The answer
is in an attempt to reduce administrative overhead, learning, and general aggrava-
tion. For example, in Windows NT Server 4.0, each administrative tool had its own
GUI interface with its own menus and commands. Learning a different interface for
each administrative tool made administration more difficult than necessary. With
the MMC, all administrative tools look exactly the same and have the same menus
and basic functionality. This feature makes the administrative learning curve much
easier to master. Another great benefit of the MMC is that you can build your own
custom consoles that contain the tools you most commonly use. For example, say
that you frequently use the Disk Management tool and Users and Groups tool. You
could create a custom console containing both of these tools so you can more eas-
ily access them. The possibilities are endless, and the MMC can make your admin-
istrative tasks easier. Finally, another benefit of the MMC is that third-party
companies can build snap-ins for the Windows environment.
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Getting to Know the MMC
So, now that I have sold you on the importance and benefit of the MMC (hopefully),
you can use this section to master the MMC. Fortunately, the MMC is quite easy to
use, but I’m going to show you several tips and tricks that you can use in your daily
use of the MMC. I’ve organized this section by topics so you can quickly work
through it and find the topic you need help with. Also, whenever possible, I have
organized information in a step-by-step format for easy reference.

Loading Snap-ins
To manually load a snap-in or several snap-ins into an empty MMC, follow these
steps:

1. Click Start → Run. Type mmc in the dialog box and click OK. The empty
console appears.

2. In the MMC, click Console → Add/Remove Snap-in.

3. The Add/Remove Snap-in window appears. Click the Add button.

4. A list of standalone snap-ins appears, as shown in Figure 10-2. Select the
desired snap-in, and then click the Add button. Repeat this step to load
additional snap-ins. When you are finished, click Close.

If you’re unsure about a particular snap-in, select it. A description of the

snap-in will appear in the lower half of the window.

Figure 10-2: Adding a standalone snap-in.
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5. Depending on the snap-in you select, a Computer Management dialog box
may appear, as shown in Figure 10-3. In this dialog box, select whether
the snap-in will manage the local computer or another computer. If you
want to use the snap-in to manage another computer, enter the name of
the computer you want to manage.

Figure 10-3: Snap-in management option.

6. After you click Finish, you are returned to the Add/Remove Snap-in 
dialog box, as shown in Figure 10-4. You see the snap-ins you selected
displayed. If you made a mistake, just select the snap-in you do not want
to use and click the Remove button. You can also click the About button
to learn more about the snap-in. Click OK when you’re done.

Figure 10-4: Add/Remove Snap-in.
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7. Also notice that there is an Extensions tab, shown in Figure 10-5. On the
Standalone tab, select the desired snap-in, and then click the Extensions
tab. The Extensions tab also lists other snap-ins that are dependent on the
selected snap-in.

Figure 10-5: Extensions tab.

By default, all extensions for a snap-in are automatically loaded.

Once you have loaded the snap-ins, you see that they now appear in the console
and are ready for you to use, as shown in Figure 10-6.

Saving a Console
The primary reason for manually loading snap-ins is to enable you to create a cus-
tom MMC. This simply means that you load the desired snap-ins and then save the
MMC. Once saved, you can open the MMC at any time and access your snap-ins.
Administrators find this feature very useful because they can group their most
commonly used snap-ins into one console and use that single console for their
administrative tasks. After you load your desired snap-ins, simply click Console →
Save As to save your console. MMCs are saved as .msc files (MMC). You can give
the console a name and select the location on your system where you want to save
the console, just as you would any other file.

549987 ch10.qxd  11/20/03  11:39 PM  Page 197



Figure 10-6: The new console.

Opening a New Window
The MMC enables you to open several windows at one time. The question you
might ask is why? You can open the same console window in several instances to
make your work easier. For example, in Figure 10-7 there are two windows open.
The windows appear in the same console, but you can see that in one window is
Computer Management and in the second window is Local Computer Policy. This
feature enables the user to work with several different snap-ins at one time by
keeping them organized in their own window. To open a new window, just click
Window → New Window. If you have several windows open at one time, you can
easily adjust how they appear in the console. Just click the Window menu and
select either cascade or tile horizontally. Also, you can drag each window around
inside of the console and place it in a manner that is easy for you to use.

Configuring Console Options
To give you different levels of control, the MMC provides you, as the author of the
MMC, with some options you can choose to implement. Click File → Options. You
see an Options dialog box, as shown in Figure 10-8, that enables you to perform a
few different actions.
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Figure 10-7: Your snap-ins can appear in different windows.

Figure 10-8: Console options.

First, you have the option to change the default icon for the console by clicking
the Change Icon button. This action enables you to select a different icon or use one
of your own. More importantly, you have the option to configure a console mode
for the MMC. A console mode either enables or denies the user certain console
rights. For example, say you are an administrator. You create a custom console
containing Disk Management and User and Groups for certain administrators. Once
you have created the console, you can change the console mode so that other
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administrators cannot make changes to the console. This feature enables you to
create the console, and then have others use the console without fear of configura-
tion changes being made. You can choose from several modes; the following list
explains the options to you:

◆ Author mode — This is your current mode. In author mode, you have full
MMC functionality. You can add or remove snap-ins, create TaskPad
views, and perform any other function within the console.

◆ User mode: Full Access — This mode gives users full access to all console
and window commands, but the user cannot add or remove snap-ins or
change the console’s properties.

◆ User mode: Limited Access, Multiple Window — This mode gives users
access rights only to the console areas that were visible when the console
was saved. Users can create new windows but cannot close existing
windows.

◆ User mode: Limited Access, Single Window — This mode gives the user
access only to areas that were visible when the console was saved.
However, the user cannot open new windows.

Any changes you make to the MMC mode take effect the next time the con-

sole is opened.

For all mode options, you also see two check boxes at the bottom of the window
that you can select or deselect. The two options are as follows:

◆ Do not save changes to this console — The user cannot save any changes
made to the console.

◆ Allow the user to customize views—This enables the user to customize the
window view.

Using the Action Menu
The Action menu is the primary menu you use to manage snap-ins and their com-
ponents. In a console that has more than one snap-in, use your mouse and select
the snap-in you want to use. From that point, most of your configuration and usage
of the snap-in is accomplished through the Action menu. Click the plus sign (+)
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next to the snap-in to expand it, then select any desired components and use the
Action menu again. You’ll notice that the contents in the Action menu change
according to what you have selected.

Right-clicking on any snap-in or snap-in component gives you the same list

of options found on the Action menu.

Using the View Menu
The View menu enables you to make changes to the appearance of the console and
your snap-ins. You have the following options:

◆ Choose Columns — This feature enables you to change the column labels
that appear in the right pane. For example, in the Domain Name System
(DNS) snap-in, you can expand the DNS server and select a desired DNS
zone. The zones appear in the right pane giving you the name, type, and
status. You can use the Choose Columns option to change which columns
are displayed for the snap-in.

◆ Large Icons — This feature provides large icons in the details pane of the
console.

◆ Small Icons — This feature provides small icons in the details pane of the
console.

◆ List — This feature provides small icons in a list format in the console’s
details pane.

◆ Detail — This feature provides a list with column information.

◆ Advanced — This feature turns on the console’s advanced information fea-
tures. The Advanced option makes certain information, such as security,
available in some snap-ins.

◆ Filter — Some snap-ins have a filter option that appears in this menu. For
example, DNS has this feature. Filter enables you to filter certain names
so that you are not overwhelmed with console information. In other
words, the filter helps you to display only information you want.

◆ Customize — The customize option gives you a Customize View window,
as shown in Figure 10-9. You can use these check boxes to customize the
console appearance, as desired.
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Figure 10-9: Customize View.

Using Favorites
You see a Favorites menu in the MMC. This is similar to Internet Explorer’s
favorites list, which you generate as you find Web sites you like. In a similar man-
ner, you can add items to a favorites list in a console. For example, say that I like
to check my system’s interrupt request lines (IRQs) on a regular basis (hey, this is
just an example). I have the Computer Management snap-in loaded. I can examine
those pesky IRQs by expanding Computer Management → System Tools → Hardware
Resources → IRQs — or I can just add IRQs to may favorites list, click the Favorites
tab, and see them easily whenever I want.

You can manage your favorites by using the Favorites menu. You have two
options here:

◆ You can choose to add an item to your favorites list. Just select the
desired item in the console and click Favorites → Add to Favorites.

◆ You can click Favorites → Organize Favorites to open a simple organiza-
tion window. Here, you can delete items, rename them, move them to
various folders, and even create folders within your favorites list.

Creating Taskpad Views
The MMC includes an important feature that you can use to greatly simplify diffi-
cult administrative tasks, or one that you can use to make things easier for inexpe-
rienced personnel. That feature is Taskpad views. Taskpad views enable you to
create a custom view of the console’s details pane or generate icons that enable you
to start certain functions with only a double-click (like a shortcut). You have a
number of options with Taskpad views, and as I think you will see, you can use
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them for a variety of situations. The following steps show you how to create a new
Taskpad view:

1. To create a Taskpad view, select the desired snap-in in the console, then
click Action → New Taskpad View.

2. The New Taskpad View Wizard appears. Click Next on the Welcome
screen.

3. In the Taskpad Display window, shown in Figure 10-10, select a style for
the Taskpad by clicking the Vertical list, Horizontal list, or No list radio
button. The graphic in the right part of the window shows you how the
display will appear. At the bottom of the window, select a style by click-
ing either the Text or InfoTip radio button. The Text option makes
explanatory text appear next to the icon. The InfoTip enables the text to
be displayed in a pop-out form. You can use the drop-down menu to
change the size of the lists. Click the Next button once you have made
your selections.

Figure 10-10: Taskpad Display.

4. In the Taskpad Target window, shown in Figure 10-11, select the desired
radio button to determine if the Taskpad view applies to the current tree
item or to all tree items of this type. Make your selection and click the
Next button.

5. In the Name and Description window, enter a desired name for the
Taskpad view and a description. Click the Next button.

6. The Summary window appears. Notice that a check box appears so you
can start the New Task Wizard. Leave this check box selected; then click
the Finish button.
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Figure 10-11: Taskpad Target.

7. The New Task Wizard begins. Click Next on the Welcome screen.

8. In the Command Type window you have three radio button options,
shown in Figure 10-12 and defined in the following list:

■ Menu command — Enables you to configure a task that runs a menu
command within the MMC.

■ Shell command — Enables you to configure a task that automatically
runs a script, starts a program, opens a Web page, or some other shell
command.

■ Navigation — Enables you to configure a task that automatically navi-
gates to a selected view in your favorites list.

Figure 10-12: Command Type.
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For the example here, I will configure a Menu command. You can experi-
ment with Shell commands and navigation, and you will discover that
they are self-explanatory. Select the Menu command radio button and
click the Next button.

9. The Shortcut Menu Command window appears, as shown in Figure 10-13.
You see a Command source drop-down menu, which contains a tree item
task and list in details pane task. Select the desired option. For a tree com-
mand, you see the console tree items and available commands. Note that
the commands available are simply menu commands for the item selected,
such as Action → All Tasks → Disk Management, Action → Properties, and
so forth. Make your desired selection and click the Next button.

Figure 10-13: Shortcut Menu Command.

10. The Name and Description window appears. The text you enter appears as
either text in the console or as InfoTip text, depending on what option
you select. Make your entries, and click the Next button.

11. In the Task Icon window, shown in Figure 10-14, select a desired icon for
this task and click Next.

Try to select an icon that visually describes your task.

12. Click the Finish button to complete the wizard.
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Figure 10-14: Task Icon.

If you want to create additional tasks, click the Run this Wizard Again check

box before clicking Finish.

After you complete the wizard, you see your Taskpad view and any tasks you
have created in the details pane, as shown in Figure 10-15.

Figure 10-15: Tasks appear in the details pane.

You can easily create new tasks, delete them, or alter your Taskpad view by
clicking Action → Edit Taskpad View.
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Tips and Tricks
Overall, the MMC is a great tool and is easy to use. The point of the MMC is to pro-
vide you with more management flexibility when you work with Windows XP, so
keep the following points in mind as you use it:

◆ Remember to keep the consoles you create organized and useful. Do not
add too many snap-ins to a single console because the console may get
more confusing than helpful. If you are creating custom snap-ins, try to
keep them organized in a way that is helpful to you.

◆ Remember to experiment with the View menu. The customization options
on the View menu may give you exactly what you need to make the MMC
more useful to you.

◆ You can add or remove a snap-in at any time by clicking File →
Add/Remove Snap-in.

◆ Use File → Options to manage authoring modes.

◆ Keep in mind that you can use Taskpad views to automate tasks so you
can perform them simply by clicking a button. This feature is helpful if
you have other users running MMC consoles and performing tasks. You
can automate tasks using taskpads so that the MMC is easier to use.
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Chapter 11

Networking on a
Workgroup
IN THIS CHAPTER

◆ Understanding networking

◆ Setting up a workgroup configuration

◆ Managing workgroup hardware

◆ Configuring a workgroup

◆ Managing connections and IP

◆ Solving common problems

IN THE PAST, NETWORKING was reserved for businesses or large corporations that had
extra money to throw around. Only a few years ago, the average computer user
would never have dreamed of being able to configure a home or small office net-
work in an effective and useful manner. All of that began to change a few years
ago when networking technologies slowly began to streamline and become more
commonplace. Today, many households and most small offices have a computer
network of some kind. Networking with Windows XP is easier than it has been with
any previous version of Windows. Windows XP does more and is easier to network
than you first might think. This chapter explores workgroup networking with
Windows XP. You’ll understand the basics of how a network works, how you can
configure one, and how to solve common networking problems.

Networking 101
There are two basic kinds of networks used in the world today. The first is generally
considered the workgroup, which is explored in this chapter, and the second is the
server-based network. A workgroup network, which is also called a home network
or a small office network, is made up of a collection of computers, such as
Windows XP Professional or Home edition, Windows 2000, Windows Me, and 
so forth. In a workgroup network, each computer user manages his or her own
computer on the network. Of course, the lines between a workgroup and a server-
based network can become confusing. After all, many workgroups are quite large,
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and some even have a computer administrator for all of the computers and the net-
work. The defining difference comes down to management and security. A work-
group has no centralized server, so there is no centralized management and
security. A server-based network uses servers for logon and management of client
computers.

Refer to Chapter 12 for more information on using servers for logon and

management of client computers in a server-based network.

Of course, the main purpose for networking is to share resources between com-
puters. In a workgroup network, you can share folders, printers, Internet connec-
tions, disk drives, and other resources between computers on the network. In a
server-based network, sharing is also a major feature, but the additional features of
security and centralized management also come into play.

In the past, the need for a network was typically found at the business level only.
However, today, many homes and small offices use workgroup configurations to
share information, printers, and even play games between different computers over
the network. In short, the idea of networking computers together is becoming
rather commonplace and for good reason.

From a networking 101 point of view, what do you need to network Windows
computers together? First of all, computers have to be outfitted with the proper
hardware. This generally includes a network interface card (NIC) of some kind.
Many computers sold today ship with a standard Ethernet card built in so that the
computer is network ready. In addition to the NIC, you’ll need a hub, which is a
device that connects all of the computers to a centralized control box. It basically
functions as the traffic cop. Many different kinds of hubs are available on the mar-
ket today. You’ll also need cabling, unless you are using a wireless network. The
hardware you’ll need is explored later in this chapter.

Next, your computer must be configured to network with other computers. This
includes the proper configuration of a communications protocol, such as TCP/IP
(see the next section for an overview), and other networking services within
Windows XP, such as File and Printer Sharing. Windows XP configures these items
for you automatically through a Network Setup Wizard.

The rest of this chapter explores the details of setting up and configuring a
workgroup network.

A TCP/IP Primer
For computers to communicate on a network, they must speak the same language.
In computer terms, that language is called a protocol. A protocol is really a set of
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instructions a computer uses to communicate with another computer; so, to net-
work a group of computers together, they must use a common protocol for com-
munication to take place.

There are many different protocols in the computer world today, but across the
board, the defacto standard for workgroup, server-based networks, and Internet
networking is Transmission Control Protocol/Internet Protocol (TCP/IP). In the past,
TCP/IP was used on the Internet and in larger networking environments. Its reputa-
tion for being difficult to work with and configure kept it out of the smaller net-
working arena. Today, TCP/IP is still a complicated protocol, but new features make
its use on a workgroup easy and automatic. In fact, if you so choose, Windows XP
can completely configure TCP/IP and use it on a workgroup without the users really
even having to know of its existence!

However, as an advanced computer user, you might want to know some things
about TCP/IP. After all, armed with knowledge, you have more configuration
options and you’ll understand how to troubleshoot network connectivity in a more
effective way if you know a few things about TCP/IP. You can use this section of
the chapter as a primer to this all-important protocol.

TCP/IP Addressing
Each computer on a TCP/IP must have a unique IP address. Think of it as the U.S.
mail system. To get your mail, you have a unique address. However, that address
has certain characteristics and features in common with other addresses because
your address resides within a certain city and state. TCP/IP is similar because each
computer on the network must have a unique TCP/IP address. However, the com-
puters also have some addressing similarities. The TCP/IP address, then, is made up
of three distinct parts, collectively called the IP address. They are as follows:

◆ Address — The actual IP address is a four-part decimal number separated
by periods, such as 10.50.200.33. Each portion of the address helps the
computer know what network and subnet it is on.

◆ Subnet mask — The subnet mask tells the computer how much of the IP
address is the actual computer address and how much notes the subnet on
which the computer resides. Subnets aren’t anything to worry about in a
workgroup, but in larger networks, subnet mask configuration can be a
confusing part of TCP/IP.

◆ Default gateway — The default gateway provides the IP address of a router
or computer that leads out of the subnet. Again, on workgroup configura-
tions, default gateways generally are not needed.

IP addresses, such as 10.50.200.23, are made of two components: the network
and the host ID. IP addresses are 32 bits long (32 individual 1s or 0s) and are
arranged in four groups of eight bits known as octets. Each of these octets can be
converted into a more user-friendly decimal number. It is in this decimal form that
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most IP addresses are displayed. While this user-friendly form makes it easier to
configure the IP address of network hosts, you do need to understand how to trans-
late from the decimal form to the binary form to understand how IP addressing
really works. For example, the IP address 10.50.200.23 (in decimal form) is repre-
sented as 00001010.00110010.11001000.00010111 (in binary form). Each of the four
octets has a possible value between 0 and 255 or 00000000 and 11111111. To iden-
tify which portion of the address identifies the host and which part identifies the
network, the subnet mask is used. When the subnet mask and the IP address are
added together (in binary form), the result will identify which portion of the IP is
network and which portion is host.

Do you really have to calculate all of this information to use TCP/IP? No, as I
mentioned, Windows XP can do it for you, but it is helpful information to know.
The most difficult part of understanding TCP/IP addressing is the subnet mask.
Early on in the design of IP it was found that there was a need to organize how IP
addresses would eventually be allocated to hosts. To facilitate this, default subnet
masks were assigned to IP address ranges. These assignments are known as address
classes. To work with IP on your network, you should understand the three primary
classes: Class A, Class B, and Class C. The matching of IP addresses to address classes
is based on the binary arrangement of the IP address. However, in this case, it is
easier to just look at the decimal value of the first (leftmost) octet. For example,
16.45.233.166 would be a Class A address because the number 16 (the value of the
first octet) is within the established range for Class A addresses. Using the first
octet, the address classes are defined as follows; Class A includes 1–126, Class B
128–191, and Class C 192–223. Each of these classes has a default subnet mask
assigned as well: 255.0.0.0 for Class A, 255.255.0.0 for Class B, and 255.255.255.0
for Class C. So, the previous example of 16.45.233.166 is a Class A address with a
subnet mask of 255.0.0.0. This means the network portion of the address is 16 and
the host address is 45.233.166.

Along with these established classes, there are a few reserved and special-
purpose address groupings. You may have noticed that addresses beginning with
127.0.0.0 are not in any of the default classes. This is because the address 127.0.0.1
is reserved as the Loopback address. When a host uses this address, it identifies the
host itself. This address is useful when troubleshooting IP on a host, which you’ll
learn more about later in this chapter.

Other specialized addresses include reserved experimental IP address classes.
Any IP address beginning with the value 224–524 is reserved for an array of spe-
cial purposes and, for the most part, should never be assigned to a workstation. In
addition to these specialized classes, there are several IP address ranges designated
as private IP addresses. These ranges reside (one each) with each of the major
address classes (A, B, and C). A private address is only useable on a network that
does not connect to a public network directly. A router must be used to connect a
network using a private IP address range with a public network such as the
Internet. The reason for these private ranges is simple: As the use of networks
increased, it became apparent that eventually there would be no more IP addresses
left for host assignments because there are a finite number of addresses possible.
Private IP addresses (the same address) can be used in multiple networks because a
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router translates between the private and public network. For example, the Boston
branch of a company can use 192.168.44.0 as its network address pool, and the
Seattle branch can use the same exact address pool. The private IP address ranges
are 10.0.0.0–10.255.255.255 (Class A), 172.16.0.0–172.32.255.255 (Class B), and
192.168.0.0–192.168.255.255 (Class C).

TCP/IP Protocols
The TCP/IP protocol is actually a suite of protocols. To give network users the vast
functionality they demand, and to provide the kind of Internet networking wanted
today (streaming media, Internet radio, e-mail, and so on), TCP/IP has to wear
many different hats. To provide these services, TCP/IP is actually a suite of proto-
cols that live under the name of TCP/IP. In fact, over 100 protocols exist in the
TCP/IP suite that can be used as needed.

Delving into all of those protocols isn’t necessary, but I thought I would mention
a few of them, so you can understand how vast TCP/IP really is.

Some of the more common TCP/IP protocols with which you are probably famil-
iar are as follows:

◆ Domain Name System (DNS)

◆ File Transfer Protocol (FTP)

◆ Telnet

◆ Hypertext Transfer Protocol (HTTP)

◆ Simple Mail Transfer Protocol (SMTP)

◆ Simple Network Management Protocol (SNMP)

These commonly used protocols are called application layer protocols. Within
TCP/IP are the Transmission Control Protocol (TCP) and the User Datagram Protocol
(UDP). Each has its own properties and uses, and they determine how data is broken
apart for network travel and reassembled. TCP is used to provide a reliable connec-
tion over a medium (network) that sometimes is not the most reliable of creatures.
Basically, TCP addresses the fact that hardware can’t always be trusted to get data
from point A to point B without losing a few bits here and there. TCP compensates
by implementing error detection and correction. When two hosts begin to establish
a session using TCP, the hosts negotiate a set of criteria that will allow each of the
participating hosts to determine if all of the data they send makes it to the intended
recipient.

Other common TCP/IP protocols include the following:

◆ Internet Protocol (IP)

◆ Address Resolution Protocol (ARP)

◆ Internet Command Messaging Protocol (ICMP)
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Internet Protocol is the most significant protocol in use in modern networking.
Virtually every networking operating system supports it, and without it, there
would be no Internet. IP was examined in some detail earlier, but it bears mention-
ing again that IP is used to uniquely identify hosts within the confines of the net-
works where they reside. Popular technologies, such as the World Wide Web,
Instant Messaging, e-mail, and streaming audio/video, depend on IP to operate. 
IP sets the stage for one host to make contact with other hosts. But even with the
IP address of a target in hand, a network application will still need to resolve 
the Mandatory Access Control (MAC) address of that host (or the device that can
get the host in touch with its desired target) before a host can actually establish
communication.

ARP is used to discover the MAC address associated with a particular IP. Where
an IP address is unique to a host within the confines of a network, the MAC address
is unique to the host among all other devices on earth. ARP sends a broadcast
requesting the MAC address associated with a particular IP address.

Finally, ICMP is a test protocol used to determine network connectivity. It is
commonly called the ICMP Echo Reply. ICMP is used to collect a wide range of
information about the status of IP processing on network hosts. You’ll see some
examples of how to use it later in this chapter.

APIPA
If all this talk about IP addressing and protocols has given you a headache, you are
certainly not alone. TCP/IP addressing can be complicated and confusing, and, for
this reason, it was not used on smaller networks in years past due to its adminis-
trative overhead. However, the advent of some new IP addressing features means
TCP/IP can work essentially in an automated way, and that occurs through
Automatic Private Internet Protocol Addressing (APIPA).

As I mentioned previously, each computer in a TCP/IP network must have a
unique IP address. So, what if there is a network with 10,000 computers? Do the
network administrators have to configure each computer with an IP address? As
you can imagine, such a task would be overwhelming and full of human error. In
such cases, server-based networks use a Dynamic Host Configuration Protocol
(DHCP) server. The DHCP server is simply a server that assigns IP addresses to net-
work clients and keeps track of which client has which address. The automated
method for IP address assignment keeps manual configuration to a minimum.

What happens on a small network where no DHCP server is used, such as a
workgroup? In the past, you would have had to manually configure each computer
to use TCP/IP. No longer, though, with APIPA. APIPA is a service that automatically
runs on Windows XP after Windows XP has been configured for networking.
Essentially, APIPA allows Windows XP to act as its own DHCP server. APIPA uses
an IP address range of 169.254.0.1 through 169.254.255.254. When a Windows XP
computer first comes online, it queries the network for a DHCP server. If no server
is found, which it will not be on a workgroup, the Windows XP computer assigns
itself an IP address from the IP address range. Before doing so, it queries the net-
work to make sure no other computer is using the address. The computer assigns
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itself the address and can begin participating on the network. As you can see, in a
workgroup setting, APIPA allows the Windows XP computers to configure them-
selves without any awareness of the users on the network. This is a great benefit
that makes home and small office networking easy.

You can use APIPA, or you can override it and configure the IP addresses

yourself.You’ll see how later in this chapter.

Exploring Types of Workgroups
To create a workgroup, you’ll first have to decide on the kind of workgroup that
you want. There are four major options within the Windows XP realm:

◆ Direct Cable Connection

◆ Ethernet

◆ HomePNA

◆ Wireless networks

The following sections explore those options so that you can make a decision
that is right for you.

Direct Cable Connection
A Direct Cable Connection (DCC) is not really a workgroup configuration in the true
sense of the word, but it does bear mentioning here because it is a quick and easy
method to connect two computers together. Say you have two computers in an
office and you simply need to exchange files from one PC to the other. No problem,
you can use the DCC. What if you travel a lot with a laptop computer and need 
a temporary connection to another computer? Again, the DCC is the easiest way 
to go.

Using a DCC, you can establish a connection between a Windows XP computer
and any other Microsoft Windows computer that supports DCC connections. They
basically all do (Windows 95 and beyond). To create a DCC connection, you need a
null modem cable or a serial cable made for DCC connections. You can find these
cables at any computer store. You can also use a DirectParallel cable, also available
at any computer store.

Be advised that DCC connections are slow, generally about the speed of a
modem, and as such, they are designed for limited and temporary use. See the
Creating a Direct Cable Connection section later in this chapter for the steps to 
create a DCC.
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Ethernet
Ethernet is a networking standard and the most popular kind of network in use
today. When you think of a network with a typical wired configuration, you are
generally thinking of Ethernet. Ethernet was first introduced in the 1970s by Xerox,
and is defined by the Institute of Electrical and Electronics Engineers (IEEE) 802.3.
This specification defines how hardware devices must function to conform to the
Ethernet standard. For this reason, you can use a mixture of Ethernet NICs from dif-
ferent vendors with no compatibility problems. Ethernet NICs connect to RJ-45
cables (which look like larger phone cables), and you’ll require an Ethernet hub,
router, or residential gateway, depending on your needs. See the upcoming section,
Getting to Know Workgroup Hardware, for more information. Ethernet networks
provide three different speeds, which must be supported by the NICs that you 
purchase:

◆ 10 Mbps — The 10BaseT Ethernet standard defines 10 megabits per second
(Mbps) transfer speed.

◆ 100 Mbps — The 100BaseT (also called Fast Ethernet) standard supports up
to 100 Mbps transfer speed.

◆ Gigabit Ethernet — Gigabit Ethernet is a new speed standard that provides
1,000 Mbps, or 1 Gbps. You must have Gigabit Ethernet NICs and hubs to
get the speed, but you still use the same RJ-45 cabling.

HomePNA
HomePNA is another type of network topology that is designed for home use, but it
works well in small offices too. HomePNA networks use typical PCI or USB NICs,
but each NIC connects to a standard phone jack in the home or small office using a
standard RJ-11 phone cable. Rather than using a hub and having wiring running
everywhere, you simply use existing phone lines as the network. Even though the
computers are connected to the phone lines, you can still have voice conversations.
This type of setup works great in homes or small offices where computers reside in
different rooms. You don’t have to run additional cabling and you don’t have to
worry about a hub. If this sounds like a dream come true, it certainly does solve a
number of problems. However, the problem with HomePNA is that you are limited
to 10 Mbps. It works fine if you are sharing only files and printers, and accessing
the Internet, but if you need to run large multimedia files over the network or play
network games, the speed is a little slow. For most users, however, the 10-Mbps
speed is all you need to use the network and access a broadband Internet connec-
tion from a residential gateway or ICS host computer. Some small office networks
even combine existing Ethernet networks with HomePNA networks for more flexi-
bility. In this case, you’ll need one Windows XP computer to act as a network
bridge. See the Configuring Network Bridges section later in this chapter for details.
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Wireless Networks
Wireless networking has been around for some time, but many people who have
been interested in wireless networking have abandoned it due to compatibility
problems and a general lack of reliability. However, wireless networking has come
a long way, and Windows XP Professional includes a number of features that sup-
port common wireless networking standards and hardware. In short, if you need a
wireless network, Windows XP has what you need to create and configure it.

Just as there are different wired networks, such as Ethernet and HomePNA, there
are also several different types of wireless networks. These different types of wire-
less networks define different standards to which hardware manufacturers must
adhere when creating wireless networking components and devices. The following
list explores each of the major types:

◆ Infrared — Infrared wireless uses an infrared beam to transmit data from
one device to the next, and is most often used in PC devices. For example,
wireless keyboards, mice, printers, and game devices can connect with an
infrared port on your computer. Additionally, laptops and PDAs can con-
nect with a desktop computer for data transfer. Infrared is a great solution
for device-to-PC connectivity, but in terms of an actual LAN, infrared is
not a preferred connectivity method.

◆ Wireless Personal Area Networks (WPANs) — A WPAN is a personal area
network, meaning it resides in one generalized space, such as a room. In
other words, a personal area space is the area surrounding a person.
WPANs are useful for wireless network computing in one location, or
wireless networking between PDAs, cellphones, laptop computers, and so
on. WPANs can make use of infrared connections for objects that are very
close, or you can also use Bluetooth, which communicates through radio
waves up to 30 feet. The IEEE has established a working group for the
development of WPANs numbered 802.15. You can learn more about the
standard by simply searching for IEEE 802.15 on any search engine.

◆ Wireless Local Area Networks (WLANs) — A WLAN is a wireless network
that exists within one geographic location, such as in a home, office
building, school, or other such structure. The IEEE 802.11 standard for
WLANs defines transfer rates at 1 to 2 Mbps. As you can see, the 802.11
standard was rather slow. However, today, the new IEEE standard for
WLAN networking is 802.11b, which defines data transfer rates of up to 11
Mbps using a 2.4-GHz frequency band. 802.11b is the popular standard
today, which provides speeds comparable to a typical Ethernet network.

◆ Wireless Metropolitan Area Networks (WMANs) — WMANs allow com-
munication between different locations within a single metropolitan area.
For example, perhaps your company resides in New York, but three offices
are located in different parts of the city. Using wireless technologies, a
WMAN could be created so that communication between those different
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offices could connect. The IEEE 802.16 standard has been approved, so
you can expect to see growth in this area of wireless networking.

◆ Wireless Wide Area Networks (WWANs) — A WWAN connects WLANs
that are separated over wide geographic areas. For example, if your com-
pany has offices in New York, Seattle, and Dallas, a WWAN could be used
to wirelessly connect the different WAN network segments. WWAN tech-
nologies involve the use of satellite communications maintained by ser-
vice providers, and use the same technologies used by cellular phones and
wireless PDAs.

Both Windows XP Professional and Windows XP Home editions support
infrared and 802.11b wireless networking. The 802.11b standard, also called Wi-Fi,
is the most popular wireless networking standard in use today, providing transfer
rates of around 11 Mbps. In a Wi-Fi network, you have a range of up to 300 feet
from point to point, and it provides the best wireless security that is currently avail-
able. Because Wi-Fi is the most popular, you’ll find plenty of wireless network
devices at any computer store that are compatible with Windows XP. If you are
shopping for wireless devices, look for compatibility information right on the box.
Also, you should see an “802.11b standard” or “Wi-Fi standard” note on the box as
well.

UNDERSTANDING INFRARED
Infrared technology uses a line-of-sight infrared beam to send data from one device
to the next. It is the same principle as a grocery store scanner. The two infrared
devices must be in range and aligned, or pointing to each other. The single infrared
beam then transfers the data. Because you have to line up the two infrared ports on
the two computers or the device (such as a PDA) and the computer, infrared net-
working is not as practical as Wi-Fi.

UNDERSTANDING WI-FI
Wi-Fi networks provide two different topologies, or modes. Wireless NICs can sup-
port either of the two modes, which are called Infrastructure mode and Ad Hoc
mode. In Infrastructure mode, an existing wired LAN, such as Ethernet, extends to
include wireless devices. The wireless devices use a hub, called an access point, that
connects to the wired LAN’s hub. In other words, the access point manages all of
the traffic between the wired network and the wireless devices, just as a typical hub
might do. As with a hub, the access point can support a certain number of wireless
clients, depending on the model you purchase, and you can also use several access
points in a daisy-chain fashion, if necessary.

Ad Hoc mode allows one wireless computer to connect to another without the
use of an access point. For example, say you have four wireless computers in the
same room. Rather than using an access point, the computer’s wireless NICs can be
configured to use Ad Hoc mode. The four computers can communicate with each
other, and because no interface is needed with a wired network, an access point is
not necessary.
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You can also use Infrastructure mode and Ad Hoc mode at the same time,
through a process called Zero Configuration. When in infrastructure mode, all wire-
less NICs look for an access point. If one is not found, the NICs switch to Ad Hoc
mode so that communication with other computers within range can occur.
Windows XP can automatically configure wireless NICs from Infrastructure mode
to Ad Hoc mode, and vice versa.

Getting to Know Workgroup
Hardware
After you have explored the types of workgroup configurations and options avail-
able to you, you need to make a decision about the kind of workgroup you want to
create. After all, each kind of workgroup, from Ethernet to HomePNA to wireless,
uses different kinds of hardware. So, your first step is to decide on the kind of 
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Wireless Security 101
Most of us would rather not spend our time thinking about or worrying about security.
However, in an age of electronic theft and malicious networking attacks, security is a
very important issue, and in fact, the problems with wireless security have kept many
networks from implementing wireless features.

Fortunately, Windows XP supports the major wireless security features that you might
need to implement. 802.11b, which contains some basic security features for access
points called the Service Set Identifier (SSID). An SSID is a known security identifier,
and it is taken from the NIC on each computer. The access point is aware of the SSID,
and once it is taken from the NIC, an association with the NIC and the SSID is made
on the access point. However, the SSID is not encrypted, which makes it available for
theft during transit. The 802.11b security standard really isn’t that secure.

However, another security standard is commonly supported by wireless hardware
called Wired Equivalent Privacy (WEP). This security standard provides a 40-bit
encryption scheme. The encryption scheme prevents theft of data that is airborne, and
this built-in standard provides a great measure of security, especially for home and
small office wireless networks. Along with WEP, many wireless NICs also support a
standard called 802.1x. The 802.1x standard provides authentication for access to
Ethernet networks over a wireless access point. Using 802.1x, the access point
authenticates users in conjunction with server software on the Windows network.
Most major brands of wireless NICs support both the WEP and 802.1x standards, so
make sure you read the box before purchasing any particular brand of wireless NIC.
Although you might not need these standards or be that worried about security, it is
good to know that your NICs support them.
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network you want, and then purchase the hardware you’ll need for that network.
The following sections give you some general information about standard network-
ing hardware that you’ll need, depending on the kind of network you choose.

Ethernet Hardware
To connect network computers using Ethernet, you need to use certain types of
hardware that conform to the Ethernet standard. Keep in mind that your computer
will detect the kind of NIC installed and configure your network based on that stan-
dard, so there is nothing you need to do but use the correct hardware. As men-
tioned earlier, many PCs ship with a standard Ethernet NIC, so you might not 
even need to buy NICs for your PCs. However, here are the items you will need to
configure an Ethernet network.

◆ Ethernet NICs — You can buy Ethernet NICs at any computer store. There
are many different manufacturers, but I recommend nationally recognized
brands, such as Linksys, SMZ, 3com, and so forth. You have better results
and more online support should problems occur.

◆ RJ-45 cabling — You will need RJ-45 cables, which look like large phone
cables, to connect the NIC to the hub. You can buy RJ-45 cables in vari-
ous lengths at any computer store and even many discount stores.

◆ Hub — Ethernet networks use hubs as a central connection device. All
computers connect to the hub using the RJ-45 cable, and the hub handles
communication between the computers. Hubs vary greatly in price,
depending on what you want. You can purchase a small, 5-port hub for a
simple network for under $50. Or, you can purchase a hub with more
ports and additional Internet networking and security options for several
hundred dollars. Many options are on the market, so you’ll have to spend
some time researching your needs and wants before making a decision.

◆ Routers and residential gateways — Some optional, additional tools on
the market are routers and residential gateways. These devices are used in
place of a hub and provide connections to DSL and cable Internet
modems. Rather than the DSL and cable modems connecting to a PC and
then sharing the connection from that PC, these devices manage all of the
network connections. Some even provide firewall and security features.

You can learn more about Internet Connection Sharing (ICS) and Internet

Connection Firewall (ICF) in Chapter 14.
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HomePNA Hardware
If you decide that a HomePNA network is right for you, all you need are HomePNA
NICs and a standard RJ-11 phone cable. Remember that the existing phone wiring
system in the home or office acts as the transmission medium; then the network
functions by simply plugging your computer into a phone jack. In many cases, you
can purchase HomePNA NICs in a quick and easy self-installation kit at your local
computer store.

Wireless Networking
Like other types of networking, you’ll need wireless NICs that are compatible with
Windows XP, and you’ll need an Access Point if you intend on using Infrastructure
mode. Of course, no cabling is necessary, with the exception of an RJ-45 cable to
connect the Access Point to an Ethernet hub.

◆ Wireless NICs — Wireless NICs are readily available as PCI internal NICs,
USB external NICs, and PCMCIA cards for laptop computers. Generally, if
you buy an internal PCI NIC, you must also buy the wireless PCMCIA card
that plugs into the PCI NIC. In other words, most wireless PCI NICs simply
provide a way to use the PCMCIA wireless radio NIC on the PC. Each
wireless NIC has a miniature antenna for transmitting and receiving wire-
less data. As you might imagine, major NIC providers, such as NetGear,
Linksys, SMC, and other vendors, provide wireless NICs. As a general rule,
wireless NICS will cost you between $60 and $100, depending on the
manufacturer and the type (PCMCIA costs more). They are a little more
expensive than Ethernet or HomePNA NICs, but the price difference is not
enough to prohibit you from using a wireless network. Make sure that any
wireless NIC you buy is compatible with 802.11b.

◆ Access Point — The access point looks somewhat like a wired hub (except
there are no ports for cable connections) with a small antenna. You con-
nect the access point to the Ethernet or HomePNA network with an RJ-11
or RJ-45 cable, as needed. Wireless clients then connect to the access
point and then the wired network. Access points generally cost around
$150 to $500, depending on what you want and the brand. As with hubs,
you have many options to choose from, and some wireless access points
also function as a router for a DSL or cable connection, in the event that
you want a completely wireless network.

Setting Up a Workgroup
When you have your hardware installed and ready, make sure everything is con-
nected according to the hardware instructions. What you do at this point depends
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on the kind of network that you want to configure. The following sections show
you how to create the workgroup.

Creating a Direct Cable Connection
You can create a direct cable connection (DCC) with two Windows XP computers,
or even with computers using Windows 95, Windows 98, Windows Me, or
Windows 2000 operating systems. During a DCC session, one computer acts as the
host (the computer you are downloading files from) and one computer acts as the
guest. The guest computer accesses information from the host, and the transfer is
one way. In other words, the host cannot access information from the guest com-
puter. DCC isn’t a true networking solution, but it is a way to get files from one
computer to another. To create the DCC, simply connect the two computers using
the null modem cable, DirectParallel cable, or even two modems, and then follow
these steps:

1. Log on to Windows XP with an administrator account. You cannot create
a host direct cable configuration unless your account has administrative
privileges.

2. Click Start → Control Panel → Network Connections.

3. In Network Tasks, click Create a New Connection. Click Next on the wiz-
ard’s Welcome screen.

4. In the Network Connection Type window, shown in Figure 11-1, select the
Set up an advanced connection radio button and click Next.

Figure 11-1: Choose the advanced connection option.

5. In the next window, choose the Connect directly to another computer
radio button option and click Next.
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6. In the Host or Guest? window, shown in Figure 11-2, select the Host radio
button and click Next.

Figure 11-2: Choose the Host or Guest option.

7. In the Connection Device window, choose the port that you want to use
for the connection (such as serial or parallel) from the drop-down menu.
When you select the desired port, the port is configured for direct cable
communication. You cannot use a port that currently has another device
attached to it. Click Next.

8. In the User Permissions window, you can select which users are allowed to
access the host computer through a direct cable connection. Notice that
you can also create additional user accounts, as needed, directly from this
window, as shown in Figure 11-3. Make your selections and click Next.

Figure 11-3: Configure the User Permissions option.
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9. Click Finish. The new connection appears in the Network Connections
folder under the label of incoming connection.

After you have the host set up, your next task is to set up the guest computer.
For Windows XP computers, you simply use the Network Connections Wizard
again and choose the Guest option instead of Host. If you are using another version
of Windows as the guest, see that operating system’s help files for setup instruc-
tions. In Windows XP, the connection on the client computer appears as Direct in
Network Connections. Simply double-click the icon to make the connection, and
then enter a valid username and password. Keep in mind that you can create mul-
tiple direct cable connections to different computers, as needed. Simply create the
connections, enter the computer name to which you want to connect, and choose
the appropriate port.

Configuring a Workgroup
Before you get started configuring Windows XP for networking, you’ll need to
make sure you have installed any necessary NICs. Arrange the physical topology of
the computers and connect the network cabling (if needed) to the hub, router, or
residential gateway. You should review any documentation and instructions that
accompanied the hardware. After the computers are all connected, determine if you
will use Internet Connection Sharing (see Chapter 14 for more information). If you
will be using ICS, you need to start the configuration of the home or small office
network with the computer that will host the ICS connection. Follow the steps pro-
vided to configure the computer:

1. Click Start → Control Panel → Network Connections. In the Network Tasks
pane of the Network Connections window, click the Set up a home or
small office network link.

2. The Network Setup Wizard appears. Click Next on the Welcome screen.

3. In the Before You Continue page, read the instructions and make sure that
all network components are connected and working. If you want to set up
the ICS host at this time, connect to the Internet.

4. In the Select a connection method window, select the first option if you
want to use ICS. If not, choose the second or third option, depending on
your needs, as shown in Figure 11-4.

5. If you chose the Other option, the next window allows you to select from
the following:

■ This computer connects to the Internet directory or through a network
hub. Other computers on my network also connect to the Internet
directly or through a hub.
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■ This computer connects directly to the Internet. I do not have a 
network yet.

■ This computer belongs to a network that does not have an Internet
connection.

Figure 11-4: Choose a connection method.

6. In Step 4, if you determined that the computer should function as the ICS
host, an Internet connection page appears, as shown in Figure 11-5. Select
the Internet connection that you want to share and click Next.

Figure 11-5: Choose the shared connection.

7. If you have multiple LAN connections installed on your computer, a page
appears asking if you want to bridge those connections. You can choose
to allow Windows XP to automatically bridge the connections by selecting
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the provided button option, or you can choose the button option so that
you can choose your own bridge connections. You can also choose no in
this step and bridge the connections later; this option is explored in more
detail later in this chapter. Make a selection and click Next.

8. If you chose to select your own bridge connections, a page appears so that
you can select the connections to bridge. Do not choose any Internet
connections — you cannot bridge a LAN connection with an Internet con-
nection, and doing so presents a serious security breach on your network.
Make your selections and click Next.

9. On the next page, give the computer a name and a description. The name
you assign the computer should be a friendly name that is easily recog-
nizable on your network. However, if you are using a broadband connec-
tion, your computer may have a required name (often true of cable
modems). In that case, do not change the name if your ISP requires it 
to remain the same. See your ISP documentation for additional details.
Click Next.

10. On the next page, assign a name for your network by typing it in the
provided dialog box. By default, your workgroup is named MSHOME.
However, you can change it to anything you like. The name should be
friendly, and all computers on your network must use the same work-
group name. Click Next.

11. Review the settings you are about to apply on the next page. When you
are sure they are correct, click Next. Use the Back button to make any
necessary changes.

12. Windows XP configures the computer for networking, and you see a wait-
ing page while the computer is configured.

13. When prompted, you can choose to create a network setup disk to use any
downlevel clients. Make a selection, if necessary, and click Next.

14. Follow any additional instructions to create the network setup disk and
click Finish. If all of the clients on your network are Windows XP clients,
you will not need a network setup disk.

Once the first computer is installed, you are ready to begin installing the other
Windows XP computers. Simply follow these same steps to install the networking
software on the additional client computers. If you are using ICS, keep in mind that
the Network Setup Wizard will ask you to choose how the computer connects to the
Internet. Select the Connect through another computer option, and the Network
Setup Wizard will locate the ICS host and proceed with setup from there.

Windows 98, Windows Me, Windows NT 4.0, and Windows 2000 clients can also
natively function in your workgroup with your existing Windows XP clients.
Windows 95, Windows 3.x, and earlier versions of Windows NT are not supported.
These clients, collectively called downlevel clients, can be configured manually for
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networking, or you can run the Network Setup Wizard on these clients, as well. To
use the Network Setup Wizard, you can either use the floppy disk that you created
when you configured the Windows XP clients, or you can use the Windows XP
installation CD-ROM to run the Network Setup Wizard.

1. Insert the Windows XP CD-ROM into the downlevel client’s CD-ROM
drive.

2. On the Welcome screen that appears, click the Perform Additional Tasks
option.

3. In the next window, click the Set up a home or small office network
option.

4. Depending on the operating system version you are using, the Network
Setup Wizard may need to copy some additional files to your computer
and restart it. Click Yes to continue.

5. At this point, the Network Setup Wizard Welcome page appears. Click
Next to continue. The remaining steps are the same. See the steps earlier
in this section for instructions.

Configuring Wireless Networks
Wireless networks basically work like an Ethernet network, but there are some
additional configuration options. For example, you can set up an infrared network
to exchange data (much like a DCC), or you can configure a true 802.11b wireless
network. The following sections explore these issues.

Setting Up an Infrared Network
An infrared network is a great way to exchange data between a few computers, or
between a computer and some device, such as a PDA, printer, mouse, game device,
and so forth. In Windows XP, infrared networking technology is implemented by
the Infrared Data Association’s standards (IrDA), which provides fast data transfer
over an infrared beam of light. To communicate, the computer must be outfitted
with an infrared port. Most laptop computers ship with an infrared port, and if you
need one on a PC, you can purchase an infrared port device that connects to the
computer via USB. As always, check the Microsoft HCL before purchasing an
infrared device. After you install an infrared device, you’ll see a wireless link icon
in the Control Panel. If you double-click the wireless link icon, you see a few con-
figuration tabs. On the Infrared tab, shown in Figure 11-6, you have the following
options:

◆ Display an icon on the taskbar indicating infrared activity — This option
will allow you to see when you are connected to an infrared link and
when another computer or device is within your infrared range.
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◆ Play sound when infrared device is near by — A tone is played when a
device first comes into range of your infrared port.

◆ Allow others to send files to your computer using infrared
communications — If you want to let other devices send files to your
computer over the infrared link, make sure this item is selected. Other-
wise, users will receive an error message stating that “access is denied.”

◆ Notify me when receiving files — When this item is selected, a transfer
status dialog box appears when files are being received.

◆ Default location for received files — If you choose to receive files, you
can configure a default location where those files are stored. Click the
Browse button to select the location.

Figure 11-6: Wireless Link — Infrared tab.

On the Image Transfer tab, you can choose to use the wireless link to transfer
images from a digital camera to your computer, which is a popular application of
infrared technology. Enable the option and choose a default storage location for the
picture files as they arrive. Also, notice the Explore location after receiving the pic-
tures option. If you choose this option, the folder in which the pictures are stored
will automatically open after you have received the files.

The Hardware tab simply lists the infrared device that is installed. You can see
basic information about the device, such as the manufacturer, COM port location,
and the current device status. If you select the device in the window and click the
Properties button, Device Manager properties or the device will open. You’ll see the
standard General and Driver tabs, but there is also an Advanced tab that can come
in handy. This tab, shown in Figure 11-7, allows you to set the maximum connec-
tion rate as well as the COM port. If you are having problems communicating with
a certain device, try lowering this value.
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Figure 11-7: Advanced properties tab.

After you have the infrared port working, you can establish two different con-
nections using Windows XP. The first is an infrared link, which allows the com-
puter to communicate with another computer or device over an infrared link. You
can connect with another Windows XP computer, a Windows 2000 computer, a
Windows 98 computer, or other devices such as PDAs and digital cameras. This
kind of link connection allows you to transfer files from computer and/or device to
the other computer and/or device.

1. Move the infrared computers or devices so that the infrared receivers are
facing each other and are within 1 meter of each other.

2. When the infrared device is detected, an icon appears in your Notification
Area and the Wireless Link icon appears on the desktop.

3. Right-click the Wireless Link icon and click Connect. The connection is
made and data can now be transferred.

The second kind of connection is an infrared network connection. An infrared
network connection provides a direct connection between two infrared computers
where the two computers can communicate with each other over the network con-
nection. One computer acts as the host and one computer acts as the guest, whereas
the guest computer primarily accesses shared resources on the host computer. 
This works basically like a direct cable connection. The guest computer provides a
username and password, and then can access shared information on the host com-
puter. The guest computer can even map to shared drives and folders. To set up an
infrared network connection between two computers, follow these steps:
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1. On the host computer, create a user account for the guest computer, if
necessary.

2. Align the two computers so that the infrared transceivers are within 1
meter of each other and are pointing at each other.

3. The infrared icon appears in the Notification area and the Wireless Link
icon appears on the desktop.

4. To establish the network connection, open Network Connections and click
Create a New Connection.

5. Click Next on the Welcome screen.

6. In the Network Connection Type window, choose Set up an advanced con-
nection. Click Next.

7. On the Advanced Connection Options page, choose Connect directly to
another computer and click Next.

8. Choose the role of the computer, which is the Host computer in this exam-
ple. Click Next.

9. On the Connection Device page, choose the infrared port as the connec-
tion device. Click Next.

10. In the User Permissions window, choose the accounts that can connect
over the infrared port. Click Add if you need to add additional accounts.
Click Next.

11. Click Finish. The connection now appears in Network Connections as an
incoming connection.

12. On the Guest computer, repeat this same process, but choose the Guest
option. When the wizard is complete, both computers can open the con-
nection in the Network Connections folder and click File → Connect to
start the infrared network session.

Setting Up an 802.11b Network
Before setting up an 802.11b network, you’ll need to decide if you’ll use
Infrastructure mode or Ad Hoc mode. If you have a few wireless computers that
only need to communicate with each other, an access point is not necessary
(Infrastructure mode). However, if you have security concerns, you’ll need an access
point to use the security features that wireless networks provide. When you are
shopping for hardware, keep in mind that some access points can also act as routers
or residential gateways for Internet access. After you install 802.11b NICs, Windows
XP configures the NICs automatically to look for an access point. If no access point
is found, Windows XP reconfigures the NICs to use Ad Hoc mode. When the con-
nection to the wireless network is attempted after the NIC is installed, a Connect to
Wireless Network dialog box appears, where you can choose the wireless network
to which you want to connect and provide the WEP key, if required by the network.
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In most cases, Windows XP does a good job of automatically managing the
wireless network connections and configurations. However, you can also access
the NIC’s properties pages and manually configure some settings, if necessary. The
following steps show the options.

1. Open Network Connections and right-click the wireless connection. Click
Properties.

2. On the Wireless Networks tab, notice that, by default, Windows configures
the wireless network settings for you. You see the available networks and
the preferred networks. If you need to configure an available network to
which you want to connect, select the option in the Available Networks
list and click Configure.

3. The Wireless Network Properties dialog box appears. By default, the wire-
less network key and network authentication are enabled. If you need to
enter the network key manually, do so in this dialog box and configure
any necessary options. Check the NIC’s documentation for details. Under
most circumstances, the key is provided automatically, and the options
here are grayed out. Notice also that if you are using Ad Hoc mode, you
can disable the settings on this tab by choosing the This is a computer-to-
computer network; wireless access points are not an option.

4. In the preferred networks list, you can reorganize the list if you have more
than one network by using the move up or move down buttons. Place the
network that you use most often at the top of the list to speed up your
initial access to that network.

5. If you only want to connect to access point networks or you only want to
connect to Ad Hoc networks, click the Advanced button at the bottom of
the Wireless Networks tab. You see an Advanced dialog box. By default,
any available network (access point preferred) is selected. If you want to
restrict the connection to only access points or Ad Hoc networks, choose
the desired option.

Configuring Network Bridges
A network bridge is a piece of software or hardware that can connect two dissimi-
lar networks or network segments. For example, say that you work in a small office
that has both Ethernet and HomePNA, and you want to connect the two networks
without having to change them to one or the other. By default, the two networks
will not readily communicate with each other, but you can use a Windows XP com-
puter to act as the bridge between the two networks. All communication flowing
from the Ethernet and HomePNA networks flows through the bridge, which acts as
a translator. This process is invisible to users who do not have to be aware of the
bridge at all.
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You don’t need a bridge if you are using a wireless network and a wired

Ethernet network. The wireless access point can connect into the wired hub

so that the two networks can communicate.

If you need to configure a network bridge, the configuration in Windows XP is
quick and easy. Select the desired Windows XP computer that will act as a bridge,
then physically install a NIC from each network. For example, if you want to bridge
an Ethernet network with a HomePNA network, install an Ethernet NIC and a
HomePNA NIC. Connect the two NICS to their networks, and then you are ready to
configure the bridge. However, never bridge a private network with a connection
that has a public Internet address. This will open your private network to the
Internet. Rather, use ICS to connect the computers to the Internet. Also, do not
bridge local networks with VPN connections or dial-up connections.

1. Log on with an administrative account.

2. Access the Properties pages of both connections. Using the Advanced tab,
turn off ICS or ICF if they are in use.

3. Open Network Connections. Hold down the CTRL key and click each of
the LAN connections you want to bridge so that they are all selected.

4. Release the CTRL key. Then, right-click the selected adapters and click
Bridge Connections.

5. Windows XP creates the network bridge. When the process is complete,
the bridge appears in the Network Connections folder, along with the LAN
connections that now appear under the Bridge category.

The computer that contains the bridge must be turned on at all times for the two
network segments to be bridged. If the bridge is offline, the segments will not be
connected. You can add or remove connections to the bridge at any time by right-
clicking the bridge icon and clicking Properties. You can have only one bridge on a
Windows XP computer, but the bridge can support multiple connections (up to 64).
You can easily add or remove connections from a bridge by right-clicking the
bridge, clicking the connection, and clicking Remove from Bridge or Add to Bridge.

Managing Connections
After the NIC is installed, it appears in the Network Connections folder, as shown
in Figure 11-8, as a Local Area Connection. You’ll also see any other connections
that are currently configured on the computer, such as dial-up and broadband
connections.
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Figure 11-8: Network Connections folder.

If you right-click the connection and click Properties, you can access the prop-
erties dialog box for the Local Area Connection. The main tab from which you can
configure items is the General tab, shown in Figure 11-9. As the figure shows, you
can click the Configure button to configure and troubleshoot the NIC itself. This
feature simply opens Device Manager properties for the NIC. In the middle of the
window, you see a list of services and protocols that are bound to the NIC. Common
examples you might see here are Internet Protocol (TCP/IP), Client for Microsoft
Networks, and File and Printer Sharing for Microsoft Networks. These services and
protocols are bound to the NIC, which means the NIC uses these protocols and ser-
vices for communication on your network. However, depending on the needs of the
network, you may need to bind other protocols and/or services, as well. For exam-
ple, say that NetWare is in use in your network. In this case, you may need to add
the NWLink protocol or Services for NetWare. In small networks, you might also
need the NetBEUI protocol (although use of NetBEUI has been widely replaced by
TCP/IP). If you do, in fact, need to add a service or protocol, you can easily do so.
Just follow these steps:

1. To add a protocol or service, click the Install button on the General tab.

2. In the Select Network Component Type dialog box, shown in Figure 11-10,
choose Client, Service, or Protocol. Click Add.

3. In the Selection List that appears, select the client, service, or protocol that
you want to install. If you have an installation disk for the client, service,
or protocol, click the Have Disk button and follow the instructions that
appear. Otherwise, click OK.

4. The new client, service, or protocol is installed.
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Figure 11-9: General tab.

Figure 11-10: Network Component Type.

Viewing Connection Information
Windows XP gives you a quick and easy way to see what is going on with any par-
ticular network connection. Simply double-click the Local Area Connection icon to
get immediate information about the connection. This opens the Status dialog box,
shown in Figure 11-11, where you can see the following:

◆ If the connection is actually connected

◆ The duration of the connection

◆ The connection speed

◆ The connection’s activity
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You can also access the Properties dialog box and disable the connection.

Figure 11-11: Status dialog box.

If you click the Support tab, shown in Figure 11-12, you can immediately gain
information about the connection, such as the IP address, subnet mask, and default
gateway, rather than having to use Ipconfig.exe. Notice that you have an option to
Repair the connection. If the connection is not working or seems to be misconfig-
ured, you can click this button, and Windows XP performs a few different actions.
Windows XP tries to obtain a new IP address from the DHCP server. It also flushes
the Address Resolution Protocol (ARP), NetBIOS, and Domain Name System (DNS)
caches. Then, the computer tries to reregister with WINS and DNS servers on the
network.

Figure 11-12: Support tab.

If you click the Details button, the Network Connection Details dialog box
appears, shown in Figure 11-13, where you can also gain additional information,
such as the physical address of the NIC and the addresses of the WINS and DNS
servers on the network.
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Figure 11-13: Network Connection Details.

You can easily manage the local area connection in the same manner by right-
clicking the local area connection icon and selecting from different choices that
appear, such as the following:

◆ Disable — This stops the connection from working; however, it does not
uninstall the NIC or remove any drivers. This feature is a great way to
stop network connectivity while a computer is being configured or for
troubleshooting purposes.

◆ Status — This gives you the same Status dialog box that appears if you
double-click the connection.

◆ Repair—This is the same repair option that appears on the Status dialog box.

◆ Bridge Connections — See the section Configuring Network Bridges earlier
in this chapter for bridge connections of different topology types.

Configuring TCP/IP
As you learned earlier in this chapter, Windows XP uses APIPA, which enables it to
automatically configure TCP/IP for a connection to your LAN. This is great news
for workgroup configurations, because it keeps you from having to manually con-
figure TCP/IP. Still, for the curious, you can manually configure an IP address, sub-
net mask, and default gateway, if necessary or desired. You don’t have to do
anything to configure TCP/IP when APIPA or DHCP is used, which is most of the
time. The only time you need to configure an IP address and subnet mask is if you
want the computer to have a static configuration. The following steps show you the
configuration for APIPA or DHCP:

1. Click Start → Control Panel → Network Connections.

2. Right-click the Local Area Connection and click Properties.
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3. On the General properties tab, select Internet Protocol (TCP/IP) in the list
and click the Properties button.

4. On the Internet Protocol (TCP/IP) Properties General tab, ensure that the
Obtain an IP address automatically and the Obtain DNS server address
automatically radio buttons are selected. After these are selected,
Windows XP Professional looks for a DHCP server. If no DHCP server is
found, an APIPA address is configured.

5. If you want to use a static configuration, choose the Use the following IP
address option, and enter the addressing information, as required (shown
in Figure 11-14). Again, make sure you need to use a static IP address
before using this configuration.

Figure 11-14: General tab.

6. If you click the Advanced button, you can configure some additional
TCP/IP settings. On the IP Settings tab, you can add, edit, and remove IP
addresses and default gateways for the computer, as shown in Figure 11-15.
This feature enables you to use multiple IP addresses and default gateways
on the same computer. This feature can be especially helpful in the case of
a laptop computer that you move from one network to the next.

7. On the DNS tab, you can enter the additional addresses of other DNS
servers that can be used. You can also determine how DNS handles names
that are unqualified. The default settings are typically all you need here.

8. On the WINS tab, you can add the names of WINS servers, if they are still
in use on your network, and you can enable LMHOSTS lookups.
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Figure 11-15: IP Settings tab.

9. On the Options tab, shown in Figure 11-16, you have a TCP/IP filtering
feature. If you select TCP/IP filtering on this tab and click Properties, you
see a simple TCP/IP Filtering window. TCP/IP filtering functions like a
miniature firewall where you can allow or deny traffic on desired TCP and
UDP ports, or on a protocol basis. This setting is not needed in a network
environment where a firewall is in use, but it can be helpful in a workgroup
setting if you want to place some IP restrictions on the computer’s network
adapters. Click OK and OK again after you have configured these options.

-
Figure 11-16: Options tab.
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Troubleshooting Connections
Troubleshooting is one of those unfortunate facts of life in the computer world, and
network connections between computers is certainly no exception. A number of
potential problems can occur, but overall, a thoughtful look at the connection will
typically give you the solution you need.

In terms of connections, you are most likely to experience either a slow network
connection, or a connection that simply doesn’t work at all. Troubleshooting slow
network connections can be a complicated task, mainly because there are so many
different problems that can affect the speed of the connection. From network bottle-
necks to various hardware problems, slow connections are a common difficulty in
any networking environment. However, the client, services, and protocols that are
installed on the local NIC can also cause slow connections. The more clients, ser-
vices, and protocols that you have installed, the more work the NIC must do to fil-
ter through these items to determine which ones need to be used at any given time.
The key point here is simply this — install what you need, but do not install services,
clients, or protocols that you are not using. Having these items available when they
are actually not needed does nothing but increase the odds that your network con-
nectivity will work more slowly.

If you simply can’t connect, which will more often be the case, first make sure
the computer is connected to the network. You would be surprised at the hours of
troubleshooting that are wasted simply because the computer isn’t connected to the
hub. So, start with the obvious and make sure the computer is connected. Next,
check the IP address and subnet mask. If you are using APIPA, make sure that the
IP properties allow the computer to gain an IP address automatically. (See the
previous section Configuring TCP/IP for details.) Next, restart the computer.
Networking software, like any software, can sometimes get fouled up, so a simple
restart might fix the problem. Also, try the Repair feature for the connection, found
by double-clicking the connection in Network Connections.

If you continue to have problems, you might want to use some helpful TCP/IP
troubleshooting tools, which can give you valuable information about the status of
your network connection. The following sections show you how to use some help-
ful tools that are available to you.

Ping
Ping is a network connectivity tool that allows you to test network connectivity
against another computer, or even your computer’s local network adapter card.
Ping sends an ICMP echo request to the desired IP address or name and provides
you with a response as to whether the ping was successful or the host was unreach-
able. At the Windows XP Professional command prompt, type ping ipaddress, such
as ping 10.0.0.1, or you can ping via name such as ping computer7. You can also
perform a loopback test against your computer’s network adapter card by typing
ping 127.0.0.1. To see all of ping’s options, type ping -? at the command prompt.
Figure 11-17 shows you an example of a successful ping test.
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Figure 11-17: A successful ping test.

Ipconfig
Ipconfig reports the IP configuration of your computer. At the command prompt,
simply type Ipconfig and press Enter. You’ll see the IP address, subnet mask, and
the default gateway for the local area connection. If you type Ipconfig /all, you can
see a more detailed list of the computer’s IP configuration, as shown in Figure
11-18. Ipconfig also gives you some additional command line parameters, which
you can review by typing Ipconfig /?.

Figure 11-18: Ipconfig.

Netstat and Nbtstat
Netstat is a connectivity tool that displays all connections and protocol statistics
for TCP/IP. You can use a number of switches with Netstat, which you can view by
typing netstat ?. For listing, you can view the protocol local address, foreign
address, and the current state of the connection.

Similarly, Nbtstat is helpful in cases where you need to troubleshoot NetBIOS
naming and connectivity problems. This tool checks the status of NetBIOS over
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TCP/IP connections, and can give you information about the NetBIOS caches, the
current sessions, and statistics. You can view a number of switches by typing nbt-
stat at the command line. The –RR switch (ReleaseRefresh) was first introduced in
Windows 2000 to send name release packets to WINS and then perform a refresh.

Tracert
Tracert is a simple utility that traces the route from one host to another. You 
can trace routes over the local network, or even to a Web site, such as www.curt
simmons.com, as shown in Figure 11-19. You can also view a listing of tracert
switches by typing tracert at the command line.

Figure 11-19: Tracert.

Pathping
First appearing in Windows 2000, Pathping combines the functionality of ping and
tracert. You can ping an address or DNS name and see the actual route of the ping,
including percentage information on the packets lost. This troubleshooting tool can
be useful in a large network environment experiencing connectivity problems.
Pathping can help you isolate where the connectivity problem resides so that it can
be repaired.

Route
The Route command can be used to view local routing tables and change them if
they contain errors. This troubleshooting tool can be used to verify correct routing
information and correct IP routing data in the host’s routing table. You can view all
the switches available for Route by typing route at the command prompt.
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Nslookup
Nslookup is used to look up IP address-to-DNS mappings in a DNS database. Of
course, this tool only works in domain environments where DNS is in use. You can
get the DNS server’s name and IP address by simply typing nslookup at the com-
mand prompt. To see a listing of available switches, type nslookup so that the DNS
server is found, and then type ? to see the options available to you.
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Chapter 12

Networking in Windows
Networks
IN THIS CHAPTER

◆ Getting to know Windows domains

◆ Joining a domain

◆ Using domain resources

◆ Disjoining from a domain

WINDOWS 2000 PROFESSIONAL IS designed to be a diverse operating system. You
can easily use Windows 2000 Professional in a workgroup environment, and it can
provide the features and functions you need for workgroup networking. However,
Windows 2000 Professional is also built to function in a Windows domain envi-
ronment, and it contains all of the necessary software and functions to take advan-
tage of what a Windows domain has to offer. This chapter takes a look at Windows
2000 Professional’s place in a Windows domain and the configuration of Windows
2000 Professional for domain networking.

Getting to Know Windows
Networking
For all the features a Windows workgroup provides, there is one major problem
with workgroups: a lack of centralized security and management. In a workgroup
environment, each individual user is responsible for administering and managing
his or her computer. This, for the most part, is fine in a small workgroup, but imag-
ine a network of thousands of computers where no centralized security and man-
agement features are in place. Certainly, such a network would pose tremendous
security and management problems.

To solve this problem, larger Windows networks use a domain model, where
collections of computers are organized for management and administrative pur-
poses. In such a model, users log on to a Windows 2000 or later authentication
server, which authenticates the user for network access. Under this model, security
is centralized, and network administrators can manage network computers and
users through a centralized group policy.
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To get a focus on Windows domain networking, you need to understand a few
networking concepts. These concepts apply to Windows 2000 and later networks
and can certainly help you understand how a larger Windows network functions.

Windows Domains
A domain is a logical grouping of users, computers, and resources that makes up a
security and administrative boundary. The domain is not a physical entity— it doesn’t
identify the actual network topology or physical locations of the network, but it
defines a boundary. A domain can be a grouping of users, computers, and resources
in one office building containing a few hundred users, or it can be a grouping of
users, computers, and resources spread over several offices around the globe con-
taining thousands of objects. In the same manner, the domain serves as a security
boundary. Security policies are applied to the domain, and desired security stan-
dards can be used across the entire domain. So, the domain is used to define both a
security and administrative boundary.

In a Windows 2000 network, all domain information is held in a central 
repository — the Active Directory. Network data and configuration, along with user,
group, and resource data are all found in the Active Directory and are replicated to
domain controllers throughout the domain. Windows 2000 networks are built on
the Domain Name System (DNS). In the past, Windows networks used NetBIOS as
the naming scheme, but DNS is the most scalable naming system in existence (it
holds the entire Internet), and Windows 2000 is completely integrated with DNS.
Because of this, the Windows namespace, or the naming area that can be resolved,
is entirely built on DNS. Therefore, Windows 2000 domain names are DNS names.
For example, ammacom.com could be the name of an Internet Web site, but it is
also a domain in a Windows 2000 network. Juser@ammacom.com is an Internet
e-mail address, but it is also a username in a Windows 2000 network. As you can
see, the Windows 2000 namespace is seamless with Internet names — simply
because they are all built on the same naming system — DNS.

Because the Windows 2000 network is built on the DNS namespace, all domains
in a Windows 2000 network follow the DNS naming structure. As I mentioned, a
company called Ammacom could implement the Active Directory using their com-
pany name for the namespace. As such, the first domain that is created, called the
forest root domain, could be named ammacom.com. All other network names are
built from this root domain name.

Understanding Windows Sites
As mentioned in the previous section, a domain is a logical grouping of computers,
users, and resources for administrative and security purposes. A site, on the other
hand, is a physical grouping of computers, users, and resources. A site is not a part
of the Active Directory namespace, and as an administrator, you typically do not
work directly with sites. Domains use sites to manage traffic. For example, say a
domain is based at your company headquarters in Dallas. All users, computers, and
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resources are physically located in that single location. To the Active Directory, the
offices make up one site because they are all contained on well-connected subnets.
In other words, there are no WAN links. The site, then, defines the geographic loca-
tions of the domain. In many cases, there may simply be one site.

The Active Directory then uses a site for each physical location and the informa-
tion you provide it to determine the speed, reliability, and availability of the WAN
links that connect these sites. To administrators and domain users, it appears as
though everyone is located in one place, but in reality, the users, computers, and
resources are spread out over several different geographic locations.

How does the Active Directory determine these sites? It does so with the infor-
mation that administrators provide. The key point to keep in mind is that the Active
Directory considers a site to be a collection of well-connected subnets. Simply put,
the Active Directory considers a site a location that has fast and readily available
bandwidth, such as a typical LAN. For the Active Directory to manage traffic over
WAN links, the Active Directory must know what sites exist and have information
about the speed and availability of the WAN links between them.

Understanding Organizational Units
So far, you have learned that domains are a logical grouping of computers, users,
and resources. Domains use sites to determine the physical location of those com-
puters, users, and resources and to manage traffic. Under the Windows 2000 design,
a domain is essentially unlimited in size. For example, the domain could contain a
few thousand objects or, potentially, hundreds of thousands of objects. In larger
domains, the problem becomes management. In other words, in a large domain
with hundreds of thousands of objects, how do you organize the domain so that
different administrators manage different portions of the Active Directory, or even
different groups of users, computers, and resources? The answer is the organiza-
tional unit (OU).
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The organizational unit is simply a container within Active Directory, much like
a folder, where different objects can be stored. Certain administrators can be dele-
gated control over the different OUs, as needed. This design gives networks a lot of
flexibility without the expense and difficulty of configuring and managing multi-
ple domains, as in the following examples:

◆ A network could organize all users into one OU that is managed by cer-
tain administrators, or all printers into one OU that is administered by
certain administrators.

◆ A network could organize its domain by its company needs. For example,
there could be a marketing OU and a sales OU. Different administrators
could manage the OUs, including all of the users and resources for those
company divisions.

◆ A network could be organized by location. There could be a Paris OU or a
Dallas OU, and administrators in those locations could manage the users
and resources, while still belonging to a single domain.

As you can see, a number of different options can be configured, and they are all
based on the organizational needs of a particular network. However, aside from
basic organization, you can accomplish some additional tasks with OUs. First of all,
OUs serve as an organizational boundary, but they also serve as a security and
management boundary. Within an OU, an administrator can place different restric-
tions on resources and users, and even use a group policy at the OU level. With del-
egation of control, one administrator can manage a particular OU, but have no
administrative power over another one. OUs are a way to subdivide a domain into
more manageable pieces.

However, there are two important points to keep in mind about the OU:

◆ OUs are invisible in terms of DNS. Say you have a resource in an OU
called resources, located in the xprod.com domain. The resources are still
found in the xprod.com domain — not resources.xprod.com.

◆ OUs are specific to the domain and can only contain objects held within
that domain. An OU cannot contain any resources that reside in another
domain.

As network administrators and planners determine the need and use of organi-
zational units, it is important to keep in mind that you can have as many OUs as
you need, and OUs can be nested, which means they can reside within other OUs.

Windows XP Professional does not have the capability to manage any of the

domain, site, or OU features discussed in these sections. All of these features

are managed by the Active Directory, which only runs on Windows 2000 and
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later domain controllers. Windows XP Professional, however, can function as

a print server or file server in a Windows network.

Joining a Domain
Windows XP Professional has the necessary software to join a Windows domain.
Before attempting to join a domain, however, you must take care of a few tasks
first. To join a domain, your computer must have a computer account with a
domain controller on the domain, and you must have a valid username and pass-
word on the network. A network administrator must configure these items. In most
cases, your computer must be configured to obtain an IP address automatically in
TCP/IP properties so that a Dynamic Host Configuration Protocol (DHCP) server can
manage your computer’s IP address (see Chapter 11 for details). Finally, your com-
puter must be configured with a network adapter card and be physically connected
to the network.

Only Windows XP Professional computers can join a domain. Windows XP

Home edition does not have domain-networking capabilities.

When you are ready to join a domain, Windows XP provides a helpful wizard
that walks you through the process. The following steps show you how:

1. Log on to the Windows XP computer with an administrator account. Click
Start → Control Panel → System.

2. In the System Properties dialog box, click the Computer Name tab. As you
can see in Figure 12-1, the Computer Name tab gives you a computer
description and Network ID and Change buttons.

3. Click the Network ID button. This opens the Network Identification Wizard
that guides you through the rest of the process. Click Next on the
Welcome page that appears.

4. The next window, shown in Figure 12-2, asks you if the computer will be
a part of a business network (domain) or a home or small office computer
(workgroup). Select the business network option and click Next.

5. In the Connecting a Network page, select the My company uses a network
with a domain option and click Next.
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Figure 12-1: Computer Name tab.

6. The next page tells you about the username, password, domain name, and
possibly computer name information that you will need. Click Next after
you have read the page.

7. On the User Account and Domain Information page, shown in Figure 12-3,
enter your username, password, and domain name. Keep in mind that the
password is case-sensitive. Click Next.

8. You may also be asked to verify the computer and the domain. If so, enter
the information in the provided page and click Next.

Figure 12-2: Connecting to the network.
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Figure 12-3: Enter your domain account information.

9. In the User Account window, you can choose to add the domain user
account to the local user accounts so that the user can gain access to local
system resources. This feature enables you to limit what the user can do
on the local machine or even make the user account a local administrator
account. For example, I am logging on to a domain using my username,
csimmons. However, I also want administrative control over my local
computer. So, I simply agree to add the new user account to the local
computer. I can then log on locally with my administrative account and
make this domain account a local administrator account. Now, I have one
login for the domain that allows me to completely manage my local com-
puter as well. Make a selection and click Next.

10. If you chose to add a new user account, choose the level of permission
that you want to assign, and click Next.

11. Click Finish. A prompt appears for you to restart your computer.

The Network Identification Wizard helps you walk through the steps of joining a
domain, but you can do so more quickly by clicking the Change button on the
Network Identification tab of System Properties. This option basically distills the wiz-
ard pages to a single dialog box, shown in Figure 12-4, where you enter the com-
puter name and (if necessary) click the option to log on to a Windows domain, and
enter the domain name. Simply click OK to join the domain and enter the username
and password for your domain account when prompted. You’ll need to restart your
computer after you complete the joining process.
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Figure 12-4: Computer Name Changes option.

Logging On to a Domain
After you join a Windows domain, you can log on to the domain and begin using
domain resources. Before you log on to the domain, however, you should note that
changes will occur to your Windows XP computer after you configure it for domain
access. Some of the features of Windows XP that you can use in a small office net-
work or without networking at all are simply incompatible with domain network-
ing, so be sure to take note of the following issues. The issues are created purpose-
fully and are not something you can directly work around:

◆ Fast User Switching does not work when you log on to a domain. Because
Fast User Switching works on a local account basis and domain connec-
tivity functions by server authentication, Fast User Switching is not
available.

◆ No password hints are available for your domain password, should you
forget it.

◆ Automatic logon is not supported. You can configure automatic logon by
editing the registry, but this constitutes a serious security breach because
anyone can use your computer and gain access to the network. This reg-
istry hack is not recommended and is most likely unwanted by your 
network administrators.

◆ The Log Off and Shut Down options look different. They do the same
thing, but they look like the standard logoff and shutdown options you
see on Windows 2000 Professional.
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◆ The Start menu displays your name, as stored in your domain user
account instead of your local administrator account.

◆ The CTRL+ALT+DEL command no longer directly opens the Task Manager.
Instead, you see a Windows Security dialog box, where you can choose
to Lock the Computer, Log Off, Change your Password, or access Task
Manager.

◆ The Users Interface in the Control Panel changes from the graphical local
accounts option you typically see. The functionality remains the same,
but the graphical interface changes.

◆ Internet Time in the Date and Time Properties dialog box does not work.
Time synchronization is handled by the Windows server instead of an
Internet timeserver.

◆ Simple File Sharing does not work. By default, Windows XP uses Simple
File Sharing (see Chapter 15), but when you configure Windows XP for
use on a Windows domain, Simple File Sharing is disabled so you can
take full advantage of NTFS permissions at the domain level.

Refer to Chapter 15 for more information on Simple File Sharing.

When you are ready to log on to the Windows domain, and you have restarted
your computer after configuring to connect to a domain, you can simply log on to
Windows XP as you normally would. However, you’ll notice that the Welcome
screen is gone and you have to press CTRL+ALT+DEL to see a standard Windows
logon dialog box where you have to type your username and password. You must
use your domain username and password — not a local Windows XP username and
password. Otherwise, you’ll see an authentication failure. Because Windows XP is
now contacting a Windows domain controller to authenticate your logon and your
local user accounts database, you must provide a network username and password.

In case you’re wondering, CTRL+ALT+DEL is a security measure. Domain con-

figuration requires you to press these keys to access the Windows logon dia-

log box. CTRL+ALT+DEL is a common keystroke that can halt malicious code

that could be running on your system, such as a Trojan Horse that can steal

your username and password. Winlogon.exe is the only program that can

run after a CTRL+ALT+DEL keystroke on Windows.
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Locating Resources on a Domain
After you have logged on to a domain, you can begin to access resources that the
domain provides. I should note upfront that domain access doesn’t mean you’ll be
able to access anything you might want. Rather, you’ll be able to access those
resources to which you have been given permission. With NTFS security in effect
on the domain, you may be able to freely access some resources, be denied access
to some, and have limited access to others. For example, you might be able to open
certain shared folders and read their contents, but be unable to alter anything. So,
don’t assume the network is yours for the taking.

So, once you log on to the domain, how can you begin accessing those
resources? There are a few different ways to access resources and a few ways that
can make your life easier with resource access. The following sections explore those
features.

Using the UNC Path
You can access a network resource using the Run dialog box, just as you can use
the Run dialog box to access a local resource on your computer, such as a folder.
Click Start → Run and use the Universal Naming Convention (UNC) path to access
the resource. The UNC path for accessing network resources is \\servername\
sharename, where servername is the name of the server or computer on the net-
work that provides the resource, and sharename is the name of the shared resource.
For example, if you wanted to access a folder called cmpydocs on a server named
server1, the UNC path you should type in the Run dialog box is \\server1\
cmpydocs, as shown in Figure 12-5. However, you are not limited to using the Run
dialog box. In fact, you can use any Explorer window in Windows XP, including
Internet Explorer, to immediately jump to a network resource using the UNC path,
as shown in Figure 12-6. Using the UNC path, you can quickly move to shared
resources on your network from essentially any folder or location on Windows XP.
However, you have to know the server’s name and the resource’s name to access
them using UNC. Many times, you will not know these names initially, so you’ll
have to resort to browsing or searching the Active Directory, as described in the
next two sections.

Figure 12-5: You can use the Run dialog box to access a UNC path.
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Figure 12-6: You can also use the Address line in any Windows Explorer 
window or Internet Explorer to access a UNC path.

Browsing for Resources
You can browse for network resources using My Network Places, which you’ll find
on the Start menu. My Network Places shows you all of the shared folders and/or
computers on your network. You can double-click a computer or shared folder to
access resources, as shown in Figure 12-7. My Network Places will show you local
resources as well as Internet resources for which you have added a network place
(explored in the Creating a Network Place section later in this chapter).

Browsing is a great way to look for resources if the domain is small or you are
using a workgroup configuration. The problem, though, is that many domains con-
tain thousands of computers and thousands of shared resources, and browsing sim-
ply leaves finding resources to chance. You have to accidentally locate what you
might need by browsing, and in a large network, browsing simply isn’t practical. In
this case, you’ll need to search the Active Directory to locate what you need, and
the following section shows you how to do that.

Searching the Active Directory
The Active Directory, as mentioned earlier in this chapter, runs on Windows domain
controllers and provides a central directory for the network. Everything from user
accounts to printers to shared folders is stored in the Active Directory. Even though
you can browse for the resources that you want, you can more easily search the
Active Directory and locate items quickly.

The Active Directory is easy to search because you can search for items based
on attributes. For example, say you need to locate a printer that prints color. Your
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network has a number of shared printers, so to ensure that you find the right one,
you can query the Active Directory to find a printer that prints in color. This pre-
vents you from having to manually locate the right printer.

Figure 12-7: My Network Places.

The Active Directory uses Lightweight Directory Access Protocol (LDAP) for

searching the Active Directory. LDAP is an industry standard used in many

different kinds of networks and search engines. It is fast, effective, and flexi-

ble, which is why Windows networks now use LDAP.

To search the Active Directory, follow these steps:

1. Open My Network Places.

2. Under Network Tasks in the left pane, click Search Active Directory. This
option only appears if your computer is part of a domain.

3. The Find Users, Contacts, and Groups window appears. In the Find box,
select what you want to search for, such as Shared Folders.

4. Complete the fields required for starting a search, which will vary depend-
ing on what you are looking for. For example, you can search for a
printer by name, location, or model. Enter your search information and
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click Find Now. The results appear in a pane that unfolds at the bottom of
the window. Simply double-click the shared resource that you want to
access.

5. Depending on the resource that you are searching for, you can also search
for the resource based on features or other information. For example, you
can search for a shared printer based on its characteristics by clicking the
Features tab. This allows you to search for color printers, printers that sta-
ple, and so on. If these options do not give you the results you want, try
the Advanced tab, where you can choose fields, conditions, and values for
the search. For example, you could choose Pages Per Minute in the Field
list and Greater Than Or Equal To in the Condition list, and then type a
number in the Value list, such as 15, to obtain a list of printers that can
print at least 15 pages per minute. If you select multiple criteria on the
various tabs, your search will reveal printers that meet all the conditions
you have specified.

Creating a Network Place
After you locate a shared resource on the network through either browsing or
searching the Active Directory, you may want to create a network place or map a
network drive to that resource. Network Places and mapped network drives are
essentially the same thing; they give you access to network resources through an
icon on your computer so that you do not have to browse or search for those
resources each time you want to use them. For example, say you locate a shared
folder that contains a number of resources you will access regularly. This is a per-
fect candidate for a network place or a mapped network drive so that you will be
able to access the resource easily, just as if it were stored locally. The following
steps show you how to configure a network place:

1. Open My Network Places.

2. Click the Add a Network Place link under Network Tasks. This opens the
Add Network Place Wizard. Click Next to move past the opening page.

3. You have the option of signing up for online storage with a storage
provider, but to create a network place that points to a location in your
domain or your workgroup, click Choose Another Network Location, and
then click Next.

4. On the What Is The Address Of This Network Place page, type the net-
work address, or click the Browse button to open the Browse For Folder
dialog box.

5. If you opened the Browse For Folder dialog box, browse to the network
resource for which you want to create a network place, as shown in
Figure 12-8. You’ll want to expand the Entire Network link, expand
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Microsoft Windows Network, and then expand your domain or workgroup
name. The network computers will be listed. Expand a computer and a
drive, and then select a folder. Click OK. The address appears in the Internet
Or Network Address dialog box. Click Next.

Figure 12-8: Browse for the network folder.

6. On the What Do You Want To Name This Place page, type a name that
will identify the Network Place for you. Click Next, and then click Finish.

The Network Place now appears in your My Network Places folder, as shown in
Figure 12-9. You can drag the icon to your desktop, another folder, or even the
Start menu for easier access to the network resource.

Figure 12-9: You can now directly access the Network Place.
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Mapping a Network Drive
You can also map a network drive. When you map a network drive, you assign a
drive letter to a network computer, disk, shared folder, printer, or other resource.
You can then use the mapped network drive just as if it were a local drive on your
computer. There is no benefit to using a mapped network drive over a network
place. Mapping a network drive is an older technology that network places essen-
tially duplicates, but you are free to create them as you want. Just follow these
steps:

1. Open My Network Places.

2. Click Tools → Map Network Drive.

3. In the Map Network Drive dialog box, choose a drive letter from the Drive
list that will represent the network location. Drive letters that are already
in use will not be displayed. Next, use the Folder box to enter the network
path in the form \\servername\sharename, shown in Figure 12-10, or
click Browse to navigate to the resource. Keep in mind that sharename
refers to the shared folder’s name, not necessarily the name of the net-
work place. Click Finish when you’re done.

Figure 12-10: Assign a drive letter and folder name.

The drive now appears in My Computer under the category of Network Drives, as
shown in Figure 12-11. You can create a shortcut to the drive and place the short-
cut anywhere on your computer. You can remove a network drive by simply right-
clicking the drive and clicking Disconnect. You can also remove a network place by
right-clicking the icon and clicking Delete.
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Figure 12-11: The mapped drive appears in My Computer.

Disjoining from a Domain
There may come a time when you need to disjoin your computer from a domain.
This occurs when the computer will no longer be used in a domain environment. In
this case, you need to essentially tell Windows XP that it is no longer a part of the
domain. Follow these steps to disjoin from a domain:

1. Log on to the local computer as a user with administrative privileges.

2. Open System in the Control Panel, and select the Computer Name tab.

3. Click the Change button. If the Change button is grayed out, you need to
log on with a local administrator account.

4. In the Computer Name Changes dialog box, choose Workgroup in Member
Of, and then type the name of the workgroup. Click OK.

5. A second Computer Name Changes dialog box appears. You must provide
the username and password of a domain account that has the credentials
to remove a computer from the domain. See a domain administrator for
assistance if necessary.
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Chapter 13

Remote Networking
IN THIS CHAPTER

◆ Using Virtual Private Networking

◆ Working with Remote Desktop

◆ Running Remote Assistance

AS NETWORKS HAVE GROWN and developed over time, the concept of being able to
remotely network to other computers has become very important — after all, just
look at the world’s largest network, the Internet. From a Windows XP networking
point of view, the option to remotely network still carries the same importance, and
Windows XP gives you a few options that can really help. As in previous versions
of Windows, XP supports Virtual Private Networking (VPN), but it also contains
two additional remote networking features: Remote Desktop and Remote
Assistance.

Understanding Virtual Private
Networking
Two of the major problems with networking remotely are security and expense. To
network remotely on the same network, you have to use a wide area network
(WAN) consisting of expensive networking topologies. If you network across public
networks, such as a phone line or the Internet, security becomes a major issue.
Microsoft has provided a solution to both of these problems through Virtual Private
Networking. When you use a VPN, Windows XP creates a secure connection to
remote computers across a public network. This virtual network allows the con-
nected users to interact as if they were all on the same private network.

For the connection to act like a point-to-point link, such as what you would
establish when communicating with a computer on a private network, the network
data has to be encapsulated so that it can travel the public network. The encapsu-
lated data is encrypted so that if any of it were stolen while in transit, the encryp-
tion key would be required to decrypt it. The VPN is extremely useful because a
computer with a VPN connection can use virtually any Internet connection to reach
the private network. The user can participate in the protected network, just as if he
or she is connected locally. This is not only useful to telecommuters and traveling 259
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employees, but VPNs can allow a company to use cheaper, high-speed access meth-
ods (cable and DSL, for example) to connect remote offices. Without the WAN
expense, companies can easily save money with the VPN solution.

How the VPN Works
A VPN uses a process called tunneling to transport data. Generally speaking, tun-
neling is the act of moving data destined for one network over the infrastructure of
another network. Most Virtual Private Networking solutions make use of one of
two tunneling protocols. The protocols most widely used are Point-to-Point
Tunneling Protocol (PPTP) and Layer Two Tunneling Protocol (L2TP), because they
are flexible and widely supported. In some situations, a more powerful, and
extremely secure, solution is required. IPSec (Internet Protocol Security) is a proto-
col for ensuring very strong security. The VPN client encapsulates packets that are
destined to be routed between the two tunnel endpoints. This information that is
added during the encapsulation process allows the VPN packets to be uniquely
identified by other VPN participants. Microsoft VPN implementations support a
number of authentication protocols. These protocols control the process of forming
a VPN tunnel. The features of these protocols range from simple and almost inse-
cure to complicated and highly secure.

For a simple explanation, the VPN tunnels network data to the destination by
encapsulating network data in PPP (Point to Point Protocol) packets. These stan-
dard PPP packets can traverse a public medium, such as a phone line or the
Internet, but the real data is hidden inside the packet. On the receiving end, the PPP
data is stripped away to reveal the real data.

Connecting to a VPN Server
Although VPN connections may sound complicated, Windows XP does all of the
work concerning encapsulation and such. Think of the VPN connection as you
would a dial-up connection. They both allow access to remote resources. To make a
VPN connection, the steps are almost the same as those used to create a dial-up
connection. It is important to note that the VPN connection works on top of your
Internet connection. If you are using the Internet to connect to a remote VPN
server, you’ll need to first establish an Internet connection, then establish the VPN
connection. The following steps show you how to create a connection that will
connect to a remote VPN server.

1. Open Network Connections in the Control Panel and click the Create a
New Connection link under Network Tasks.

2. The New Connection Wizard appears. Click Next on the Welcome screen.

3. Click the Connect to a network at my workplace option and click Next, as
shown in Figure 13-1.
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Figure 13-1: Selecting a Network Connection Type.

4. On the next page, choose Virtual Private Network connection and click
Next.

5. Enter a name for the connection and click Next.

6. On the Public Network page, you can choose to have Windows automati-
cally dial the connection so that the VPN connection can be established,
or you can choose to manually dial the connection, as needed. If you are
using a broadband connection that is always connected, choose the Do
not dial option. Make your selection and click Next.

7. In the VPN Server Selection window that appears, enter the fully qualified
domain name (FQDN) or IP address of the VPN server to which you will
connect. Click Next.

8. Click Finish.

Configuring Windows XP to Accept Incoming VPN
Connections
Just as you can allow incoming connections on your Windows XP computer, you
can also configure Windows XP to accept VPN connections from remote clients.
This process works basically the same way as allowing incoming connections.
Follow these steps:

1. Click Start → Connect To → Show All Connections, or open Network
Connections in the Control Panel.

2. In the Network Connections window, click the Create a New Connection
option under Network Tasks.
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3. Click Next on the New Connection Wizard’s opening page.

4. In the Network Connection Type window, choose the Set up an advanced
connection option and click Next.

5. On the Devices for Incoming Connections page, select the modem or
broadband device you want to use to allow incoming connections. 
Click Next.

6. On the next page, choose the Allow virtual private connections option
and click Next.

7. On the User permissions page, select the user accounts that are allowed to
use a VPN connection. If the user account does not exist for the client,
click New to create one. Click Next.

8. In the Networking Software window, add or remove networking software
that can be used over the connection, as needed. Click Next.

9. Click Finish.

Managing VPNs and Firewalls
For the most part, utilizing VPN connectivity when one endpoint is behind a fire-
wall is not an issue. Most firewalls allow liberal privileges when it comes to outgo-
ing connections. Incoming connections are different, though. For a VPN server to
accept incoming connections, the firewall (if any) that it resides behind needs to be
configured to allow incoming connections on port 1723.
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Solving VPN Connection Problems
If you dial in to a VPN server, but you cannot seem to access the rest of the network,
the VPN server needs to be configured with an IP address and subnet mask that are
the same as the internal network so the VPN server does not become a dead end. If
you are using Windows XP as a VPN server, right-click the VPN icon in Network
connections and click Properties. On the Networking tab, select Internet Protocol
(TCP/IP) and click Properties. Adjust the IP address and subnet mask, as necessary.

If you are using a VPN connection, and other connection services to the Internet stop
working, such as Internet Explorer, the VPN connection is configured to use the
default gateway on the remote network you are accessing. This is helpful if you are
accessing the Internet through a corporate network, but not if you are accessing a
single VPN server. To stop using the remote default gateway, access the VPN connection
properties and click the Networking tab. Select Internet Protocol (TCP/IP) from the list
and click Properties. On the General tab, clear the Use Default Gateway On Remote
Network check box.
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If the firewall makes use of the Network Address Translation (NAT) features, the
firewall needs to be configured to forward VPN traffic to the appropriate internal
host, as well as to allow incoming connections. External hosts cannot directly
request access to hosts on a private LAN, so the firewall is left to play matchmaker
and ensure that the incoming requests are forwarded to the correct internal server
and nowhere else. Most software firewalls offer relatively simple interfaces for con-
figuring the incoming ports, whereas many hardware firewalls (especially business-
class equipment) can require moderate expertise to configure correctly. Using an
Internet Connection Firewall (ICF) with VPN connections is not recommended.

Using Remote Desktop
Windows XP Professional includes a new feature called Remote Desktop Sharing
or, more simply, Remote Desktop. Say that you have a Windows XP computer at
your office. You also have a laptop computer, or even a home computer. Using
Remote Desktop, you can connect to your office computer from another computer
and access your office files and applications, just as if you are actually sitting in
front of the office computer. Using Remote Desktop, a terminal window appears,
and you simply use your office computer from your home or remote computer.

Remote Desktop is built on Windows 2000 Terminal Services, which allow you
to create terminal sessions with remote machines. Remote Desktop uses this same
principle. Through the Terminal window that appears, you can open files, launch
programs, configure system changes, browse folders — basically anything you
might do — as if you were sitting at the computer locally. As you can imagine, this
feature has a lot of possibilities because your desktop PC no longer needs to be a
local resource only.

Understanding Remote Desktop
Remote Desktop is generally easy to use and set up, but depending on the needed
configuration, you might have a few networking snags to work through. Keep the
following important points and restrictions in mind concerning Remote Desktop.

Windows XP Professional can function as a Remote Desktop host in that other
computers can connect to it. You can connect to a Windows XP Professional com-
puter and manage it remotely using Windows XP Professional or Home edition, or
by installing the Remote Desktop Connection software on Windows 2000, Windows
NT 4, Windows Me, Windows 98, or Windows 95. The setup and configuration of
the Remote Desktop Connection software is explored later in this chapter.

Remote Desktop allows multiple users to connect to the same computer so that
different users can access different resources and run different applications, as
needed. When a remote user connects to the Remote Desktop host, the local desk-
top is locked. This prevents anyone from using the computer while you are logged
on remotely.
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Each client accessing the Remote Desktop host must have a direct connection to
the host. This can be accomplished using a LAN/WAN connection, a dial-up con-
nection, or a VPN connection, or it can be done over the Internet if the Remote
Desktop host has a public IP address. See Connecting with Remote Desktop later in
this chapter for details.

Turning on Remote Desktop
To use Remote Desktop, you must first turn on the Remote Desktop service on a
Windows XP Professional computer that you want to function as the remote host.
Keep in mind that only Windows XP Professional computers can be Remote
Desktop hosts, but you can connect to the Remote Desktop using other Windows
computer systems that run the Remote Desktop Connection software. To turn on
Remote Desktop on a Windows XP Professional computer, follow these steps:

1. Log on to the Windows XP Professional computer as a member of the
Administrators group. You cannot enable Remote Desktop without an
administrator account.

2. Click Start → Control Panel → System. Open the System Properties dialog
box, shown in Figure 13-2, and click the Remote tab. Click the Allow
users to connect remotely to this computer check box.

Figure 13-2: Remote tab.

3. After the setting is enabled, the current user, and any member of the
Administrators or Remote Desktop groups, can access the computer using
Remote Desktop. However, you might want to change the default settings
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to allow or prevent users from accessing Remote Desktop. One important
note, however, is that any user who attempts to use Remote Desktop must
have a password. Remote Desktop connections do not allow blank pass-
words. To manage the users that can access the Remote Desktop, click the
Select Remote Users button.

4. In the Remote Desktop Users dialog box, shown in Figure 13-3, you can
click the Add button to add users to the Remote Desktop group, or use the
Remove button to remove users from that group. Keep in mind that local
administrators automatically have access. When you are done, click OK.

Figure 13-3: Determine which users can access the computer remotely.

Keep in mind that Remote Desktop does not allow blank passwords. If you

want to give specific accounts access to the Remote Desktop, and those

accounts use a blank password to log on to Windows, you must configure a

password for those accounts. Users will then have to enter that password

when logging on to Windows and when logging on to the Remote Desktop.

Connecting with Remote Desktop
For Remote Desktop to work, you must be able to make a connection to the host
computer from the client computer. Depending on how you are connecting, that
process might be simple. However, any remote connection has its own set of prob-
lems. Before configuring your client computers, you must determine how clients
will connect to the Remote Desktop host. The following sections explore your
options.

CONNECTING OVER A LAN/WAN
Connecting to a Remote Desktop host over a LAN or WAN is the easiest way to con-
nect. The client computer uses the host computer’s IP address or resolvable DNS
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name to make a direct connection. You don’t have to worry about any additional
configuration. If you are connecting over different subnets, or are connecting to a
remote office via some kind of dial-up connection, see the next section. Overall, if
you are on a business LAN or WAN, you can seek help from your network admin-
istrator if you are having problems connecting from one LAN or WAN segment to
another.

CONNECTING USING A DIAL-UP CONNECTION
You can connect to a Remote Desktop host through a dial-up connection. For
example, say your work computer resides in a small office. That computer has a
modem and is connected to the phone line. To access your work computer from a
home computer, you first use the Create a New Connection Wizard on your work
computer to configure the computer to accept incoming calls. Then, from your
home computer, configure a dial-up connection to dial the work computer’s number.
You can then dial the work computer directly and create a Remote Desktop session.

CONNECTING USING THE INTERNET
You can connect to a Remote Desktop host over the Internet, but the process is a bit
more complicated. When a computer is connected to the Internet, it is assigned an
IP address by the Internet service provider (ISP). This public IP address must be used
to make the Remote Desktop connection. The problem, however, is that public IP
addresses change frequently. For example, if you are using a modem to connect to
the Internet, each time you connect, you are generally given a new dynamic IP
address. Even with broadband connections, such as cable and DSL, the IP addresses
can change frequently. There is no easy solution for this issue; the simple fact is
that you must know the IP address of the computer to connect to it. To find the
public IP address, follow these steps:

1. Connect to the Internet.

2. Double-click the connection in Network Connections.

3. Click the Details tab, and you’ll see the current public IP address.

4. You can then use this IP address to connect to the host from the client
computer. If you are using a dial-up connection, you must leave the 
host computer connected to the Internet to make the Remote Desktop
connection.

CONNECTING OVER A FIREWALL
Another difficulty concerning Remote Desktop connections over the Internet is
firewalls. Most firewalls will not, by default, allow Remote Desktop traffic. If you
need to connect to a Remote Desktop host that resides behind a firewall, you must
consider a couple of issues. First, if you are using ICF on the host computer, you
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need to access the Advanced Settings dialog box and enable Remote Desktop 
traffic. This will allow Remote Desktop traffic to pass through the firewall after the
service is enabled. Second, if the host computer resides on a LAN that is protected
by a firewall, or if another individual firewall product is used, you need to ask an
administrator to configure the firewall to allow incoming access on TCP port 3389.
Remote Desktop uses TCP port 3389, and the connection will fail if the firewall is
not configured to allow incoming access on this port.

See Chapter 14 to learn more about using Internet Connection Firewall.

CONNECTING THROUGH A REMOTE ACCESS SERVER
If you need to connect to a Remote Desktop host over the Internet and through a
remote access server (RAS), you should use a VPN connection. This gives you the
most security when using the Remote Desktop host over the Internet. An adminis-
trator must configure the remote access server to allow VPN traffic. Once you con-
nect to the network, you can start the Remote Desktop session with the host by
simply connecting to it using the host’s IP address.

Setting Up the Remote Desktop Client
After you have enabled the Remote Desktop host and you have determined how the
client(s) will connect to the host, you can configure the Remote Desktop client. In
Windows XP, the client software is known as Remote Desktop Connection (called
Terminal Services Client in previous versions of Windows). The Remote Desktop
Connection software enables a client to generate a terminal services connection
with the host. If you are using Windows XP Professional or Windows XP Home
Edition, there is nothing you need to configure. The Remote Desktop Connection
software is already installed and configured on the system. See the next section to
start a Remote Desktop session. If you are using Windows 2000, Windows NT 4.0,
Windows Me, Windows 98, or Windows 95, you must install the Remote Desktop
Connection software on those computers. The Remote Desktop Connection software
is found on the Windows XP CD-ROM. Insert the CD-ROM in the desired client and
choose Perform Additional Tasks, from the Welcome screen; then choose the
Remote Desktop Connection option. This will install the software. If you do not
have a Windows XP CD-ROM available, you can also download the software 
from Microsoft’s Web site at www.microsoft.com/windowsxp/pro/downloads/
rdclientdl.asp. Follow the simple setup instructions that appear.
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Creating a Remote Desktop Connection
After the host and client are configured as needed, you can establish a Remote
Desktop connection. To start the connection from a Windows XP client, 
click Start → All Programs → Accessories → Communications → Remote Desktop
Connection. If you are connecting from a downlevel client, click Start →
Programs → Accessories → Communications → Remote Desktop Connection. The
Remote Desktop Connection dialog box appears, as shown in Figure 13-4.

Figure 13-4: Remote Desktop Connection.

If you are connecting a host that resides on your LAN or WAN, simply enter the
computer’s name or IP address. If you are connecting through a VPN connection or
over the Internet, use the remote host’s IP address. After you have entered the name
or IP address, just click Connect. Once the connection is made, the screen turns
black, and you see a login dialog box. Enter a username and password of someone
who is a member of the Remote Desktop group, one who has administrative privi-
leges, or one who has been specifically assigned access to the Remote Desktop and
click OK. After the username and password have been accepted, the terminal win-
dow provides your remote desktop.

You can maximize and minimize the terminal window, as needed, and simply
use the remote computer through the terminal window, just as you would if you
were sitting locally at the computer. Keep in mind as you are working with the
Remote Desktop that you can open applications and create and save files. However,
the files you create, edit, and save are saved on the remote computer. For this rea-
son, you cannot save files to your local client desktop, and you cannot drag and
drop items from the terminal window (host computer) to your local computer
(client computer). You can use the terminal window to access network files
remotely, but keep in mind that the remote account you are using must have per-
mission to access items on the network.

Using Automatic Logon
To make Remote Desktop even easier, you can configure it to log on automatically.
For example, say that you access your Windows XP Professional computer at work
from a Windows XP Home computer most evenings. You can configure automatic
logon to make the process quicker and easier. To configure the automatic logon
option, follow these steps:
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Managing Multiple Users
When you are using Remote Desktop, you can easily connect to the remote computer
and use a terminal window. However, what happens if another user is accessing the
computer locally? For example, say that you have a Remote Desktop account to access
a computer from your home office. However, sometimes other administrators use the
Windows XP Professional computer at the office when you are not there. In this case,
one of two things can happen.

If Fast User Switching is enabled on the remote computer, the remote user sees a
message. The user sitting at the computer locally has the ability to reject your
message and keep you from logging on by clicking the No button. If no one is actually
sitting at the computer (but is logged on), the local user is logged off because no
response is given. In reality, the local user’s session remains logged on because Fast
User Switching is enabled, so all applications and all open files remain that way.
However, the local user will not be able to use the computer until you log off.

If Fast User Switching is not enabled on the remote computer, you have the option to
forcefully log the local user off the computer. The problem, however, is that the local
user will not have the option to save any open files. For this reason, it is best to use
Fast User Switching with Remote Desktop so that any local users accessing the
computer will not lose data. On the other hand, in this same scenario, a local
administrator can forcefully log on, disconnecting the remote user; or, if more than
one person uses the same account, the local user can always disconnect the remote
user. As you can see, you should put some thought into the management of users
when multiple people use the same machine. The best practice if you are working with
Remote Desktop is to give each user a different account and ensure that Fast User
Switching is enabled.

1. Click Start → All Programs → Accessories → Communications → Remote
Desktop Connection.

2. In the Remote Desktop Connection dialog box, click the Options button.

3. On the General tab that appears, enter the computer to which you want to
connect, the username, password, and domain (if necessary.) Click the
Save my password check box, shown in Figure 13-5.

4. Click the Save As button. By default, the settings are saved in an .RDP file
in My Documents with a filename of Default. If you want the settings you
entered to be your default settings, simply click Save. If not, give a differ-
ent name to the logon settings.

5. Click Connect to make the connection. From now on, you’ll not be asked
to provide the username and password when you make the Remote
Desktop connection.
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Figure 13-5: General tab.

Configuring Remote Desktop Options
Remote Desktop gives you some configuration options that help you make the most
of Remote Desktop, including some performance management features. If you are
using Remote Desktop to connect to a remote desktop over a LAN or WAN, perfor-
mance will probably not be an issue, because plenty of bandwidth is available.
However, what if you need to connect to a remote desktop using a dial-up connec-
tion, VPN connection, or over the Internet? In this case, the amount of graphics
that must be downloaded and displayed on your computer can cause Remote
Desktop to perform slowly.

For this reason, Windows XP gives you some performance options that can help
speed up Remote Desktop service, giving you better performance while removing
some of the graphical interface that tends to slow things down. Open the Remote
Desktop Connection, and in the Remote Desktop Connection dialog box, click the
Options button. You see several available tabs. Click the Experience tab, shown in
Figure 13-6.

Use the drop-down menu to select your connection speed, and use the check
boxes to specify further connection options. As you can see, reducing the usage of
items, such as Display Background, reduces the amount of bandwidth required to
transmit the images to your remote computer. You can adjust these settings, as
needed, until you find the performance level that meets your needs. Make sure you
leave the Bitmap caching option enabled. Bitmap caching allows your computer to
store bitmap images locally on your remote computer so that they do not have to
be downloaded each time they need to be displayed — this actually speeds up the
performance of the connection.
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Figure 13-6: Experience tab.

Local Group Policy configurations prevent the Experience features from

working correctly. The Windows XP Professional computer that functions as

the remote host might have local as well as site, domain, and OU policies

that prevent changing the Experience settings. If this is the case, talk to a

network administrator about changing the Group Policy settings so that

they are more lenient to allow the configuration of performance options.

You can also click the Display tab, shown in Figure 13-7, to modify how
Windows handles the remote session in the terminal window. You can specify the
resolution of the terminal window and the color depth. Again, lower settings help
conserve bandwidth — they might not look as good, but you will see performance
gains.

The Local Resources tab, shown in Figure 13-8, gives you some configuration
options that can also help performance. Three categories are found on this tab for
sound, keyboard, and local devices. You can choose to have sounds downloaded
and played locally, such as in the case of Windows events, but this option does
consume more bandwidth. The keyboard option allows you to use special key com-
binations that will operate when the remote session is open. The options you’ll find
here are self-explanatory. Finally, the Local devices option enables the mapping of
the following to the remote host:

◆ Client disk drives

◆ Printers
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◆ Serial ports

◆ Smart card devices

This option allows you to map drives from the remote host to your local com-
puter. For example, say you are working on the remote computer, but you want to
print the document on your home computer (remote client). This feature allows you
to do that, or even access information on your local drives from within the termi-
nal window.

Figure 13-7: The Remote Desktop Connection Display tab.

Figure 13-8: The Remote Desktop Connection Local Resources tab.
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Using Remote Desktop with Internet Explorer
If you travel with a laptop and you frequently use Remote Desktop over the
Internet, or if you need to access your remote desktop computer from a variety of
computers in different locations, you will use Internet Explorer to launch Remote
Desktop sessions, rather than using the Remote Desktop Connection software. If
you want to access Windows XP Professional Remote Desktop connections using
Internet Explorer, you must configure Internet Information Services (IIS) on
Windows XP Professional to allow the connection. After the configuration, you can
generate a terminal session using Internet Explorer 4.0 or later.

To configure the Windows XP Professional host to allow Web connections, you
must first install IIS. Open Add/Remove Programs in the Control Panel, and then
click the Add/Remove Windows Components button to install IIS. Then, you can
configure IIS to allow Remote Desktop, which runs the Remote Desktop Web
Connection software. Follow these steps:

1. Click Add/Remove Programs in the Control Panel.

2. Click Add/Remove Windows Components.

3. On the Windows Components Wizard page, select Internet Information
Services (IIS) and click the Details button.

4. In the Internet Information Services dialog box, select World Wide Web
Service and click Details.

5. In the World Wide Web Service dialog box, select Remote Desktop Web
Connection and click OK. Click OK again, and again to complete the 
wizard.

After the Remote Desktop Web Connection component is installed, you need to
set the permissions. Follow these steps:

1. Click Start → Control Panel → Administrative Tools → Internet Information
Services.

2. Expand the computer name, then navigate to Web Sites/Default Web Site/
tsweb.

3. Right-click the tsweb container and click Properties.

4. Click the Directory Security tab and click Edit under Anonymous Access
and Authentication Control.

5. In the Authentication Methods dialog box, ensure that anonymous access
is allowed and click OK. Anonymous access only gives a remote user
access to the IIS directory. Once connected, Remote Desktop will still
require a username and password.

Chapter 13: Remote Networking 273

549987 ch13.qxd  11/20/03  11:40 PM  Page 273



After the remote computer is configured to allow Web access to Remote Desktop,
you can use your client computer to connect. You must be using Internet Explorer
4 or later to connect to the remote desktop with a Web browser. If you are connect-
ing over the Internet to the remote computer, use the computer’s public IP address
to connect. If you are connecting through a RAS (Remote Access Server), make the
connection and use the name or IP address of the remote desktop to generate the
connection.

To connect to the remote desktop using Internet Explorer, open Internet Explorer
and type the default address, which is http://server/tsweb. Again, if you are
connecting over the Internet, use the public IP address to connect, as in http://
ipaddress/tsweb. You’ll see a Remote Desktop Web Connection screen.

When you first connect, you’ll probably see a Security Warning (depending on
your Internet Explorer configuration). The Remote Desktop installs an ActiveX con-
trol on your computer, so just click Yes to the Security Warning (if you do not,
Remote Desktop will not work). You’ll see the same logon dialog box. Enter your
username and password and click OK. The Remote Desktop session opens in
Internet Explorer or in full-screen mode, depending on your selection.

Concerning logon, when you arrive at the Remote Desktop Web Connection
window in Internet Explorer, you can select the Send logon information for this
connection check box. This provides you with the username and domain dialog
boxes. However, a better idea is to simply add the Remote Desktop to your Favorites
menu. This saves your server name, screen size, and username in the URL so you
can connect automatically by simply clicking the Favorites option. You’ll still have
to enter your password, but this method is much faster. Note that to make this
work, you must select the Send logon information for this connection check box
and enter your username and domain in the provided dialog boxes on the Remote
Desktop Web Connection page.

Using Remote Assistance
Windows XP provides a new and very helpful tool called Remote Assistance. You
can use Remote Assistance to remotely access another user’s Windows XP com-
puter for troubleshooting purposes. With permission, you can even remotely con-
trol the user’s computer to repair problems. Remote Assistance has far-reaching
implications in support situations, or even between two users over the Internet. I
live about 5 hours away from my sister who also uses Windows XP. If she has a
problem, she can just send me a remote assistance invitation, and I can connect to
her computer and control it remotely, just as I would using Remote Desktop.

When you use Remote Assistance, one user is termed the expert, while the user
who needs help is called the novice. When the novice properly authorizes the
expert, the expert can connect to the novice’s computer and see what is going on.
If the novice gives the expert full control, the expert can make configuration
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changes on the remote computer. For Remote Assistance to work, both users must
be connected to the same network or the Internet at the same time. Both must be
using Windows XP Professional or Home editions, and the novice user must be an
administrator on the local computer. Limited users cannot send remote assistance
invitations.

How Remote Assistance Works
Remote Assistance works with invitations. The novice user sends an invitation for
Remote Assistance to the expert user through e-mail or through Windows
Messenger. The expert user then accepts the invitation, which opens a terminal
window showing the novice user’s desktop. Using Windows Messenger, the novice
user and the expert user can even communicate with messages as the session is
taking place. The novice user can allow the expert user to simply view his or her
computer, or the novice user can give the expert full control.

The Remote Assistance invitation is made up of XML fields, containing data and
the novice user’s IP address. The expert’s computer connects to this IP address and
uses TCP port 3389 for the terminal session. All of these details are hidden from the
user, so the connection seems easy, immediate, and transparent.

As with Remote Desktop, Remote Assistance can present some problems when
connecting through a firewall. ICF works transparently with Remote Assistance,
automatically opening TCP port 3389 for the connection. So, if either (or both) the
novice or expert user(s) are running ICF, Remote Assistance will work automatically
without either having to configure anything. If you are using Windows Messenger
to make the connection, you shouldn’t have any problems with firewalls. Windows
Messenger is configured to work around the port issue, so if the firewall allows
Windows Messenger traffic, you should still be able to use Remote Assistance with-
out any trouble. If you are using a router or residential gateway, the router or resi-
dential gateway needs to support Universal Plug and Play (UPnP). UPnP is a
standard that allows devices to communicate with each other over a network. If
only one remote assistance computer is behind a NAT-based (Network Address
Translation) firewall, Remote Assistance should still work; however, if both are
behind a NAT firewall, the connection cannot be established. The lesson here is that
routers and residential gateways should support UPnP to allow Remote Assistance
to function. If you are about to purchase a router or residential gateway for your
network, make sure it supports UPnP to work around this problem.

Enabling Remote Assistance
To use Remote Assistance, you must first turn on the feature. Open the Control
Panel, then the System Applet. Click the Remote tab and select the Allow Remote
Assistance invitations to be sent from this computer option, as shown in 
Figure 13-9.
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Figure 13-9: The System Properties Remote tab.

After you turn on Remote Assistance, click the Advanced button. This opens the
Remote Assistance Settings dialog box (shown in Figure 13-10), which allows the
novice to give the expert full control of the computer, if desired, and to set a time
limit for the invitation to expire. By default, the invitation is good for 30 days.
After the time expires, the expert can no longer connect to the novice using the
invitation. You can adjust this expiration value as needed.

Figure 13-10: Remote Assistance Settings.

Requesting Help from an Expert
After Remote Assistance is enabled on the novice computer, the novice user can
easily request help from an expert. This can be done in three ways: 

◆ A Remote Assistance invitation can be sent through e-mail as an e-mail
attachment.

276 Windows XP for Power Users

549987 ch13.qxd  11/20/03  11:40 PM  Page 276



◆ A Remote Assistance invitation can be sent using Windows Messenger.

◆ A Remote Assistance invitation can be sent manually by copying the
Remote Assistance (RA) ticket onto a floppy disk and hand delivering it to
the expert.

When the novice is ready to request help from the expert, the novice uses the
Windows XP Help and Support center to generate the ticket. The process is easy,
and the following steps guide you through it. Remember that if you are using
Remote Assistance over the Internet and a dial-up connection is in use on the
novice computer, you must connect to the Internet before creating the invitation so
that the correct public IP address can be used. Because you typically receive a dif-
ferent IP address each time you connect, you must connect and stay connected for
the duration of the invitation and the session, or you’ll have to cancel the invitation
and send another one, because the expert will not receive the correct IP address if a
disconnect occurs.

1. Click Start → Help and Support.

2. In the middle-to-upper-right portion of the window that appears (in the
Help and Support Center) notice there is a section titled “Ask for
Assistance.” Click on the green square beside Invite a friend to connect to
your computer with Remote Assistance.

3. Now the Remote Assistance portion of the Help and Support Center
should be open. Select the Invite someone to help you option, as shown
in Figure 13-11.

Figure 13-11: The Help and Support Center.
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After the Invite someone to help you link has been clicked, there are three 
possible methods for sending a request from a novice to an expert:

◆ Windows Messenger — Click the Sign In button in the Windows XP Help
and Support Center. After you are signed into Windows Messenger, choose
a name and click Invite This Person. The expert receives the request in
Windows Messenger and can accept the Invitation. If you want to use
Windows Messenger, you can also bypass the Windows XP Help and
Support Center and request help directly through Windows Messenger by
clicking Actions → Ask for Remote Assistance, from the Windows
Messenger toolbar.

◆ E-mail — You can send the invitation via e-mail by entering the e-mail
address in the box provided in the Windows XP Help and Support Center
and clicking Invite This Person. In the next window that appears, enter
your name and a message and click Continue. In the next window, specify
a time duration for the invitation and enter a password the expert user
must enter to access your computer. Click Send Invitation. The message is
entered in your default e-mail client (such as Outlook Express). The e-mail
contains instructions and a file called rcBuddy.MsRcIncident. When the
user receives the file, he or she can double-click it to start the Remote
Assistance session.

◆ Invitation file — If you cannot e-mail the invitation or use Windows
Messenger, you can save the invitation as a file, which can then be hand
delivered to the desired recipient. Using this option, you can also enter a
duration for the invitation and a password. The File is saved as
RAInvitation. You can then transfer the file by hand, in an e-mail, or via
a network share.

After the expert accepts the invitation and the connection takes place, the termi-
nal session begins. The novice user receives a message that the invitation has been
accepted. A terminal window appears on both the novice and expert user’s com-
puter, and a chat dialog box appears so that the two users can talk to each other
during the session. The session appears in real time and, depending on network
conditions, can be slow at times. If the novice has given the expert the option to
take control, the expert can simply click the Take Control button that appears in
Remote Assistance. At any time during the session, the novice can get control of
the session and end it by clicking the Stop Control button, and pressing the ESC key
or CTRL+C.
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Chapter 14

Internet Access, ICS, and
ICF
IN THIS CHAPTER

◆ Configuring Internet connections

◆ Using Internet Connection Sharing

◆ Configuring Internet Connection Firewall

ONLY A FEW YEARS AGO, Internet connections were reserved for computer enthusi-
asts who were willing to tolerate the slow Internet connections of the day just to be
able to browse the World Wide Web. Today, millions upon millions of users are con-
nected to the Internet; it has become a part of our lives. As such, computer users
expect operating systems to be friendly to the Internet and help out with connec-
tions and features. Windows XP meets this need by providing a number of tools
and configuration options to help you set up and manage your Internet connection.
This chapter explores Internet connections, along with Internet Connection Sharing
and Windows XP’s new Internet Connection Firewall (ICF).

Exploring Internet Connections
An Internet connection is basically a connection to a remote server. With an Internet
connection, you enable your computer to connect to a remote server at an Internet
service provider (ISP). This server then facilitates your connection to the Internet by
retrieving the data you need from various Web servers. To create an Internet con-
nection, your computer needs both hardware and software. The computer has to be
outfitted with some kind of connection hardware, such as a dial-up modem, DSL
modem, cable modem, satellite connection, or other type of broadband hardware
that is available. With the proper hardware, you’ll also need an account with an
ISP. The account includes a username and password that must be used by the con-
nection software to validate your identity and give you Internet access. After you
have the necessary hardware and your account with an ISP, you must use Windows
XP to create a connection that can use the hardware and the account to connect to
the ISP.
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So, what kind of connection should you choose? That all depends on your needs
and how much per month you are willing to pay. A standard dial-up connection
will only give you  48-Kbps transfer speed at best, but they are fairly cheap (often
under $20). For much faster service, DSL and cable connections give you broad-
band access at various speeds from 200 Kbps to over 1 Mb, in some cases. These
services can range anywhere from $30 per month to over $100 for very fast con-
nections. If you live out of cable or DSL range, you can also get satellite access
through companies such as StarBand (www.starband.com) or DirecWay
(www.direcway.com). Satellite access is not as fast as DSL or cable and it is more
expensive, but it does provide broadband access at a reasonable rate. In case you
are wondering, larger corporations most often use broadband connections, such as
T1 or T3 links, often costing thousands of dollars per month. As you look at your
Internet needs, you’ll have to find a balance between what is available and what
you are willing to pay each month. If you are interested in a few more details about
the different types of connections, the following list outlines them for you.

◆ Dial-up — Basically, all areas of the United States provide some type of
dial-up service. Dial-up service requires a modem and a phone line, and
your computer dials a phone number to connect to an ISP server. Dial-up
connections are the most common type of Internet connections used
today. Most dial-up connections cost around $20 per month for unlimited
use. The greatest drawback is that all modem connections are slow by
today’s standard. Phone line limits restrict modems to 56-Kbps transfer,
with around 45-Kbps transfer being the reality. Considering the multime-
dia nature of today’s Internet, this speed is rather slow, and you’ll spend a
lot of time waiting for pages to load. Additionally, the use of streaming
media and even Internet radio is difficult to use. If you need Internet
access for a small office, all computers will share the dial-up connection,
which will further reduce the amount of available bandwidth.

◆ Digital Subscriber Line (DSL) — DSL is a broadband technology that has
become very popular during the past few years. DSL provides broadband
throughput, with speeds often between 400 Kbps and 8 Mbps, depending
on your area. Also, DSL is an always-on technology, meaning the com-
puter is always connected to the Internet and there is no need to dial a
connection. DSL also works with public telephone lines, but different
channels are used to transmit high-speed data. This feature allows DSL to
always be connected, but voice calls can be made over the line at the
same time. DSL requires a special DSL modem that connects to your com-
puter, which is often included for free when you sign up for service. DSL
service typically costs around $40 per month for basic, beginning service,
and quite a bit more depending on the speed you want, but it is, unfortu-
nately, not available in all areas. DSL hardware typically requires a USB
or Ethernet connection to your computer.
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◆ Cable — Cable Internet connections are another form of broadband con-
nection and a direct competitor with DSL. Cable Internet uses a typical
coaxial cable attached to your computer, just as you would use a coaxial
cable with your television. Access to the Internet is performed over the
cable connection and your cable company or service provider provides an
always-on service, just as you would receive cable television. In the past,
cable connections worked well, but often did not have the bandwidth of
DSL. However, with new cable implementations, the cable access speed is
just as fast as DSL and sometimes faster. As with DSL, you can expect to
pay around $40 a month for cable Internet. Cable modems typically
require an Ethernet or USB connection to your computer.

◆ Satellite — Satellite connections are relatively new in the Internet market
and are the least popular type of Internet connectivity available. However,
for people who cannot get other types of broadband connections, satellite
connectivity is a good broadband solution, providing on average 300-
Kbps transfer. However, it is not as fast as DSL and cable and costs con-
siderably more. The satellite disk equipment generally costs around $500
and monthly, unlimited access is around $60. Satellite connections work
with a satellite modem that connects to your computer through a USB or
Ethernet port.

Configuring Internet Connections
After you have the hardware installed on the computer and the account informa-
tion from the ISP, you can create an Internet connection on Windows XP that you
can use to access the Internet. Note that some ISPs give you an installation disk and
specific setup instructions for your computer, which are often necessary for broad-
band connections. You should follow the ISP’s instructions for creating the
Internet. However, if you need to create a connection without ISP software,
Windows XP can help you create that connection with the New Connection Wizard.
The following steps show you how to create an Internet connection using the New
Connection Wizard.

It is a good idea to check out your ISP’s instructions for setting up an Internet

connection. Some ISPs, particularly broadband companies, provide you with

their own setup wizard. So, use the New Connection Wizard if necessary,

but be sure to follow any additional or different instructions provided by

your ISP.

1. Click Start → Control Panel, and open the Network Connections folder.

2. In the Network Tasks dialog box, click the Create a New Connection link.
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3. The New Connection Wizard appears. Click Next.

4. In the Network Connection Type window, shown in Figure 14-1, you can
choose the kind of connection that you want to create. Select the Connect
to the Internet radio button and click Next.

Figure 14-1: Choose the Connect to the Internet option.

5. In the Getting Ready window, you can choose from a list of ISPs if you do
not have an account. This process opens a connection to a referral service
so you can sign up with available service providers on the Internet. If you
have an installation CD, you can also choose the option to run setup from
the CD. Finally, you can choose the manual setup option, which is shown
in the rest of the wizard steps here.

6. In the Internet Connection window, choose the type of connection that
you are using, such as a dial-up, broadband that is always on, or broad-
band that requires a username and password. Make your selection and
click Next, as shown in Figure 14-2. Because you are most likely to use
the New Connection Wizard to set up modem connections, the rest of the
steps focus on that option.

7. In the Connection Name window, enter a name for the connection and
click Next. The name should be something memory-friendly that distin-
guishes the connection from other connections.

8. In the Phone Number window, enter the phone number required to dial
the ISP and click Next.
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9. In the Internet Account Information window, shown in Figure 14-3, enter
your username and password and click the check box options that you
want to use. Note that the account can be used by anyone using your
computer, or just you. You can also make the connection the default 
connection, and you can turn on the Internet Connection Firewall. Make
your entries and selections and click Next.

10. Click Finish. The new connection now appears in the Network
Connections folder.

Figure 14-2: Choose the type of connection.

You might notice the reference to Point-to-Point Protocol over Ethernet

(PPPoE) when you select the type of connection that you want to create.

PPPoE is used with broadband Internet connections that require a user-

name and password (not always connected); it is specifically a protocol used

by some broadband connections for access to the Internet. PPPoE is

designed for users on a local area network (using standard Ethernet) who

access the Internet over that Ethernet network through a broadband con-

nection. In other words, Point-to-Point protocol, which is used on the

Internet, functions over Ethernet to provide Internet access to these users.

With PPPoE, each user can have a different access configuration, even

though they all reside on the same LAN. ISPs also use PPPoE to control the

use of static IP addresses.You can learn more about PPPoE by accessing RFC

2516 on the Internet.
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Figure 14-3: Enter the ISP assigned username and password.

Starting a Connection
If you use a dial-up connection, a connection to the ISP must be established each
time you want to connect to the Internet. If you are using a broadband connection,
the connection is always on. To launch a dial-up connection, you can use the con-
nection icon that appears in the Network Connections folder, now that you have
created the connection. Or, you can access the connection by clicking Start →
Connect To and clicking the connection. As you can see in Figure 14-4, all connec-
tions are found in the Network Connections folder.

Figure 14-4: Network Connections folder.
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If you are using a dial-up connection, you’ll need to launch a connection to your
ISP each time you want to use the Internet. You can do so from within Network
Connections by double-clicking the connection icon, or by right-clicking the con-
nection icon and clicking Connect. A connection window appears, as shown in
Figure 14-5.

Figure 14-5: The Connect Dial Up dialog box.

Enter your username and password for the ISP. Notice that you can choose to
save the username and password so you don’t have to retype it each time. You can
save the password for yourself only, which allows the connection to be used only
with your user account, or you can choose to allow anyone who uses the computer
to use the Internet connection. The phone number you entered appears by default.
Click Dial to make the connection.

You should be aware of one security issue — if you use the Me only option, you
are the only one who can launch the connection. However, if you leave the com-
puter unattended, anyone who sits at the computer while you are logged on can
launch the connection. If you want to make certain that no one can ever use the
connection, simply leave the Save this username and password for the following
users check box disabled, which will disable both suboptions. This way, you’ll have
to supply the username and password each time you connect.

Managing Dial-Up Connections
As with most Windows features, dial-up connections have properties pages that
enable you to configure the connection and manage its behavior. In many cases,
frustrations and problems with dial-up connections can be solved by making
changes to dial-up connection properties, but you need to know what changes can
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and should be made. The properties pages have a number of settings that determine
how the connection operates; those settings are covered in the following sections.

General Tab
On the General tab of the Dial Up Properties dialog box, you have a few different
items, as shown in Figure 14-6:

◆ Modem configuration — If you click the Configure button, you can
access the modem’s properties pages and make configuration changes, as
desired. (See Chapter 4 to learn more about modem configuration and
other hardware.) 

◆ Phone numbers — You can configure alternative phone numbers that can
be used with the connection, and you can configure dialing rules.

◆ Notification — Use the check box at the bottom of the page to display an
icon in the Notification Area when connected.

Figure 14-6: General tab.

You might notice the option for Dialing Rules on the General tab. Dialing rules
tell Windows XP how to handle area codes, long-distance calls, and even calling
cards. In other words, area code rules help Windows XP know what calls are 
local, which ones are long distance, and how certain phone numbers should be
handled. See the section, Configuring Dialing Rules later in this chapter for more
information.
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Options Tab
The Options tab, shown in Figure 14-7, gives you a few dialing and redialing
options, as follows:

◆ Display progress while connecting — If you want to see the connection
progress as the connection is being made, click this check box. If it is
cleared, you won’t be advised of any progress during the connection
process.

◆ Prompt for name and password, certificate, etc. — If you want to be
prompted for the username, password, certificate, and so on during the
connection, check this option. If this information is entered in the connec-
tion and you don’t want to have to reenter it each time, do not use this
option.

◆ Include Windows logon domain — This option, which can only be used in
conjunction with the Prompt for name and password, certificate, etc.
option, requests the Windows domain for logon purposes. Generally, when
dialing to an ISP, you do not need this option. If you were dialing to a
corporate server using a Windows domain, this option would be helpful.

◆ Prompt for phone number — This option allows you to see, modify, and
select the phone number that will be used when dialing the connection. If
you only use one phone number, you can simply clear this check box
option.

◆ Redial attempts — If the first dial connection is not successful, Windows
can automatically redial the number. Use the selection box to determine
how many times Windows tries to redial the connection before stopping.
The default is 3.

◆ Time between redial attempts — By default, Windows XP waits 1 minute
between each redial attempt. You can change this value, if desired.

◆ Idle time before hanging up — If you want the connection to automati-
cally disconnect after a certain period of idle time, enter the value here.
Use Never if you do not want the connection to automatically disconnect.

◆ Redial if line is dropped — If you lose the connection, this option will
have Windows XP automatically try to redial the connection.

◆ X.25 — If you are logging on to an X.25 network, click the X.25 button
and enter the X.25 network provider and the remote server information,
as required.
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Figure 14-7: The Options tab.

Security Tab
The Security tab, shown in Figure 14-8, provides security settings for the dial-up
connection. By default, the Typical connection options are used. This validates your
username and password with the ISP’s server. Notice that you also have Advanced
connection options, but these options are generally used for dial-up connections to
corporate networks, not to ISP servers. Do not change any of the settings on this
tab unless explicitly instructed to do so by your ISP. Incorrectly changing these set-
tings will stop your computer from successfully logging on to the ISP.

Figure 14-8: The Security tab.
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Networking Tab
The Networking tab, shown in Figure 14-9, shows you the current networking ser-
vices and protocols that are used for the connection. If you need additional services
or protocols for the connection, use the Install button to add them. In most cases,
for ISP connections, there is nothing you need to configure here.

Figure 14-9: The Networking tab.

Advanced Tab
The Advanced tab enables you to turn on Internet Connection Firewall and Internet
Connection Sharing, which you learn more about later in this chapter.

Common Connection Problems
It’s no secret that dial-up connections can cause you some problems, due primarily
to the nature of the connection over a public phone line. In many cases, there isn’t
much you can do, but keep the following quick fixes to some common problems in
mind:

◆ Connections drop — Due to problems with phone line noise and/or prob-
lems with the ISP, connections can be dropped. Generally, there’s nothing
to do but redial the number. Keep in mind that the Options tab enables
Windows XP to automatically redial if the connection is dropped, so you
might want to make sure this option is enabled. If drops occur often, you
should call technical support at your ISP for assistance.
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◆ Connections are automatically disconnected — As a safety measure to
keep connections from staying connected when in use, the Options tab
has an auto-disconnect option. After the connection is idle for a certain
period of time, the connection is disconnected automatically. If you do not
want to use this option, however, simply disable it on the Options tab.

◆ Connections are slow — Slow connections can occur for a number of rea-
sons, most of which are beyond your control. Modem speeds at your ISP,
phone line congestion, and even phone line noise can contribute to this
problem. If the modem seems to always connect at a low speed, make sure
you have the correct modem driver installed. Otherwise, call the ISP for
support.

◆ Username and password prompts — You can have Windows XP prompt
you for the username and password, and even the phone number, each
time a connection is made to the ISP. If you do not want to use these
options, turn them off on the Options tab.

◆ A “1” is always dialed when dialing phone numbers — If a 1 is always
dialed, you need to edit the area code rules properties from the General tab.

◆ The logon fails each time during authentication — If the logon fails dur-
ing authentication, make sure you are using an appropriate username and
password for the connection. Remember that your password might be
case-sensitive. Also, check the Security tab and make sure you are using
settings that are compatible with the ISP. If all seems to be in order, con-
tact the ISP for assistance.

Configuring Dialing Rules
As mentioned earlier in this chapter, dialing rules enable you to configure how the
modem dials various phone numbers. Because some locations require an area code,
others do not, some require that you dial 9 to get an outside line, and so forth, the
dialing rules options enable you to tell Windows XP how to dial your connection,
regardless of your specific needs. Just follow these steps:

1. On the Dial Up Properties General tab, click the Use dialing rules check
box; then click the Dialing Rules button.

2. The Phone and Modem Options window appears, as shown in Figure 14-10.
On the Dialing Rules tab, you see the current location that is configured.
You can choose to edit the existing location or create a new one by click-
ing the appropriate button. Regardless of whether you choose to edit a
current location or create a new one, the same configuration dialog box
appears.
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Figure 14-10: Phone and Modem Options — Dialing Rules.

3. The New or Edit Location window appears. On the General tab, shown in
Figure 14-11, enter the area code and country/region the area code is
found in; then use the Dialing rules boxes to determine the rules concern-
ing the use of the area code. You can also choose to disable call waiting
and choose tone or pulse dialing.

Figure 14-11: New Location settings.

Chapter 14: Internet Access, ICS, and ICF 291

549987 ch14.qxd  11/20/03  11:40 PM  Page 291



4. Click the Area Code Rules tab. Area code rules determine how phone
numbers are dialed within your current location as well as other locations.
To create an area code rule, click the New button.

5. In the New Area Code Rule dialog box, shown in Figure 14-12, enter the
area code to which this rule applies. Then, you can enter a list of prefixes
that can be used with the area code, or accept the default that all prefixes
you use can work with the area code. For example, say the area code is
214. You only want to use 564 and 569 prefixes with that area code. In
this case, click the Include only the prefixes in the list below button and
click Add to enter those prefixes. If you do not place any prefix restric-
tions, Windows XP will assume that any prefix you dial can be used with
the area code. At the bottom of the dialog box, use the check boxes to
determine if a 1 should be dialed when using the area code, and if the
area code should be dialed when using the prefixes. For example, if a dial-
out number is 214-564-1234, and the area code is required each time you
dial the number, click the Include the area code check box. Click OK.

Figure 14-12: New Area Code Rule.

6. The new area code rule now appears in the Area Code Rules tab. You can
create new area codes and edit existing ones at any time on this tab.

7. Click the Calling Card tab. If you need to use a Calling Card to make the
connection, such as in the case of dialing a long-distance number when
you are traveling with a laptop, enter your card information, as necessary,
on the Calling Card tab, shown in Figure 14-13. Click OK to save your
changes.
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Figure 14-13: Calling Card tab.

Sharing an Internet Connection
As with previous versions of Windows, Windows XP gives you the option to share
your Internet connection. You can share the Internet connection when you first cre-
ate the connection using the New Connection Wizard, explored in the previous sec-
tion, and you can also share an Internet connection when you run the Network
Setup Wizard (refer to Chapter 11 for more information on the Network Setup
Wizard). When you use Internet Connection Sharing (ICS), a single computer on the
network becomes the ICS host, and all other computers on the network access the
Internet through the ICS host’s Internet connection. This feature enables you to
have one Internet connection utilized by multiple computers.

As you are thinking about sharing an Internet connection, it is important to

think about how the connection will be used. You can share any kind of

Internet connection that you want, even a dial-up connection, but if multiple

people are accessing the same connection, your bandwidth might run low.

For this reason, broadband connections, such as DSL and cable, work better

with ICS because they can provide much greater bandwidth. However, don’t

be fooled. Even some cable connections are relatively slow if several people

are accessing the Internet at the same time, particularly if those users are

accessing Internet multimedia applications or downloading programs and

files. As with most decisions, you’ll need to strike a balance between what

you need, what kind of connection is available, and what you can afford.
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Understanding ICS
When you enable the ICS host, the ICS host computer becomes an Internet gateway
for the other computers on your network. When ICS is enabled, the ICS host uses
the IP address of 192.168.0.1. Essentially, the ICS host becomes a Dynamic Host
Configuration Protocol (DHCP) server for the other clients on your network, assign-
ing IP addresses as needed. All other ICS clients on your network see the host com-
puter as the gateway, and no other computer on your network can use the same
address. When a client computer needs to access the Internet, a request is sent to
the shared connection, which causes the ICS host to connect to the Internet and
retrieve the requested information. To ICS client users, it appears as though their
computers are directly connected to the Internet. Clients can use the Internet and
retrieve e-mail seamlessly.

When you choose an ICS host while using the Network Setup Wizard, several
things are configured on the ICS host. First, the local area connection for your
internal network interface card (NIC) is configured as 192.168.0.1, with a subnet
mask of 255.255.255.0. If the ICS host has more than one NIC for your workgroup,
such as in the case of a multisegment network, you need to bridge those connec-
tions so that both network segments can use ICS. Next, the DHCP Allocator service
is configured on the ICS host. When additional network clients are added to the
network, this service automatically assigns IP addresses to those clients. As previ-
ously mentioned, the DHCP Allocator service allows the Windows XP computer to
act as a DHCP server. The IP addresses range from 192.168.0.2 through
192.168.0.254 with a subnet mask of 255.255.255.0. A DNS proxy is also enabled
so that additional Domain Name System (DNS) servers are not required on your
network. These services run automatically in the background, and they require no
additional configuration. Finally, if a modem connection is used on the ICS host,
autodial is turned on by default so that the connection is automatically dialed when
an ICS client makes a request to the Internet.

ICS will work on client computers running any version of Windows XP,
Windows 2000, Windows Me, Windows 98, Windows NT, and Windows 95. To con-
figure the clients, run the Network Setup Wizard from the Windows XP installation
CD or from a setup disk you create. The wizard enables ICS Discovery and Control
on the downlevel clients so they can access the ICS host. You need to also make
sure that the downlevel clients are running Microsoft Internet Explorer 5.0 or later.

You might have noticed that the configuration options are performed when

you configure ICS using the Network Setup Wizard. Of course, you can also

turn on ICS using the Advanced tab of the Internet connection’s properties.

Which way is correct? If you are using all Windows XP computers on the

network, enable the ICS feature on the Advanced tab, but if you are using
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downlevel clients, it is best to use the Network Setup Wizard so that the

DHCP Allocator service will be configured. Then, run the Network Setup

Wizard on the client computers as well. Otherwise, the client computers

might have problems connecting to the Windows XP host. When in doubt,

use the Network Setup Wizard on the host and all client computers. This is

your best way to get the service up and running and all computers con-

nected quickly and easily.

Working with ICS
After ICS is configured, it is generally easy to use and not something you have to
spend your time worrying about, but you should note some settings and features, as
you may need to use them from time to time.

You access the ICS settings for the shared Internet connection by opening
Network Connections on the host computer. Right-click the shared Internet connec-
tion (the icon appears with a hand under it to indicate it is shared), and click
Properties. In the Dial Up Properties dialog box, click the Advanced tab, as shown
in Figure 14-14. There are three options concerning ICS:

Figure 14-14: ICS host settings.

◆ Allow other network users to connect through this computer’s Internet
connection — This option essentially enables or disables ICS. If you want
to stop sharing the connection at some point in the future, clear this check
box, which automatically clears the other check box options as well.
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◆ Establish a dial-up connection whenever a computer on my network
attempts to access the Internet — You’ll only see this option if you are
sharing a dial-up connection. This option allows Windows XP to automat-
ically dial the connection when another computer in the workgroup
attempts to use the Internet. If this selection is cleared, ICS clients will
only be able to use the Internet when the ICS host computer is dialed up
to the Internet manually. Under most circumstances, enabling this auto-
dial setting is the best choice.

◆ Allow other network users to control or disable the shared Internet
connection — This option, which is new in Windows XP, allows ICS clients
to essentially control the connection. In a small home or office network,
this setting might work well. Basically, users can manage the shared con-
nection as though it was physically located on their computers.

As noted in the preceding list, you can enable or disable client management of
the shared Internet connection. Consider this example: What do you do if you do
not have access to the ICS host computer, but you need to disconnect the dial-up
Internet connection to free up a shared telephone line? How can you find out if the
connection appears to be working? ICS in Windows XP addresses these problems
by allowing users to control and disconnect the Internet connection from any ICS
client computer (not just from the ICS host computer). This feature is provided by
ICS Discovery and Control, which broadcasts the availability of shared Internet
connections from the host to client computers so they can use them. If you are
using a broadband or always-on connection, these issues are not as important, but
by default, client control of the Internet connection is enabled. When ICS Discovery
and Control is in effect, the ICS host allows the ICS clients to discover the connec-
tion and manage it. Specifically, network clients can view Internet connection sta-
tistics, monitor the status of the connection, and connect and disconnect the
connection to the ISP.

As long as the ICS host administrator does not disable ICS Discovery and Control
by clearing the Allow other network users to control or disable the shared Internet
connection check box on the Advanced tab of the shared connection’s properties
dialog box, clients can perform these actions. After ICS is set up, ICS clients will see
a category named Internet Gateway in the Network Connections folder, which con-
tains the icon of the shared Internet connection, as shown in Figure 14-15.

To use Internet Gateway to control the shared connection, double-click the icon
to see a status dialog box, as shown in Figure 14-16. You can view the status, dura-
tion of the connection, its speed, and a count of packets sent and received through
the gateway. Notice that you can click Disable to stop the connection from work-
ing. If other users are accessing the Internet at the time, they are disconnected as
well.
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Figure 14-15: Internet Gateway.

Figure 14-16: Internet Gateway status.

If you click the Properties button, a simple dialog box appears telling you which
connection you are using, as shown in Figure 14-17. You can select the Show icon
in notification area when connected option at the bottom of this dialog box to give
yourself quick access to this Internet connection from the Windows desktop. Click
the Settings button.

The Services tab of the Advanced Settings dialog box appears, as shown in
Figure 14-18. This dialog box lets you select which services you want ICF to allow
to run on your network. By default, most of these services are disabled for security
reasons, and you don’t need to enable them for typical Internet activities. Do not
enable any services that you don’t actually need to use without knowing the secu-
rity risks involved. Note that the Advanced Settings options are not available if the
host computer is not configured to allow users to manage the Internet connection.
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Figure 14-17: Use this tab to show the Internet Gateway in the notification area.

Figure 14-18: Enable or disable services.

Configuring Internet Connection
Firewall
With the Internet comes the typical trouble one might expect from a worldwide
network — hacker attacks and malicious content. Just as none of us can leave our
front doors unlocked at night, your computer connected to the World Wide Web is
subject to attack if you do not have some kind of protection. In the past, the fire-
wall concept was limited only to large corporations. Today, firewalls are readily
available for the home PC. Windows XP includes its own built-in firewall, called
the Internet Connection Firewall (ICF).
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ICF was specifically developed to protect modem and broadband Internet

connections — it was not designed for large networks where other types of

Internet access are used. In those networks, firewall hardware or software on

Windows 2000 servers is used to control and manage Internet access. ICF,

however, was designed for a local computer or a local computer that is pro-

viding a shared Internet connection to other computers on a small network.

As such, if your computer is part of a Windows domain, do not enable ICF, or

you’ll probably lose all of your network connectivity.

ICF works with an Internet connection to provide security from external attacks.
ICF uses a table method of protection, where ICF keeps track of all requests (and
answers) that are made to the Internet. Anything that you do not explicitly request
from the Internet is blocked by the firewall. Consider an example of accessing a
typical Web page. Using your Web browser, you request a Web page. ICF makes an
entry in its table noting the page you are requesting. When the Web page is served
back to the computer, ICF examines the IP packets and looks at the IP addresses. If
ICF finds a match after comparing the IP address of the traffic arriving against the
table entry, it determines that the IP traffic was requested and allows the traffic to
enter the computer. In the same situation, should any traffic arrive at the firewall
that does not match an IP address listed in the table, the IP packets are dropped and
are not allowed to enter the computer. ICF is considered a stateful firewall, because
it examines all traffic passing in and out of the firewall and makes decisions con-
cerning that traffic, as needed. In other words, ICF considers the current state of the
packets and determines whether they are allowed or not based on the ICF table.

You can use ICF with ICS. Just enable ICF on the ICS host computer and your

entire network is protected from Internet intruders.

Because all inbound traffic is dropped unless it has been specifically requested
from an internal network client, ICF blocks some types of traffic that you might
actually want on your network. For example, all incoming Internet Control
Message Protocol (ICMP) traffic (such as ping requests) is blocked, as is all Remote
Desktop traffic. So, ICF provides you with a way to override the table configuration
for certain services.

Overall, ICS is easy to use, and you can get the protection you need if you sim-
ply follow a few important principles. First, all Internet connections should be fire-
walled. For example, if your computer has a broadband connection to the Internet
as well as a dial-up connection to the Internet, both the broadband connection and
the dial-up connection should be firewalled for complete protection. Failure to turn
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on ICF for one of the Internet connections is considered a security breach because
your computer or network will not be protected whenever that connection is used.
Second, internal network connections should not be firewalled. NICs used to com-
municate on your local network must not be firewalled. If they are, computers on
the network will not be able to access your computer because the ICF table will not
allow any network traffic to enter the computer that is not explicitly requested 
by you. ICF is used on the Internet connection only, not on any internal network
connections.

ICF does not protect you from every possible threat. ICF does not protect you
from viruses; it doesn’t detect downloaded viruses and e-mail viruses. You must use
antivirus software with ICF for complete protection against these dangers. See
www.symantec.com and www.mcafee.com for more information about antivirus
products for Windows XP. 
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Changing ICS Hosts
Networks change over time, and, as such, you might add new client computers or
remove existing client computers, or you might even need to change the Windows XP
computer that is functioning as the ICS host. If you need to change the ICS host, note
that Windows XP will not allow another computer on the network to become the ICS
host until you remove ICS on the original host. If you try to enable another computer
as the ICS host, you’ll receive a Network Connections error message.

To change the ICS host to another computer, follow these steps:

1. Disable the ICS host computer by clearing the Allow other network users to
connect through this computer’s Internet connection option on the Advanced
tab of the Internet connection’s properties dialog box. This will clear the
former ICS host’s IP address.

2. On the computer you want to become the new ICS host, run the Network
Setup Wizard again, and choose the This computer connects directly to the
Internet option. The other computers on your network connect to the
Internet through this computer. When prompted, select the Internet connec-
tion directly connected to this computer that you will be sharing with the
rest of the workgroup.

3. After the ICS host computer setup is complete, run the Network Setup
Wizard on the client computers so that they will be configured to use the
new ICS host. Choose the This computer connects to the Internet through
another computer on my network or through a Residential Gateway option
for each client computer.
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ICF does not protect you from Trojan horse viruses. Once they get into your
computer (usually in e-mail you receive), Trojan horse viruses gather information
from your computer, such as addresses from an e-mail address book, and send
themselves to your contacts, spreading themselves further. Because ICF is only con-
cerned with inbound traffic, ICF does not inspect outbound traffic for these threats.
To ensure that your computer is not using Trojan horses or other viruses, you need
a program that can safeguard your computer. Some third-party firewall products,
such as ZoneAlarm (www.zonealarm.com), provide this kind of protection, but you
should always use a combination of firewall and antivirus software for complete
protection. 

Finally, ICF does not protect you from internal attacks and threats. ICF only pro-
tects your Internet connection. If an internal user on your network decides to attack
other computers inside the network, ICF provides no protection. Typically, however,
in a home or small office network, this is not a serious issue.

Setting Up ICF
ICF is easy to set up and configure on Windows XP. This section shows you how to
enable and configure ICF. Note that you must be logged on as a local computer
administrator to enable and configure ICF.

You can enable ICF quickly and easily using a single check box. Click Start →
Connect To → Show All Connections. In the Network Connections window, right-
click the Internet connection on which you want to enable ICF, and click Properties.
In the Dial Up Properties dialog box, click the Advanced tab, as shown in 
Figure 14-19. In the Internet Connection Firewall section, select the Protect my
computer and network by limiting or preventing access to this computer from the
Internet check box and click OK. The connection is now firewalled.
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When Not to Use ICF
You should not use ICF if you are using another firewall product, such as a residential
gateway or another firewall software product. You should only use one firewall
product, whether that product is a hardware or software solution. Multiple firewall
products usually do not work together and can cause you to lose your Internet
connection. Also, never firewall a NIC that is used to connect to other computers on
your network including a connection to a proxy server or firewall server. ICF is
designed for home and small office use and will cause network communication
problems if you try to use it on a Windows domain on which you are using virtual
private networking (VPN). ICF does not work with VPN connections and will hinder
communication.
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Figure 14-19: Turn on ICF on the Advanced tab.

Enabling Services
Because ICF blocks all incoming communication that is not explicitly requested,
some services will not work with ICF unless you make further configurations. For
example, say that you are hosting a Web site on your computer. If users try to
access the Web site, the traffic coming to your computer is not solicited, so the
packets would be dropped. Or, you might want to access your computer from a
remote location using Remote Desktop. ICF will not allow the communication
because it is not solicited. Because ICF’s blocking functions by default affect all
protocols and TCP ports, you might want to override the ICF behavior for certain
services so that they will work with ICF. To enable a service to work with ICF, fol-
low these steps:

Do not turn on these services unless you are providing them from your com-

puter. For example, you don’t need to turn on Web Server to access Web

servers on the Internet.You only need to enable this option if your computer

is a Web server and hosting a Web site to the Internet.

1. Click Start → Network Connections → Show All Connections.

2. Right-click the ICF-protected connection and click Properties.

3. Select the Advanced tab and click the Settings button.
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4. On the Services tab of the Advanced Settings dialog box, shown in
Figure 14-20, select each service that you want to enable. Remote
Desktop is enabled in this figure.

Figure 14-20: Enable services to work with ICF.

5. When you first select a service, the Service Settings dialog box appears for
that service, showing its default settings, including the name of the net-
work computer on which the service is to be enabled. If you want to
enable the service for a different computer on your network, type its name
or IP address in the Name box.

6. Click OK on the Settings tab. You can adjust these settings at any time by
selecting the service and clicking the Edit button.

7. If you want to enable a service that is not listed, click the Add button, and
enter the service name, address, and port numbers.

8. Click OK to close each dialog box when you are done.

The predefined services listed on the Services tab are the ones most often used.
However, what if you are using a custom service? For example, your computer
might host a custom application that other users access via the Internet. Can you
use the custom application with ICF? Yes, but you’ll need to create a service entry
and define some parameters for the service. Follow these steps:

1. Click Start → Network Connections → Show All Connections.

2. Right-click the ICF-protected connection and click Properties.
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3. Select the Advanced tab and click the Settings button.

4. On the Services tab, click the Add button.

5. In the Service Settings dialog box that appears, shown in Figure 14-21,
enter a friendly description, the name or IP address of the computer host-
ing the service (such as your computer or another computer on your net-
work), and then enter the internal and external port numbers used for the
service and protocol.

Figure 14-21: Configure the new service option.

6. Click OK to add the service, and then close the remaining dialog boxes.

Allowing ICMP Traffic
ICMP is a protocol used for troubleshooting and for network diagnostics. Common
TCP/IP network tools, such as ping and tracert, use ICMP. You can collect a great
deal of helpful information about networking conditions and problems; but ICF
blocks all ICMP traffic by default because the traffic is not originating from your
computer.

You can enable some or all of the ICMP information requests, depending on
which features you want to make available. If you open the Advanced Settings dia-
log box of the ICF-protected connection’s properties dialog box once again, and
select the ICMP tab, you’ll see a list of options that enable you to specify the ICMP
requests you want to make available. See Figure 14-22.

Using the ICF Log
ICF gives you the option of logging the events that occur with ICF, but the log is
not set up and configured by default. Using ICF’s simple log file, you can log
dropped packets as well as all successful connections. You can also determine the
maximum size to which the log file can grow.
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If you choose to log dropped packets, you can view the log file and see what
attempts to access your computer over the Internet have been thwarted. This gives
you clues about anyone who might be trying to tamper with your network. If you
log successful connections, you’ll see the destination IP address of every site that
you have visited. However, this will cause the log file to grow rapidly, especially if
the Internet is used a lot on the local computer or on an ICS network.

To configure the security log, just follow these steps:

1. Click Start → Network Connections → Show All Connections.

2. Right-click an Internet connection with ICF enabled and click Properties.

3. In the Properties dialog box, select the Advanced tab. Click the Settings
button.

4. Select the Security Logging tab, shown in Figure 14-23.

Figure 14-22: Enable ICMP services on this tab.

5. Under Logging Options, select either or both Log dropped packets and Log
successful connections.

6. By default, the log file is named pfirewall.log, and it is stored in your
Windows directory. If you want to store it elsewhere, click the Browse
button or type another destination in the Name box.

7. The default maximum log file size is 4,096 KB. You can decrease this
value if you like, or increase it to a maximum size of 32,767 KB.

8. Click OK when you’re done.
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After logging is turned on, you can view the log file at any time by simply open-
ing it with Notepad or any text editor or word processing application. The ICF log
file contains TCP/IP information about the connection or dropped packets. The ICF
log is a W3C Extended File format log, which can be opened and analyzed with
third-party logging utilities, as well.
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ICMP Options
In case you are wondering what each ICMP option is, exactly, here are some quick
definitions:

◆ Allow incoming echo request — This option permits a ping test to complete.
A message is sent to the computer and is echoed back to the sender. The ping
utility tests for network connectivity.

◆ Allow incoming timestamp request — This option enables data sent to the
computer to be acknowledged with a timestamp.

◆ Allow incoming mask request — This option enables the computer to listen
for and respond to requests for more information about the public network
to which it is connected.

◆ Allow incoming router request — This option permits the computer to
respond to requests for router information.

◆ Allow outgoing destination unreachable — This option causes the computer
to acknowledge and display a “destination unreachable” message when data
does not reach the computer due to errors or transmission problems.

◆ Allow outgoing source quench — This option permits the computer to send a
“slow down” message when data is arriving at the computer and the com-
puter cannot keep up.

◆ Allow outgoing parameter problem — This option permits the computer to
send a “bad header” message when data is received with an incorrect or
problematic header and is dropped.

◆ Allow outgoing time exceeded — This option causes the computer to send a
“time expired” message to the sender when data is incomplete because it
took too long to send.

◆ Allow redirect — This option enables data that is sent from the computer to
be rerouted if the default path changes.
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Figure 14-23: Security Logging tab.
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ICF and E-mail
ICF works seamlessly with most e-mail applications. This means that you do not need
to configure the e-mail application to work with ICF. However, an example of when
ICF and an e-mail application can have problems has to do with notification
messages.

If you are using Web-based e-mail, such as Hotmail, where you log on to a mail server
on the Internet, ICF will work without any problems. If you are using an e-mail client,
such as Microsoft Outlook Express, which polls its mail server to see if new mail is
present (and the mail is downloaded if it is), ICF will not interfere with this kind of
communication.

However, if your e-mail client waits for a remote procedure call (RPC) from a mail
server that tells the e-mail client that there is mail to download, ICF will block the
RPC traffic because it will appear as unsolicited traffic. Outlook is an example of an
e-mail application that uses RPCs. If you are using Outlook to access e-mail from a
Post Office Protocol (POP) server, you are not likely to have problems. However, if you
are accessing a corporate Exchange server from the Internet, ICF will block the RPC
messages from the Exchange server.
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Chapter 15

Sharing and Security
IN THIS CHAPTER

◆ Simple File Sharing

◆ Manage shared folders

◆ Working with Share and NTFS permissions

◆ Managing caching, ownership, and shared printers

IF YOU HAVE NETWORKED with Windows XP, you know that the major reason for
networking is to share information, whether that information is a collection of files,
or even a shared printer or hard disk However, along with sharing can come diffi-
cult decisions concerning security. After all, you want to give users access to shared
items on your Windows XP computer, but you probably also need to control what
those users can and can’t do with those items. Fortunately, Windows XP provides
plenty of security options that will meet your needs. This chapter considers sharing
and security.

Understanding Simple File Sharing
To begin working with shared folders and security settings in Windows XP
Professional, you need to first understand a new feature of Windows XP called
Simple File Sharing (SFS). It’s a great feature, but one that initially causes some
confusion, especially if you have come to Windows XP from a Windows 2000
computer.

In an effort to make computing easier, Windows XP uses SFS by default. SFS is
actually a collection of NT File System (NTFS) settings that govern how Windows
XP will share and manage shared files and folders. In short, SFS is designed to sim-
plify sharing and security. Average users can share files and folders and never have
to worry about security settings, because they are configured by default. SFS only
gives you a few options and it isn’t very flexible; but for a home or small office
network where everyone trusts everyone, it is a great feature that keeps you from
having to configure permissions on shared resources.

SFS is a collection of default settings that govern shared folders and user access.
When you install Windows XP, or under most default installations or upgrades
from Windows 9x, SFS is automatically configured. That configuration creates a 309
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collection of shared folders automatically so you can easily share documents and
files with users on other computers and for those persons who have administrative
privileges on your local computer. For administrators on the local computer, all of
the files in your user profile are made visible. You can also create a Shared
Documents folder to place shared documents so that any user on your local system
can access them. The default location for the shared documents folder is
C:\Documents and Settings\All Users\Documents, as you can see in Figure 15-1.

Figure 15-1: The Shared Documents folder is a place of general access.

How does Simple File Sharing affect the sharing of files and folders in a net-
work? SFS is basically an all-or-nothing approach. You can share a folder or make
it private so that no one can access it. If you choose to share the folder, users on
your network have read access, but you can change the setting so that users have
full control. However, you can’t individually manage user access permissions or
create other restrictions or privileges under SFS.

Overall, use SFS if you have a home network or a small office network where
everyone trusts each other. Beyond that, if you need more access to security set-
tings and more security flexibility, you can turn off SFS and use NTFS permissions.
To turn off SRS, access Folder Options in the Control Panel. On the View tab, clear
the Use simple file sharing check box, shown in Figure 15-2. The next section gives
you more details about using SFS when sharing folders.

Windows XP Home Edition does not support networking with NTFS permis-

sions. You must use SFS on Windows XP Home Edition and you cannot dis-

able it.
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Figure 15-2: Turn off SFS and use NTFS permissions.

Working with Shared Folders
One of the major ways you’ll use shared resources on a network is through shared
folders. Shared folders can contain all kinds of data and files. The purpose of shar-
ing a folder, of course, is to give network users access to the contents of that folder.
Using Windows XP Professional, you can share folders either through SFS, or if
you choose to use NTFS permissions, you can share the folder and set permissions
as needed.

Your computer must be configured for networking for the sharing option to
appear. This includes a network adapter card and the configuration of File and
Printer sharing. 

See Chapter 11 to learn more about configuring your computer for

networking.

Next, if you are using SFS, you are ready to share any folder by simply access-
ing the folder’s properties dialog box. To share a folder, simply right-click the
desired folder, click Properties, and then click the Sharing tab. As you can see in
Figure 15-3, the Sharing tab gives you two options when you use SFS.
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Figure 15-3: The Sharing tab using SFS.

1. You can share the folder locally. If you want only users of your local
computer to be able to access the folder, simply drag the folder to the
Shared Documents folder that is available in Windows XP. When a user
logs on to the computer, the Shared Documents folder is available to the
user, as is anything stored in the folder.

2. You also have the option to make the folder private. If you choose this
option, there are a few issues you should consider.

■ When you choose the private option, no one else who uses your com-
puter will be able to access the private folder. However, the configura-
tion only applies to folders within your user profile. In other words,
you can’t make an application folder private.

■ When you use the private option, all files and subfolders within the
private folder are also private. You can’t individually manage subfold-
ers and files for privacy purposes.

■ If you later decide to move the private folder to another folder, the
folder then inherits whatever settings are configured on the target
folder.

Keep in mind that this option is designed to give you privacy from other
people who access your local computer, but keep the limitations in mind
as well.

To share the folder on the network, select the Share this folder on the network
check box, and then enter a desired share name. To stop a folder from being shared,
simply clear this check box. If you want network users to be able to change files in
the folder, just click the Allow network users to change my files check box.
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If you decide that you do not want to use SFS and turn it off using Folder
Options (see the previous section), the Sharing tab changes and you also see a
Security tab on a folder’s properties dialog box, as shown in Figure 15-4. You can
choose to share the folder, give the folder a name and comment, limit the number
of users who can connect at any given time, and you can configure permissions
and caching functions. Security and caching options are explored later in this
chapter.

Figure 15-4: The Sharing tab without SFS.

You can also use Computer Management’s Shared Folders feature to manage
shared connections. For example, you can see how many users are connected to a
particular shared folder and view open files. You can forcefully disconnect sessions
from this console, as well. The following steps show you how to use the Computer
Management console.

1. Log on as an administrator.

2. Open Control Panel → Administrative Tools → Computer Management.

3. In the Computer Management console, shown in Figure 15-5, expand
Shared Folders. You can then view the shares, sessions, and open files. To
close sessions and open files, right-click Sessions or Open Files in the left
console pane and choose either Disconnect All Sessions or Disconnect All
Open Files.

4. Close the console when you’re done.

Chapter 15: Sharing and Security 313

549987 ch15.qxd  11/20/03  11:40 PM  Page 313



Figure 15-5: Use the Computer Management console to manage shared folders.

Using Share and NTFS Permissions
You can use share permissions or NTFS permissions to manage access to shared
folders, if you are not using SFS. Using NTFS permissions, you can accurately con-
trol what users can and cannot do with a locally shared folder. If you’ve spent any
time on a Microsoft network, you know that the issue of permissions can certainly
get complicated and difficult. Permissions give you that fine level of control you
want, but they can certainly get out of hand if you don’t have a clear vision of what
you are trying to accomplish from a security perspective.

As noted in the previous section, with NTFS, you can access the Sharing tab, you
can still elect to share the folder and assign a desired name, and you can even limit
the number of users who can connect to the share at the same time. You can also
set folder permissions. There is no difference in file and folder permissions in
Windows XP than in Windows 2000, so if you have worked with Windows 2000
Server, you’ll see no differences here. The following sections take a look at file and
folder permissions and advanced NTFS permissions.

File and Folder Permissions with NTFS
File and folder permissions are set on the Security tab found on the properties sheet
of the file or folder. Simply right-click the desired file or folder, click Properties,
and then click the Security tab, shown in Figure 15-6. As you can see, you can
select a desired group or individual user and configure the desired file level permis-
sions for that file.

314 Windows XP for Power Users

549987 ch15.qxd  11/20/03  11:40 PM  Page 314



Figure 15-6: File and folder permissions.

The standard permissions are Full Control, Modify, Read & Execute, List Folder
Contents, Read, Write, and special permissions. In truth, each of these permissions
is actually made up of a combination of certain special permissions. Before looking
at what special permissions make up these standard permissions, first consider the
special permissions and their definitions, which are described in Table 15-1.

TABLE 15-1 SPECIAL PERMISSIONS DEFINITIONS

Special Permission Explanation

Traverse Folder, Execute File Allows or denies browsing through folders to reach
other subfolders.

List Folder, Read Data List Folder allows or denies viewing file and/or
subfolder names. Read Data allows or denies reading
data in a file.

Read Attributes Allows or denies the reading of attributes of a file or
folder.

Read Extended Attributes Allows or denies the reading of extended attributes of a
file or folder.

Create Files, Write Data Create Files allows or denies the right to create a file in
a particular folder. Write Data allows or denies the
writing of new data to a file or the overwriting of
existing information.

Continued
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TABLE 15-1 SPECIAL PERMISSIONS DEFINITIONS (Continued)

Special Permission Explanation

Create Folders, Append Data Create Files allows or denies the ability to create
subfolders in a folder. Append Data allows or denies the
appending of data to an existing file (does not allow
the changing of existing data in the file).

Write Attributes Allows or denies the editing of attributes in a file or
folder.

Write Extended Attributes Allows or denies the writing of extended attributes for
a file or folder.

Delete Subfolders and Files Allows or denies the power to delete subfolders and
files within a folder.

Delete Allows the deletion of a file or folder.

Read Allows or denies reading of a file or folder.

Change permissions Allows or denies the ability to change permissions for a
file or folder.

Take Ownership Allows or denies the power to take ownership of a file
or folder.

Synchronize Allows or denies the power to synchronize data.

Standard permissions are combinations of special permissions that give users or
groups certain rights. The following list tells you which special permissions are
included in which standard permissions:

◆ Full Control — Full Control permissions contain all special permissions.

◆ Modify — Modify permissions contain the following special permissions:

■ Traverse Folder/Execute file

■ List Folder/Read Data

Read Attributes

Read Extended Attributes

Create Files/Write Data

Create Folders/Append Data
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Write Attributes, Write Extended Attributes

Delete

Read

Synchronize

■ Read and Execute

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Read Extended Attributes

Read

Synchronize

■ List Folder Contents

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Read Extended Attributes

Read

Synchronize

■ Read

List Folder/Read Data

Read Attributes

Read Extended Attributes

Read

Synchronize

■ Write

Create Files/Write Data

Create Folders/Append Data

Write Attributes

Write Extended Attributes

Read
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Now that you have taken a look at the file and folder standard permissions and
what special permissions make up the standard permissions, it is important for you
to know how the permissions work together. You should keep in mind two impor-
tant rules as you work with NTFS permissions:

1. File and Folder permissions are cumulative. If a user has Read permission
but that same user is a member of a group that has Full Control permis-
sion, the user’s effective permission is Full Control. In situations where
multiple permissions apply to the same user, the least restrictive permis-
sion takes effect.

2. Deny permission overrides all other permissions. This is an exception to
the first rule. For example, say that a user has Full Control permission but
is a member of a group that is denied access. In this case, the user’s effec-
tive permission is Deny. The user has no access to the file at all.

Advanced NTFS Permissions
Under most circumstances, the standard permissions of Full Control, Modify, Read
& Execute, List Folder Contents, Read, and Write are all you need to effectively
manage user access to shared folders and files. However, in some cases, you may
need to customize the security settings for a particular user or group. For example,
what if you wanted to give a particular group Full Control to a shared folder with-
out the special permission of Take Ownership? You would do so through advanced
permissions.

You can easily set advanced permissions for any desired file or folder and apply
those advanced permissions to a desired user group. One issue you must consider,
however, is inheritance. By default, objects in Windows XP Professional, as well as
Windows 2000, inherit the properties of the parent object. For example, say that a
particular folder called Docs resides in a shared folder called Company. By default,
the properties and permissions of Company are enforced on the Docs folder, as well.
This inheritance behavior keeps administrators from having to configure folder
after folder. Instead, you configure the top-level folder and all subfolders inherit
those settings. As you can guess, this is a great timesaving feature. However, at
times, you might need to override this feature, and you can do so with the
Advanced security settings, as needed. The following steps show you how:

1. Log on as an administrator.

2. Right-click the desired file or folder and click Properties. Click the
Security tab.

3. Choose the desired user or group from the provided list and click the
Advanced button.
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4. The Advanced Security Settings window appears, as shown in Figure
15-7. Note that the Inherit from parent the permission entries that apply
to child objects . . . check box is selected by default. If you want to over-
ride inheritance for this object, deselect the check box here. Select the
user/group in the window for whom you want to change permissions and
click the Edit button.

Figure 15-7: Advanced Security Settings.

5. In the Permission Entry window, shown in Figure 15-8, click the Apply
onto drop-down menu and select one of the following, as applicable:

■ Apply onto this folder, subfolders, and files

■ Apply onto this folder only

■ Apply onto this folder and subfolders

■ Apply onto this folder and files

■ Apply onto subfolders and files only

■ Apply onto subfolders only

■ Apply onto files only

After you have made your selection, click the desired check boxes to con-
figure the permissions of the user or group. Also, note that at the bottom
of the page, you can choose to apply these permissions to objects and/or
containers within the existing container. When you are done, click OK and
OK again to leave the Advanced settings window.
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Figure 15-8: Permission Entry dialog box.

Share Level and NTFS Permissions
As you learned in the previous section, a user’s effective NTFS permission is the
least restrictive permission available. For example, if a user has Read, Write, and
Full Control permission based on different groups, the user has Full Control per-
mission because it is the least restrictive.

Windows XP Professional, like Windows 2000, also supports share level permis-
sions. Share level permissions are the only permissions available for shared folders
that reside on non-NTFS volumes, such as FAT or FAT32. They are a weaker form
of permissions without all of the advanced options found in NTFS permissions.
There are three types of share level permissions:

◆ Read — The user can view a list of what resides in the shared folder and
subfolders to view data and run applications in the shared folder.

◆ Change — The user can do everything provided by Read permissions, but
the user can also create files and subfolders and edit existing files. The
user can also delete files and subfolders in the share.

◆ Full Control — The user can do everything provided by Read and Change,
but the user can also take ownership of the folder and change any exist-
ing NTFS permissions.

You can configure share level permissions by clicking the Permissions button in
the Sharing tab for the folder; this opens a basic window where you can configure
the permission based on user or group, as you can see in Figure 15-9.
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Figure 15-9: Permissions dialog box.

Like NTFS permissions, a user’s cumulative share level permissions provide the
effect permission. For example, if a user has Read permission due to one group
membership and Full Control from another group membership, the user has Full
Control over that folder.

This all sounds simple enough. However, what happens when share and NTFS
permissions are mixed, which often happens? For example, say a user belongs to a
group that has Read share level permission for a folder but Full Control NTFS per-
mission. Which permission does the user get? Where combinations of share and
NTFS permissions occur, the most restrictive permission is provided — which, in this
case, is Read. This is the opposite of cumulative approach of NTFS permissions and
Share level permissions. Keep these three points in mind:

◆ NTFS permissions are cumulative. When a user has several different per-
mission for the same share, the least restrictive permission applies. The
exception is Deny, which overrides all other permissions.

◆ Share level permissions are cumulative. When a user has several different
permission for the same share, the least restrictive permission applies. The
exception is Deny, which overrides all other permissions.

◆ When share level permissions and NTFS permissions are combined, the
user receives the most restrictive permission. For example, if a user has
Modify NTFS permission for a share but Read share level permission, the
effective permission is Read. Also, Deny overrides everything.
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Managing Caching Settings
on Shared Folders
When a folder is shared on the network, you have the option of configuring a
caching level for the information in that folder. This feature enables network docu-
ments to be stored locally on the user’s computer in a cache, which is a temporary
storage location. The benefit is network performance. Because cached files are
stored locally, not as much information must traverse the network. Caching is not a
great tool for user information that changes frequently, but for network data and
files, caching can keep network traffic problems at bay, especially on networks
where a lot of network files are accessed regularly.

You can configure caching on a shared folder by right-clicking the folder and
clicking Properties. Return to the Sharing tab and click the Caching button. You’ll
see the Caching Settings window, shown in Figure 15-10. To enable caching, click
the check box and choose one of the following three options from the Setting drop-
down menu:

◆ Automatic caching of documents — This option is recommended for fold-
ers containing user documents; they are automatically downloaded and
made available when working offline.

◆ Automatic caching of programs and documents — This option is recom-
mended for folders with read-only data or applications that are run over
the network. Opened files are automatically downloaded and made avail-
able offline.

◆ Manual caching of documents — Users must specify any files that they
want to make available when working offline. The only difference here is
that documents are not automatically downloaded.

Figure 15-10: Caching Settings.
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Taking Ownership of a File or Folder
NTFS permissions give you the ownership right when you create a folder and share
it on the network. You are the owner of the folder, and you have the right to set
permissions on that folder for all other users who might access it. However, there
may come a time when you want to transfer ownership of a folder to another user,
or in the case of a local administrator, you may need to take ownership of a folder
from a user who no longer manages it. In either case, Windows XP gives you a way
to either transfer the ownership of a file or folder to yourself, or if you are a local
administrator, you can take ownership, although you can’t transfer ownership to
someone else once you have forcibly taken it.

If you want to give ownership of a file or folder to another person, you can do
so by accessing the special permissions option in the Advanced Security Settings
dialog box, as explored in the previous sections. Open the Permissions Entry dialog
box, as shown in Figure 15-11, and grant the Take Ownership permission to the
desired user.

Figure 15-11: Take Ownership.

If you are an administrator and you need to forcibly take ownership of a file or
folder, follow these steps:

1. Right-click the folder or file and choose Properties.

2. On the Security tab, click the Advanced button.

3. In the Advanced Security Settings dialog box, click the Owner tab.
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4. On the Owner tab, you see the current owner (see Figure 15-12). Select
your account or another administrator’s account to change the current
owner, and then click OK. Notice that you can also replace the owner on
subcontainers and objects within the folder, if the object is a folder.

Figure 15-12: Owner tab.

Managing Shared Printers
As you work on a network, accessing and even sharing printers will more than
likely be an important part of your work. Using Windows XP, you can easily con-
nect to network printers as well as share local printers connected to your computer.

Aside from installing a local printer on a Windows XP computer, you can also
configure a printer that connects to a network or Internet print device. Keep in
mind that a printer is simply the software that allows you to connect to a print
device, whether that print device is local, network, or even on the Internet.
Additionally, you can configure several printers for the same print device that uses
different configurations. You can connect to another printer on your network and
print to that printer. Typically, in Microsoft networks, a certain computer functions
as a print server and clients connect to that print server to use the printer. You can
easily connect to a network printer by using the Add Printer Wizard in the Printers
and Faxes folder. The following steps show you how:

1. Open the Printers and Faxes folder in the Control Panel. Click the Add
Printer Wizard to start it.

2. Click Next on the Welcome screen.
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3. In the Local or Network Printer window, select the Network printer radio
button and click Next.

4. In the Specify a Printer window, shown in Figure 15-13, you have a few
different options:

■ You can choose to browse for a printer. If you click this option and
click Next, you see a selection window.

■ You can select a shared network printer that you see in the window,
and click Next to install it.

■ If you know the Universal Naming Convention (UNC) path of the
printer to which you want to connect, select the radio button option
and enter the path. 

I am connecting to a computer named Writer and using the HP printer
attached to it. Make your selection and click Next.

Figure 15-13: Specify a printer.

5. The printer is installed on your computer. The Test Page window appears.
If you want to print a test page, choose Yes and click Next.

6. Click Finish.

Windows XP also supports printing to a print device on the Internet. The idea is
that networks can use the Internet as a free print transfer network. For example, say
you want to send a series of documents to a user in Spokane, Washington, but you
are located in Dallas, Texas. You can use the Internet printing feature to print to an
Internet-enabled printer in the Spokane office. You’ll learn about configuring
an Internet printer to provide Internet printing in the next section. If you want to
connect to an Internet printer, use the Add Printer Wizard again, as shown in the
following steps:
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1. Open the Printers and Faxes folder in the Control Panel. Click the Add
Printer Wizard to start it.

2. Click Next on the Welcome screen.

3. In the Local or Network Printer window, select the Network printer radio
button and click Next.

4. In the Specify a Printer window, choose the option to connect to a printer
on the Internet and enter the URL of the printer, as shown in Figure 15-14.

Figure 15-14: Enter the URL of the printer.

5. Click Next and click Finish.

After the printers are set up, you can print to them as you would a local printer.
If you have more than one printer configured, you’ll see a selection screen when
you print that allows you to choose the printer to which you want to print. In
Windows domain environments, users can also search the Active Directory to
locate printers. Printers configured and published on Windows 2000 and XP com-
puters are automatically published in the Active Directory. Users can search the
Active Directory for certain characteristics, called attributes. For example, a user
could search for laser printers and find all printers in the network that are laser
printers.

If you need to print to an Internet printer, you can follow this same format, but
you can also connect to an Internet printer using a browser (IE 4.0 or later only). If
you know the URL, simply enter it in the address line. If you do not, enter the
server’s name followed by /printers to see a listing of Internet printers on that
server. For example, say that I know the server is http://myserver. If I don’t know
the printer name, I can type http://myserver/printers to see a listing of printers
available on that server. If you know the name of the printer, you can simply type
the server name and printer name, such as http://myserver/internetprint, to

326 Windows XP for Power Users

549987 ch15.qxd  11/20/03  11:40 PM  Page 326



directly access the Internet printer. After you locate the printer you want, you can
click the Connect button. Windows XP will copy the necessary drivers and the new
printer will appear in your Printers and Faxes folder. This is a simple way to use a
Web browser to access the Internet printer, rather than using the Add Printer
Wizard to set it up.

Sharing a Printer and Managing Permissions
You can configure a local area network (LAN) printer when you install the printer
using the Add Printer Wizard, or you can share the printer later once installation is
complete. To configure sharing after installation is already complete, access the
printer’s properties and click the Sharing tab, shown in Figure 15-15. Click the
Share this printer radio button and enter a desired share name in the dialog box.

Figure 15-15: Enter the URL of the printer.

If you have network clients other than Windows XP or 2000, you can also use
this tab to install additional drivers. When a downlevel computer wants to connect
to the printer, Windows XP downloads the drivers to that computer so the printer
can be used. If you click the Additional Drivers button, you see a list of options,
shown in Figure 15-16. Simply click the check box next to the drivers you want to
install and click OK. You may be prompted to insert your Windows XP CD-ROM or
asked to provide the driver you want to make available. You can usually obtain
downlevel drivers from the manufacturer’s Web site.

Once the printer is shared, network users can begin accessing the printer, typi-
cally using the default permissions. Aside from a LAN printer, you can also config-
ure a printer for Internet or intranet access. This feature enables users to print to a
URL and open a printer from Internet Explorer. To configure a printer so that it can
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be accessed via a URL, IIS must be installed on your Windows XP computer. When
IIS is installed, the printer is automatically made available via Web services when
you share the printer. You can think of the Internet printing options as just another
way for users to access the shared printer, which can be helpful in the case of
intranet printing. All permissions and related configurations apply to an Internet
printer, as they do for a standard printer.

Figure 15-16: Additional driver options.
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Problems Connecting to Network and Internet Printers
If you are having problems connecting to a network or Internet printer, there are a
few issues to keep in mind. First, if you cannot connect to a network printer, you need
to verify that the printer and server are online and that the UNC path information has
not changed. If the network server is online and the UNC path information is correct,
check your computer’s network connectivity and connectivity to the print server using
the Ping command. If you have connectivity and the server and print devices are
connected and ready, you can try rebooting to restart services, or delete the printer
and recreate it using the Add Printer Wizard.

For Internet printing, make sure you are using IE 4.0 or later. If you do not know the
actual URL of the printer, you can access http://servername/printers to see
what printers are available. If you know the exact URL, you can access it directly from
the browser using http://servername/printername or you can set up the
Internet printer using the Add Printer Wizard. Either way, once the printer is
recognized, you can use it as if the printer is local. If you cannot connect to the
Internet printer, you’ll need to verify Internet connectivity and that the print server
and printer are online.
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The preferred method for managing any network resource in a Windows envi-
ronment is through NTFS permissions, and the same holds true for shared printers.
Depending on your network needs, you may have several print devices that you
want to make available to all users at all times. Or, you may have certain print
devices that should be available to some users some of the time and others at other
times — or not at all. The possible permission scenarios with any shared resource are
many, and printer sharing is certainly no exception.

To modify a printer’s permissions, you need to access the Security tab of the
printer’s properties pages, shown in Figure 15-17. There are three primary permis-
sions that you can assign concerning printing:

◆ Print — This permission allows a user to print to the printer.

◆ Manage Printers — This permission allows a user to open the printer’s
properties pages and configure options.

◆ Manage Documents — This permission allows a user to open the print
queue and manage documents.

Figure 15-17: Security settings.

In Windows XP, local administrators are given all three permissions. The
Creator/Owner is given the Manage Documents permission, Everyone is given the
Read permission, and Power Users are given all three permissions. Obviously, most
users in your environment will have Print permission for the printer, whereas only
a select few will be given the Manage Printers and Manage Documents permissions.

As with all permission features, you can also click the Advanced button and view
a listing of permission entries for particular groups (see Figure 15-18). You can
select a desired group, click the Edit button, and you can reconfigure the default
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permissions for that group, if necessary. You can also set up auditing, view the
owner, and you can view the Effective permissions for a group by using the Effective
permissions tab. The tabs you see here are standard, and they work for printer per-
missions as they do for any other shared object. Note that if no permission is
expressly applied to the group, the group can inherit its permission from the Active
Directory. If there is no inheritable permission, the group is simply denied access.

Figure 15-18: Permission Entry window.

As you can see, printing permissions seem rather straightforward. However, in
most cases, your permission problems will not be so cut and dried. For example, say
that two different groups — marketing and accounting — use a certain shared printer.
You want to make sure that the accounting group can only access the printer between
3:00 and 10:00 p.m., but accounting has full access. Also, when the printer is avail-
able to both groups, how can you ensure that the accounting group’s jobs are given
preferential treatment? In cases such as this, you use a combination of multiple
printers, different priorities, and different availability options to make the configu-
ration work. Keep in mind that you cannot single out a group for certain time
access through the security permissions available — that has to be done using mul-
tiple printers for the same print device. Fortunately, the configuration for situations
like this is easy, once you determine your plan of attack.

Managing Print Queues
The process of printer configuration and setup is typically a one-time event, assum-
ing everything works the way you want it to. However, you may have to manage
the print queue from time to time to control documents. The queue refers to the
holding area — documents that are either currently printing or are waiting to be
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printed. Assuming you have permission to access the print queue on a Windows XP
computer, you can do so by double-clicking the printer icon in the Printers and
Faxes folders, or you can click the printer icon that appears in the Notification Area
when items are being printed.

You must have permission to open, view, and modify the print queue. If you

do not, an access denied message appears if you try to open the printer in

the Printers and Faxes folder, and you will not see a printer icon in the

Notification Area.

The print queue gives you a listing of documents that are printing or are waiting
to be printed (see Figure 15-19). You can manage the print queue in a few ways:

◆ You can click the Printer menu and choose Pause Printing or Cancel all
Documents. The pause feature is good if you need to perform maintenance
on the printer without deleting everything that is waiting in the queue.

◆ You can use the Document menu to manage individual documents. For
example, you can select a document and click the Document menu, where
you can Pause, Resume, Restart, or Cancel the document’s print. These fea-
tures can be helpful if a document seems to be stuck in the queue — you
can cancel it and the other documents waiting should resume printing.

◆ You can also easily perform these same actions by simply right-clicking
on the document icon in the print queue.

Figure 15-19: Print queue.

You can also make a few adjustments to a document’s printing by right-clicking
the document and clicking Properties. As you can see in Figure 15-20, you have a
standard properties sheet with several tabs. The noteworthy items are found on the
General tab. You can change the priority of the document in the queue. Under most
circumstances, documents are set to a priority of 1. What if there are 15 documents
in the print queue, but one particular document needs to be printed first? Just
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access the document’s properties and change the priority setting to Highest — this
will ensure that the document prints first, assuming no other documents have a
Highest setting.

Also, notice that you can configure a schedule for a particular print job. Say that
someone in a certain group in your office has sent a 300-page report to the printer
during peak printing hours. You can access the document’s properties and change
the time restriction so that the job is held in the queue until after hours. In larger
networks, managing print queues can be very important. After all, you have the
power to pause, restart, delete, and even reorder jobs in the print queue. Many
larger networks have administrators whose sole job is to manage printing and solve
problems with network printers and printing bottlenecks.

Figure 15-20: Print Document Properties.
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Chapter 16

Auditing and Disk Quotas
IN THIS CHAPTER

◆ Auditing your Windows XP computer

◆ Configuring Disk Quotas

WINDOWS XP GIVES YOU a number of management tools for a variety of tasks and
features. This chapter explains two of those features that you may find helpful if
your computer is connected to a network: auditing and disk quotas. In a network
environment, users may access your computer in a number of ways. You might
even have user folders on your computer in a file server manner where users can
store files. Using Windows XP’s auditing features, you can keep track of what users
are doing on your computer by auditing different events, including logon events
and even access to different objects, or shared folders. If you allow users to store
data on your computer from the network, you can use disk quotas to manage stor-
age space more effectively. These features are rather easy to use and can be quite
helpful in a variety of situations.

Auditing in Windows XP
Windows XP Professional gives you the ability to audit security events on your
Windows XP system. This feature enables you to see what users are doing and/or
accessing. When you turn on auditing for the desired events, the audit data is
recorded to the Security Log, which is available in Event Viewer. The primary use
for auditing is security. For example, you can audit failed logon events so that you
can detect possible attacks on your computer, or you can audit shared folders so
you can detect possible inappropriate use. In other words, auditing is a protective
measure that can help increase security on your computer by alerting you of suspi-
cious behavior.

You can audit the following items in Windows XP:

◆ Account Logon events — This option audits each instance of a user log-
ging on to or logging off the system from another computer where your
computer is used to validate the account.

◆ Account Management — This option audits account management tasks,
such as creating, deleting, or changing users and group accounts. 333
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◆ Directory Service Access — This option audits the access of an Active
Directory object that has its own system access control list.

◆ Logon Events — This option audits logon events, such as a user logging on
or off, or making a network connection to your computer.

◆ Object Access — This option audits access to some object in Windows XP,
such as a file, folder, registry key, printer, or other object. The object must
have its own system access control list.

◆ Policy Change — This option audits any local policy change or audit policy
change, and changes to user rights assignments.

◆ Privilege Use — This option can audit each instance of a user exercising a
user right.

◆ Process Tracking — This option can audit detailed tracking information for
different system processes.

◆ System Events — This option can audit when a user invokes a system
event, such as a restart, shutdown, or any other event that affects the sys-
tem security log or the security log.

You probably won’t want to use all of the audit features available, and, for the
most part, the common use of auditing is to audit logon events, system events, and
objects. But you do have all of these options available to you should you need more
auditing policies configured on your system.

Keep in mind that auditing, like anything else, uses system resources to run.

Each time an auditing event occurs, it must be written to the System Log,

which you then use to view auditing events. A lot of writing to the system

log can degrade Windows XP performance, so do not turn on auditing fea-

tures unless you really intend to use them because they can put a drain on

system resources.

As mentioned previously, when you enable auditing, auditing events are written
to the system log, which you can then view using Event Viewer. Auditing basically
works through Access Control Lists (ACLs), which are used to determine who can
access what on Windows XP. You enable auditing on the Local Security Settings
console. Because Windows XP Home editing doesn’t provide a Local Security
Settings console, you can’t audit events on Windows XP Home edition.
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Configuring Auditing
To configure auditing, you must access the Local Security Settings console. You can
access the console by opening Control Panel → Administrative Tools, then double-
clicking the Local Security Policy console. Or, you can click Start → Run and type
secpol.msc and click OK. Either way, the Local Security Settings console opens.
Expand Local Polices in the left console pane, and select Audit Policy. The policies
appear in the right pane, as shown in Figure 16-1.

To configure auditing, you’ll need to be logged on as a local computer

administrator.

Figure 16-1: Local Security Settings console.

To turn on auditing for a policy, double-click the policy in the right console
pane. For each policy, you can determine whether you want to audit success, fail-
ure, or both, as you can see in Figure 16-2. As a general rule, you’ll want to mainly
audit failure. For example, if you audit Logon Events, you probably want to see the
failure of logon events in Event Viewer, rather than each successful logon. The
choice is yours, but keep in mind that if you audit successes, each successful event
will have to be written to the Security Log. To enable the policy, simply select the
check boxes you want and click OK.
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Figure 16-2: Audit logon events Properties.

As you enable the policies you want, the Security Setting option found in the
Local Security Settings right console pane will reflect your change.

If you are in a Windows domain, site, domain, or OU, policies may prevent

you from configuring auditing on your local computer. Consult your net-

work administrator for more information if access to the Local Security

Policy console seems to be restricted, even though you are logged on with a

local administrator account.

Setting Up Objects for Auditing
If you want to audit access to objects, such as files, folders, and printers, you must
first enable auditing of objects in the Local Security Settings console (see the previ-
ous section). After you have enabled auditing of object access, you can configure
each file, folder, printer, or other object of auditing, as desired. Keep in mind that
turning on auditing of object access in the Local Security Settings console simply
enables the feature — you must configure each object you want to audit for auditing.

Auditing will not work with Simple File Sharing turned on, so you’ll need to turn
off Simple File Sharing so you can actually access security settings for the object.
(See Chapter 15 to learn more about Simple File Sharing.) Then, access the object’s
properties by right-clicking the object and clicking Properties. On the Security tab,
shown in Figure 16-3, click the Advanced button.
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Figure 16-3: Click the Advanced button on the Security tab.

The Advanced button takes you to the Advanced Security Settings window for
the object. Follow these steps to enable auditing:

1. In the Advanced Security Settings window, click the Auditing tab, shown
in Figure 16-4.

Figure 16-4: Auditing tab.
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2. Click the Add button.

3. In the Select User or Group window, enter the users and groups that you
want to audit for this object, as shown in Figure 16-5. You can click the
Advanced button if you want to choose them from a list. When you are
done, click OK.

Figure 16-5: Select User or Group.

4. The Auditing Entry dialog box appears, as shown in Figure 16-6. Enable
the check boxes for Successful or Failed for each kind of access you want
to audit on this object. Click OK when you are done.

Figure 16-6: Auditing Entry.

5. The entry now appears on the Auditing tab. Click OK, then OK again to
exit.
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Keep in mind that you use these same steps, regardless of the object you want to
audit. The auditing entries will change, depending on the object, of course. As you
can see in Figure 16-7, the Auditing Entry window for a printer gives you access
options pertaining to the printer that you can audit. This feature will help you see
who is accessing the printer, or the number of times a print job has failed.

Figure 16-7: Auditing Entry for a printer.

Using Event Viewer to View the Security Log
After you have configured auditing policies, you can view events pertaining to
those policies with the Security Log. You can review the Security Log using Event
Viewer, which you can access from the Applications folder in the Control Panel, or
via the Computer Management console. The following steps show you how to use
Event Viewer to access the Security Log.

1. Open Event Viewer. In the left console pane, double-click the Security Log
option. In the right console pane, shown in Figure 16-8, you see log entries
for either successful or failed audits, depending on your configuration.

2. To view more information about an audit, double-click it in the right con-
sole pane.
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Figure 16-8: Use the Security Log to access auditing events.

3. As you can see in Figure 16-9, an Event Properties window opens, where
you can view the date, time, category, type, event ID number, user, and
computer concerning the audit. You can move through different events
using the arrows on the right side of the window, as desired.

Figure 16-9: Event Properties window.
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Using Disk Quotas
Disk Quotas is a feature that enables you to control user storage capabilities. For
example, say you are using Windows XP as a file server and user storage center.
You want to have users store files and folders on the shared hard disk, but you do
not want users storing more than 500 MB of data. This restriction keeps users from
wasting a lot of disk space storing items they no longer need. Using Disk Quotas,
you can easily configure this restriction. When users begin running out of storage
space, they will receive warning messages. Depending on your configuration, users
can even be prevented from storing data until they have removed old data to stay
below the 500 MB limit. As you can imagine, disk quotas can be very helpful in a
variety of circumstances, and they can help force users to conserve disk space when
users are storing files on local computers.

Before you can use Disk Quotas, note that quota management only works on NT
File System (NTFS) volumes. Also, users cannot compress data to store more than
their quota limits. Disk Quotas are available on the Quota tab found on the disk’s
Properties dialog box. You can enable disk quota management on the Quota tab by
clicking the Enable quota management check box, shown in Figure 16-10.
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Inheritance and File and Folder Auditing
In Windows XP, the concept of inheritance makes your use of files and folders easier.
For example, say that a folder contains 10 files. Using inheritance, you can set
permissions on that folder, and all of the contents of the folder inherit those
permissions. This keeps you from having to set permissions on the folder itself, then on
each individual file in the folder.

The same concept holds true for auditing. When you set auditing on a parent folder,
all subfolders and files within that parent folder automatically inherit the auditing
settings of the parent. However, what if you have a parent folder you want to audit,
but there is a collection of 10 subfolders that you don’t want to audit within the
parent folder? No problem; you can simply block inheritance on the folder so that
auditing settings are not passed on to child folders. Access the Auditing tab as you
would to configure auditing, but look at the bottom of the tab and you’ll see an
Inherit from parent the auditing entries that apply to child objects check box. Clear
the check box to turn off inheritance for the audited parent folder. This will solve your
inheritance headaches.
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Figure 16-10: Quota tab.

Once you enable quota management, a few configuration options are available
to you:

◆ Quota management can be used to deny disk space to users who exceed
the quota limit, or it can be used to warn users without actually denying
them disk space. If you want to strictly enforce quota management, you
can choose the deny option by clicking this check box.

◆ Set the amount of disk space a user can have in the quota and a warning
level. The warning level is generally an amount slightly lower than the
quota. Once the warning level is met, the event is logged in the Event Log.

◆ You can use the final two check boxes to log events to the event log when
users exceed their storage limits or reach the warning level. These options
are not available by default, but you can enable them if you like.

After quotas are enabled on a disk, they apply uniformly to all network users
who store data on the disk. However, what if you need an exception? What if you
need to give certain users unlimited access while giving other users even more
restrictive access? In this case, you can create a quota entry for that user. A quota
entry further defines the user or groups quota and overrides any existing general
settings configured on the Quota tab.
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To configure a quota entry, just follow these steps:

1. On the Quota tab, click the Quota Entries button. This opens the Quota
Entries window, as shown in Figure 16-11.

Figure 16-11: Quota Entries.

2. Click Quota → New Quota Entry.

3. This opens a search window, shown in Figure 6-12, where you can search
for and select the user that you want to add. When you have selected the
user, click the OK button.

Figure 16-12: Select Users.

4. The Add New Quota Entry window appears, as shown in Figure 16-13.
You can choose not to limit disk space, or you can set the quota and
warning level for that particular user. This feature allows you to have
flexibility for users who need more storage space.
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Figure 16-13: Select users.

5. The new entry appears in the Quota Entries window. You can edit and
change the entry at any time using this console.
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Chapter 17

Backing Up and Restoring
Data
IN THIS CHAPTER

◆ Understanding backup concepts

◆ Creating backup jobs

◆ Restoring a backup

BACKING UP DATA IS one of those tasks that most of us fail to think much about.
After all, it is much more fun to work on Windows XP than spend time thinking
about data backup. However, in the case of a failed hard drive or an operating sys-
tem that goes crazy and refuses to work again, the issue of data backup becomes
paramount. After all, there is nothing worse than losing data, whether it is work
documents or your vacation digital photos. Windows XP Professional provides you
with backup and restore tools that you should get to know and put to work often.
This chapter considers the issues of backup and restore and shows you how to make
sure your data is safe.

Understanding Backup Options 
in Windows XP
One of the great things about Windows XP’s backup features is they are easy to
use — it is simply a matter of your putting them to work to ensure that your data is
always safe and secure. The backup and restore wizards you’ll find in Windows XP
were first introduced in Windows 2000, and they are more flexible than the origi-
nal backup tools seen in earlier versions of Windows.

My best piece of advice is to organize yourself and create an effective backup
plan that protects your data. Computer hardware fails all of the time, and you sim-
ply never know when a computer’s hard disk may crash. This is even true of newer
computers that you may think of as safe. I would liken computers to new cars: You
never want to drive off the lot without insurance, and you never want to store data
on a PC without an effective backup plan just in case something should happen.
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An effective backup plan doesn’t have to take up a lot of your time and a lot of
storage media, but it does require a bit of forethought and planning. The next few
sections explore the issues you should consider.

I often get mail from users who have Windows XP Home edition, asking

where the backup utility is on their computer. Windows XP Home edition

does not ship with the backup utility installed. However, it is lurking around

in the Home edition installation CD-ROM. If you want to install it, just 

navigate to \valueadd\msft\ntbackup. The file that you install is

NTBACKUP.MSI. Once you install the backup utility, it should work according

to this chapter’s instructions.

Types of Backup
Windows XP Professional supports several different types of backups, all of which
can be performed on NT File System (NTFS) and file allocation table (FAT) drives.
You should be familiar with these so you can formulate your own backup plan.

◆ Normal — A normal backup backs up all selected files and marks them as
having been backed up. All files you select are backed up, regardless of
their previous backed-up state. This type of backup is also known as a full
backup and is the type of backup you initially use to back up data.
Because the normal backup is actually backing up all data you select, it
can take some time to complete.

◆ Incremental — An incremental backup backs up all selected files that have
changed since the last backup. Commonly, a normal backup is performed,
followed by several incremental backups, which only back up the
changes. This backup strategy reduces overall backup time and storage
space.

◆ Differential — A differential backup is the same as an incremental backup,
but the files backed up are not marked as having been backed up. The
result is that a differential backup may re-backup files that have not
changed because they were not marked. The difference between an incre-
mental backup and a differential backup is recovery. A differential backup
takes longer than an incremental backup, but in the event of a failure, you
only need to run the normal backup job for recovery with the last differ-
ential backup. If you use an incremental backup job, you have to recover
the normal backup and every incremental backup that was created since
the last normal backup.
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◆ Copy — A copy backup backs up selected files without marking them as
having been backed up. This option is useful when you want to back up
certain files in between normal and incremental backups without altering
the incremental backup jobs.

◆ Daily — This backup backs up all selected files that have changed during
the day without marking them as having been backed up.

Once you consider the kinds of backup jobs and commit them to memory, you’ll
need to understand how they are typically used. First of all, a normal backup sim-
ply backs up all files you select. You can perform a normal backup and create a new
backup file every day if you like, but the problem comes down to time. A normal
backup takes more time than other types of backups, so people who use their com-
puters a lot and have a significant amount of data to back up find the normal
backup too time consuming to run every day.

Since normal backups are too time consuming to run every day, most people run
a normal backup at a certain interval, then either an incremental or differential
backup every day between normal backups. The main difference between incre-
mental and differential backups is in backup and restore time. When you run an
incremental backup, it only backs up the changes of selected files. For example, say
you run a normal backup on Monday, and an incremental backup on Tuesday,
Wednesday, Thursday, and Friday. Should a failure occur, you would restore
Monday’s normal backup, then every incremental backup since then. Incremental
backups take less time during the backup process because they only back up
changes. However, during a restore situation, you have to restore the normal
backup and all incremental backups to get your data back, which can be time con-
suming and tedious.

A differential backup, on the other hand, simply backs up all data that has
changed since the last normal backup. Because it is backing up all changes, the
backup process takes longer, but restoration is faster. Say you perform a normal
backup on Monday, then a differential backup on Tuesday, Wednesday, and
Thursday. If you have hard disk failure and need to restore the system on Friday,
you only need to run Monday’s backup and Thursday’s backup. The choice comes
down to time. If you want to spend less time backing up, use a normal backup and
incremental backups. If you want to spend less time restoring, use a normal backup
and differential backups.

Formulating Your Backup Plan
Once you understand the basic features of backing up, you’ll need to formulate a
backup plan to follow. Overall, your backup plan should consider the urgency of
data recovery, the amount of time you want to spend backing up data, and how
critical that data is. For example, many users who want to make sure that their sys-
tems are backed up run a normal backup every Monday and either incremental or
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differential backups each day thereafter. However, if the data on your Windows XP
computer is not that critical, you might run a normal backup every few weeks and
incremental backups in-between. The key is simply to think about how critical your
data is, how readily available it must be for restoration, and how much you want to
invest in backing up data. The plan you choose to follow depends on your needs.
Think carefully about your options and then create a backup plan that is right 
for you.

Understanding System State Data
System State Data refers to a collection of system data that you can back up so that
you can restore your Windows XP computer in the event of a failure. Instead of
having to back up individual system components, you can simply choose to back
up System State Data, which will back up the following items:

◆ The Registry

◆ COM+ Class Registration database

◆ Boot files, including the system files

◆ System files that are under Windows File Protection

If you are thinking that Windows XP’s System Restore feature keeps you

from having to worry about backing up, think again. System Restore only

restores operating system files and functions in order to fix an operating
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Backup Media
Windows XP creates a backup file with a *.bkf extension when you run a backup job.
So, when you store the backup file, you’ll be dealing with one file, not a bunch of
copies of files and folders from your operating system. You can store the backup file in
any location you like, such as a removable media drive (CD, Zip, and so on), or you can
invest in a tape drive and back the file up to tape. A number of affordable tape drives
are on the market today that will work well with Windows XP. One important note
here is that you cannot directly back up to a CD within the backup utility, but you can
create the backup file, save it on your system, and then burn it to a CD as you would
any other file.

Overall, when you create the backup file, think carefully about where you store it to
ensure that the backed-up data is safe. Some people even store backup files off-site,
such as in a safety deposit box. What you will need depends on the critical nature of
your data.
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system that is not working properly. It does not provide any protection for

your personal files and data, so don’t depend on System Restore to protect

you.You can learn more about System Restore in Chapter 19.

Creating a Backup Job
When you are ready to create a backup job, you can easily do so using Windows
XP’s Backup utility, where you can use a wizard to guide you through the backup
process. To create a backup job, just follow these steps:

1. Click Start → All Programs → Accessories → System Tools → Backup.

2. The Backup Wizard appears. Click Next on the Welcome screen.

3. In the Backup or Restore window, choose the Back up files and settings
radio button and click Next.

4. In the What to Back Up window, shown in Figure 17-1, you can choose to
back up everything on the computer, selected files, drives, or network
data, or System State data. Make a selection and click Next.

Figure 17-1: Choose what to back up.

5. If you choose to back up selected files, drives, or network data, the Items
to Back Up window appears, as shown in Figure 17-2. In this Explorer-
based window, browse in the left pane and select the files that you want
to back up in the right pane. Click Next.

6. In the Backup Type, Destination, and Name window, choose a backup
location and give the backup job a name. Click Next.
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7. In the Completion window, click the Advanced button instead of clicking
Finish.

8. In the Type of Backup window, use the drop-down menu and choose
either Normal, Incremental, Differential, Copy, or Daily backup, as shown
in Figure 17-3.

Figure 17-2: Items to back up.

Figure 17-3: Items to back up.

9. In the How to Back Up window, you can choose to verify data after
backup, use hardware compression (if available), and disable volume
shadow copy (which allows a backup to occur even if the file is currently
being written to), as shown in Figure 17-4. Click Next.
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10. In the Backup Options window, shown in Figure 17-5, you can choose to
append this backup job to an existing backup job or replace an older
backup job. Also note that you can allow only the owner and administra-
tor to have access to the backup (if you are overwriting an older job).
Make your selection and click Next.

11. In the When to Back Up window, you can choose to run the backup job
now or at a scheduled time. Make any desired selections and click Next.

Figure 17-4: How to back up.

Figure 17-5: Backup Options.

12. Click Finish. The Backup Progress window shows the status of the backup,
as shown in Figure 17-6. Click Close when the job is complete.
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Figure 17-6: The backup is created.

Once you have created the backup job using the wizard, you may find that sim-
ply creating the job manually is a bit faster. Windows XP gives you this option.
Basically, you can manually configure everything the wizard presents to you, but
you do it on one selection tab. The following steps show you how to create a
backup job without having to use the Backup Wizard.

1. Click Start → All Programs → Accessories → System Tools → Backup.

2. In the Backup Utility window, click the Backup tab, shown in Figure 17-7.
If the Backup Wizard begins automatically, click the Advanced Mode link
on the first window; this will take you to the Backup Utility. In the left
pane, choose what you want to back up. Note that you can choose System
State data found under the My Computer category. Make your selections
and click the Start Backup button.

3. In the Backup Job Information window, you’ll see the option to enter a
backup description and append or replace former backup jobs, as shown
in Figure 17-8. Make any desired changes.

4. If you click the Schedule button, you can create a schedule for when the
backup should start. Also note that you can click the Advanced button
and choose the Advanced backup options you saw when using the wizard,
such as verification and backup type, shown in Figure 17-9. Make any
desired changes and click OK.

5. Click the Start Backup button to begin the backup job.
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Figure 17-7: Choose what you want to back up.

Figure 17-8: Backup Job Information.

Figure 17-9: Backup details.
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Scheduling a Backup Job
The Backup Utility has a Schedule Jobs tab, shown in Figure 17-10. This tab gives
you a calendar view where you can simply double-click dates or click the Add Job
button to create a job. After you double-click a date or click Add Job, the Backup
Wizard begins, and you can schedule a backup job for that day. You can complete
this process over and over for different days so that you can schedule a series of
backup jobs at one time. This feature allows your operating system to handle the
backups automatically on the desired date and time you configured.

Figure 17-10: Schedule Jobs.

Restoring Data
In the event of user data, system state data, or a complete operating system failure,
you can use the backup jobs that you have created to restore the data to the com-
puter. In the event of a disk failure or operating system failure, you can reinstall
Windows XP, and then use your backup jobs to restore the data or the complete
operating system that has been saved in your backup jobs. As with backing up data,
you can also restore data with the help of a wizard.

When you restore data, you choose the backup file that you want to restore
using the Restore Wizard (or you can use the Restore and Manage Media tab on the
Backup Utility, shown in Figure 17-11). You can choose to restore the data to its
original location or you can choose a different location.
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Figure 17-11: The Restore and Manage Media tab.

You may find it helpful to use the Restore Wizard for your first restore run.
Depending on your backup strategy, you may need to run several restores in a row
using your Normal and Differential or Incremental backups. The following steps
show you how to use the Restore Wizard.

1. Click Start → All Programs → Accessories → System Tools → Backup.

2. In the Backup Utility window, click the Restore Wizard button found on
the Welcome tab.

3. Click Next on the Restore Wizard Welcome screen.

4. In the What to Restore window, shown in Figure 17-12, expand File in
the left portion of the window, select what you want to restore, and then
click Next.

5. In the completion window, click the Advanced button instead of clicking
Finish.

6. In the Where to Restore window, you can choose to restore the files to the
original location, an alternative location, or a single folder. This feature
works well if you need to restore data but don’t necessarily want to
restore it to its original location. Make a selection from the drop-down
menu and click Next.

7. In the How to Restore window, shown in Figure 17-13, you can choose to
leave your existing files, replace existing files if they are older than the
backup files, or replace existing files. Make sure you understand the full
ramifications of your decision if you choose to replace existing files. Make
a selection and click Next.
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Figure 17-12: The What to Restore window.

Figure 17-13: Choose how to restore.

8. In the Advanced Restore Options window, you can choose to restore secu-
rity settings and junction points and preserve existing volume mount
points. All of these items are selected by default. Click Next.

9. Click Finish to begin the restore.
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About Automated System Recovery
Automated System Recovery (ASR) is an option you see on the Backup Utility’s
Welcome tab. ASR is a process that backs up your system partition so that it can be
restored in the event of a catastrophic failure. However, it is important to note that
ASR doesn’t restore everything, and the process isn’t exactly automated as one might
think. You can use ASR to back up your system partition, but you’ll also need to use
the Backup Wizard to back up all of your files and folders (you can choose the Back up
everything on my computer option). Essentially, ASR is helpful only if you have
prepared a full backup in advance.

To use ASR, create a full backup to tape or another media, and then run the ASR
Wizard. In the event of a catastrophic failure, you can start your computer using the
Windows XP installation CD, then press F2 to run ASR. Follow the prompts that
appear.

Note that ASR doesn’t work on Windows XP Home edition.
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Chapter 18

Monitoring and Managing
System Performance
IN THIS CHAPTER

◆ Using Windows XP’s Performance tool

◆ Managing hard disks

◆ Managing memory and the processor

◆ Using Scheduled Task

AS WITH ANY COMPUTER operating system, it’s a good idea to both monitor and
manage Windows XP’s performance so that you can keep it in good working con-
dition. Windows XP is easier to monitor and gives you more performance configu-
ration options than has been possible with earlier Microsoft operating systems.
However, Windows XP is a real powerhouse and consumes a lot of power. Take a
look at the features and issues explored in this chapter so you can monitor perfor-
mance and get the most out of Windows XP.

Performance
Windows XP contains a Performance tool that works well and can be helpful in
providing you with specific information about the performance levels of various
services and hardware running on Windows XP.

Windows XP’s Performance tool was once called Performance Monitor,

and iterations of the tool have been around since the days of Windows NT

without much change.

Performance can provide you with information in a chart, report, or histogram
format. You can also log data to a log file and configure administrative alerts.
Administrative alerts can be sent in the following forms:
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◆ An entry to the application event log

◆ A network message

◆ Starting a performance data log

◆ Running a program

Because the Performance tool works on a counter basis, you can individually
choose what you want to monitor. That’s good news because the tool can help you
isolate specific problems.

Performance monitoring doesn’t fix any problems; it simply monitors your sys-
tem in a way that you can discover the cause of existing problems. The purpose of
performance monitoring is to gain information about the performance of various
system components and hardware, such as memory and processor utilization.
Typically, the Performance tool is best used with a baseline of performance. This
means that you monitor performance over a period of time during peak and non-
peak times to determine the baseline that the component functions under. You’ll
record high and low peaks of performance, and you can effectively determine what
is normal and satisfactory for that component. With the baseline, you can later use
the Performance tool to see if the component is functioning within normal parame-
ters. If it is not, you know that a problem exists with the component, or perhaps the
load placed on the component has increased. Either way, you can effectively iden-
tify what component is unable to keep up with the demand placed on it, which is
commonly called a bottleneck.

Performance functions through the use of objects, counters, and instances. In
Performance, objects represent certain performance categories, such as memory,
physical disk, processor, and related categories of system components and hard-
ware that can be monitored. Under each object are specific counters that you can
monitor. Counters represent what you are actually monitoring under that object,
such as bytes per second. Some objects have only a few counters, depending on
what can be monitored, while others may have 10 or more. The idea is to provide
you with specific counters so that you can monitor specific object actions. For
example, you can monitor the memory object, the available bytes counter, and the
pages-per-second counter to gain information about memory availability and cur-
rent usage, or you can use a combination of a number of other memory counters.
When you choose to monitor a counter, you monitor an instance of the counter.

Getting to Know Performance
If you click Start → Control Panel → Administrative Tools → Performance, the
Performance tool opens, as shown in Figure 18-1.
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Figure 18-1: Performance tool.

As you can see, the Performance tool is a basic MMC interface. The left console
pane contains the System Monitor node and the Performance Logs and Alerts node.
However, you primarily interact with the Performance tool by using the right con-
sole pane. There are three basic divisions of this pane, starting at the top, as 
follows:

◆ Toolbar — The toolbar contains icons you will use regularly to generate the
types of charts and information you want. The toolbar contains the fol-
lowing button options, which are shown from left to right in Figure 18-2.
They are as follows:

■ New Counter Set

■ Clear Display

■ View Current Activity

■ View Log Data

■ View Graph

■ View Histogram

■ View Report

■ Add
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■ Delete

■ Highlight

■ Copy Properties

■ Paste Counter List

■ Properties

■ Freeze Display

■ Update Data

■ Help

Figure 18-2: Performance toolbar.

◆ Information Area — The information area contains the qraph, histogram,
or report that you want to view, as shown in Figure 18-3. Just click the
desired button on the toolbar to view counter information in the desired
format.

Figure 18-3: Information area.

◆ Counter List — The bottom portion of the window contains a counter list,
as shown in Figure 18-4. All of the counters displayed in the list are cur-
rently being reported in the information area. You can easily remove or
add counters to the list using the toolbar. Each counter in the counter list
is given a different color for graphing and histogram purposes.
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Figure 18-4: Counter list.

Adding Counters
You primarily use Performance by accessing objects and choosing counters. Choose
the counters that you want to monitor, and then view those counters in either a
chart, histogram, or report format. The following steps show you how to add coun-
ters to the Performance tool interface.

1. Click Start → Control Panel → Administrative Tools → Performance.

2. In the Performance MMC, click the New Counter Set button on the tool-
bar. Then click the Add button on the toolbar.

3. In the Add Counters window, shown in Figure 18-5, use the drop-down
menu to choose a performance object. (As you can see, I have chosen the
PhysicalDisk counter.)

Figure 18-5: Add Counters.
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4. Next, you can choose to monitor all counters under the object you
selected, or you can choose specific counters. To select individual coun-
ters, simply select the counter and click the Add button. Notice that the
Instances of the dialog box may be active, depending on your selection.
The Instances dialog box allows you to choose certain instances, if they
are available. For example, as you can see in Figure 18-5, I have three
physical disks on the computer. I can monitor all disks or a selected one if
I choose.

5. Repeat the counter add process until you have added all desired counters,
then click Close.

6. You can see that the counters you added are being monitored. You can
change the graph-histogram-report view by clicking a different option
button on the toolbar. Figure 18-6 demonstrates the report view.

Figure 18-6: Report view.

Logging Data
As you monitor various counters, you can gain information about the performance
of the system processes and components that you selected. Generally, consistent
high readings mean that the component or hardware is not able to meet the burden
placed on it by the operating system’s processes. Although high spikes are normal,
consistent high readings on counters usually mean that a problem exists. This is
where your baseline data is important. Using the baseline, you can tell if a compo-
nent has higher readings than normal and what those readings might mean for
system performance.
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So, if baseline performance is important to establish, how can you gain that data
without sitting in front of a screen all day? Or, if a particular object seems to be
causing problems, how can you monitor that object during an entire day’s opera-
tions without physically watching the screen? The Performance tool gives you the
ability to log data over a period of time, which is a great way to gain performance
data without physically sitting at the machine. The performance data for the
desired object(s) and counter(s) can be sampled over a period of time, and then
recorded in a log file. You can then use the log file to examine the data at a time
that is convenient for you. Fortunately, using the log file is rather easy; the follow-
ing exercise walks you through the process:

1. In the Performance tool, expand Performance Logs and Alerts in the left
pane. Right-click Counter Logs and click New Log Settings.

2. In the New Log Settings dialog box that appears, give the log file a name
and click OK.

3. The settings window for the log appears. On the General tab, shown in
Figure 18-7, you can change the default log filename and storage location
if you like. Next, use the Add Objects and Add Counters buttons to add the
desired objects or counters that you want to log. Under the sample data
heading, choose how often you want the log file to sample data. For exam-
ple, Figure 18-7 shows that I am sampling memory data every 15 seconds.

Figure 18-7: General tab.

4. On the Log Files tab, shown in Figure 18-8, you can choose the type of
log file that you want to produce, which is a binary file by default. You
can use the drop-down menu, however, to configure a text file, binary cir-
cular file, or even an SQL database file. You can use the rest of the tab to
adjust the file-naming scheme.
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Figure 18-8: Log Files tab.

5. The Schedule tab allows you to configure how the log file is started or
stopped, as shown in Figure 18-9. The settings here are self-explanatory.
When you are finished with all of the settings for the log file, just click OK.

Figure 18-9: Schedule tab.
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Creating Alerts
Say that you are using a Windows XP Professional computer for certain network
tasks. To make sure that the computer is functioning at its peak, you want to be
notified when a certain performance object falls below the performance baseline.
The Performance tool can provide you with this information through an alert. An
alert is simply an action that the Performance tool carries out when triggered. The
trigger occurs when an object or counter falls below its specified performance base-
line. You configure the alert to carry out a particular action, such as send a network
message or record an event to the Event Log, when the alert is triggered. This is a
great way to keep track of objects that fall below baseline standards, and in critical
scenarios, it is a great way to find out about the baseline failures as they occur. 
As with log files, alerts are rather easy to configure; the following exercise shows
you how:

1. In the Performance tool, expand Performance Logs and Alerts in the left
pane. Right-click Alerts, and click New Alert Settings.

2. Give the new alert setting a name in the dialog box that appears and
click OK.

3. On the General tab that appears, shown in Figure 18-10, add counters to
the alert, just as you do for a log file. After you’ve added the counters to
the list, choose a baseline limit and a data sample rate.

Figure 18-10: General tab.
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4. On the Action tab, shown in Figure 18-11, choose an action that occurs
when the event is triggered.

5. On the Schedule tab, you can configure a schedule as desired. This is the
same Schedule tab you see when configuring a log file.

Figure 18-11: Action tab.

Using Task Manager’s Performance
Option
The Performance tool is very effective because you can identify and monitor spe-
cific counters. However, it can be a lot of work to monitor those counters and sift
through the data they provide. What if your computer is running sluggishly or
experiencing another common performance problem and you want a quick look at
what’s going on? No problem. Windows XP’s Task Manager also provides a quick
chart of common performance data. Just press CTRL+ALT+DEL to access Task
Manager, and then click the Performance tab, shown in Figure 18-12. You can get
a look at CPU usage and Page File usage, along with some other information about
memory. The Performance tab tells you whether the CPU is the problem or memory
is the problem. You don’t have any configuration options here, but this feature is a
great way to get quick performance information.

368 Windows XP for Power Users

549987 ch18.qxd  11/20/03  11:41 PM  Page 368



Figure 18-12: Performance tab.

Managing Hard Disk Performance
Hard disk performance generally isn’t a serious problem because Windows XP gives
you some helpful tools to keep the computer’s hard disk(s) in tiptop shape. If you
are having serious problems with a hard disk’s performance, you can use the
Performance tool to thoroughly examine the function of the hard disk. For physical
disk performance, you’ll find a PhysicalDisk object and a number of potential
counters. For example, you can monitor %Disk Read Time, %Disk Write Time,
%Idle Time, and so forth. In most cases, though, you’ll not need to use the
Performance tool to manage the performance of your hard disks. Doing so requires
that you simply run a few tools from time to time to keep things in good working
order and hard disk clutter out of the way.

Keep in mind that Windows XP gives you some basic hard disk management

tools, but if you are serious about hard disk management, you’ll also find a

number of third-party products, such as Norton Utilities, that give you more

flexibility and functions for managing hard disks.You might consider invest-

ing in one of these inexpensive programs, available at all computer stores.

Error Checking
The Error Checking tool, which is available on the Tools tab of the hard disk’s prop-
erties sheets, gives you simple check box options to check for file system errors and
recovery of bad sectors, as you can see in Figure 18-13. The Error Checking tool
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needs complete access to the disk for it to work. Applications must be closed, and
in some cases, Error Checking will ask you to reboot before it starts to gain com-
plete access to the disk. If you use your computer frequently, it is a good idea to run
this tool every 6 weeks or so just to make sure your disk is in good working order.

Figure 18-13: Error Checking.

Disk Defragmenter
Disk Defragmenter, which is also available on the Tools tab of the disk’s properties
sheets, is a tool you should run about once a month if you use your computer fre-
quently. Disk Defragmenter helps repair file fragmentation, which occurs over time
in any file system. Windows XP attempts to store files in a contiguous format.
However, as files are changed and resaved, the file system has to move data to dif-
ferent blocks of free space. The end result is that a typical file might have pieces
scattered all over the disk. When you open the file, the disk must work harder to
retrieve all of the pieces and assemble them. When this happens, the disk is referred
to as a fragmented disk.

The Disk Defragmenter tool is used to defragment the drive and rearrange data
so that it is stored in a contiguous manner. Bear in mind that the defrag tool is not
perfect, and the drive will not be completely defragmented after the utility is run.
However, for very fragmented drives, you are likely to notice a performance
improvement after running Disk Defragmenter. The following steps show you how
to use the Disk Defragmenter tool.

1. Open My Computer. Right-click the disk that you want to defragment and
click Properties. On the Tools tab, click the Defragment Now button.

2. The Disk Defragmenter window appears, as shown in Figure 18-14. Click
the Analyze button.

3. An analysis of the drive is performed, and a message appears telling you
whether or not you should defragment the drive. You can also choose to
view a report, as shown in Figure 18-15.
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Figure 18-14: Disk Defragmenter analysis.

Figure 18-15: Analysis report.

4. If the drive needs to be defragmented, click the Defragment button. The
defragmentation process begins and may take some time, depending on
how badly the drive is fragmented. Once the process is complete, you can
view a report again if you like.

Disk Cleanup
Windows XP also has a Disk Cleanup tool, which basically examines your hard disk
for temporary files and other file fragments that are no longer needed. You can
access Disk Cleanup on the General tab of the disk’s properties pages. Click the Disk
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Cleanup button, and Windows XP will examine your drive and tell you about the
files it can safely remove and how much space you can gain, as shown in Figure
18-16. You can also click the More Options tab to clean up Windows components,
installed programs, and system restore. Overall, this is a helpful tool that can give
you a quick and automated way to remove hard disk junk that you don’t need.

Figure 18-16: Disk Cleanup.

Managing Memory Performance
When discussing system performance, one of the most important issues that comes
to mind is RAM, and rightfully so. Operating systems, as well as applications, are
RAM guzzlers these days, and with the increase in digital photography and video
applications, many people have problems getting enough RAM. The same is true for
the processor — it must be able to keep up with the demands of the operating system
and the applications and/or processes placed on it. Although memory and proces-
sor performance are not the only performance issues that you may face with
Windows XP, they are certainly important.

As a part of desktop performance and configuration, Windows XP gives you a
simple interface that allows you to adjust the graphical nature of Windows XP to
conserve RAM and processor cycles. If a system seems sluggish, this may be your
first line of defense. If you right-click My Computer and click Properties, or just
open System in the Control Panel, you can click the Advanced tab, and then click
the Settings button under Performance.

This opens the Performance Options window, as shown in Figure 18-17. As you
can see on the Visual Effects tab, Windows XP attempts to choose its own settings
by default. However, you can change these settings to adjust Windows XP’s visual
effects for appearance or performance. You can also click the Custom button and
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clear the desired visual effects check boxes to reduce RAM and processor usage on
certain items. For example, you might remove the shadows features and fading fea-
tures of Windows XP.

Figure 18-17: Visual Effects tab.

If you click the Advanced tab, you can also manage a few additional memory
and processor settings, as shown in Figure 18-18. Windows XP is set to provide a
greater amount of processor cycles to applications over Windows XP background
processes. As a general rule, you should keep this setting to ensure that perfor-
mance is optimized for applications, but you can change it so that the processor is
used more efficiently for background services by simply clicking the radio button.

Next, you see that memory usage is also set to programs. This allows programs
to get the most power from memory instead of system cache processes. However,
depending on your RAM needs, you can optimize memory for system cache.

You also see the Page File (Virtual memory) Change button. If you click the
Change button, you see the Virtual Memory window, shown in Figure 18-19.
Virtual memory allows Windows XP to use a portion of the computer’s hard disk as
a memory storage area. As data is loaded into memory and memory becomes low,
pages of data are written to the hard disk and recalled as they are needed. This fea-
ture allows Windows XP to keep more information readily accessible in memory,
even when physical memory begins to run low. This virtual memory tactic is cer-
tainly nothing new in Windows (it was around even in the days of Windows 95),
and the process still works the same in Windows XP.

Windows XP is set to manage its own virtual memory settings. However, you
can manually input a minimum and maximum size for the page file if you like. The
commonly recommended amount is 1.5 times the amount of physical RAM
installed on the computer. So, if you have 128 MB of RAM, the recommended 
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initial paging file size is 192 MB. It is important to note here, however, that
Windows XP does a good job of managing its own memory settings, and as a gen-
eral guideline, you should allow Windows XP to handle those settings on its own.
Incorrectly setting the virtual memory settings or choosing the No paging file
option is likely to have adverse affects on system performance. Also, providing
more paging file room is not a replacement for physical RAM. If the computer is
running too slowly because there is not enough physical RAM installed on the sys-
tem, the paging file will not provide a cheap solution. In short, the paging file is
used to help Windows XP’s physical memory — not replace it.

Figure 18-18: Advanced tab.

Figure 18-19: Virtual Memory.
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Scheduling Tasks
Scheduled Task gives you a way to schedule certain tools and utilities to run at spe-
cific times so you can automate the process of keeping Windows XP functioning at
its peak. Scheduled Task is rather straightforward and easy to configure with the
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Helpful Memory and Processor Performance Counters
Aside from the basic setting features previously mentioned, you can use the
Performance tool to check out the performance of memory and the processor — and
even the paging file. By monitoring these objects, you can get a clear view of system
and application usage, and how memory and the processor are holding up under the
demands placed on them. See the previous section on the Performance tool, and
consider using these important counters.

For the processor object, use these common counters:

◆ %Interrupt Time — The amount of time the processor spends receiving and
servicing hardware interrupts. This counter can help you see if the processor
can handle the system’s hardware needs.

◆ %Processor Time — The percentages of time the processor spends to execute
a non-idle threat. This counter tells you how much time the processor
requires to meet system and application threads.

◆ Interrupts/sec — The average rate at which the processor receives and ser-
vices interrupts.

◆ %Idle Time — The amount of time that the processor is idle during a sam-
pling period. If there seems to be no idle time, this may indicate that the
processor cannot keep up with system, application, and hardware demands.

For the memory object, keep these counters in mind:

◆ Page Reads/sec — The amount of pages read in a monitored second.

◆ Page Writes/sec — The amount of pages written in a monitored second.

◆ Pages/sec — The rate at which pages are written to or read from a disk.

For the paging file object, keep these counters in mind (which are the only two):

◆ %Usage — The amount of page file instances in use.

◆ %Usage Peak — The peak usage of the paging file in a percentage. A high
percentage is an indicator that more RAM may be needed on the system
because the paging file is being used excessively.
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help of the Scheduled Task Wizard. The following steps walk you through the
process. Consider using Scheduled Task to run Disk Defragmenter or Error Checking
during the night so the tools don’t interrupt your work. Also, make sure that the
date and time on the computer’s clock are accurate so that Scheduled Task will
actually run when you want it to.

1. Click Start → All Programs → Accessories → System Tools → Scheduled
Task.

2. In the Scheduled Task folder, double-click Scheduled Task Wizard.

3. Click Next on the Welcome screen.

4. In the Scheduled Task Wizard window, select the task that you want to
schedule, as shown in Figure 18-20. You can also browse for other pro-
grams, if necessary. Click Next.

Figure 18-20: Select the desired task.

5. In the next window, give the task a name and choose when you want to
run the program (daily, weekly, monthly, when you log on, and so on).
Click Next.

6. Depending on your selection, an additional window may appear where
you configure the time and day of the week, as shown in Figure 18-21.
Make any necessary selections and click Next.

7. Your username is listed on the next screen. Enter your password, if
required, for your account. Note that scheduled tasks are configured for a
certain user — multiple users on the same computer can have different
scheduled tasks configured. Click Next.

8. Review your settings and click Finish. If you want to see Advanced prop-
erties for the scheduled task, click the check box before clicking Finish.
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Figure 18-21: Create a schedule.

9. If you choose to view Advanced properties, the properties pages for the
task appear. The Task and Schedule tabs allow you to make changes to the
values you configured when using the wizard. However, the Settings tab
enables some additional configuration options, as follows:

■ Delete the task if it is not scheduled to run again.

■ Stop the task if it runs for x number of hours and x minutes. This is a
safety feature that stops a task that is taking too long to complete.

■ You can choose to start the task only if the computer has been idle for
x number of minutes, and you can stop the task if the computer ceases
to be idle.

■ You can choose not to start the task if the computer is running on bat-
teries, and to stop the task if the computer enters battery mode.

After you create a scheduled task, it appears in the Scheduled Task folder. You
can right-click the task and run it manually if desired, delete it, or change the prop-
erties of the scheduled task. If you are having problems with scheduled tasks, or if
you want to suspend all scheduled tasks, you can easily do so in the Scheduled Task
folder. Notice the Advanced menu. This menu contains the options to stop using
Scheduled Task, pause Scheduled Task, enable a notify option of missed tasks,
change the service account, and view a log file.

Your scheduled tasks run at the time they are configured to run, even if you

are not logged on to the computer, and even if another user is logged on.

In this case, the scheduled tasks still run, but are invisible to the user who is

currently logged on.
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Chapter 19

System Failure and
Recovery
IN THIS CHAPTER

◆ Using CTRL+ALT+DEL

◆ Running Safe Mode

◆ Using System Restore

◆ Using the Recovery Console

NO MATTER HOW GREAT Windows XP may be, it is still an operating system running
millions of lines of code, and problems can certainly occur. Fortunately, Windows
XP is more stable than any other operating system Microsoft has produced to date.
In most cases, problems you experience will be the result of applications that are
not behaving the way they are supposed to, or hardware problems. Windows XP
gives you a few tools that can help you solve problems and get out of jams.

Troubleshooting Windows XP
When a problem arises, don’t get in a hurry. Think carefully about what has hap-
pened and what you were doing when the problem occurred. Consider grabbing a
piece of scratch paper and writing down the steps you have taken and which appli-
cations were open when the problem occurred. If there are serious problems with
Windows XP, you might need this information later. Next, use a logical approach to
problem solving. Try one thing at a time to resolve the problem. With each action
you take, write down what you did. Do not randomly press keys — do one thing at a
time in an organized manner. Remember, computer operating systems are built on
logic. Use logic when you try to solve problems. The following sections explore
some problem-solving tools and tactics that are at your disposal.
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Using CTRL+ALT+DEL
Although you will not experience the system lockup problems that you did in pre-
vious versions of Windows, you might have an application that stops responding
from time to time. In Windows 9x, this would often bring your entire system to a
standstill, but that is typically not the case in Windows XP. A system lockup occurs
when an application doesn’t behave the way it should. Basically, when an applica-
tion locks up, the application stops responding to mouse and keyboard controls. In
some cases, two applications that are open can interfere with each other, causing
them both to lock up. Fortunately, Windows XP itself is unlikely to lock up. In most
cases, you can still get control of the system and close the offending application
without having to reboot Windows.

In the case of an application lockup, you should use the CTRL+ALT+DEL com-
mand on your keyboard. This action opens the Windows Task Manager. Click the
Applications tab, shown in Figure 19-1, and you can see any applications that are
currently open. If an application is not working, its status will say Not Responding.
You can select the name of the program and click End Task on the Applications tab.
This action forces the task to end so you can get control of your computer. If you
have any unsaved data in your application at the time it locked up, you will lose
that data (save data frequently when working to avoid loss).

Figure 19-1: Use Windows Task Manager to close applications.

In some cases, CTRL+ALT+DEL will not give you control of the computer. This
problem occurs when there are errors within Windows XP, possibly associated with
an application, that cause the operating system to hard lock. In this situation,
pressing CTRL+ALT+DEL doesn’t do anything. You can’t do anything by pressing
keys on your keyboard, and your mouse pointer is gone. In such cases, the only
way to get control of Windows XP is to turn off the computer’s power switch.
Again, a complete hard lock is uncommon in Windows XP, but it is possible.
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Accessing Windows Help
Windows XP provides excellent troubleshooting information via the Help files. In
the past, Windows Help files have been somewhat sketchy. They are still not perfect
in Windows XP, but you are likely to find information that can be of help when you
are trying to solve problems. With an Internet connection, the Help files can search
the local file database for information and access information at Microsoft.com.
The Help files are self-explanatory for the most part, but I do want to mention some
standard interfaces and available options you should take note of. You can easily
access Windows Help by clicking Start, and then clicking Help and Support. The
Windows Help interface appears, as shown in Figure 19-2.

Figure 19-2: Home section of Windows Help and Support Center.

Notice the “Did you know?” section on the initial start page.This information

comes directly from the Internet and can be a great source of articles and

information.You can even set your own online search options here.

When you first open the Help files, you find yourself in the Home section (shown
in Figure 19-2). Home is the starting point of accessing Help. Home is used to
mimic a Web page because the Windows Help files are HTML-based, just like a Web
page. As you use Help, you’ll notice hyperlinks that enable you to jump from the
Help files to additional help resources on the Internet.
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In the Home window, you’ll see some generic categories that can help you get
moving in the right direction, such as Networking, Games, Sound, Video, and so
on. You also see sections where you can fix a problem or find more resources.

If you click the Index icon on the Help toolbar, you can access the Help Index,
shown in Figure 19-3.

Figure 19-3: Help Index.

On the left side of the window, you see the entire index displayed in alphabeti-
cal order. Use the scroll bar to locate a topic you want, select it, and then click the
Display button. The information about that topic appears in the right pane. You can
read the information, click the Print button to print a copy, and even reorganize the
window by clicking the Change View button. If you don’t want to scroll down the list
of index topics, you can type a keyword in the Search dialog box above the index.
The closest matches to your search request will appear.

As you are searching, keep these actions in mind: Searches are not case-sensitive
and you can use operator words, such as and, or, not, and so forth. Also, you’ll
often have better results if you use your primary keyword first in the search string.

The Add to Favorites option, also available on the toolbar, works a lot like
Favorites in Internet Explorer. Whenever you find a Help page that you want to
visit again, click the Add to Favorites button and the page will be added to a
Favorites list. Whenever you want to see that list, click the Favorites menu option
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at the top of the window to see a list of your favorite Help topics. Also, just like
Internet Explorer, History keeps track of all of the pages you have visited on the
Internet from the Help and Support interface. You can check out the History and
revisit any of these pages by double-clicking the link that appears in the list. The
Options section allows you to change the interface of Help and Support and even
share Help with others.

One of the best features of the Help and Support Center is the Support option,
(see Figure 19-4) also found on your toolbar. If you are having serious problems
with Windows XP that you can’t seem to resolve, you can get help from one of two
places: by asking a friend or from the Windows Web site forum.

Figure 19-4: Support options.

If you click the Ask a friend to help option, you can create a Remote Assistance
file that you can send to a friend so he or she can help you with your problem. The
Support window gives you easy, step-by-step instructions to generate this remote
Help connection. For more information about this feature, refer back to Chapter 13.

The second option is to Go to a Windows Web site forum. This feature allows
you to access online newsgroups and resources so you can try to find the answer to
your problem. The content, though, comes from other users, so you’ll sometimes
find mistakes. Still, this feature can be really helpful. You’ll need an active Internet
connection to use this feature.
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Using Safe Mode
Safe Mode is a Windows XP feature that enables you to start Windows with a min-
imal number of drivers. Safe Mode is used in instances when you cannot start
Windows normally. Safe Mode fixes problems with your system — it essentially gets
Windows up and running, but that’s about it. Most major XP features do not work
in Safe Mode.

Several different Safe Mode options are available to you so that you can boot
Windows, according to your specific needs. They are as follows:

◆ Safe Mode — If Windows XP will not start normally, you can use this
basic Safe Mode option, which attempts to load Windows XP with a mini-
mal number of drivers. Once you reach the desktop, you can troubleshoot
the problem and use System Restore (see the next section), if necessary.

◆ Safe Mode with Networking — This option boots into Safe Mode, but it
enables networking services and protocols so you an access network
resources within Safe Mode.

◆ Safe Mode with Command Prompt — This option boots into Safe 
Mode and enables you to use the command prompt for command line
troubleshooting.
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Windows Troubleshooters
Within the Windows Help interface, you can access a handy, helpful component called
a troubleshooter. A troubleshooter is an HTML interface that appears on the Help
window. The troubleshooter asks you a series of questions and tells you to try different
actions to resolve a problem you are having. Many troubleshooters are available in the
Help files, and they are easy to use. Just follow these steps:

1. Click Start → Help and Support.

2. In the Help Search window, type the kind of troubleshooter you want. 
For example, you might type modem troubleshooter, ICS troubleshooter, 
or sound card troubleshooter, and so forth. To see a full list, just type 
troubleshooter.

3. Begin the troubleshooter by clicking an appropriate link that comes back
from your search, and then click the Next button to continue.

4. Continue following the troubleshooter steps to attempt to solve the problem
you are experiencing.
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◆ Enable Boot Logging — This option logs the entire boot process. This fea-
ture can be helpful to support technicians or related personnel who can
analyze the boot process and see where the boot process is failing.

◆ Enable VGA Mode — This option boots Windows XP with a generic video
graphic array (VGA) driver for your display adapter. Wrong display
adapter drivers are common problems with boot failure.

◆ Last Known Good Configuration — This option uses the last known good
backup of the CurrentControlSet in the Registry to boot Windows. Each
time you successfully boot Windows, the CurrentControlSet key is backed
up. The Last Known Good option allows you to boot using that saved
Registry key.

You can access all of these options by using the Windows Startup menu, which
you’ll see if you hold down the CTRL key on your keyboard when you turn on your
computer. If CTRL doesn’t seem to work, hold the F8 key down when you start the
computer. You’ll see a Startup menu that allows you to choose Safe Mode, Safe
Mode with Networking, and some other options. When your computer boots into
Safe Mode, you can access the tools and help you need to try to solve the problem.
When you’ve finished, just reboot the computer and it will boot into Normal Mode.

Using System Restore
I can emphatically say that System Restore is a great feature of Windows XP and
one that can get you out of all sorts of trouble. What if your computer won’t start?
What if you install a bad application that wrecks your computer? What if your
nephew decides to delete C:\Windows? No problem — just use System Restore and
put your computer back to the way it was before the problem, tragedy, or accident
happened, with only a few mouse clicks. I’ve used System Restore numerous times
after fouling up Windows XP with my experiments, and I must say, it has worked
flawlessly for me. The following sections show you how to use System Restore.

Enabling System Restore
System Restore is automatically installed and configured on Windows XP if your
computer has at least 200 MB of free disk space after Windows XP is installed. If
your computer does not have 200 MB of free disk space, System Restore is installed,
but it is not set up to run. System Restore functions by saving information about
your system so that it can be restored in the event of a problem. For System Restore
to function correctly, 200 MB of free disk space is required, and, in reality, System
Restore may need much more. Fortunately, if you are using a newer computer, you
most likely have plenty of free disk space, and System Restore is already opera-
tional on your computer.
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If your computer did not have 200 MB of free disk space upon initial installa-
tion, but you have made 200 MB or more of free disk space available, you can
enable System Restore so that it begins functioning on your Windows XP com-
puter. To enable System Restore, just follow these steps:

1. In the Control Panel, double-click System, right-click My Computer, and
then click Properties.

2. Click the System Restore tab.

3. You can click the check box shown in Figure 19-5 to turn off System
Restore on all drives on your computer. If this check box is selected, just
click to clear it so that System Restore is enabled.

Figure 19-5: System Restore tab.

4. Click OK, and OK again in the System Properties window.

By default, System Restore is given 12 percent of your hard disk space when you
install Windows XP, assuming that 12 percent is at least 200 MB. If you access
System Properties, click the System Restore tab, and then click the Settings button,
you see a slider bar on the Drive Settings dialog box that indicates the total amount
of disk space System Restore is allowed to use, as shown in Figure 19-6. You can
raise or lower this amount by moving the slider bar. However, keep in mind that
System Restore must have at least 200 MB, and if you want System Restore to func-
tion really well, you should leave this 12 percent setting at its default level.
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Figure 19-6: Drive Settings.

Creating Restore Points
System Restore functions by creating restore points. A restore point is a snapshot of
your computer’s configuration that is stored on your hard disk. If System Restore
needs to be used, System Restore accesses a restore point to reconfigure your com-
puter. This process brings your computer back to a stable state — a place where it was
when the system was stable. It is very important to note here that System Restore
restores your operating system and applications only. It does not save and restore any
files. If you delete a project you are working on, you can’t use System Restore to get
the project back. Also, note that System Restore doesn’t protect you from any
viruses, Trojan horses, or any other malicious code. Incidentally, System Restore
does not affect other files, such as e-mail and Web pages. Performing a System
Restore won’t make you lose new e-mail or files — it only configures your system
settings and application settings.

System Restore automatically creates restore points for you, so there is no need
to manually create a restore point. However, if you are about to try some configu-
ration option or configure some software that you know might be risky or that has
caused you problems in the past, you can manually create a restore point so you
can later restore your system to its present state. To create a restore point, just fol-
low these easy steps:

1. Click Start → All Programs → Accessories → System Tools → System Restore.

2. In the System Restore window, click the Create a restore point button, and
then click Next, as shown in Figure 19-7.

3. In the window that appears, enter a description. You might want to
include information that will help you distinguish the restore point from
others. The date and time of the restore point are added automatically so
you don’t need to include those. Click Next.

4. The restore point is created. Click OK and you’re done.
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Figure 19-7: Create a restore point.

Using System Restore
In the event that you need System Restore, you’ll certainly be glad that the software
has been keeping track of your system and creating restore points. Running a
System Restore is easy, and the following two sections show you how to use System
Restore.

IF YOU CAN BOOT WINDOWS . . .
If you can boot Windows, follow these steps:

1. Click Start → All Programs → Accessories → System Tools → System Restore.

2. Click the Restore My Computer to an Earlier Time radio button, and then
click Next.

3. A calendar and a selection list are presented to you, as shown in 
Figure 19-8. You can select different days to find a desired restore point.
If you did not create a restore point, you should choose to use the latest
one available. The latest one will be listed first in the current or previous
day window. Select a restore point and click Next.

4. A message appears telling you to save all files and close all open applica-
tions. Do so at this time, and then click the Next button.

5. Restoration takes place on your computer, and your computer automati-
cally reboots when the restoration is complete. Click OK on the restoration
message that appears after you reboot.
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Figure 19-8: Choose a restore point.

IF YOU CANNOT BOOT WINDOWS . . .
If you cannot boot Windows, follow these steps to run System Restore:

1. Turn on your computer and hold down the CTRL key or the F8 key until
you see the Startup menu options.

2. Choose Safe Mode, and then press the Enter button.

3. After Windows boots, the Help screen that appears gives you the option to
restore your computer. Click the System Restore link.

4. Click the Restore My Computer to an Earlier Time radio button and then
click Next.

5. A calendar and a selection list are presented to you. You can select differ-
ent days to find a desired restore point. If you did not create a restore
point, you should choose the latest one available. The latest one will be
listed first in the current or previous day window. Select a restore point
and click Next.

6. A message appears telling you to save all files and close all open applica-
tions. Do so at this time, and then click the Next button.

7. Your computer automatically reboots when the restoration is complete.
Click OK on the restoration message that appears after booting has taken
place.
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Undoing a Restoration
In the event that a System Restore doesn’t give you the results you need, or you
happen to select the wrong restore point, you can reverse a restoration. The follow-
ing sections show you how to reverse a restoration.

REVERSING A RESTORATION IF YOU CAN BOOT WINDOWS
To reverse a restoration if you can boot your computer, follow these steps:

1. Click Start → All Programs → Accessories → System Tools → System Restore.

2. In the System Restore window, click the Undo my last restoration radio
button, and then click Next. The Undo my last restoration option does not
appear unless you have previously run a restoration.

3. Close any open files or applications, click OK, and then click Next.

4. The previous restoration is removed and your computer reboots. Click OK
on the restoration message that appears after reboot.

REVERSING A RESTORATION IF YOU CANNOT BOOT WINDOWS
If you cannot boot into Windows and you need to undo a restoration, just follow
these steps:

1. Turn on your computer and hold down the CTRL key or the F8 key until
you see the Startup menu options.

2. Choose Safe Mode and then press the Enter button.

3. When Windows boots, the Help screen that appears gives you the option
to restore your computer. Click the System Restore link.

4. Click the Undo my last restoration radio button, and then click Next.

5. A message appears telling you to save all files and close all open applica-
tions. Do so at this time, and then click the Next button.

6. Your computer is rebooted once the restoration has been removed.
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Important System Restore Issues
When you are working with System Restore, you should keep a few issues in mind
because they might affect the desired outcome of a system restore:

◆ Applications that you install in-between restore points will not be saved dur-
ing a system restore. You’ll need to reinstall those applications.

◆ Always remember that System Restore does not provide backup functions. If
you lose data due to any problem, the data is lost unless you have a backup.
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Using the Recovery Console
The Recovery Console is a powerful tool in Windows XP that can enable you to
start your computer and fix problems when your computer will not boot normally.
I will, however, give you the warnings upfront. The Recovery Console is considered
a power user or administrator tool and is not to be taken lightly. The Recovery
Console gives you many command options, which you can use to fix your 
computer — or further wreck it, depending on your actions. The Recovery Console is
a command line interface tool, so the changes you make occur immediately and
without any additional warnings. As such, the Recovery Console is a helpful, but
potentially dangerous tool. With the right commands and understanding, however,
it can certainly get you out of Windows XP jams when Safe Mode, System Restore,
and other standard troubleshooting options have failed.

Using the Recovery Console, you can do the following:

◆ Enable and disable services

◆ Format drives

◆ View directories

◆ Copy files from a floppy disk or CD and place them in directories
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◆ If you create a new user account and then use System Restore to go back to
a restore point before the new user account was created, the new user
account will be lost. However, System Restore doesn’t actually remove the
user’s data, just the account.

◆ If you change your computer or workgroup name between restore points and
then perform a System Restore, your computer or workgroup name will be
rolled back to the previous name.

◆ If you use the Recovery Console (see the next section) to make changes to
your system, System Restore will not detect those changes, and they will not
be recovered during a System Restore.

◆ When you install a service pack, you can choose to save or reset the restore
points. If you use the reset option, all restore points are deleted. Then,
System Restore will begin creating new restore points.

◆ If you stop monitoring a drive with System Restore, all of the restore points
on the drive are deleted. In other words, you can’t monitor a drive during
certain periods only. Once you turn off System Restore, you lose all of the
restore points on that drive.
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◆ Read and write data on a local drive

◆ Fix the boot sector

There are many administrative options you might find helpful to fix Windows if
you can’t start the operating system.

It is important to note that the Recovery Console isn’t the command prompt
(cmd.exe). You don’t have the flexibility or the number of options that you find
when using the command prompt because you would have a big security hole in
your computer if you did. As such, you can only access files in the root directory of
any volume: in the %SystemRoot% folder and subfolders; the Recovery Console
folder and subfolders; and files and folders on removable disks, such as floppy
disks and CDs. Additionally, write access to removable disks is enabled, which pre-
vents someone from copying files from your system to a removable disk. Also, you
cannot change the local Administrator password using the Recovery Console.
Finally, you can’t use any text-editing tools from within the Recovery Console.

One additional note concerns dynamic disks. If you are using dynamic disks on
the installation you access via the Recovery Console, you might not see the
dynamic volumes displayed accurately in the Recovery Console. This is simply a
technical limitation, and you can read more about it at Microsoft.com by accessing
the Knowledge Base article, Q227364.

Installing and Starting the Recovery Console
The Recovery Console is not available by default in Windows XP. You’ll need to
install it so that it appears as a boot menu option that you can select when you start
Windows XP.

To install the Recovery Console as a startup option, follow these steps:

1. Log on with the local Administrator account.

2. With Windows running, insert the Setup CD into your CD-ROM drive.

3. Click Start → Run.

4. Type the following where D: is the CD-ROM drive letter:

D:\i386\winnt32.exe /cmdcons

5. Follow the instructions on the screen.

To start the Recovery Console from the Windows XP Setup CD-ROM, follow
these steps:

1. Insert the Setup compact disc (CD) and restart the computer. If prompted,
select any options required to boot from the CD.

2. When the text-based part of Setup begins, follow the prompts; choose the
repair or recover option by pressing R.
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3. If you have a dual-boot or multiple-boot system, choose the installation
that you need to access from the Recovery Console.

4. When prompted, type the Administrator password.

5. At the system prompt, type your Recovery Console commands. When you
are using the Recovery Console, you can type help for a list of commands.

6. To exit the Recovery Console and restart the computer, type exit.

To start the Recovery Console if you have installed it as a startup option, follow
these steps:

1. During startup, select Recovery Console from the Startup options menu.

2. If you have a dual-boot or multiple-boot system, choose the installation
that you need to access from the Recovery Console.

3. When prompted, type the Administrator password.

4. At the system prompt, you can begin using the Recovery Console.

5. To exit the Recovery Console and restart the computer, type exit.

Recovery Console Commands
When you are ready to use the Recovery Console, you’ll need to use the available
Recovery Console commands to fix Windows XP. Several are available to you, and
the following sections outline each command and its parameters.

ATTRIB
Attrib changes file attributes for a single file or folder. This command sets or
removes the read-only, system, hidden, and compressed attributes assigned to files
or directories. You can use the following parameters:

attrib [+r|-r] [+s|-s] [+h|-h] [+c|-c] [[drive:][path] filename]

◆ +r — Sets the read-only file attribute

◆ -r — Clears the read-only file attribute

◆ +s — Sets the system file attribute

◆ -s — Clears the system file attribute

◆ +h — Sets the hidden file attribute

◆ -h — Clears the hidden file attribute

◆ +c — Sets the compressed file attribute
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◆ -c — Clears the compressed file attribute

◆ [[drive:][path] filename] — Specifies the location and name of the directory
or file you want to process

BATCH
The batch command executes the commands specified in a text file. Use batch
input_file [output_file] where input_file specifies the text file that contains
the list of commands to be executed. Input_file can consist of a drive letter and 
a colon, a folder name, a filename, or a combination of these. Output_file, if speci-
fied, stores the output of the commands in the named file. If not specified, the 
output is displayed on the screen.

BOOTCFG
Use the bootcfg command for boot configuration and recovery (boot.ini for most
computers). The bootcfg command with different parameters is available from the
command prompt. Make sure you make a backup of your boot.ini file before run-
ning any of these commands. A few examples follow:

◆ bootcfg /default — Sets the default boot entry

◆ bootcfg /add — Adds a Windows installation to the boot list

◆ bootcfg /rebuild — Iterates through all Windows installations and allows
the user to choose which parameters to add

◆ bootcfg /scan — Scans all disks for Windows installations and displays the
results

◆ bootcfg /list — Lists the entries already in the boot list

◆ bootcfg /disableredirect — Disables redirection in the boot loader

◆ bootcfg /redirect [PortBaudRate] | [useBiosSettings] — Enables redirec-
tion in the boot loader with the specified configuration

CHDIR
The chdir command checks a directory; it displays the name of the current direc-
tory or changes the current folder. You have the following parameter options:

chdir [drive:][path] [..]   or  cd [drive:][path] [..] 

◆ none — Used without parameters, chdir displays the names of the current
drive and folder. Used with only a drive letter (for example, cd C:), chdir
displays the current directory on the specified drive.

◆ [drive:][path] — Specifies the drive (if other than the current drive) and
directory to which you want to change.
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◆ [..] — Specifies that you want to change to the parent folder. Use a space
between chdir and the two periods.

CHKDSK
Chkdsk creates and displays a status report for the disk, and it also lists and cor-
rects errors on the disk. You have the following parameters available:

chkdsk [drive:] [/p] [/r]

◆ none — Used without parameters, chkdsk displays the status of the disk in
the current drive.

◆ drive: — Specifies the drive that you want chkdsk to check.

◆ /p — Performs an exhaustive check even if the drive is not marked for
chkdsk to run. This parameter does not make any changes to the drive.

◆ /r — Locates bad sectors and recovers readable information. Implies /p.

CLS
This command simply clears the screen. Once cleared, you only see the command
prompt and insertion point.

COPY
The copy command copies a single file to another location. The source of the copy
can be any removable media disk, the current Windows installation, the root of any
drive, or the Cmdcons directory. You have the following parameter options, but
note that copy doesn’t support wildcard characters.

copy source [destination] 

◆ source — Specifies the location and name of the file to be copied. Source
can consist of a drive letter and colon, a directory name, a filename, or a
combination.

◆ destination — Specifies the location and name of a file or set of files to
which you want to copy. Destination can consist of a drive letter and
colon, a folder name, a filename, or a combination.

DELETE
Delete deletes a single file. You have the following parameters:

delete [drive:][path] filename or del [drive:][path] filename
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DIR
Dir displays a list of the files and subdirectories in a directory. You have the fol-
lowing parameters:

dir [drive:][path][filename] 

◆ [drive:][path] — Specifies the drive and directory for which you want to
see a listing.

◆ [filename] — Specifies a particular file or group of files for which you
want to see a listing. You can use multiple filenames. Spaces, commas, or
semicolons can separate filenames. You can use wildcard characters (? and
*) in the filename parameter to display a group of files.

DISABLE
The disable command disables a Windows XP, Windows 2000, or Windows NT 4.0
system service or device driver. You have the following parameters:

disable {[service_name] | [device_driver_name]}

◆ service_name — The name of the system service you want to disable

◆ device_driver_name — The name of the device driver you want to disable

DISKPART
Diskpart creates and deletes partitions on a hard drive. You have the following
parameters:

diskpart [/add | /delete] [device_name | drive_name |
partition_name] [size]

◆ none — Used without parameters, the diskpart command starts the
Windows character-mode version of diskpart.

◆ /add — Creates a new partition.

◆ /delete — Deletes an existing partition.

◆ device_name — The device on which you want to create or delete a parti-
tion. The name can be obtained from the output of the map command.

◆ drive_name — The partition you want to delete, by drive letter. Used only
with /delete.
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◆ partition_name — The partition you want to delete, by partition name.

◆ size — The size, in megabytes (MB), of the partition you want to create.
Used only with /add.

ENABLE
The enable command enables a Windows XP, Windows 2000, or Windows NT 4.0
system service or driver. You have the following parameters:

enable {service_name | device_driver_name} [startup_type]

◆ service_name — The name of the system service you want to enable.

◆ device_driver_name — The name of the device driver you want to enable.

◆ startup_type — The startup type that you want to designate for the service
or device driver. Valid startup types are SERVICE_BOOT_START, SERVICE_
SYSTEM_START, SERVICE_AUTO_START, SERVICE_DEMAND_START.

EXIT
This command closes the Recovery Console.

EXPAND
The expand command extracts a file from a compressed file. This command is used
to extract a file from the cabinet (.cab) file or another compressed file. Do not
extract the entire cabinet file, as the process is lengthy; instead, extract only the file
you need. You have the following parameters:

expand source [/f:filespec}] [destination] [/d] [/y]

◆ source — Specifies the file to expand. Use this if the source file contains a
single file. Source can consist of a drive letter and a colon, a directory
name, a filename, or a combination. You cannot use wildcard characters.

◆ /f:filespec — If the source contains more than one file, this specifies the
name of the file you want to extract. You can use wildcards for the files
you want to extract.

◆ destination — Specifies both the destination directory and filename for the
extracted file, or each individually.

◆ /d — Lists the files contained in the cabinet file without expanding it or
extracting from it.

◆ /y — Suppresses the overwrite prompt when expanding or extracting files.
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FIXBOOT
The fixboot command writes a new  boot partition sector to the system partition.
The command is simply fixboot [drive] where drive is the drive letter where the new
boot sector will be written.

FIXMBR
The fixmbr command repairs the master boot record of the boot disk. The full com-
mand is fixmbr [device_name] where device_name is the device (drive) on which
you want to write a new master boot record.

FORMAT
The format command formats the specified drive with the file system you choose.
You have the following parameters:

format [drive:] [/q] [/fs:file-system]

◆ drive: — Specifies the drive you want to format. You cannot format a
floppy disk from the Recovery Console.

◆ /q — Performs a quick format of the drive. The drive is not scanned for bad
areas, so you should use this parameter only on drives that you have pre-
viously formatted.

◆ /fs:file-system — Specifies the file system to use (FAT, FAT32, NTFS). If
you don’t specify a file system, the existing file system format is used.

HELP
The help command provides a listing of Recovery Console commands and parame-
ters. See the Help section for listings and examples.

LISTSVC
The listsvc command lists all of the services and drivers on the computer.

LOGON
This command logs you on to the desired Windows XP installation. You must have
local administrator privileges to log on to the Recovery Console.

MAP
The map command displays a mapping of drive letters to physical device names.
The command is helpful when you want to use the fixboot and fixmbr commands,
because you need to see the mappings to use those commands. The syntax is map
[arc] where arc instructs the map command to display Advanced RISC Computing
(ARC) device names, such as multi(0)disk(0)rdisk(0)partition(1). See the Windows
XP Help and Support Center to learn more about ARC paths.
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MKDIR (MD)
The mkdir or md command creates a directory or subdirectory. You have the fol-
lowing available parameters:

mkdir [drive:]path or md [drive:]path

◆ drive: — Specifies the drive on which you want to create the new directory.

◆ path — Specifies the name and location of the new directory. You cannot
use wildcard characters.

MORE
The more command displays the contents of a text file. You have the following
parameters:

more [drive:][path] filename or type [drive:][path] filename

◆ [drive:][path] filename — Specifies the location and name of the file that
you want to view

NET USE
The net use command connects a network share to a drive letter. You have the fol-
lowing parameters:

net use [\\ComputerName\ShareName [/user:[DomainName\]UserName]
password] | [drive letter:] [/d]

◆ \\ComputerName\ShareName — Specifies the name of the server and the
shared resource. If ComputerName contains blank characters, enclose the
entire computer name from the double backslash (\\) to the end of the
computer name in quotation marks. The computer name can be from 1 to
15 characters long.

◆ /user: — Specifies the username with which the connection is made.

◆ DomainName — Domain name to use when validating the credentials for
the user.

◆ UserName — Specifies the username with which to log on.

◆ Password — Specifies the password needed to access the shared resource.
Leave blank to produce a prompt for the password.

◆ /d — Indicates that this connection is to be disconnected.
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RENAME (REN)
Rename or ren changes the name of a single file. You have the following parameters:

rename [drive:][path] filename1 filename2  or ren [drive:][path]
filename1 filename2

◆ [drive:][path] filename1 — Specifies the location and name of the file you
want to rename. You cannot use wildcard characters.

◆ filename2 — Specifies the new name for the file. You cannot specify a new
drive or path when renaming files.

RMDIR (RD)
Rmdir or rd deletes a directory. You have the following parameters:

rmdir [drive:]path or rd [drive:]path

◆ [drive:]path — Specifies the location and name of the directory you want
to delete. You cannot use wildcard characters.

SET
The set command displays and sets Recovery Console environment variables. The
set command is an optional command that must be used with Security Templates.
The command is set [variable=[string]] where variable specifies the variable you
want to set or modify.

SYSTEMROOT
The systemroot command gets the current directory to the systemroot folder of the
Windows installation you are logged on to.

TYPE
Type displays the contents of a text file. You can use the type or more command to
view a text file without modifying it. You have the following parameters:

type [drive:][path] filename or more [drive:][path] filename

◆ [drive:][path] filename — Specifies the location and name of the file that
you want to view.
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Removing the Recovery Console
If you installed the Recovery Console as a startup option, you can later choose to
remove it, if necessary. See the following steps for details:

1. Open My Computer.

2. Double-click the hard drive on which you installed the Recovery Console.

3. On the Tools menu, click Folder Options.

4. Click the View tab.

5. Click Show hidden files and folders, clear the Hide protected operating
system files check box, and then click OK.

6. At the root directory, delete the \Cmdcons folder.

7. At the root directory, delete the file Cmldr.

8. At the root directory, right-click the Boot.ini file and then click Properties.

9. Clear the Read-only check box, and then click OK.

10. Open Boot.ini in Notepad, and remove the entry for the Recovery Console.
It will look similar to this:

C:\cmdcons\bootsect.dat=”Microsoft Windows Recovery Console”
/cmdcons

11. Save the file and close.
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Chapter 20

Customizing with
Windows XP PowerToys
IN THIS CHAPTER

◆ Downloading and installing PowerToys

◆ Exploring PowerToys

POWERTOYS ARE SIMPLE APPLICATIONS you can download for free from Microsoft.
com. They are typically developed as an afterthought to an operating system, and
they add some helpful and fun customization options to Windows XP. Windows XP
is certainly not the first operating system to have PowerToys available for down-
load, but PowerToys are refined for Windows XP and, generally, you’ll find them
useful in some different ways. This chapter takes a look at the PowerToys, shows
how to use them, and explains how they can help you customize your Windows XP
experience.

Checking Out PowerToys
PowerToys are a collection of software applications. Each miniapplication is
designed to perform a specific task or function. You can download all of the
PowerToys from Microsoft, or you can choose the specific toys you want to use and
download only those. At the time of this writing, the PowerToys listed in Table 20-1
are available:

TABLE 20-1 AVAILABLE POWERTOYS

Toy Description

Tweak UI This PowerToy allows you to configure some system
settings that are not readily available in the Windows
XP user interface.
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TABLE 20-1 AVAILABLE POWERTOYS (Continued)

Toy Description

Open Command Window Here This tool adds an “open command window here”
context menu option on file system folders so you
can easily get to the command line from within a
folder.

ALT-tab Replacement This PowerToy gives you the ease of switching
between pages and seeing a preview of those pages.

Power Calculator This PowerToy provides graph and evaluate functions
along with many different types of calculating
conversions.

Image Resizer This PowerToy enables you to resize one or several
image files at the same time simply by right-clicking
them.

CD Slide Show Generator This tool allows you to view images burned to a CD as
a slide show. This tool also works on Windows 9x and
Me computers.

Virtual Desktop Manager You can manage up to four desktops on your
Windows XP computer from the Windows taskbar
with this PowerToy.

Taskbar Magnifier You can easily magnify part of your Windows XP
screen from the taskbar using this tool.

HTML Slide Show Wizard You can easily create an HTML slide show of your
digital pictures that can be viewed locally or
uploaded to a Web site.

Webcam Timershot Use this tool to take pictures at specified time
intervals from a Webcam connected to your
computer, and then save them to a desired location.
It’s your own mini-surveillance camera.

Downloading and Installing
PowerToys
You can easily download and install PowerToys on your Windows XP computer.
Most of the PowerToys are between 500 and 600 KB in size, and you download
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them one at a time. Even with a slower modem connection, you’ll still be able to
complete the downloads to your computer.

To download PowerToys, point your Web browser to www.microsoft.com/
windowxp/pro/downloads/powertoys.asp. This will take you to the PowerToys
main page, shown in Figure 20-1.

Figure 20-1: PowerToys home page.

Before you begin downloading PowerToys, you should note the following:

◆ PowerToys are created but not supported by Microsoft. In other words,
you can’t get technical support from Microsoft for their use. Basically, you
are on your own, but they are generally easy to use and are problem free.

◆ If you have old PowerToys installed on your computer, you need to unin-
stall them before downloading and installing new PowerToys.

◆ PowerToys only work with U.S.-English regional settings.

◆ Most PowerToys are user-specific. This means you can use the PowerToys
to customize your XP system, but the customization applies only to you —
not others who have an account on the local computer.

To download the PowerToys, follow these steps:

1. Click the desired PowerToy link on the right side of the PowerToys home
page (see Figure 20-1).
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2. A dialog box appears, asking if and where you want to save the
PowerToy. You can choose Open, which will start the download and
installation, or just click Save to download the PowerToy without
installing it.

3. If you choose to download the PowerToy without installing it, just double-
click the download icon after the download is complete to install the
PowerToy. This will walk you through a very basic setup routine.

4. After you install the PowerToys, you’ll be able to access them through
Start → All Programs → PowerToys for Windows XP.

The following sections explore each PowerToy and show you how to use it.

Tweak UI
Tweak UI (User Interface) is a little tool that gives you access to some standard sys-
tem settings that you can’t configure through the default Windows XP tools and
interface. You’ll find some of these settings really useful, while a few won’t seem as
important. Fortunately, the tool is easy to use, and you can mix and match any of
the settings that you want to use. Essentially, the tool gives you an interface to
these settings, and you can change them, as you like, just as you would do with a
standard properties dialog box.

The Tweak UI interface, shown in Figure 20-2, gives you a left column with dif-
ferent setting categories. Expand a category and choose a setting, and you’ll see the
configurable options in the right pane. The following sections show you what is
available in each category.

Figure 20-2: Tweak UI interface.
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About
The About option gives you a series of tips for using the Tweak UI interface, and
the Policy option under About gives you direct access to the Group Policy Editor,
where you can make a number of changes and enforce policies across all users on
the Windows XP local computer (assuming you are the computer administrator).
See Chapter 2 to learn more about using the Group Policy Editor.

General
The General category has only one entry, called Focus. Using this option, you can
prevent applications from stealing focus. This setting prevents applications from
stealing focus from the current window you are working on. Rather than stealing
focus, the taskbar icon for the application will flash, letting you know the applica-
tion needs your attention. Simply enable the setting and choose the taskbar flash-
ing option you want (continuous or flash a certain number of times).

Mouse
The Mouse category gives you several settings to control mouse movements and
behavior. As you can see in Figure 20-3, you can manage the menu speed and
mouse sensitivity to double-clicking and dragging. Under the Mouse category are
the following subcategories:

◆ The Hover category allows you to adjust your mouse hover sensitivity and
hover time.

◆ The Wheel category allows you to manage scrolling using the mouse
wheel.

Figure 20-3: Mouse options.
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◆ The X-Mouse option allows you to configure activation for windows that
follows the mouse movements. This keeps you from having to click the
mouse to bring a window into focus.

Explorer
The Explorer section gives you a number of settings that control some basic
Windows interface functionality. If you select the Explorer category, you see a
number of check box options that enable you to manage different features of
Windows. You’ll see everything from the displaying of Help on the Start menu to
enabling Windows hotkeys. Select a setting, and you can read more about the fea-
tures of each one on the description section of the page.

If you expand Explorer and select Common Dialogs, you can create a Custom
Places bar where you show either default places or custom places you choose, such
as My Documents, My Music, History, and so forth. Overall, this option gives you
more flexibility to easily get to the items you most frequently use.

Taskbar
The Taskbar category gives you several setting options to manage your taskbar. If
you select the Taskbar category, you can choose to enable balloon tips and receive
a warning when disk space runs low. If you select Grouping under the Taskbar cat-
egory, you can configure how applications are grouped on the taskbar. For exam-
ple, you can group least-used applications first, and you can group applications
with the most windows first. If you select XP Start Menu under Taskbar, you can
choose whether to list certain programs on the frequently used programs section
of the Start menu. Simply click or clear the desired check boxes next to each
application.

Desktop
On the Desktop category, you can choose what icons you want to display on the
desktop. By default, Windows XP only displays the Recycle Bin on the desktop, but
you can easily add the following by selecting the available check boxes:

◆ Internet Explorer

◆ My Computer

◆ My Documents

◆ My Network Places

Under the Desktop category, you can also manage the First Icon option. You can
choose to have My Documents or My Computer displayed first on the desktop. Note
that this is a per-user setting that only works if the user has permission to alter My
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Computer settings. Also, you may need to log off and back on for the setting to take
effect.

My Computer
The My Computer option allows you to manage which drives and folders you see in
My Computer. Simply expand this category and choose Drives, Special Folders, or
AutoPlay. You can determine what you see in My Computer from these options and
determine what is done with AutoPlay for each icon or folder.

Under the Control Panel section of My Computer, you can choose to enable or
hide certain Control Panel icons. For example, you can hide accessibility options,
add hardware, and so forth. Some people use this option to make the Control Panel
neater by removing icons that are not typically used. Note that removing the
options here only removes the icon from the Control Panel — it does not uninstall
the Control Panel option. You can add the icons back at any time by simply return-
ing to this Windows option and enabling the desired check boxes.

Under the Templates option, you can control what kind of document Windows
offers to make when you right-click and select New from the menu. Just enable or
clear the desired check boxes here, as desired.

Internet Explorer
Under the Internet Explorer section, you can choose to use a custom toolbar back-
ground for Internet Explorer by selecting the option and clicking the Change but-
ton to select a new bitmap image you have on your computer. This feature allows
you to customize Internet Explorer with your own bitmap image.

Under the Internet Explorer category, you can edit the search function so that
searches within Internet Explorer are directed to certain search engines. Under View
Source, you can manage what program is used to view Web page source code (it is
Notepad by default).

Under the Command Prompt option, you can choose a couple of completion
options that determine the character used for command prompt filename comple-
tion. You can also specify word separators.

Logon
The Logon option allows you to determine the users that appear on the Welcome
screen and whether the Autoexec.bat file is parsed at logon (this option is selected
by default). You can select the Autologon option and have the system log you on
automatically at system startup, and you can also configure whether or not to show
unread e-mail on the Welcome screen.

Finally, you also see a Repair option that you can use to have Tweak UI rebuild
icons and remove unused icons from Explorer. From the drop-down menu, you can
choose different folders you want to repair, such as the Fonts folder, My Music, My
Pictures, and so forth.
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Open Command Window Here
This little PowerToy gives you a contextual menu option to open a command win-
dow from any file system window that you happen to be working in. All this fea-
ture does is prevent you from having to go to Accessories to open a command
prompt, or from having to click Start → Run and entering cmd to open a command
prompt. As you can see in Figure 20-4, in My Computer, you can simply right-click
any icon and have an Open Command Window Here context menu option. Clicking
this immediately opens a command window. This feature is really helpful if you use
the command prompt frequently.

Figure 20-4: Open Command Window Here.

ALT-Tab Replacement
You can use the ALT-Tab keys to toggle between multiple windows on your screen.
The ALT-Tab Replacement PowerToy gives you an enhancement to ALT-Tab. After
you install the ALT-Tab Replacement PowerToy, you get a small window showing
the actual content of the windows you want to switch to. Basically, this little option
can make using multiple windows in the same application easier because you can
see exactly what you are switching to before doing so. Just press ALT-Tab, then
continue holding the ALT key to use your mouse or keyboard arrow keys to select
the window to which you want to toggle.
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PowerToy Calculator
The PowerToy Calculator performs graphing functions and other conversions 
that are not available on the standard Windows XP calculator. As you can see in
Figure 20-5, the PowerToy Calculator contains standard charting and graphing fea-
tures. Use the Functions menu to access basic operations, trig functions, log func-
tions, and user functions. On the Conversions menu, you can easily convert the
following to different values:

◆ Length

◆ Mass

◆ Time

◆ Velocity

◆ Temperature

Use the View menu to access numeric, history, and advanced views, and check
out File → Help to learn more about using different functions and features.

Figure 20-5: PowerToy Calculator.

Image Resizer
Image Resizer is a great little tool if you work with digital images on a frequent
basis. You can use Image Resizer to quickly and easily resize images or groups of
images, as needed. This feature prevents you from having to open the image(s) in
an image editor and resize them through that program. Once installed, just follow
these steps to resize your images.
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1. Right-click on an image or collection of images, as desired. On the
Context menu that appears, you’ll see the option to Resize Pictures, as
shown in Figure 20-6. Click the option.

Figure 20-6: Right-click the image to see the Context menu.

2. In the Resize Pictures dialog box that appears (see Figure 20-7), choose
the size to which you want to resize the photos. This action creates a copy
of the photos and stores them in the current folder. It does not alter your
original photos.

Figure 20-7: The Resize Pictures dialog box.

3. Click the Advanced button to extend the options, as shown in Figure 20-8.
You can create a custom size, choose to make photos smaller but not
larger, and you can choose to resize the original photo, if desired. Click
OK when you’re done.
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Figure 20-8: Advanced options. 

Exercise caution when resizing original photos. You can reduce photo qual-

ity if you reduce a photo’s size, and this might prevent you from using the

photo for certain printing needs. As a general rule, always maintain your

original photo and select to make a copy of the photo when resizing.

CD Slide Show Generator
This PowerToy allows you to view photos on a CD as a slide show. When you open
the CD, you’ll see a View as a slide show link under Picture Tasks, as shown in
Figure 20-9. After you click the link, the photos will be displayed full screen, one at
a time, and will automatically advance after a period of a few seconds (you can
manually advance them by clicking your mouse button). The slide show will continue
to loop through all of the photos until you press the ESC key on your keyboard.

Figure 20-9: CD slide show.
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Virtual Desktop Manager
The Virtual Desktop Manager allows you to use up to four different desktops on
your Windows XP computer at the same time, just by toggling between them using
the taskbar. For example, one desktop can have one background and applications
open while another can use a different background and applications. You’ll see a
Taskbar icon where you can simply click between the different desktops. It’s like
having up to four computers in one!

To use the Virtual Desktop Manager, first install it, and then follow these steps:

1. Right-click on an empty area of the taskbar, then point to Toolbars. In the
submenu that appears, shown in Figure 20-10, click Desktop Manager.

Figure 20-10: Desktop Manager.

2. The Desktop Manager now appears on the toolbar, as shown in 
Figure 20-11.

Figure 20-11: Desktop Manager on the toolbar. 

3. To switch between desktops, simply click each one, and then change each
desktop, as desired. You can adjust the background and applications open
on each desktop. After you have configured the desktops you want, you
can simply click between them using the Desktop Manager icons on the
Taskbar.

4. To see a preview of your desktops (see Figure 20-12), click the green
Preview button next to the desktop buttons on the Desktop Manager.
You’ll see each desktop on the screen and you can click between them.
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Figure 20-12: Desktop Preview option.

Taskbar Magnifier
So, say you have some problems seeing some of the things that appear on your
screen, or you have to work with a bunch of small icons or other small text issues
on the screen. The Taskbar Magnifier may be able to help you. This magnifier is a
lot like the magnifier you can use from Accessibility Options in the Control Panel,
but this one will stay on your taskbar as an icon until you turn it off.

Simply install the Taskbar Magnifier, right-click an empty area of your Taskbar,
point to Toolbars, and then click Taskbar Magnifier. The Magnifier appears on your
Taskbar. Anything you move your mouse over appears in the magnifier area. For
example, in Figure 20-13, I am pointing to a folder; you can see the folder icon
appear in the magnifier on the Taskbar.

Figure 20-13: Taskbar Magnifier. 
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HTML Slide Show Generator
The HTML Slide Show Generator is a wizard you can use to assemble a collection of
digital photos into a slide show. Once the slide show is made, you can view it in any
browser, so you can easily e-mail it to someone, burn it to a CD, or upload it to
your Web site. After you install the HTML Slide Show Generator, just follow these
steps:

1. Click Start → All Programs → PowerToys for Windows XP → Slide Show
Wizard.

2. Click Next on the Welcome screen.

3. On the Image window, use the Add Image and Add Folder buttons to add
images and folders to your collections. All of the photos you add here will
be used in the slide show, as shown in Figure 20-14.

Figure 20-14: Add Images or Folders.

4. In the slide show options window, enter a name for the slide show and
your name for the author (if you like). By default, the slide show is saved
in My Documents\My Slide Shows, but you can change the location by
clicking the Browse button and selecting a different location. Under the
Picture size category, choose a desired picture size. Keep in mind that if
you are posting the photo to the Web, smaller sizes such as 640×480 work
best. If you are going to be using the slide show on your computer only or
on a CD, choose a larger size or keep the current size. Under the Slide
show type category, you can choose between simple and advanced, and
you can also choose to display the slide show full screen (see Figure 20-15).
Make your selections and click Next.

416 Windows XP for Power Users

549987 ch20.qxd  11/20/03  11:41 PM  Page 416



Figure 20-15: Slide show options. 

5. The slide show is created and you arrive at the Finish screen. Note that
you can view the slide show from this completion window by clicking the
View the Slide Show Now button. Figure 20-16 shows you a sample slide
show being played in fullscreen.

Figure 20-16: Slide show in fullscreen mode.
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Webcam Timershot
The Webcam Timershot PowerToy uses a Webcam attached to your PC to take pho-
tos at specified intervals. Basically, it is a way to create a collection of photos of a
room or office, for example, primarily used for security purposes. After you install
the Webcam Timershot, click Start → All Programs → PowerToys for Windows XP →
Timershot. The window that appears allows you to see the photos taken, and you
can adjust the properties for the timershot. For example, you can determine how
often to take a photo, where to save the photo, and whether to save all photos or
just the last photo taken. You can even save your photos to a network location so
you can take photos of a remote location and see them from a network share.
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Chapter 21

Scripting with Windows XP
IN THIS CHAPTER

◆ Understanding Scripting

◆ Scripting with Windows XP

IF YOU ARE INTERESTED in getting Windows XP to do more than what is available in
the operating system, scripting might be for you. If you are a savvy computer user,
you can do all kinds of customization and automation using scripting. Windows
XP supports all of the scripting options and features you might want, and you’ll
have fun using scripts within Windows XP. If you are new to scripting, this chapter
gives you an overview of how scripting works and some examples of what you can
do on Windows XP.

Understanding Scripting
So what is scripting anyway? Scripting is a form of programming, in the sense that
you create code using an editor, such as a simple text editor like NotePad. This code
contains instructions for your computer to perform. These instructions can be later
compiled into an application, as is often the case with higher-level languages like
C/C++ and VB .NET, or the code can be interpreted. Interpreted code is not compiled
into a standalone application; rather, it depends on the existence of other applica-
tions running on the system to read the code and perform the instructions contained
within. To illustrate this example, look at Figures 21-1 and 21-2. Notice that the com-
piled application in Figure 21-1 contains all of the elements needed to carry out the
programmer’s instructions. The interpreted code, or script, in Figure 21-2 requires
an interpreter (sometimes called a script engine) capable of reading the instructions
in the file and executing them as specified by the programmer who wrote them.

One of the benefits of compiled code is that the resulting application (what the
code becomes once it is compiled) tends to execute very quickly when compared to
the performance of interpreted code. The benefit of interpreted code is that it is
often platform-independent; that is, one set of the code can be executed on a vari-
ety of operating systems without changing the code. JavaScript, Visual Basic Script
(VBScript), and PHP are famous examples of interpreted languages. All of the
scripts that you build in Windows XP make use of interpreted code.
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Figure 21-1: Using a compiled program.

Figure 21-2: Using an interpreted script.

What can you use scripting for? One of the most common uses for scripting is
the automation of systems management processes. Under Windows XP (as well as
Windows 2003 Server and Windows 2000), you can make scripts to automate an
amazing array of processes. For example, you can use a simple batch file to map
network drives for your users. As a user logs on, the batch file (a type of script) exe-
cutes and runs a series of commands to map network drives. You can make use of
some of the more powerful scripting engines to change systems settings based on
the users group, configure networking settings, edit the Registry, or even create
new dial-up profiles. However, scripting is not just for customizing the environ-
ment at user logon. There are handy scripts that will allow you to automate, for
example, the process of doing virtually any Windows administration task. All you
have to do is provide the variable information (such as usernames if you are creat-
ing users), and the rest is handled while you do something else more interesting or
productive. You could launch these files manually, or you could use the Windows
Scheduler to execute them at predetermined times.

What scripting languages are supported within Windows XP? Without adding
third-party scripting engines, which you can and many people do, you can make
use of Batch Scripting, JScript, and VBScript.

Batch Scripting Overview
Batch scripting is probably the most common form of Windows scripting, and if
you have even a little Windows scripting experience, there is a good chance that
you have encountered a Windows batch file or two. Though it is possible to use
other file extensions, batch files typically make use of the .bat or .cmd file exten-
sion. The files are used to run simple system commands. To create the file, you can
open any text editor, such as notepad, enter the scripting information, and then

User
Executes Program

Scripted instructions
via CMD.exe

Processing via Scripting
Engine (includes OS

interfaces)
Result

User
Executes Program

Program
instructions

Needed
Support Files

Interfaces to the
operating system
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save the text file with the proper extension. Any command you can run from a
command line on a Windows operating system can be inserted verbatim into a
batch file for execution. While batch files lack the complexity of the higher-level
scripting languages available (VBScript and JScript), they can be used to accom-
plish a variety of useful tasks, and multiple simple scripts can be nested to accom-
plish more complex tasks. This is particularly useful because it’s pretty easy to learn
the basic syntax used in batch files. This is especially good if you are new to script-
ing, because you are more likely to have scripting success right away. Because of
this accessibility and its ubiquitous usage, batch scripting is the primary focus of
this chapter.

JScript Overview
The JScript language is marketed as an object-based, interpreted scripting lan-
guage. It is fair to say that the capabilities of JScript (as well as VBScript) wholly
exceed those of relatively simple batch scripting. While JScript does not approach
the speed (it is interpreted after all), complexity, or power of more robust program-
ming languages, it does serve as a nice intermediary language useful for a variety
of tasks. Oddly enough, one of the limitations of the language is that no native
support is provided for reading and writing to files. This task is relatively simple in
the less robust batch-scripting environment. The JScript language’s developers are
quick to point out that this is not JavaScript, nor is it really related to the Java
languages. The JScript language is used frequently on the Internet (like JavaScript)
and can be processed by any of several compatible interpreters, such as Active
Server Pages, Windows Scripting Host, and Internet Explorer.

If you are familiar with higher-level programming languages, you might have
strong feelings about a few JScript traits. In JScript, you cannot declare data types,
such as the char or int types used in many programming languages. This means
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The .NET difference
The .NET languages, including JScript .NET, are not the same thing as their non-.NET
equivalents. There is improved performance and flexibility in the new generation of
languages, so if programming in general is a serious interest, I highly recommend you
begin learning the basics of the .NET languages. In some cases, the .NET revision of
the language adds more functionality than the previous iteration, while still remaining
backward-compatible with the previous (in our case) scripting languages. However,
this is certainly not the case in all instances; for example, Visual Basic .NET and its
predecessor, Visual Basic, are for all practical purposes entirely different languages
that share little more than some common syntax and the words Visual Basic in their
name. To make use of the .NET variants with Windows XP, you will need the current
.NET support files and runtimes installed on your system. I am assuming that you are
not making use of the .NET architecture in your scripting development.
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that you have to be careful about mixing data types, or at least how you deal with
them. Numbers can end up being stored as text if you’re not careful, and can cause
some peculiar outcomes if you are trying to develop overly complex applets with
JScript that accept input from a range of sources. Because the data types cannot be
defined, it is fairly simple to accidentally convert numbers into a character string.

VBScript Overview
Unlike JScript, Visual Basic Scripting edition (VBScript or VBS) is a derivative of
another programming language, Visual Basic (VB). There is enough in common
between VBScript, VB, and other variants of the language that proficiency in one
language is very useful when and if you decide to begin working with one of the
other variants. Like JScript, VBScript can be processed in a number of environ-
ments. VBS is also an interpreted language, and although it cannot be used to build
standalone applications, it is very useful for building robust, interactive scripts.

The interpreter that allows the use of JScript and VBScript is the Windows
Scripting Host. The Windows Scripting Host has a graphical interface that will
allow you to run scripts that have the extensions .wsf, .vbs, or .js by double-clicking
them. If there is a need to execute one of the scripts via a command line, you use
the Command Line Scripting interface (CScript). For example, the CScript engine
would allow you to call a .vbs script from the command line, within a batch of .wsf
files, and have it execute properly.

Batch Scripting Basics
As mentioned earlier, batch files are probably the most widely used form of script-
ing with Windows. Because a batch file can use any command that you can execute
from a command prompt, you have a relatively wide array of options at your 
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Windows Script File
If you are mixing the various scripting languages supported by Windows XP and you
would like to use a single file to house the individual bits of scripting languages, you
can use a file format called the Windows Script File. This file type is an unformatted
text file like the other scripting types and carries the extension .wsf. When a script of
this kind is executed, the Windows Scripting Host processes the script and uses the
proper interpreter for each language that is encountered within the file. This func-
tionality can be extremely useful if multiple developers are using different scripting
languages, or if you wish to merge existing scripting source code into a single file.
Essentially, the Windows Script File acts as a container for the various supported
languages. For more information using the Windows Scripting File format, check out
http://msdn.microsoft.com and search for Windows Script or .wsf.
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disposal. The collection of instructions is placed in an unformatted text file, and the
resulting file is saved as either a .bat or .cmd file. For example, a batch file called
“mybatchfile” would be named either mybatchfile.bat or mybatchfile.cmd. Along
with the commands you can run from a prompt, some other commands can be
added to a batch file to provide additional functionality. These commands are as
follows:

◆ if

◆ goto

◆ for

These enable the creation of simple conditional expressions within the batch file.
Each one of these operators has a set of variables and output options, which you
will need to understand clearly if you plan on using them in your batch program-
ming. To use the decision-making commands, you need to understand the concept
of parameters and how they are used in batch files. After an exploration of the con-
cept of batch parameters as well as batch file redirection, we will discuss the batch
file commands and provide some examples of how to build your own batch files.

Throughout this chapter are sections of sample code indicating how the usage of
the various batch parameters and commands works. Notice that in most of the code
samples there are comments preceded by the rem statement. The rem statement tells
the operating system to ignore the information on the same line as the statement.
The result is the removal of the information on that line of the batch file from the
script execution process. It is particularly important when you build your scripts to
leave some simple kinds of notes indicating what it is you are trying to accomplish
with a particular script or portion of a script. This way, if you or someone else needs
to revisit the scripts at a later time, your objectives and logic will be discernable.
Rem can also be used if you have a large batch where a portion of it is not working
as expected and you wish to disable it without actually removing the code from the
file.

Using Batch Parameters
Batch parameters allow you to work with a variety of environment setting infor-
mation. For example, parameters allow you to create a batch file that accepts user
input. A batch script file that contains instructions for backing up selected local
files to a network location (called netback.bat, for argument’s sake) could be con-
figured to accept the source location (where to get the files from) and a destination
location (where to send the files to). For example, a user might run the following
command:

netbat.bat C:\files W:\mydirectory\files

To build a batch file that will accept the parameters, you must use one of the
accepted parameter values for a Windows batch file. The values %0 through %9 are
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considered valid, although %0 always refers back to the name of the batch file, so
it’s not very useful for letting users pass arguments on to the batch file itself. To
give you an example, the following code defines two variables for the copy com-
mand. This works well, because the copy command expects the user to specify
where to copy the files from and where to copy them to:

copy %1 %2

The user would then have to provide the needed information when invoking the
batch file. It is important to note that the variables and/or arguments are stored in
numerical order. The first value the user places after the name of the batch file
becomes %1, the next %2, and so forth. This assumes you begin with %1, which
you should always do to ensure the script executes as expected. You can make some
other modifications to the % parameters, but they go beyond the scope of this
chapter and beyond what most folks need when crafting their own batch files. If
you would like to explore the topic more, you can do so at the following URL:
http://www.microsoft.com/windowsxp/home/using/productdoc/en/default.asp?url=
/windowsxp/home/using/productdoc/en/percent.asp. You can find this link by
going to www.microsoft.com, searching for the term “batch parameters”, and
browsing to the results, immediately under the Product Information heading in the
results file.

Using Batch Redirection Operators
A redirection operator is basically a special parameter that changes how the output
of a command is used. A common example is the redirection of screen output to a
text file. The operator that does this particular task is > and can prove extremely
useful if you want to capture the output of commands that normally only display
the results on the screen. For example, the following command reroutes the output
of the dir (directory listing) command to a text file called direct.txt.

dir>direct.txt 

Conversely, the < operator is used when you want to pull information from a file
to be processed by the command you are running. So, if you wanted to display the
contents of a file (direct.txt, in this case) in alphabetical order, you could open a
command prompt and run the following command:

sort<direct.txt

Batch File Logic Commands
We will now return to the commands available for use within your batch files that
can be used to make the system do something. The parameters examined in previous
paragraphs will allow you to modify how these commands behave. The next sections
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explore the most common commands that enable you to perform basic logic within
the batch file: if and goto.

USING THE IF COMMAND
When using the if command to make decisions within a batch script, several values
can be evaluated generally. Each option changes the kind of evaluation that you
can make using the if command. Table 21-1 outlines the common if command uses
and the relevant applications.

TABLE 21-1 COMMON IF COMMANDS

Command Example Use

if exist/if not exist if exist C:\filename.txt. del Determines the existence or absence
C:\filename.txt of files, folders, and (mapped) drives.

if string/if not string if string %1==launchweb Used to determine if two strings 
start iexplore are the same or not. /i (if string /i ...)

tells the process to ignore the case
of the letter.

if errorlevel/if not if not errorlevel 1 echo Evaluates the exit code (errorlevel) 
errorlevel The last operation failed of the last command to run before

the if errorlevel command. These
codes are either 1 or 0.Typically, 1
indicates successful exit and 0 is a
failure.

The general syntax of the if command and its options are as follows:

if/if not errorlevel number [success commands] [else expression]
if/if not stringA==stringB [success commands]  [else expression]
if/if not exist file/drive/directory [success commands]  [else
expression]

When using the if command (without the not modifier), the command that follows
the if statement will only be executed if the evaluation is true. If the not modifier is
used, the command will only be executed if the statement is false. The else statements
are used to specify the actions to be taken in the event that the if condition is not met,
as in the following code example:

if %1==run. start iexplore
else echo %1 is not valid
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This code would evaluate the string passed by the user when executing the script
and either launch a program (Internet Explorer) or return a message that the string
(%1) is not valid.

USING THE GOTO COMMAND
If you would like to perform different actions based on the if/else logic, you can
compartmentalize your batch file by making use of the goto command. The goto
command tells the batch process where to go in the file to begin processing, or
where to go for the next step. In the code shown in Figure 21-3, the script begins by
directing the process to the start section. The : operator identifies the title of any
particular section. Once the title is located, the batch process begins executing the
instruction on the next line.

Figure 21-3: Goto sample.

In the case of the preceding code, a message is displayed and then some network
drives are mapped. At the end of the script an evaluation is made. If the L:\ drive
exists, the program will go to :END, which has no commands after it and causes the
process to terminate. If the logic fails (there is no L:\ drive), the batch proceeds to
the mapl section and maps the drive. You can use a goto command to direct the
processing to an earlier section of the file. This allows you to create a recursive
process. For example, see the code in Figure 21-4. You simply will not exit the
script until both the R: and L: drives are mapped.
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Figure 21-4: Recursive goto example.

Other Useful Operational Commands
Several other operational commands act as background operators to change how
the batch process progresses. Rather than map a network drive, as the net use com-
mand (covered in the next section) can, these commands are used to display
progress information to the user, pause batch processing, inactivate lines of code in
the batch file without deleting them, and so forth. The syntax and usage of these
commands are briefly explored here.

USING CALL
The call command is used to call another batch file from within a batch file. Take
the following code line, for example:

if not exist C:\init.dat call init.bat

The line of code uses the now-familiar if statement to determine the existence of
a file called init.dat. If the file does not exist in the location specified, C:\ in this
case, the call command launches another script. In a typical batch file, the called
script would execute and, upon completion, create the file that the original if state-
ment is looking for. In this scenario, the tandem scripts ensure that if the batch file
responsible for creating C:\init.dat has not been performed (and only then), the
responsible batch file can be processed.
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USING START
You might want to launch an actual, graphical application with your batch file. By
making use of the start command, you can launch any installed application from the
command line and pass to it any supported application variables. For example, if
you wanted to have a batch file configure a new user’s network hardware and then
show that user the company network policy page on the intranet, you could build a
script that makes use of the start command. See the example code in Figure 21-5.

Figure 21-5: Using start.bat.

Don’t worry if you are not familiar with the netsh command; it’s discussed a lit-
tle later in this chapter. For now, take for granted that it is used to configure the
local network interface, in this case, with a static IP address 10.10.50.122. After the
interface is configured, the start command loads Internet Explorer (iexplore.exe)
while passing it the address of the company network usage policy, netpolicy.html.

USING SETLOCAL AND ENDLOCAL
Suppose that you wish to use the start command as in the previous example, but
you want to run an application located in a place that is not part of the current sys-
tem environment. To start some program, you will first need to define the path to
that application. To ensure that the environment variable you set is only valid dur-
ing the execution of the script, you can make use of the SetLocal and EndLocal
commands from within your batch file. SetLocal indicates that any environment
variables changed after the SetLocal statements are temporary. The EndLocal state-
ment tells the batch file when to undo the environment changes specified. Refer to
Figure 21-6 for an example.
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Figure 21-6: SetLocal and EndLocal example.

This time, instead of using Internet Explorer, the example used a program called
companywebbrowser, located in the W:\programs\customwebviewer\launcher folder.
The SetLocal/EndLocal statements allow you to temporarily add the relevant path to
the systems list of known file paths (that is, places the system will look when you try
to launch an application without the complete path in the file). You could also have
started the application using the complete path, as in the following example:

start f:\folder\subfolder\application
http://intranet.company.com/netpolicy.html

The real advantage of the SetLocal and EndLocal commands becomes apparent if
you need to repeatedly refer to the same file. For example, if you want to write the
output from a command to a file and then display that file, or if you need to use a
custom application multiple times with different parameters each time, SetLocal
and EndLocal can help keep your script manageably small because the full path
need only be entered once.

USING ECHO
If you want to control what information is displayed to the user while the script is
executed, you can use the echo command to either hide the individual commands
being executed, or to display a message to the user. For example, in the code sam-
ple in Figure 21-7, the @echo off statement hides all of the commands that it pre-
cedes. Without this command, the user would see each line as it was processed. The
line “echo please enjoy your newly configured system” is a message displayed to
the user.
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Figure 21-7: Echo command.

USING PAUSE
The pause command is used to interrupt the processing of a batch file without end-
ing the process altogether. To use this command, simply insert the command on a
line of its own in the batch file. When the pause command is encountered, the mes-
sage “Press any key to continue . . .” is displayed. When the user presses a key, the
batch will continue to process. So when would you use the pause command? One
example would be in a script that copies some user files to a floppy disk. To ensure
the user has a disk in the drive, you could use the pause command to prompt the
user to insert a floppy disk. A script that pauses to prompt the user before copying
a file from the hard drive to the floppy drive is shown in Figure 21-8.

Figure 21-8: Using pause.

Batch-Compatible System Commands
This section looks at some of the commands that you can use within a batch file to
actually perform complex systems functions, move data from one place to another,
or connect you to resources. These commands are useful for both configuring the
system at logon and performing scheduled tasks with the help of Windows XP’s
built-in scheduling software (Scheduled Task in the Control Panel). All of these
commands have a varying number of switches you can use at runtime to specify
different behaviors. Each command also has its own syntax that is expected when
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the command is used. To find all of the available switches and the syntax for any
command, run the command with the /? or -h option. For example, ipconfig /? will
give you the relevant information for the ipconfig command.

Using Net
The net command allows you to do a variety of things, including the following (to
name a few):

◆ Sharing information

◆ Mapping network drives

◆ Disconnecting previously mapped network drives

◆ Disconnecting remote user connections to the computer where the com-
mand is run

Commonly, the net command is used to add and remove network drive map-
pings. In the code sample in Figure 21-9, the net command maps a network share
as a local drive (net use), then some arbitrary commands are run, and, finally, the
mapped drives are dropped using the /delete option for the net use command.

Figure 21-9: Simple net command.

This fairly simple example can be compounded in more complex scripts where
you could be adding and removing drives to standardize the network drives used by
a particular user or user group. By assigning the batch file in question to the per-
son’s profile, you could unmount all existing network drives and restore only the
ones you want there. For example, look at Figure 21-10.

Alternatively, you can use the if command to dismount only those shares that
conflict with the ones you plan to map in the batch file. The code in Figure 21-11
checks for the existence of a drive, and if it’s there, the code deletes it and remaps.

This script ensures that the drive letter is mapped to the correct location (the
location you choose in the script), and prevents the script from removing drive let-
ter mappings that do not need to be deleted for your planned mappings to work.
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Figure 21-10: Remove existing shares and remap.

Figure 21-11: Using if and net.

Using Xcopy
Xcopy is a versatile command that allows you to copy files and directories based on
some very useful criteria options. Essentially, xcopy’s syntax allows you to specify
the location of the directory or file(s) that you want to copy and where to place the
copies of those files. Something like xcopy C:\file.a F:\file.a is used to make a basic
file transfer. The real power is in the options. Table 21-2 explains some of the key
options available with xcopy. Like most commands, you can use xcopy /? to see a
complete list of options.

TABLE 21-2 KEY XCOPY OPTIONS

Option Example Explanation

/C xcopy /C C:\files\*.* D:\ Continue processing if an error is encountered. This
is particularly useful if you’re processing a directory
with lots of files. Instead of disrupting the process,
your script will be able to complete.
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Option Example Explanation

/O xcopy /O C:\userdata This copies all of the files and transfers the file 
E:\userbackup security information as well. For example, if the file

is set to allow only one user write permission, that
security setting will be transferred. Without this
option, the security settings destination location is
applied to the copied files (no changes are made to
the original in either case).

/D xcopy /D C:\userdata This option allows you to copy files based on the 
E:\userbackup date they were last changed. You can specify the

date in the form mm-dd-yy, or you can leave off the
specification and xcopy will only copy the file if it is
newer than the file at the target destination. If no
file is at the destination, the file will be copied (the
file is “newer than nothing”).

/E xcopy /E C:\userdata This option copies everything within the source 
E:\userbackup directory including files (hidden and system files)

and all subdirectories.

/Y xcopy /o C:\userdata This option tells xcopy that if it needs to prompt the
E:\userbackup user (overwrite existing file?), it is to assume the

user answers “yes.”

The code sample in Figure 21-12 makes use of the previous net command exam-
ple and expands on it by copying files that have a newer revision date than those
at the destination (/D), copying all files and folders (/E), and continuing even if it
encounters an error (/C). *.* indicates all files and folders in the location being ref-
erenced (H, in this case).

Figure 21-12: Xcopy sample.
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Using Dir, CD, and Delete
Most folks who have used the command line environment in Windows for anything
are familiar with the dir (directory), cd (change directory), and delete commands.
The script sample in Figure 21-13 uses the same general script as with the xcopy
sample, but there are some added lines to output the remote directory list to a text
file (dir /a>dirlist1.txt after switching the context to the H: drive). It also creates
another directory map after the file copy and then deletes the original text file
(dirlist1.txt) from the remote directory.

Figure 21-13: Using the dir, cd, and delete commands.

Why would you create the text files that contain the directory information and
store them along with the newly copied files? One reason might be to ensure that
the destination structure matches the one that was copied. Remember that the /C
option makes xcopy continue on any error. If a file was locked or had security set-
tings that prevented the user running the script from being able to read the file, the
batch would still complete normally.

Using Netsh
If you need to configure a network interface from the command line, the netsh
command is the best tool for the job. The netsh command can also be used to dis-
play information about the networking configuration of the target computer. The
computer where you want to make the change needs to execute the netsh command
locally, so using this command in a logon script can be particularly useful. At first
glance, the syntax for the netsh command can be a bit overwhelming because it
makes use of a dizzying array of run options. To explore these options, open a
command prompt and type netsh. This launches the netsh command and creates a
new prompt (see Figure 21-14).
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Figure 21-14: Accessing netsh help.

By entering one of the commands revealed in the preceding figure, followed by
a ?, you can see the further suboptions of that netsh option. In this manner, you can
drill down through the command options until you have revealed the syntax you
need to perform a particular task from the command line. In the code sample that
follows, the command “netsh interface ip set address local static 10.44.23.122
255.255.255.0 10.44.23.1 1” configures the local network adapter to use the IP
address 10.44.23.122 with a default gateway of 10.44.23.1. Next, the script maps a
network drive. If you were making use of access control lists that restrict the access
to sensitive network data based on the IP address of the host connecting to the
resource, this script could be useful. Of course, you’d have to be exceedingly care-
ful with this configuration because duplicating IP addresses would be fairly easy.

netsh interface ip set address local static 10.44.23.122
255.255.255.0 10.44.23.1 1
net use R: \\server6\userfiles

A version of this script that forces hosts to use Dynamic Host Configuration
Protocol (DHCP) instead of a static address might be a bit more practical. The script
would ensure that all network hosts remained DHCP clients regardless of any
changes the previous user made.
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Gathering Information with ipconfig and netstat
Sometimes you might just want to collect information about the configuration of
PCs as they are when a user logs on to the system. You might also want to collect
information about the ports to which the system is currently listening, and which IP
ports have users currently connected. By redirecting the output of the ipconfig and
netstat commands, you can create a centralized repository of the needed informa-
tion. Several options are available with each command. If you execute either com-
mand with the /? switch, you will be shown all of the available options. In the
script sample in Figure 21-15, the ipconfig command sends all of the configuration
output to a text file that uses the currently logged on user’s name. Netstat dumps all
of the current open ports and connections into a text file for review.

Figure 21-15: ipconfig and netstat scripts.

The result is that two text files containing the output of the two commands that
were executed will be in a folder bearing the user’s name.
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Scheduling Batch Files
The Windows XP Scheduler is particularly handy if you want to automate batch file use
that occurs at a time other than user logon. By scheduling the time of execution and
specifying the credentials to use, you can schedule batch files to do a wealth of tasks.
For example, if you make use of NT Backup to save system data, you could schedule a
batch file to grab network data before the backup begins. Your script could make use of
the xcopy and net commands to connect to shares (administrative or otherwise), and
then copy all of the files in those mapped drives to a location on the system scheduled
to have the backup performed. This way, using only Windows Backup and a batch file,
you could have a networkwide backup solution. While this configuration does not scale
well for large networks, it is ideal for small networks or workgroups. An example of
source code that would grab network data appears in the next section.
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Sample Network Backup Script
Here’s a sample network backup script you can try:

rem Network Backup Script
rem Maps administrative shares and copies “My Documents” from each
user to a
rem corresponding folder on the system running the backup
rem This section maps administrative shares and requires the account
rem running the script to have administrative access to the target
host
net use F: \\host1\c$
net use G: \\host2\c$
net use H: \\host3\c$
net use I: \\host4\c$
rem This section begins to copy all of the files in the documents
and settings folder on
rem the target drive. Use ‘xcopy /?’ to see the function of each
switch used.
xcopy /c /h /o /d /e F:\docume~1 C:\host1
xcopy /c /h /o /d /e G:\docume~1 C:\host2
xcopy /c /h /o /d /e H:\docume~1 C:\host3
xcopy /c /h /o /d /e H:\docume~1 C:\host4
rem This section deletes the mapped drives since they are no longer
needed. This is 
rem a security precaution.
net use /delete F:
net use /delete G:
net use /delete H:
net use /delete I:

This code has quite a bit going on. This is a server-side script in that it would
need to run on the device that will be performing the system backup. The first sec-
tion of the code uses the net command to connect to the administrative shares on a
series of hosts. To make a connection to the hidden share, the target machine will
need to be using Windows NT, Windows 2000, Windows XP, or Windows 2003
Server in a default configuration. You will also need to schedule the batch file to run
under the credentials of a user who has administrative access to all of the target
machines.

After the drives are connected, a series of xcopy commands is used to move con-
tent from the target to the backup system. The series of switches used specifies that
xcopy continues in the event that it does the following:

◆ Encounters a fault (/C)

◆ Copies hidden files (/H)
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◆ Carries the Access Control List (ACL or file security) settings (/O)

◆ Only moves files if they are newer than the ones on the backup system (/D)

◆ Copies all files and subdirectories (/E)

Finally, a series of net commands is used to disconnect the mapped drives. This
step is really a tidying-up procedure that is not absolutely essential.
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Appendix A

Windows XP Installation
Options
IN THIS APPENDIX

◆ Using an attended installation

◆ Using an unattended installation

INSTALLING ANY OPERATING SYSTEM can be a grueling task; after all, you never know
what problems you might encounter along the way. Fortunately, Windows XP is
generally an easy operating system to install, but you might consider a number of
different installation options, and if you are working with Windows XP in a larger
network environment and have inherited the task of installing several computers,
there are a few advanced setup features you might want to consider. Regardless of
your needs, this appendix explores Windows XP installation and the options avail-
able to you.

Performing an Attended Installation
An attended installation of Windows XP Professional means that you will attend to
the computer as installation is taking place. In this situation, you use a CD-ROM to
install Windows XP, or you can install Windows XP over the network from a net-
work share. In either case, you physically run the installation and answer installa-
tion prompts as they occur.

As with previous versions of Windows, particularly Windows 2000 Professional,
the key to a successful Windows XP Professional installation is careful planning
before the installation takes place. Through proper planning, you can avoid prob-
lems before they occur, and you can make sure your computer and applications are
ready to meet the demands of Windows XP Professional. Armed with the correct
information, installation is typically anticlimactic because you solve potential
problems before they occur. In the following sections, you’ll explore the important
planning steps you should take before installing Windows XP Professional.
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Minimum Hardware Requirements
Like all operating systems, Windows XP has certain hardware requirements that
must be met before it can be installed, or at least hope for it to perform in a satis-
factory manner. Before installing Windows XP Professional, check out the com-
puter’s hardware and make sure it is powerful enough to handle the demands of
Windows XP. Table A-1 gives you the minimum hardware requirements as well as
the recommended hardware requirements for Windows XP. As you might expect,
the base, or minimum, hardware requirements are just that — what you need to
install Windows XP Professional for it to actually run. However, if you want good
performance from the machine, you should meet the recommended hardware
requirements and, preferably, exceed them.

TABLE A-1 MINIMUM HARDWARE REQUIREMENTS

Component Minimum Requirement Recommended Requirement

Processor 233-MHz Pentium 300 MHz or higher — the faster the
processor, the better performance you
are likely to see

RAM 64 MB 128+ MB recommended — 4 GB
maximum

Hard Disk Space 1.5 GB free disk space 4+ GB

Monitor VGA Monitor VGA Monitor

Mouse Windows compatible Windows compatible

CD-ROM Windows compatible CD or Windows compatible CD or DVD-ROM
DVD-ROM drive drive

Network Card Compatible network card and Compatible network card and cable if 
cable if over-the-network over-the-network installation is desired
installation is desired

During the setup routine, Windows XP Professional will check the computer’s
hardware and software applications to determine if there are incompatibilities.
However, your best bet is to check these items first so that problems can be avoided
during installation. You should also take inventory of the computer’s hardware, such
as the sound card, video card, modem, and related components, and check the
Windows XP Hardware Compatibility List (HCL) found at www.microsoft.com/hcl.
Some devices might not appear on the HCL; however, this does not mean that the
hardware will not work — Microsoft just hasn’t tested it. If you have questionable
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hardware, check the hardware manufacturer’s Web site for more information and
possible driver updates or upgrade packs. You should acquire the new drivers or
updates before starting the installation of Windows XP Professional.

If you are installing Windows XP Professional on a computer that has no exist-
ing operating system, and XP is the only operating system you want to use, there is
nothing you need to do. The setup routine will format the drive for you and allow
you to choose a file system of choice (FAT32 or NTFS). Windows XP is optimized
for the NTFS file system, which provides file-level security and a host of additional
security features that are not available under FAT or FAT32.

If an operating system currently exists on your computer, Windows XP can
either upgrade the existing operating system, install a clean copy of Windows XP
(which essentially erases the previous operating system and data), or you can install
Windows XP Professional in a separate partition for a dual-boot scenario. A dual-
boot scenario enables you to boot more than one operating system on the same
computer. For example, you could have a system that will boot Windows 2000
Server and Windows XP Professional, or a system that will boot Windows Me or
Windows XP Professional. Each operating system resides in its own partition, and
during boot, you are given a boot menu so that you can choose which operating
system you want to boot. Across the board, dual-boot configurations are easy to
configure, but keep in mind that only Windows XP, Windows 2000, and Windows
NT 4.0 can read NTFS partitions. Windows 9x, Me, and 95 can only read FAT or
FAT32 drives. So, if you want the downlevel operating system to read the Windows
XP partition, you’ll need to use FAT32 as the file system instead of NTFS.

Getting Ready for an Upgrade
When you upgrade an operating system, you keep all of your existing files and set-
tings, which are then moved to the new operating system when it is installed. When
you begin the installation of Windows XP, the setup routine detects any previous
versions of Windows that may be present; depending on the version, Windows XP
can either upgrade the existing operating system or it can install a clean copy of
Windows XP. When you upgrade, Windows XP installs in the same folder as the
previous operating system, upgrading files and drivers, as needed. Your existing
applications and settings are preserved. When you clean install, Windows XP
installs in a different folder. After installation is complete, you must reinstall any
applications that you want to use. As a general rule, upgrading to Windows XP is
very easy and straightforward, but make certain you adhere to the guidelines
explored in the following sections.

If you are upgrading a previous operating system, such as Windows 2000,

make sure you have the latest service pack installed before you start the

upgrade.This action will help reduce the likelihood of installation problems.

See Microsoft.com to find out more about available service packs.
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Upgrade Compatibility
All hardware requirements still apply in an upgrade scenario, so it is important to
check out the computer’s hardware before starting an upgrade. Also, spend a few
moments checking out the applications you are installing to see if they are com-
patible with Windows XP. You can check the software vendors’ Web sites for
upgrade information.

Windows XP Professional can directly upgrade the following operating systems:

◆ All versions of Windows 98

◆ Windows Me

◆ Windows NT 4.0 Workstation (with service pack 6 or later)

◆ Windows 2000 Professional

◆ Windows XP Home edition

Notice that Windows 95 did not make the list, nor did any previous versions of
Windows NT. If you want to upgrade these operating systems, your only choice is
to either choose a clean install (in which case you lose all of your applications and
settings), or to upgrade the unsupported operating system to a supported version,
then upgrade to Windows XP. For example, you could upgrade Windows 95 to
Windows 98, and then to Windows XP.

Application Compatibility
Before upgrading to Windows XP Professional, take a look at the applications that
you want to use with the operating system. If you are moving from some earlier
version of Windows, such as Windows 98, you may have applications that are
incompatible with Windows XP. If you are moving from Windows 2000, you are
not likely to experience any problems.

Finally, you need to remove any software that may interfere with installation.
You should remove any antivirus programs. Setup needs full access to your com-
puter’s hard drive and antivirus programs may interfere. Also, you cannot install
Windows XP Professional on any drives that are compressed. Decompress affected
drives before running the installation. Finally, remove any disk management soft-
ware, as these programs can interfere with installation.

Installing Windows XP Professional
Windows XP Professional can be installed as an attended installation using the
installation CD-ROM or over the network from a network share. In many network
environments, the network installation option is often used to make installations
easier and provide one central location for the installation files. The following sec-
tions explore both types of installations.
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Installing from a CD-ROM
The Windows XP installation CD is bootable, and you can start installation by
booting from the CD if your computer supports CD booting. In an upgrade or clean
install scenario, just insert the CD-ROM while you are booted into your current
operating system and follow the setup instructions. If your computer has no oper-
ating system and your CD-ROM drive is not bootable, you’ll need to boot into DOS
using a startup disk (or even a Windows 98 startup disk). You can then start the
installation by accessing your CD-ROM drive and running setup.exe.

At the Welcome to Microsoft Windows XP screen, you can launch setup or you
can have setup check your system for compatibility. Setup is rather straightforward,
and the following steps will guide you:

1. Launch the CD-ROM or setup.exe, as necessary, for your particular 
installation.

2. Setup begins and collects information about your computer. In the
Welcome to Windows Setup screen, shown in Figure A-1, you can use the
drop-down menu to select New Installation or Upgrade. Make your deci-
sion and click Next.

3. The Licensing Agreement window appears. Read the agreement, click the I
Accept this Agreement radio button, and click Next.

4. The product key window appears. Enter the 25-character product key that
is found on the yellow sticker on the back of your CD case. Enter the key,
and click Next.

5. The Setup Options window appears, as shown in Figure A-2, if you
selected the Clean Install option in Step 2. At this point, you can change
the Accessibility Options and language, if desired, and you can also click
the Advanced Options button.
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Create a Backup
The smartest action you can take before installing Windows XP Professional as an
upgrade is to back up the previous operating system and all of your data. In the event
that something goes wrong during installation, you can always recover from backup.
Of course, if you are installing a clean copy of Windows XP Professional or installing
XP on a new computer with no operating system, a backup is unnecessary. In an
upgrade scenario, however, it is very important to protect your data by backing it up.
Depending on the operating system you are currently using, your backup options may
vary, and you can even use third-party backup tools, so you’ll need to check your
current operating system for backup instructions.
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Figure A-1: Select the kind of installation you want.

Figure A-2: Setup Options.

6. In the Advanced Options window, shown in Figure A-3, you have the fol-
lowing options:

■ Installation file copy—You can specify the location from which the setup
files should be copied. This feature can be useful if you need to start setup
from a CD, but actually want the files copied from another location.

■ Folder location — You can specify the folder name to which the files
should be copied. \Windows is the default and typically what you
should use.

■ Copy all installation files from the Setup CD — Use this option to copy
all files to the computer’s hard drive before beginning installation. This
feature can be helpful if you need to install several computers but only
have one CD. You can copy the files and continue with installation
without the CD-ROM so that it can be used on another machine.
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■ I want to choose the install drive letter and partition during Setup —
This option allows you to choose the install drive letter and partition.

Figure A-3: Advanced Options.

Make any desired selections, click OK, and then click Next.

7. The Setup Files window appears. You can choose to connect to the Internet
and check for updated files that can be downloaded and used during the
installation. Your current operating system must be configured with an
Internet connection for this option to work, but if you have a connection,
you should use the option. Choose either Yes or No and click Next.

8. At this point, the file copy process begins. Setup copies the necessary files
to your computer’s hard drive, and then automatically reboots your com-
puter (make sure there is no floppy disk in the disk drive).

9. After the computer reboots, the MS-DOS portion of setup begins. The
Setup Notification window appears. Press Enter to Continue.

10. In the Welcome to Setup window, you can choose to install Windows XP
Professional now by pressing Enter, repair an existing installation by press-
ing R, or quit setup by pressing F3. Press Enter to continue with Setup.

11. Depending on your upgrade or clean install choices, you may see a parti-
tion window where you can choose the desired partition in which you
want to install Windows XP Professional and format that partition, as
well. Follow the setups that appear to select a desired partition, create a
partition from unpartitioned space, and to format that partition.

12. After the partition is established and formatted with a file system, the file
copy process begins. This may take some time and requires no interven-
tion from you.

13. After the file copy process is complete, the computer automatically
reboots. At this point, you see the Windows XP setup screen and installa-
tion continues. The approximate amount of time that setup will require is
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also displayed here. It is not unusual for the screen to flicker several times
during this phase of setup.

14. During the installation of Windows XP Professional, the Regional and
Language Options window appears. You can click the Customize button to
choose a different language or region, or you can click the Details button
to view information about your current regional configuration. Click Next
to continue.

15. In the Personalize Your Software window, enter your name and organiza-
tion. Click Next.

16. In the Computer Name and Administrator password window, enter a name
for the computer (or accept the default) and an administrator password.
The password will be used in conjunction with the Windows XP
Professional administrator account and should be kept private. Typically,
for the best security, the local administrator password should be at least
seven characters long and should contain both letters and numbers.

17. In the Modem Dialing information window, choose your country and
enter your area code and outside line number (if necessary). This window
does not appear if you do not have a modem attached to your computer.
Click Next.

18. In the Date and Time Settings window, use the drop-down menus to
choose the correct time, date, and time zone. Click Next.

19. Setup continues and a Networking Settings window appears if a network
adapter card is installed on the computer. You can choose Typical
Settings, which installs TCP/IP, Client for Microsoft Networks, and File
and Printer Sharing for Microsoft Networks. If you want to select the ser-
vices and IP address you will configure, choose the Custom Settings
option and click Next to complete the information.

20. The Choose Workgroup or Computer Domain window appears. Choose a
desired work or domain name and click Next. If you are creating a new
workgroup, enter the desired name in the provided dialog box.

21. Setup continues and may require another 30 minutes or longer before the
computer reboots.

22. After the computer reboots, Windows XP Professional boots for the first
time.

Once setup completes, a few questions appear, such as the configuration of an
Internet connection, the user’s name, registration, and so on. The user can also
choose to activate Windows XP Professional if an Internet connection exists. See
Activating Windows XP later in this chapter for more information about activation
of the software.
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Installing from a Network Share
Rather than using a Windows XP CD-ROM for an attended installation, you can
connect to a network share and begin setup over the network. This feature is often
used to install a group of computers at the same time so that you do not have to
wait for an installation CD to become available. The actual installation steps and
procedures remain the same when installing over a network share, but you start the
installation by connecting to the network and share launching setup.exe.

To install Windows XP Professional over the network, you must first set up a
server that will function as a distribution server. This server holds a shared folder
that contains all of the contents of the Windows XP Professional installation
CD-ROM. In actuality, the distribution server can be any computer on the network
that can share files and folders. To use a distribution server, create a shared folder on
the desired computer, and then copy the contents from the Windows XP installation
CD-ROM to this folder. For client computers to access the shared folder, the client
computer must be configured with a network card and connection cabling. In most
cases, the use of a distribution server is helpful for upgrades, where IT support per-
sonnel or even end users themselves use the existing operating system to connect to
the shared folder and begin installation. If a computer has no current operating sys-
tem, you would need a network boot disk to install Windows XP in this manner.

To begin the installation, the client computer simply connects to the distribution
server’s shared folder and launches setup.exe. For example, if the distribution
server’s name is Server1 and the shared folder’s name is XP, you can start the
installation by connecting to \\Server1\XP\setup.exe. When setup.exe is launched,
the files are copied from the distribution server to the client computer, and installa-
tion proceeds as it typically would.

Using Winnt32.exe
Winnt32.exe is a setup program used to start a Windows XP installation using a
variety of setup switches. Windows XP Professional, like previous versions of
Windows, supports Winnt32.exe, and you can use this program for an upgrade of
supported versions of Windows. Using the provided setup switches, you can make
the installation of Windows XP easier by invoking different needs or setup options
automatically. Also, if you want to use an unattended installation of Windows XP
Professional, you can start the unattended installation using Winnt32.exe. Table A-
2 provides an explanation of the available command line switches appearing in the
following Winnt32.exe syntax.

winnt32 [/checkupgradeonly] [/cmd:command_line] [/cmdcons]
[/copydir:i386\folder_name] [/copysource:folder_name]
[/debug[level]:[filename]] [/dudisable] [/duprepare:pathname]
[/dushare:pathname] [/m:folder_name] [/makelocalsource] [/noreboot]
[/s:sourcepath] [/syspart:drive_letter] [/tempdrive:drive_letter]
[/udf:id [,UDB_file]][/unattend[num]:[answer_file]]
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TABLE A-2 AVAILABLE COMMAND LINE SWITCHES

Switch Explanation

/checkupgradeonly Checks your computer for upgrade compatibility with Windows XP. If
you use this option with /unattend, no user input is required.
Otherwise, the results are displayed on the screen, and you can save
them under the filename you specify. The default filename is
Upgrade.txt in the systemroot folder.

/cmd:command_line Tells Setup to carry out a specific command before the final phase of
Setup. This occurs after your computer has restarted and after Setup
has collected the necessary configuration information, but before
Setup is complete.

/cmdcons Installs the Recovery Console as a startup option on a functioning
computer. You can only use the /cmdcons option after normal Setup
is finished.

/copydir:i386\ Creates an additional folder within the folder in which the 
folder_name Windows XP files are installed. You can use /copydir to create as

many additional folders as you want.

/copysource: Creates a temporary additional folder within the folder in which
folder_name the Windows XP files are installed. You can use /copysource to create

as many additional folders as you want, but the folders /copydir
creates, /copysource folders are deleted after Setup completes.

/debug[level]: Creates a debug log at the level specified, for example, 
[filename] /debug4:Debug.log. The default log file is C:\systemroot\

Winnt32.log, and the default debug level is 2. The log levels are as
follows: 0 represents severe errors, 1 represents errors, 2 represents
warnings, 3 represents information, and 4 represents detailed
information for debugging. Each level includes the levels below it.

/dudisable Stops Dynamic Update from running. This option will disable
Dynamic Update even if you use an answer file and specify Dynamic
Update options in that file.

/duprepare:pathname Carries out preparations on an installation share so that it can be
used with Dynamic Update files that you downloaded from the
Windows Update Web site. This share can then be used for installing
Windows XP on multiple clients.

/dushare:pathname Specifies a share on which you previously downloaded Dynamic
Update from the Windows Update Web site, and on which you
previously ran /duprepare:pathname. When run on a client, specifies
that the client installation will make use of the updated files on the
share specified in the pathname.
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Switch Explanation

/m:folder_name Specifies that Setup copies replacement files from an alternate
location. Instructs Setup to look in the alternate location first, and if
files are present, to use them instead of the files from the default
location.

/makelocalsource Tells Setup to copy all installation source files to the local hard disk.
Use /makelocalsource when installing from a CD to provide
installation files when the CD is not available later in the installation.

/noreboot Instructs Setup not to restart the computer after the file copy phase
of Setup is completed so that you can execute another command.

/s:sourcepath Specifies the source location of the Windows XP files. To
simultaneously copy files from multiple servers, type the
/s:sourcepath option multiple times (up to a maximum of eight). If
you type the option multiple times, the first server specified must be
available, or Setup will fail.

/syspart:drive_letter Specifies that you can copy Setup startup files to a hard disk, mark
the disk as active, and then install the disk into another computer.
When you start that computer, it automatically starts with the next
phase of Setup. You must always use the /tempdrive parameter with
the /syspart parameter. 

/tempdrive:drive_letter Directs Setup to place temporary files on the specified partition. For
a new installation, Windows XP will also be installed on the specified
partition. For an upgrade, the /tempdrive option affects the
placement of temporary files only; the operating system will be
upgraded in the partition from which you run winnt32.

/udf:id [,UDB_file] Uses an identifier (id) that Setup uses to specify how a Uniqueness
Database (UDB) file modifies an answer file (see the /unattend entry).

/unattend Runs an upgrade using the previous operating system (if supported).
All user settings are taken from the previous installation, so no user
intervention is required during Setup.

/unattend[num]: Performs a fresh installation in unattended Setup mode. The 
[answer_file] specified answer_file provides Setup with your custom specifications.

(Num is the number of seconds between the time that Setup finishes
copying the files and when it restarts your computer. You can use
num on any computer running Windows 98, Windows Me, Windows
NT, Windows 2000, or Windows XP.)
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Activating Windows XP
Windows XP Home and Professional versions use a new feature from Microsoft
called Product Activation. Due to software piracy, product activation is now used to
enforce the end user license agreement where one copy of Windows XP can be
installed on one computer only. This feature prevents the copying of installation
CDs, otherwise known as softlifting.

During installation, the product key found on the back of the CD-ROM case is
combined with a generated hardware identifier number, taken from information
about the computer system on which the software is being installed. Taken together,
the two numbers create a unique installation ID that is uploaded to Microsoft
servers via the Internet, or manually through a call to Microsoft customer support.
Once the product is activated, the CD cannot be used to install another computer
with Windows XP Professional, which enforces the end user license agreement of
one CD per computer. In large environments where large numbers of computers are
configured with Windows XP Professional, activation may work differently or not
be necessary at all, depending on the licensing agreement between the corporation
and Microsoft.

In a typical activation scenario, you are prompted to activate Windows XP after
an installation completes, if a modem is detected on the computer. If one is not
detected or a connection cannot be made, you will be prompted to contact
Microsoft to manually activate the product. You can skip over this step and activate
Windows at a later time because you are given a 30-day grace period in which to
activate it. If Windows XP is not activated immediately after Setup, an activation
icon appears in the Notification Area which you can click to start the activation
process, or simply click Start → All Programs → Activate Windows.

Moving Files and Settings to Windows XP
One of the big problems with a new computer system is migrating documents and
settings to that new computer. As PC upgrades and changes have become more
common in the ever-growing hardware market, this problem has only grown —
even at the home user level. Windows XP Professional answers this question by
providing a new File and Settings Transfer Wizard.

The File and Settings Transfer Wizard enables you to copy files and settings
from a previous version of Windows where they are saved on some kind of remov-
able media or network connection and then transferred to a new computer. Keep in
mind that this feature works for moving data from one computer to another and is
not necessary when upgrading the operating system on the same computer. For
example, say I have an old Windows 98 computer and I purchase a new computer
with Windows XP. I can use the File and Settings Transfer Wizard to move all of
my information and settings to the new computer quickly and easily. You can
transfer files and settings from any version of Windows 95, Windows 98, Windows
Me, Windows NT 4.0, Windows 2000, or Windows XP (32-bit only).
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The File and Settings Transfer Wizard can transfer settings from the following:

◆ Accessibility

◆ Command prompt settings

◆ Display properties

◆ Internet Explorer settings

◆ Microsoft Messenger settings

◆ NetMeeting settings

◆ Mouse and keyboard settings

◆ MSN Explorer

◆ Network printers and drivers

◆ Outlook Express

◆ Regional settings

◆ Sounds and multimedia

◆ Taskbar options

◆ Windows Media Player

◆ Windows Movie Maker

You may also be able to transfer settings from other software, such as Microsoft
Outlook. The wizard can also transfer specific folders, such as the following:

◆ Desktop

◆ Fonts

◆ My Documents

◆ My Pictures

◆ Shared Desktop

◆ Shared Documents

Additionally, the wizard can transfer most multimedia files not found in these
folders.

To transfer settings from an older version of Windows, you can use the Windows
XP installation CD, and then follow these steps:

1. On the downlevel computer, insert the Windows XP Professional CD-ROM.
At the Windows XP startup screen, click Perform Additional Tasks, and
then click Transfer Files and Settings.
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2. The File and Settings Transfer Wizard appears. Click Next.

3. The system is scanned and the Select a method of transfer window
appears. You can choose to use a direct cable connection, network con-
nection, removable media connection, or another type of connection (such
as saving the settings to a disk drive or a network folder). Make your
selection and click Next.

4. In the What do you want to transfer window, you can choose to transfer
settings only, files only, or both. You can click the Let me choose check
box to specifically select what you want to transfer. Make your selection
and click Next.

5. If you choose the Let me choose check box option in Step 4, the custom
window appears. From this window, you can add or remove settings and
files, file types, and folders, as desired. When you are done, click Next.

6. The wizard collects the data that you specified. This may take some time
depending on how much information you want to transfer. When the wiz-
ard is done, click Finish.

After you have completed the collection portion of the File and Settings Transfer
Wizard, you can run the wizard on your Windows XP computer so that the settings
can be migrated and configured. Once again, the File and Settings Transfer Wizard
walks you through this process. Just follow these steps:

1. Click Start → All Programs → Accessories → System Tools → Files and
Settings Transfer Wizard.

2. Click Next on the Welcome screen.

3. On the Which computer is this? screen, click the New Computer radio 
button and click Next.

4. The wizard then provides you with a screen asking if you have a Windows
XP CD and telling you that you need to run the wizard on the old com-
puter. Notice here that the wizard can create a wizard disk for you if you
are missing the CD-ROM. Because you have already collected your set-
tings in the previous exercise, click the I don’t need the wizard disk radio
button option, and then click Next.

5. Choose where the files should be collected (direct cable connection,
removable media, network folder, and so on). Make your selection and
click Next.

6. The wizard locates the files and transfers them to the new computer. Click
Finish. You will be prompted to log off and log back on for the settings to
take effect.
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Running an Unattended Installation
Windows XP Professional contains a program called Setup Manager that can help
you generate answer files for a Windows XP Professional unattended installation.
Before getting into answer file creation, let’s back up a bit and talk about unat-
tended installations and answer files. In an unattended installation, you typically
start Setup using Winnt32.exe, using an unattended switch and pointing to an
answer file.

An answer file is simply a text file that Setup can read to find the answers to
Setup prompts. For example, Setup always asks if you want to check for Dynamic
Updates on the Web. Using the answer file, you can answer the question one time;
Setup reads the file, and no input is required directly from you. The advantages are
obvious — you can start the installation routine on several or even hundreds of
computers without having to sit through the installation.

You can find a sample of an answer file in the I386 folder on your Windows XP
Professional CD-ROM. The file is called Unattend.txt, and as you can see in Figure
A-4, the file is a simple text file that you can read. In the past, answer files were
somewhat difficult because you had to write them from scratch. With Setup
Manager, a wizard guides you through the process and helps you create the answer
file, which makes unattended Setups a lot easier.

Figure A-4: Unattend.txt.

Setup Manager is located on your Windows XP Professional installation
CD-ROM in the Deploy.cab folder. You have to extract this folder to use the Setup
Manager tool so you can create an answer file. The following steps show you how
to extract the Deploy.cab folder.
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1. On the desired computer, log on as the administrator and create a folder
in which to place the deployment tools and name the folder, as desired.

2. Insert the Windows XP Professional installation CD-ROM. Close the
installation window that appears.

3. Open My Computer, right-click the CD-ROM drive, and click Explore.

4. Open the Support folder, and then open the Tools folder. You’ll see the
Deploy.cab file, as shown in Figure A-5.

Figure A-5: Deploy.cab.

5. Double-click the Deploy.cab file to open it. You’ll see several different
tools appear, including Setup Manager (setupmgr).

6. Click Edit → Select All, and then right-click the files and click Extract.

7. In the Select a Destination dialog box that appears, browse for the folder
you created, select it, and then click the Extract button. The tools are
copied from the CD-ROM to the desired folder.

Now that the Deployment tools have been copied to the desired computer, you
can create an answer file to use for an unattended installation. Remember that an
answer file simply answers the questions that the Setup routine typically poses to
you during an attended Setup. With this automated method, an IT technician can
start an installation and not have to wait for each prompt the Setup routine poses.
Instead, the answer file contains the answers that you want provided, and it can
even provide Setup with information about hardware, such as sound cards,
modems, and so on.

Of course, the Windows XP Professional CD-ROM gives you unattend.txt, which
you can use for unattended installations. This text file provides basic Setup options,
but you may need to customize your own Setup file. Using Setup Manager, you can
easily create this file, and the following steps show you how:
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1. Launch the setupmgr program in your deployment folder.

2. Click Next on the Welcome screen.

3. In the New or Existing Answer File window, shown in Figure A-6, you can
choose to create a new answer file, or you can modify an existing answer
file by selecting the option and browsing for the file. For this exercise, we
are going to create a new answer file. Click the radio button option and
click Next.

Figure A-6: Create a new file.

4. In the Product to Install window, shown in Figure A-7, you can create the
answer file for a Windows Unattended Installation, Sysprep Install, or
Remote Installation Services installation. Here, we are creating an answer
file for a Windows Unattended Installation (the other two are advanced
options that require Windows server configuration). Select the unattended
option and click Next.

5. In the select the platform that this file installs, choose the Windows XP
Professional radio button and click Next.

6. The User Interaction Level window appears, as shown in Figure A-8. You
have five different options:

■ Provide defaults — This option provides an unattended Setup where the
answers you are provided are considered the defaults. When the instal-
lation is run, the user can see the answer defaults and interrupt Setup
to change them if desired. As you can see, this option is not fully auto-
mated, but it does provide the answers up-front for review.

■ Fully automated — Using this method, the user is never prompted to
answer any questions. All answers are taken from the answer file and
the user cannot interrupt Setup or change any of the options.
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■ Hide Pages — If you provide all of the answers for the Windows Setup
Wizard page, the wizard page is hidden from the user.

■ Read Only — If the Windows Setup Wizard page is not hidden from the
user, you can use this option so that the page is read only. The user can
make no changes to the Setup wizard.

■ GUI Attended — Only the text-mode portion of Windows Setup is 
automated.

Figure A-7: Unattended installation option.

Make your selections based on the level of user input and/or automation
that you want and click Next.

Figure A-8: User Interaction Level window.

456 Windows XP for Power Users

549987 AppA.qxd  11/20/03  11:43 PM  Page 456



7. The Distribution folder window appears. When using an answer file, you
can choose to install Windows XP Professional from the CD, or from a
distribution folder. A network distribution folder holds the Windows XP
Professional installation files so you can connect to this folder over the
network. In conjunction with an answer file, you can roll out any number
of installations at one time. Choose the desired radio button and, for this
exercise, create a distribution folder. Click Next.

8. If you choose to create a distribution folder, you can copy the files from a
CD or from another location. Make your selection and click Next.

9. In the Distribution Folder Name window, you can choose to create a new
distribution folder or modify an existing one. If you choose to create a
new distribution folder, select the location and the share name for the
folder, and then click Next.

10. The License Agreement window appears. Read the basic End User License
Agreement (EULA) and click the I Accept check box. Click Next.

11. The Customize window appears. At this point, you can click through each
setting in the left window and enter your answer in the right pane. Setup
will use the answers provided here to configure the answer file, which
automates Setup. Simply respond to the answer prompts and click Next
through the entire list of settings.

12. After you answer the final prompt, a dialog box appears telling you that
Setup Manager has successfully created an answer file and prompting you
for the location to which to save the file. Choose the desired location and
click OK. Click Finish when prompted.

After the answer file is created, you can begin running unattended Setups with
the answer file. Once you are ready to run Setup, you can use Winnt32 to begin the
unattended installation of Windows XP Professional. The syntax for running the
unattended Setup is as follows:

Winnt32 /s: d:\i386 /u:c:\unattend\unattend.txt

Where:

◆ /s: d:\i386 — Specifies the location of the Windows XP Professional
installation files — this can be your I386 folder on the CD-ROM or a net-
work distribution folder.

◆ /u:c:\unattend\unattend.txt — Specifies that this is an unattended installa-
tion and the answer file is unattend.txt and is located in the Unattend
folder on the C: drive. Of course, your location will probably be different,
so just enter the correct UNC path to the answer file.
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Common Troubleshooting Issues
No installation is foolproof, and problems can occur when you install Windows XP.
Typically, if you follow the hardware guidelines and setup procedures, you are unlikely
to experience installation problems, but you should be aware of the potential
problems and troubleshooting areas you should examine.

In a typical Windows XP Professional installation scenario, the most common causes
of installation problems or failure are as follows:

◆ Hardware is incompatible or hardware does not meet the minimum hardware
requirements. Typically, Windows XP will tell you if the hardware in the PC is
incompatible or does not meet minimum standards; however, in a failed
installation, you should always start here and make sure there are no com-
patibility problems.

◆ Some CD-ROM drives, particularly older drives, might not work well with
Windows XP. Make sure the CD-ROM drive is compatible. Also, make sure
you do not have a faulty CD.

◆ During hardware detection and driver installation, your computer can lock
up. Although this typically does not happen with Windows XP, you can sim-
ply restart the computer, and installation should continue where it left off.

◆ Make sure your video card is up-to-date and is supported by Windows XP
Professional. Installation problems can occur due to faulty video cards.

If you are having extensive problems with Setup and you have checked the preceding
points, you can also access a Setup log to determine what problems may have
occurred. This assumes that you can get the operating system actually installed. The
log is called setupact.txt and is located in C:\Winnt (if you installed in a different
drive, just substitute the correct drive letter for C:).
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Appendix B

Using the Command
Console
IN THIS APPENDIX

◆ Understanding the command console

◆ Using the command console

THE COMMAND CONSOLE IS certainly still available in Windows XP and ready for
your use. In the past, the command console was the main interface of most com-
puting systems. Today, of course, the need for the command console has diminished
as graphical interfaces do more and quickly provide the configuration and access
options you need. However, many tasks can still be accomplished more quickly and
easily using the command console, and this appendix gives you a quick overview
of the console and the commands you might want to use from time to time.

Getting to Know the 
Command Console
The Windows XP command console, cmd.exe, is the one you should use for all of
your command line activities. If you are wondering what happened to
Command.com from earlier Windows days, it is still around and supported in
Windows XP for backwards compatibility with older applications that need
Command.com. However, cmd.exe is a 32-bit version of the command console, and
it allows you to do things that Command.com cannot do, such as run external MS-
DOS commands, batch files, and support other commands that Command.com does
not support. So, the quick lesson here is to always use cmd.exe, unless you have a
specific reason for using Command.com.

You can open cmd.exe easily by clicking Start → Run and typing cmd at the Run
line, then press Enter. The command console (shown in Figure B-1) appears, show-
ing your logon name. The prompt is now ready to receive commands. You can type
help to get a listing of commands (which are also listed later in this appendix), 
or exit to leave the command console. You can also click the X in the upper-right
corner to exit. 459
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Figure B-1: The command console.

One important note here is the color and style of the command console, which
gives you a black background and white lettering by default. You can right-click
the command console title bar and click Properties to open a Properties dialog box.
On the Options tab, you can manage the cursor size and display options, along with
command history and edit options. On the Font tab, you can change the font used
for the command console, which can be helpful if the default font is difficult to
read. On the Layout tab, you can change the screen buffer size, window size, and
window position for further customization. On the Colors tab, shown in Figure B-2,
you can determine what colors are used on the text and background. As you can
see, these options are easy to change and can make the command console easier for
you to use.

Figure B-2: You can manage the appearance of the command console.
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Syntax
The common command console syntax you can use with commands provides you
with a few different options for using the command console and getting the results
you want. Keep in mind that each command may contain additional parameters
you can use, which you can find by typing the command with a /? at the command
line. For example, you can type start /? at the command line to see all of the para-
meters for the start command, as you can see in Figure B-3.

Figure B-3: Find the parameters for any command using the /? option.

Otherwise, you can use the following parameters for cmd:

cmd [[{/c|/k}] [/s] [/q] [/d] [{/a|/u}] [/t:fg] [/e:{on|off}]
[/f:{on|off}] [/v:{on|off}] string]

◆ /c — Carries out the command specified by string and then stops.

◆ /k — Carries out the command specified by string and continues.

◆ /s — Modifies the treatment of string after /c or /k.

◆ /q — Turns the echo off.

◆ /d — Disables the execution of AutoRun commands.

◆ /a — Creates American National Standards Institute (ANSI) output.

◆ /u — Creates Unicode output.

Appendix B: Using the Command Console 461

549987 AppB.qxd  11/20/03  11:44 PM  Page 461



◆ /t:fg — Sets the foreground (f) and background (g) colors. You have the fol-
lowing values you can use for f and g.

■ 0 = Black

■ 1= Blue

■ 2 = Green

■ 3 = Aqua

■ 4 = Red

■ 5 = Purple

■ 6 = Yellow

■ 7 = White

■ 8 = Gray

■ 9 = Light Blue

■ A = Light Green

■ B = Light Aqua

■ C = Light Red

■ D = Light Purple

■ E = Light Yellow

■ F = Bright White

◆ /e:on — Enables command extensions.

◆ /e:off — Disables command extensions.

◆ /f:on — Enables file and directory name completion.

◆ /f:off — Disables file and directory name completion.

◆ /v:on — Enables delayed environment variable expansion.

◆ /v:off — Disables delayed environment variable expansion.

◆ string — Specifies the command you want to carry out.

◆ /? — Displays help at the command prompt.

Editing the Command Line
One of the frustrations of the command line is mistakes. When typing commands, it
is easy to make mistakes, and in the past, command consoles have not exactly been
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easy to maneuver around in. Cmd.exe gives you several keyboard strokes you can use
to move around within the command line to fix errors and see what you have done.
Try the options listed in Table B-1 when you are working with the command line:

TABLE B-1 COMMAND LINE OPTIONS

Option Action

Up Recalls the previous command in the command history

Down Recalls the next command in the command history

PgUp Recalls the earliest command used in the current session

PgDn Recalls the most recent command used in the current session

Left Moves left one character

Right Moves right one character

Ctrl+Left Moves left one word

Ctrl+Right Moves right one word

Home Moves to the beginning of the line

End Moves to the end of the line

Esc Clears the current command

F7 Displays the command history in a scrollable pop-up box

F8 Displays commands that start with characters currently on the 
command line

Alt+F7 Clears the command history

Common Commands
If you type help at the command prompt, you can see a list of common commands
available to you, which are also listed in Table B-2. As  mentioned previously, you
can type any command with the /? switch to see all of the parameter options for
that command.
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TABLE B-2 COMMON COMMANDS

Command Action

ASSOC Displays or modifies file extension associations

AT Schedules commands or programs to run on a computer

ATTRIB Displays or changes file extensions

BREAK Sets or clears extended CTRL+C checking

CALCS Displays or modifies access control lists of files

CALL Calls one batch program from another

CD Displays the name of or changes the current directory

CHCP Displays or sets the active code page number

CHDIR Displays the name of or changes the current directory

CHKDSK Checks a disk and displays a status report

CHKNTFS Displays or modifies the checking of a disk at boot time

CLS Clears the screen

CMD Starts a new instance of the command console

COLOR Sets the default console foreground and background colors

COMP Compares the contents of two files or sets of files

COMPACT Displays or alters the compression of files on NT File System (NTFS)
partitions

CONVERT Converts file allocation table (FAT) drives to NTFS

COPY Copies one or more files to another location

DATE Displays or sets the date

DEL Deletes one or more files

DIR Displays a list of files and subdirectories in a directory

DISKCOMP Compares the contents of two floppy disks

DISKCOPY Copies the contents of one floppy disk to another

DOSKEY Edits command lines, recalls Windows commands, and creates macros

ECHO Displays messages or turns echoing on or off

ENDLOCAL Ends localization of environment changes in a batch file
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Command Action

ERASE Deletes one or more files

EXIT Quits the CMD.exe program

FC Compares two files or sets of files and displays the differences 
between them

FIND Searches for a text string in a file or files

FINDSTR Searches for strings in files

FOR Runs a specified command for each file in a set of files

FORMAT Formats a disk for use with Windows

FTYPE Displays or modifies file types used in file extension associations

GOTO Directs the Windows command interpreter to a labeled line in a 
batch program

GRAFTABL Enables Windows to display an extended character set in a 
graphics mode

HELP Provides command line help information

IF Performs conditional processing in batch programs

LABEL Creates, changes, or deletes the volume label of a disk

MD Creates a directory

MKDIR Creates a directory

MODE Configures a system device

MORE Displays output one screen at a time

MOVE Moves one or more files from one folder to another

PATH Displays or sets a search path for executable files

PAUSE Suspends processing of a batch file and displays a message

POPD Restores the previous value of the current directory saved by PUSHD

PRINT Prints a text file

PROMPT Changes the Windows command prompt

PUSHD Saves the current directory and then changes it

RD Removes a directory

Continued
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TABLE B-2 COMMON COMMANDS (Continued)

Command Action

RECOVER Recovers readable information from a bad or defective disk

REM Records comments in a batch file

REN Renames a file or files

RENAME Renames a file or files

REPLACE Replaces files

RMDIR Removes a directory

SET Displays, sets, or removes Windows environment variables

SETLOCAL Begins localization of environment changes in a batch file

SHIFT Shifts the position of replaceable parameters in batch files

SORT Sorts input

START Starts a separate window to run a specified program or command

SUBST Associates a path with a drive letter

TIME Displays or sets the system time

TITLE Sets the window title for a CMD.exe session

TREE Graphically displays the directory structure of a drive or path

TYPE Displays the contents of a text file

VER Displays the Windows version

VERIFY Tells Window whether to verify that your files are written correctly 
to a disk

VOL Displays a disk volume label and serial number

XCOPY Copies files and directory trees
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Appendix C

Helpful Windows XP
Utilities
IN THIS APPENDIX

◆ Helpful software you can use

LET’S FACE IT; WE all love free utilities for Windows, especially those that do some
cool things or make Windows XP run a bit better. I’ve scoured the Web in search of
useful utilities and have found more than I can even list here, but I’ve narrowed the
list down to a handful that I think you will enjoy using and should certainly try
out. Keep in mind that Web site URLs change all the time, so if you have problems
accessing a utility by the URL listed here, just search for the utility on the Web and
you should have no problem locating it.

Ad-aware 5.71
http://download.com.com/3000-2094-10045910.html

Published by Lavasoft, this tool has the ability to scan your RAM, registry, hard
drives, and any external devices that are likely to be used for advertising, tracking,
and data mining from Web site ads and scripts. In a nutshell, this tool can help you
maintain a greater degree of privacy while you surf the Web. The utility does a
good job, and may even block some Internet tools you want to use, so some con-
figuration may be required on your part.

Emergency Recovery Utility NT 1.0
http://download.com.com/3000-2094-10069122.html

This tool enables you to back up the Windows XP/2000/NT registry to a folder of
your choice. Considering the registry backup features of Windows XP and the
Windows XP Backup utility, you may not find this utility that helpful. However, if
you want to back up the registry to a folder for easy storage, this tool works great.
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FreeRAM XP Lite 1.03
http://download.com.com/3000-2086-10070530.html

From YourWare Solutions, this tool automatically monitors your memory and
optimizes it. You can even get real-time information about memory usage and con-
sumption on your system. With this tool, your system gets more freed-up RAM
without compromising performance.

HelioBar XP
http://download.com.com/3000-2343-10069347.html

This little tool can free up your entire desktop by making the Start menu and
taskbar transparent, revealing the entire desktop. This tool can be especially helpful
if you are working with graphics and other programs where the taskbar and Start
menu seem to get in your way.

SkinStudio 1.6
http://download.com.com/3000-2106-10058457.html

The SkinStudio program gives you the capability to create desktop overlays, or
skins. Basically, the tool allows you to take images that you create with some other
graphics program and put them together as your own interface. You can completely
change the look and feel of Windows using this tool, and, overall, it is easy to use.
You can even change task panes, title bars, buttons, icons, and so forth.

System Mechanic
www.wugnet.com/shareware

System Mechanic, shown in Figure C-1, is a great collection of tools that clean
up, tune up, and make your system run better. A Windows Startup Manager feature
and a Customize Windows tool even enable you to manage the startup, including
programs and the overall look and operation of Windows XP. The tool also con-
tains an Internet booster, which can help speed up the responsiveness of your
Internet connection.
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Figure C-1: System Mechanic.

XP SysPad
www.winxpfix.com/free-windows-utilities.htm

If you get tired of having to wade through the Control Panel to access different
system tools, you’ll like the XP SysPad. The SysPad is a launcher that gives you
access to Windows system utilities. Essentially, this tool puts access to the utilities
on the SysPad and you can launch them with a single click without having to move
around through menus to access them.

TuneUp Utilities
www.tune-up.com

TuneUp Utilities optimizes the performance of your computer, fixes programs,
and gives you the capability to further customize Windows. Overall, the utility can
make Windows run faster and manage various aspects of your system, such as con-
figuration, security, maintenance, and so forth. You can get the free trial version at
the Web site.
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MindSoft Utilities XP 7.5
www.mindsoftsite.com

The MindSoft Utilities XP 7.5 is a full maintenance package you should try out.
You can defragment disks, fix common problems, make Windows run faster, and
accelerate your Internet connection. An included ActiveMemory feature even
makes your computer run as if it has more RAM. You can download a free trial ver-
sion at the Web site.

Desktop Utilities
www.xdesksoftware.com

Xdesksoftware provides a number of helpful utilities that provide virtual desktop
management, Notification Area management, file management, and several others.
You can download shareware versions at the Web site and try them out.

SuperSpeed
www.superspeed.com

SuperSpeed is a RAM disk feature that writes data in memory to a portion of
your hard disk, then retrieves it as needed by the operating system. You end up with
a persistent RAMDisk that takes the place of physical RAM. The result is a faster
running system. You can find out more about this product at the Web site.

MagicTweak 2.50
www.magictweak.com

MagicTweak (shown in Figure C-2) is an optimization and personalization pro-
gram that helps you make Windows your own. Hundreds of tweaks are available
that reconfigure hidden system settings in Windows XP and earlier versions of
Windows. This software even optimizes your Internet connection and helps you
manage startup items. You can get a free trial version at the Web site.
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Figure C-2: MagicTweak 2.50.

Also, be sure to check out www.tucows.com, which is a major download site

containing a number of Windows shareware and freeware utilities. Some of

the items you’ll find here are more helpful than others, but you’ll find every-

thing from system maintenance tools to digital photography tools.
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Numerics
16-bit applications, 59
24-bit (True Color) scheme, 20
32-bit applications, 59
802.11b networks, 230–231

A
About category (TweakUI

PowerToy), 407
AboveNormal priority option

(Task Manager), 66
Accelerated Graphics Port

(AGP), 130
access

MAC (Mandatory Access
Control), 200, 214

printer access, auditing,
339

Access Control Lists (ACLs),
334

access points, 218, 221
accessing. See also opening

Group Policy tool, 35–36
help options, 381–383
Media Player 9, 71
System Restore, 109
Task Manager, 65

Account Policies (Group
Policy tool), 40–41

accounts. See group
accounts; user
accounts

ACLs (Access Control Lists),
334

ACPI (Advanced
Configuration and
Power Interface), 114

activating Windows XP, 450
Active Directory, domain

resources, locating,
253–255

Ad Hoc mode, wireless
networks, 218

Ad-aware 5.71 tool, 467
Add button

Classic Start menu, 8
Media Library feature, 79

Add command (File menu), 68
Add Hardware Wizard,

120–121
Add New Programs button

(Control Panel), 54
Add Standalone Snap-in

window, MMC, 35–36

adding
items, to Classic Start

menu, 8
Start menu items, 4
Web pages, to desktop, 16

Add/Remove Programs option
(Control Panel), 54–55

addresses
address classes, 212–213
APIPA (Automatic Private

Internet Protocol
Addressing), 214–215

IP addresses, 211–212
MAC (Mandatory Access

Control), 214
NAT (Network Address

Translation), 263
Administrative Templates

container (Group
Policy tool)

Network container, 48–49
Printers container, 49
System container, 47–48
Windows Components

container, 44–47
administrators, group

accounts, 33
Advanced Configuration and

Power Interface
(ACPI), 114

Advanced Power Management
(APM), 118

Advanced tab
Customize Start Menu

window, 6–7
Dial Up Properties dialog

box, 289
AGP (Accelerated Graphics

Port), 130
album information, Media

Player 9
Copy from CD feature, 76
Media Library feature, 79

alert triggers, performance
management,
367–368

All Programs command (Start
menu), 61, 87

Analyzer tool (Application
Compatibility
Analyzer tool), 60

APIPA (Automatic Private
Internet Protocol
Addressing), 214–215

APM (Advanced Power
Management), 118

Appearance tab (Display
Properties), 18–20

AppEvents subkey,
HKEY_CURRENT_USE
R Registry key, 183

Application Compatibility
Analyzer tool, 60

application layer protocols,
213

Application Verifier tool, 60
applications. See also

compatibility,
applications;
programs; software
applications

compatibility problems, 56
data collection

methods, 60
events, 183
fixes, 62
lockups, 54, 380
MS-DOS, 59
patches, 62
performance

management, 63–64
priorities, setting, 65–66
problem solving

techniques, 64–66
16-bit, 59
32-bit, 59
updates, automatic, 66

arranging icons, 162–163
ASR (Automated System

Recovery), 357
associations, files, managing,

164
attended installation,

Windows XP,
439–442

attrib command (Recovery
Console tool),
393–394

audio options, Movie
Maker 2, 94–96

auditing
audit options, 333–334
Audit Policy (Group

Policy tool), 41
Auditing Entry dialog

box, 338–339
configuring, 335–336
files and folders, 341
objects for, setting up,

336–338
printer access, 339
Security Log, 339–340
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Authentication Methods
dialog box, 273

Automated System Recovery
(ASR), 357

automatic logon, Remote
Desktop, 268–269

Automatic Private Internet
Protocol Addressing
(APIPA), 214–215

Automatic Updates feature,
applications, 66

B
background desktop options,

setting with digital
photos, 99

backup operators, group
accounts, 33

backups. See also restoration;
System Restore feature

ASR (Automated System
Recovery), 357

backup jobs, creating,
349–352

Backup utility, 155
copy backups, 347
daily backups, 347
differential backups, 346
incremental backups, 346
media, 348
normal backups, 346
planning considerations,

347–348
reasons for, 345
sample network backup

script, 437–438
scheduling, 354
System State Data, 348

Basic Input/Output Systems
(BIOS), 114

batch command (Recovery
Console tool), 394

batch scripting. See also
scripts

batch parameters,
423–424

execution time,
scheduling, 436

logic commands,
424–426

operational commands,
427–429

overview, 421
redirection operators, 424
system commands,

430–434
batteries, power

management, 115
BelowNormal priority option

(Task Manager), 66

binary data, hexadecimal
notation, 177

BIOS (Basic Input/Output
System), 114

bitmap caching, 270
block option, driver signing,

129
bootcfg command (Recovery

Console tool), 394
booting

boot time, system startup,
108

System Restore feature,
388–389

Browse For Folder dialog
box, 255–256

browsing
folders, 158
network resources, 253

burning digital photos to
CDs, 106

buttons
Add (Classic Start

menu), 8
Add (Media Library

feature), 79
Add New Programs

(Control Panel), 54
Remove (Classic Start

menu), 8
Shuffle (Media 

Player 9), 74
Start menu taskbar,

grouping, 9
toolbars, 160, 162
Windows Update (Control

Panel), 54

C
cables

connections, 281
RJ-45, 220

caching
bitmap, 270
on shared folders, 322

Calculator PowerToy, 411
call command, batch

scripting, 427
camcorder connections,

Movie Maker 2, 86–87
Cameras and Scanners folder

(Control Panel), 96
Cancel option, print queues,

331
category view, Control

Panel, 12
cd command, batch scripting,

434
CD Slide Shoe Generator

PowerToy, 413

CD-ROM
CDFS (CD-ROM File

System), 135
Windows XP installation,

443–446
CDs

burning digital photos to,
106

Copy from CD feature
(Media Player 9),
76–78

Copy to CD or Device
feature (Media
Player 9), 81

disk management,
135–137

Change Player color option
(Media Player 9), 74

chart information,
performance
management, 361

chdir command (Recovery
Console tool), 
394–395

chkdsk command (Recovery
Console tool), 395

classes, address, 212–213
Classic Start menu option

(Start menu), 7–8
clips, Movie Maker 2

combining, 91
sequencing, 93
splitting, 90–91
trimming, 92

cls command (Recovery
Console tool), 395

clusters, defined, 139
CMOS (Complementary Metal

Oxide Settings),
114–115

collections, Movie 
Maker 2, 90

Collector tool (Application
Compatibility
Analyzer tool), 60

color
Change Player color

option (Media
Player 9), 74

display drivers, 131
True Color (24-bit)

scheme, 20
columns, MMC, changing,

201
COM objects,

HKEY_CLASSES_ROO
T Registry key, 182

combining clips, Movie
Maker 2, 91
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command console
commands, list of,

464–466
display options,

changing, 460
navigating, 463
opening, 459
syntax, 461–462

command line switches,
448–449

compatibility, applications.
See also applications;
programs; software
applications

Application Compatibility
Analyzer tool, 60

Application Verifier
tool, 60

Compatibility
Administrator tool,
60–63

performance
management, 63

Program Compatibility
Mode Wizard, 57–59

Complementary Metal Oxide
Settings (CMOS),
114–115

compression
file and folders, 168–171
zipped files, 170–171

Computer Management
console

Backup utility, 155
user accounts, creating,

29–31
Computer Name Changes

dialog box, 258
computers, locking, 113
configuring

auditing, 335–336
dialing rules, dial-up

connections, 290–292
drive letter and path

information, dynamic
disks, 145–147

Group Policy settings,
37–40

hardware profiles,
124–126

ICF (Internet Connection
Firewall), 292

Internet connections,
281–283

MMC options, 198–200
network bridges, 231–232
Recovery Agents,

167–168
Remote Desktop client,

267
Start menu, 50–51

Start menu taskbar, 8–9
TCP/IP (Transmission

Control
Protocol/Internet
Protocol), 236–238

wireless networks, 227
workgroups, 224–227

connections. See also dial-up
connections

cables, 281
camcorder, Movie 

Maker 2, 86–87
DCC (Direct Cable

Connection), 215, 222
DSL (Digital Subscriber

Line), 280
Internet, 281–283
networks, 232–236
Ping connectivity tool,

239
printers, 324–327
to Remote Desktop hosts,

265–268
satellite, 281
troubleshooting, 239–242
VPN (Virtual Private

Network), 260–261
Console subkey,

HKEY_CURRENT_USE
R Registry key, 183

Control Panel
Add New Programs

button, 54
Add/Remove Programs

option, 54–55
appearance of, 

changing, 12
Appearance tab (Display

Properties), 18–20
Cameras and Scanners

folder, 96
category view, 12
Desktop tab (Display

Properties), 14–17
overview, 4
Screen Saver tab (Display

Properties), 17–18
settings, customizing,

51–52
Settings tab (Display

Properties), 20–21
Themes tab (Display

Properties), 13–14
User Accounts option,

25–29
Windows Update

button, 54
control sets, startup data, 186
copy backups, 347
copy command (Recovery

Console tool), 395

Copy from CD feature (Media
Player 9), 76–78

Copy Music tab (Media
Player 9), 83

Copy Profile dialog box, 125
Copy to CD or Device feature

(Media Player 9), 81
counters, performance

management, 362–364
Create Files permission, 315
Create Folders permission, 315
cumulative permissions, 318
Customize Start Menu window

Advanced tab, 6–7
customization options, 5
General tab, 5–6

customizing
Control Panel settings,

51–52
desktop, 51
folders, 163–164
IE (Internet Explorer),

49–50
toolbars, 161–162

D
daily backups, 347
data

data collection,
applications, 60

data logs, performance
management,
364–366

data types, Registry, 177
DCC (Direct Cable

Connection), 215, 222
default gateway, TCP/IP

addressing, 211
defragmented drives, Disk

Defragmenter tool,
370–371

delete command
batch scripting, 434
Recovery Console tool,

395
Delete permission, 316
Delete Subfolders and Files

permission, 316
deleting user accounts, 32
Deny permissions, 318
desktop

background options,
setting with digital
photos, 99

customizing, 51
Desktop category

(TweakUI PowerToy),
408–409
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desktop continued
Desktop tab (Display

Properties), 14–17
wallpaper feature, 16
Web pages, adding, 17

device drivers
driver signing, 128–129
incompatibility issues,

126–127
managing, Device

Manager feature, 123
uninstalling, 128
updating, 128

Device Manager feature
device settings, 122
driver management, 123
hardware categories, 121

Devices tab (Media 
Player 9), 83

DHCP (Dynamic Host
Configuration
Protocol), 214, 247

Diagnostic Startup option,
system startup, 108

dialog boxes
Auditing Entry, 338–339
Authentication Methods,

273
Browser For Folder,

255–256
Computer Name Changes,

258
Copy Profile, 125
Dial Up Properties,

286–289
Folder Options, 157–160
Log Off Windows, 111
Network Connection

Details, 235–236
New Area Code Rule, 292
Open With, 164–165
Properties (Start menu), 4
Select Network

Component Type,
233–234

System Properties, 264
Turn Off Computer, 111
Windows Task

Manager, 65
dial-up connections. See also

connections
Dial Up Properties dialog

box, 286–289
dialing rules, configuring,

290–292
hardware requirements,

280
problems in, 289–290
Remote Desktop

connections, 266
differential backups, 346

digital photos
burning to CD, 106
Cameras and Scanners

folder (Control
Panel), 96

desktop background
options, setting, 99

e-mailing, 105
filmstrip views, 97
image-editing

capabilities, 99
list views, 98
organizing, 96–97
previewing options,

98–99
printing, online photo

printing, 100–102
printing, overview, 99
printing, to home

computer, 103–104
rotation options, 99
slideshow features, 100
thumbnail views, 97
tile views, 97

digital signature stamps,
device drivers, 128

Digital Subscriber Line (DSL),
280

dir command
batch scripting, 434
Recovery Console tool,

396
Direct Cable Connection

(DCC), 215, 222
DirecWay Web site, 280
disable command (Recovery

Console tool), 396
Disabled option (Group

Policy tool), 38
diskpart command (Recovery

Console tool),
396–397

disks. See also dynamic
disks; hard disks

Disk Cleanup tool,
371–372

Disk Defragmenter tool,
370–371

disk management,
135–137

Disk Quotas feature,
341–344

disk space requirements,
System Restore
feature, 385–386

display drivers
color quality settings, 131
monitor settings, 133
screen resolution,

adjusting, 131
troubleshooting, 133

video adapters, 132
video cards, installing,

130
display options, command

console, 460
Display Properties (Control

Panel)
Appearance tab, 18–20
Desktop tab, 14–17
Screen Saver tab, 16
Settings tab, 20–21
Themes tab, 13–14

Domain Name Server
(DNS), 48

domains
defined, 244
disjoining from, 258
joining, 247–249
logging on to, 250–251
organizational units,

245–246
passwords, 250
resources on, locating,

252–256
trust relationships, 245

Dots Per Inch (DPI), 21
downloading PowerToys,

404–405
drive letter and path

configuration,
dynamic disks,
145–147

drivers. See device drivers;
display drivers

dropped connections, dial-up
connections, 289

DSL (Digital Subscriber Line),
280

dual-view feature, monitors,
133–134

dynamic disks. See also
disks; hard disks

converting basic disks to,
142–144

display states, 145
driver letter and path

configuration,
145–147

Dynamic Host Configuration
Protocol (DHCP),
214, 247

E
echo command, batch

scripting, 429
effects, Movie Maker 2, 

93–94
EFS (Encrypting File System),

165, 167
802.11b networks, 230–231
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e-mail
digital photos, 105
ICF (Internet Connection

Firewall) and, 309
Remote Assistance

invitations, 276
showing on Start menu, 5

Emergency Recovery Utility
NT 1.0, 467

emptying Recycle Bin items,
10–11

Enable Boot Logging option
(Safe Mode feature),
385

enable command (Recovery
Console tool), 397

Enable VGA Mode (Safe
Mode feature), 385

Enabled option (Group Policy
tool), 38

Encrypting File System (EFS),
165, 167

encryption options, 165–168
EndLocal command, batch

scripting, 428–429
Enhancements option (Media

Player 9), 75
Environment subkey,

HKEY_CURRENT_USE
R Registry key, 183

equalization options (Media 
Player 9), 75

errors
Error Checking tool, 154,

369–370
error reporting, system

container options, 48
Ethernet networks, 216, 220
events, applications, 183
Execute permission, 317
exit command (Recovery

Console tool), 397
expand command (Recovery

Console tool), 397
expiration dates, pass-

words, 41
Explorer category (TweakUI

PowerToy), 408
exporting Registry files,

190–191

F
Fast User Switching feature,

log off options,
112–113

fault tolerance, hard disks,
153

Favorites menu, MMC, 202
File Allocation Table (FAT),

139–140

file formats, Movie Maker
requirements, 86

File menu commands
Add, 68
Export Registry File, 190

file sharing. See shared
resources

File Signature Verification
utility, driver signing,
129

file systems
backup ups, 155
clusters, 139
FAT (File Allocation

Table), 139–140
fragmentation in, 155
NTFS (NT file system),

139–142
sectors, 139

File Transfer Protocol (FTP),
213

File Types tab
Folder Options dialog

box, 160
Media Player 9, 85

files
associations, managing,

164
auditing, 341
compression, 168–171
encryption, 165–168
file protection, system

container options, 48
hiding, 159
information about,

viewing, 160
offline, 160, 171–174
ownership of, 323–324
permissions, 314–318
Registry, exporting and

importing, 190–191
security, 140

filmstrip views, digital
photos, 97

filter options, Microsoft
Management Console,
201

firewalls. See also Internet
Connection Firewall

connecting to Remote
Desktop over,
266–267

stateful, 299
fixboot command (Recovery

Console tool), 398
fixes, applications, 62
fixmbr command (Recovery

Console tool), 398
folders

auditing, 341
browsing, 158

Cameras and Scanners
(Control Panel), 96

compression, 168–171
customizing, 163–164
encryption, 165–168
Folder Options dialog

box, 157–160
hiding, 159
My Computer, 4
My Documents, 4
My Music, 4
My Network Places, 4
My Pictures, 4
offline, 160, 171–174
ownership of, 323–324
permissions, 314–318
security, 140
shared, 311–313
Start menu items, list of, 4
Start menu, selecting, 7
Web content in,

displaying, 158
font size, selecting, 19
foreign display state,

dynamic disks, 145
format command (Recovery

Console tool), 398
FreeRAM XP Lite 1.03 utility,

468
FTP (File Transfer Protocol),

213
Full Control permissions, 316
Full Mode option (Media

Player 9), 74
Full Screen option (Media

Player 9), 75

G
General category (TweakUI

PowerToy), 407
General tab

Customize Start Menu
window, 5–6

Dial Up Properties dialog
box, 286

Folder Options dialog
box, 158

System Configuration
dialog box, 108–109

goto command, batch
scripting, 426

graphics, Accelerated
Graphics Port, 130

group accounts. See also user
accounts

creating, 34
default groups, list of,

33–34
overview, 32
programs, 68
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Group Policy tool
accessing, 35–36
Account Policies, 40–41
Administrative Templates

container, 44–48
Audit Policy, 41
Computer Configuration

node, 36
Disabled option, 38
discussed, 34
Enabled option, 38
features, 36–37
Local Computer Policy

node, 36
Local Policies, 41–43
Not Configured

option, 38
Public Key Policy, 43
Security Options Policy,

42–43
settings, configuring,

37–40
Software Restriction

Policy, 44
Software Settings

node, 40
User Rights Policy, 41–42
Windows Settings node,

40–44
grouping Start menu taskbar

buttons, 9
guests, group accounts, 33

H
hard disks. See also disks;

dynamic disks
Disk Defragmenter tool,

370–371
errors, checking for, 154
fault tolerance, 153
file systems, 139–142
formatting and

converting to NTFS,
42, 140–141

information about,
viewing, 153

mounting, 147
performance

management,
369–372

quotas, 156
shared, 156
simple volumes, 148–150
spanned volumes,

150–151
striped volumes, 151–152

hardware
Add Hardware Wizard,

120–121
Device Manager

categories, 121

dial-up connection
requirements, 280

Ethernet networks, 220
HomePNA networks, 

221
installing, 119–121
Movie Maker 2

requirements, 86
operating system

requirements,
440–441

performance management
requirements, 63

profiles, configuring,
124–126

Hardware Compatibility List
(HCL), 120, 440

HelioBar XP utility, 468
help command (Recovery

Console tool), 398
help options

accessing, 381–383
Help and Support Center,

4, 278
Remote Assistance

feature, 276–278
hexadecimal notation, 177
hibernation

Hibernate option (Turn
Off Computer dialog
box), 111

power management,
116–117

hiding
files/folders, 159
Media Player 9

playlists, 73
Start menu taskbar, 9

High priority option (Task
Manager), 65

hives, Registry keys, 178–179
HKEY_CLASSES_ROOT

Registry key, 176, 182
HKEY_CURRENT_CONFIG

Registry key, 177, 187
HKEY_CURRENT_USER

Registry key, 176,
182–184

HKEY_LOCAL_MACHINE
Registry key, 176,
184–186

HKEY_USERS Registry key, 
177, 187

HomePNA network topology,
216, 221

HTML Slide Show Generator
PowerToy, 416–417

hubs, wireless networks, 
218

Hypertext Transfer Protocol
(HTTP), 213

I
ICF. See Internet Connection

Firewall
icons

arranging, 162–163
size of, changing, 201
size of, selecting, 5

ICS (Internet Connection
Sharing), 49, 220

Identities subkey,
HKEY_CURRENT_USE
R Registry key, 183

IE. See Internet Explorer
IEEE (Institute of Electrical

and Electronics
Engineers), 216

if command, batch scripting,
425–426

ignore option, driver signing,
129

IIS (Internet Information
Server), 30, 273

image editing capabilities,
digital photos, 99

Image Resizer PowerToy,
411–413

importing
Registry files, 190–191
video, Movie Maker 2, 89

incompatibility issues, device
drivers, 126–127

incremental backups, 346
Industry Standard Allotment

(ISA), 130
Info Center option (Media

Player 9), 75
infrared wireless networks,

217–218
Infrastructure mode, wireless

networks, 218
initializing display state,

dynamic disks, 145
installing

hardware, 119–121
PowerToys, 405–406
Recovery Console tool,

392
software applications,

54–55
video cards, 130
Windows XP, attended

installation, 439–442
Windows XP, from

CD-ROM, 443–446
Windows XP, from

network shares, 447
Windows XP,

troubleshooting
issues, 458
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Windows XP, unattended
installation, 453–457

Windows XP,
Winnt32.exe setup
program, 447

Institute of Electrical and
Electronics Engineers
(IEEE), 216

Internet
connections, configuring,

281–283
Internet Connection

Sharing (ICS), 49, 220
Internet Information

Server (IIS), 30, 273
Internet Service Provider

(ISP), 266
online photo printing,

digital photos,
100–102

Radio Tuner feature
(Media Player 9),
80–81

showing on Start menu, 5
Internet Connection Firewall

(ICF). See also
firewalls

configuring, 298–301
e-mail and, 309
security logs, 304–305
services, enabling,

302–304
setting up, 301
traffic, 304

Internet Explorer (IE)
customizing, 49–50
Internet Explorer

category (TweakUI
PowerToy), 409

policy options, 44–45
Remote Desktop with,

273–274
Internet Protocol (IP)

IP addresses, TCP/IP,
211–212

networking
considerations,
213–214

server policies, 44
interrupt request lines (IRQs),

119, 202
invitations, Remote

Assistance feature,
275–276

IP. See Internet Protocol
ipconfig command

batch scripting, 436
troubleshooting

connections, 240
IRQs (interrupt request lines),

119, 202

ISA (Industry Standard
Allotment), 130

ISP (Internet Service
Provider), 266

J
joining domains, 247–249
JScript language, 421–422

K
keyboards

hardware profile
configuration, 124

Keyboard Layout subkey,
HKEY_CURRENT_USE
R Registry key, 183

keys, Registry
HKEY_CLASSES_ROOT,

182
HKEY_CURRENT_CONFIG,

187
HKEY_CURRENT_USER,

182–184
HKEY_LOCAL_MACHINE,

184–186
HKEY_USERS, 187
list of, 176–177

L
LAN (local area network),

124, 327
Last Know Good Config-

uration option (Safe
Mode feature), 385

Layer Two Tunneling
Protocol (L2TP), 260

license agreement, Windows
XP installation, 443

Lightweight Directory Access
Protocol (LDAP), 254

limited users, user
accounts, 26

List Folder Contents
permissions, 317

lists views, digital photos, 98
listsvc command (Recovery

Console tool), 398
loading snap-ins, 195–197
local area network (LAN),

124, 327
Local Computer Policy node

(Group Policy tool), 36
Local Policies (Group Policy

tool), 41–43
locking

computers, 113
Start menu taskbar, 8
toolbars, 161

lockups, applications, 54, 380

Log Off Windows dialog box,
111

logic commands, batch
scripting, 424–426

logon settings
dial-up connections, 287
domains, 250–251
logon command (Recovery

Console tool), 398
Logon option (TweakUI

PowerToy), 409
Remote Desktop, 268–269
system container

options, 47
lookups, TCP/IP

configuration, 237
Low priority option (Task

Manager), 66
L2TP (Layer Two Tunneling

Protocol), 260

M
MagicTweak Web site, 470
Manage Printers permission,

329
Mandatory Access Control

(MAC), 200, 214
map command (Recovery

Console tool), 398
mapping network drives, 257
md command (Recovery

Console tool), 399
media

backups, 348
plug-ins, 75

Media Player 9
accessing, 71
Change Player color

option, 74
Copy from CD feature,

76–78
Copy to CD or Device

feature, 81
equalization options, 75
full screen views, 73
Media Guide feature, 76
Media Library feature,

78–80
media lists, creating,

79–80
Now Playing lists, 71–75
Options properties sheet,

83–85
play controls, 74–75
playlists, showing/

hiding, 73
Premium Services

feature, 82

continued
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Media Player 9 continued
Radio Tuner feature,

80–81
Shuffle button, 74
Skin Chooser feature, 82
songs, recording, 77–78
Switch to Skin Mode

option, 74
updates to, 71
video and visualization

views, maximizing, 73
memory requirements

Movie Maker 2, 86
performance

management,
372–375

power management,
116–117

Microsoft Management
Console (MMC)

access modes, 200
Add Standalone Snap-in

window, 35–36
appearance of, changing,

201
column labels, changing,

201
configuring, 198–200
emptying, 194
favorites list, 202
filter options, 201
icon size, changing, 201
management

considerations, 207
overview, 193
saving, 197
snap-ins, 35, 195–197
Taskpad views, 202–205
windows, opening

multiple, 198
Microsoft Web site, 267
MindSoft Utilities XP 7.5, 470
missing display state,

dynamic disks, 145
mkdir command (Recovery

Console tool), 399
MMC. See Microsoft

Management Console
modem configuration, dial-

up connections, 286
Modify permissions, 316–317
monitors

display driver settings,
133

dual-view feature,
133–134

Monitor area, Movie
Maker 2, 88

screen savers, 17
more command (Recovery

Console tool), 399

mouse
hardware profile

configuration, 124
Mouse category (TweakUI

PowerToy), 407–408
Movie Maker 2

advantages of, 85
audio options, 94–96
camcorder connections,

86–87
clips, combining, 91
clips, sequencing, 93
clips, splitting, 90–91
clips, trimming, 92
collections, 90
effects, 93–94
hardware requirements, 86
Monitor area, 88
opening, 87
Tasks area, 88
toolbars, 88
transitions, 93–94
video, importing and

recording, 89
Workspace, 89, 92–93

MSCONFIG utility, system
startup, 108

MS-DOS applications, 59
music options. See Media

Player 9
My Computer category

(TweakUI PowerToy),
409

My Computer folder, 4
My Documents folder, 4
My Music folder, 4
My Network Places folder, 4
My Pictures folder, 4

N
narration options, Movie

Maker 2, 95
NAT (Network Address

Translation), 263
Nbstat utility,

troubleshooting
connections, 240–241

net command, batch
scripting, 431

net logon settings, system
container options, 48

net use command (Recovery
Console tool), 399

netsh command, batch
scripting, 434–435

netstat command
batch scripting, 436
connections,

troubleshooting,
240–241

Network Address Translation
(NAT), 263

Network Connection Details
dialog box, 235–236

Network container
(Administrative
Templates container),
48–49

network interface card (NIC),
210

Network tab (Media
Player 9), 85

Networking tab (Dial Up
Properties dialog box),
289

networks. See also
workgroups

configuration operators,
group accounts, 33

connections, 232–236
802.11b, 230–231
Ethernet, 216, 220
HomePNA, 216, 221
LAN (local area network),

124, 327
network bridges,

configuring, 231–232
network drives, mapping,

257
network places, creating,

255–256
overview, 210
printer connections,

324–327
resources, browsing, 253
server-based, 209
VPN (Virtual Private

Networking), 259–263
Wi-Fi, 218–219
wireless, 217–219, 227
WLANs (Wireless Local

Area Networks), 217
WMANs (Wireless

Metropolitan Area
Networks), 217–218

WPANs (Wireless
Personal Area
Networks), 217

WWANs (Wireless Wide
Area Networks), 218

X.25, 287
New Area Code Rule dialog

box, 292
NIC (network interface card),

210
no media display state,

dynamic disks, 145
normal backups, 346
Normal priority option (Task

Manager), 66
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Normal Startup option,
system startup, 108

Not Configured option
(Group Policy
tool), 38

not initialized display state,
dynamic disks, 145

Notification area, Start menu
taskbar, 9

Now Playing lists (Media
Player 9), 71–75

Nslookup utility,
troubleshooting
connections, 242

NT file system (NTFS)
discussed, 139
file and folder level

security, 140
formatting and

converting drives to,
140–142

permissions, 320–321

O
offline display state, dynamic

disks, 145
offline files and folders,

160, 171–174
online display state, dynamic

disks, 145
online photo printing, digital

photos, 100–102
Open Command Window

Here PowerToy, 410
Open With dialog box,

164–165
opening. See also accessing

command console, 459
Movie Maker 2, 87
Recycle Bin, 10
windows, multiple, 198

operational commands, 
batch scripting,
427–429

operators, redirection, batch
scripting, 424

Options properties sheet
(Media Player 9),
83–85

Options tab (Dial Up
Properties dialog box),
287

organization, digital photos,
96–97

organizational units,
domains, 245–246

ownership, files and folders,
323–324

P
Packer Scheduler feature, 49
paper quality considerations,

digital photos, 103
passwords

Account Policies (Group
Policy tool), 40–41

dial-up connections, 287
domains, 250
expiration dates, 41
reset disks, 29
user accounts, 27–29

patches, applications, 62
path and drive letter

configuration,
dynamic disks,
145–147

Pathping utility,
troubleshooting
connections, 241

pause command, batch
scripting, 430

Pause option, print queues,
331

PCI (Peripheral Component
Interconnect), 134

Pentium 600 MHz processors,
Movie Maker 2
hardware require-
ments, 86

performance management
alert triggers, 367–368
applications, 63–64
chart information, 361
compatibility, 63
counters, adding,

362–364
data logs, 364–366
Disk Cleanup tool,

371–372
Disk Defragmenter tool,

370–371
Error Checking tool,

369–370
hard disks, 369–372
memory performance,

372–375
monitoring options,

selecting, 360
Performance tab (Task

Manager), 368
reasons for, 359
Remote Desktop, 270

Performance tab
Media Player 9, 83
Task Manager, 368

Peripheral Component
Interconnect (PCI), 134

permissions
file and folder, shared

resources, 314–318
NTFS, 320–321
printers, 329–330
share level, 320–321

phone number config-
urations, dial-up
connections, 286

photos. See digital photos
pictures. See digital photos
Pin to Start menu command

(Start menu), 3
Ping connectivity tool, 239
play controls (Media

Player 9), 74–75
Player tab (Media 

Player 9), 83
playlists (Media Player 9)

creating, 79
showing/hiding, 73
shuffling, 74

plug-ins, media, 75
Plug-ins tab (Media

Player 9), 84
Point to Point Protocol (PPP),

260
Point-to-Point Tunneling

Protocol (PPTP), 260
policies. See Group Policy

tool
power management

ACPI (Advanced
Configuration and
Power Interface), 114

APM (Advanced Power
Management), 118

BIOS (Basic Input/Output
Systems), 114

CMOS (Complementary
Metal Oxide Settings),
114–115

hibernation, 116–117
power scheme

preconfiguration
options, 115–116

UPS (Uninterruptible
Power Supply), 118

power users, group
accounts, 33

PowerToys
Alt-tab Replacement, 410
Calculator, 411
CD Slide Show Generator,

413
downloading, 404–405
HTML Slide Show

Generator, 416–417
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PowerToys continued
Image Resizer, 411–413
installing, 405–406
list of, 403–404
Open Command Window

Here, 410
Taskbar Magnifier, 415
TweakUI, 406–409
Virtual Desktop Manager,

414
Webcam Timershot, 418

PPP (Point to Point Protocol),
260

PPTP (Point-to-Point
Tunneling Protocol),
260

Premium Services feature
(Media Player 9), 82

previewing digital photos,
98–99

printers
access, auditing, 339
connection problems, 328
hardware profile

configuration, 124
HKEY_CURRENT_USER

Registry key, 184
network connections,

324–327
permissions, 329–330
print queues, 330–332
Printers container

(Administrative
Templates
container), 49

shared resources,
327–330

printing digital photos
to home computer,

103–104
online photo printing,

100–102
overview, 99

priorities, applications, 
65–66

Privacy tab (Media 
Player 9), 85

privileges. See permissions
problem solving. See also

troubleshooting
applications, 64–66
printer connections, 328

Product Activation feature,
450

profiles
hardware profiles,

configuring, 124–126
user accounts, 182

Program Compatibility Mode
Wizard, 57–59

programs. See also
applications;
compatibility,
applications; software
applications

group accounts, 68
installation and removal

of, controlling, 67–69
removing from

computers, 55
starting, 4
user accounts, 67

Properties dialog box (Start
menu), 4

properties, Recycle Bin,
changing, 11

protocols
APIPA (Automatic Private

Internet Protocol
Addressing), 214–215

application layer, 213
DHCP (Dynamic Host

Configuration
Protocol), 214, 247

FTP (File Transfer
Protocol), 213

HTTP (Hypertext Transfer
Protocol), 213

IP (Internet Protocol), 
44, 213–214

LDAP (Lightweight
Directory Access
Protocol), 254

L2TP (Layer Two
Tunneling Protocol),
260

PPP (Point to Point
Protocol), 260

PPTP (Point-to-Point
Tunneling Protocol),
260

SMTP (Simple Mail
Transfer Protocol),
213

SNMP (Simple Network
Management
Protocol), 213

TCP (Transmission
Control Protocol), 213

tunneling, 260
UDP (User Datagram

Protocol), 213
Public Key Policy (Group

Policy tool), 43
purchasing software

applications, 53

Q
Quality of Service (QoS), 49
queues, print, 330–332

quotas
Disk Quotas feature,

341–344
hard disks, 156

R
Radio Tuner feature (Media

Player 9), 80–81
RAS (remote access server),

267, 274
rd command (Recovery

Console tool), 400
Read Attributes permission,

315
Read Extended Attributes

permission, 315
Read permission, 316–317
Realtime priority option (Task

Manager), 65
recording video, Movie

Maker 2, 89
Recovery Agents

assigning, 167
configuring, 167–168

Recovery Console tool
attrib command, 393–394
batch command, 394
bootcfg command, 394
chdir command, 394–395
chkdsk command, 395
cls command, 395
copy command, 395
delete command, 395
dir command, 396
disable command, 396
diskpart command,

396–397
enable command, 397
exit command, 397
expand command, 397
fixboot command, 398
fixmbr command, 398
format command, 398
help command, 398
installing, 392
listsvc command, 398
logon command, 398
map command, 398
md command, 399
mkdir command, 399
more command, 399
net use, 399
rd command, 400
removal options, 401
ren command, 400
rename command, 400
rmdir command, 400
set command, 400
starting, 392–393
systemroot command, 400
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type command, 400
uses for, 391–392

Recycle Bin
items in, emptying, 10–11
items in, restoring, 10
items in, viewing, 10
opening, 10
properties, changing, 11
space within, setting

limits to, 12
redial attempts, dial-up

connections, 287
redirection operators, batch

scripting, 424
Refresh option (Media

Player 9), 75
reg files, Registry, 190
REG_BINARY Registry data

type, 177
REG_DWORD Registry data

type, 177
RegEdit tool (Registry),

180–181
REG_EXPAND_SZ Registry

data type, 177
Registry feature

data types, list of, 177
defined, 175
files, exporting and

importing, 190–191
hives, 178–179
HKEY_CLASSES_ROOT

key, 182
HKEY_CURRENT_CONFIG

key, 187
HKEY_CURRENT_USER

key, 182–184
HKEY_LOCAL_MACHINE

key, 184–186
HKEY_USERS key, 187
keys, list of, 176–177
reg files, 190
RegEdit tool, 180–181
restoration, 179–180
structure of, 176–177
subtrees, 176–177
updating, 190

REG_MULTI_SZ Registry data
type, 177

REG_SZ Registry data type,
177

remote access server (RAS),
267, 274

Remote Assistance feature
help options, 276–278
invitations, 275–276
overview, 274
turning on, 275–276

Remote Desktop feature
clients, configuring, 267
connecting with, 265–268

IE (Internet Explorer) and,
273–274

logon, automatic,
268–269

overview, 263
performance management

features, 270
Remote Desktop

Connection software,
267–268

turning on, 264–265
Remote Procedure Calls

(RPC), 48
Remote tab (System

Properties dialog box),
264

Remove button (Classic Start
menu), 8

removing
items from Classic Start

menu, 8
programs from

computers, 55
Recovery Console, 401
software applications, 55

ren command (Recovery
Console tool), 400

rename command (Recovery
Console tool), 400

renaming user accounts, 32
resolution

digital photos, printing
considerations, 103

display drivers, 131
screen resolution slider

bar, 20
Restart option

print queues, 331
Turn Off Computer dialog

box, 111
restoration. See also backups;

System Restore feature
Recycle Bin items, 10
Registry, 179–180
restore points, 387
Restore Wizard, 354–356
reversing, 390

restore points, 387
Resume option, print queues,

331
RJ-45 cables, 220
rmdir command (Recovery

Console tool), 400
rotating digital photos, 99
Route command,

troubleshooting
connections, 241

routers, Ethernet networks,
220

RPC (Remote Procedure
Calls), 48

S
Safe Mode feature,

troubleshooting
options, 384–385

SAM (Security Account
Manager), 185

satellite connections, 281
scheduling

backups, 354
batch files, 436
Scheduled Task Wizard,

375–377
Screen Saver tab (Display

Properties), 16
scripts. See also batch

scripting
JScript language,

421–422
sample network backup

script, 437–438
script engines, 419
scripting, defined, 419
system container

options, 47
VBScript language, 422
Windows Script File, 

422
Search feature, 4
sectors, defined, 139
security

files and folders, 140
ICF (Internet Connection

Firewall), 304–305
passwords, user

accounts, 27
SAM (Security Account

Manager), 185
Security Log, auditing,

339–340
Security Options Policy

(Group Policy tool),
42–43

SSIDs (Service Set
Identifiers), 219

WEP (Wired Equivalent
Privacy), 219

wireless networks, 219
Security tab

Dial Up Properties dialog
box, 288

Media Player 9, 85
Select Network Component

Type dialog box,
233–234

Selective Startup option,
system startup, 
109

sequencing clips, Movie
Maker 2, 93
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servers
policies, IP (Internet

Protocol), 44
RAS (remote access

server), 267
server-based networks,

209
VPN, connecting to,

260–261
Service Set Identifiers

(SSIDs), 219
services, ICF, 302–304
Services tab (System

Configuration dialog
box), 109

SessionInformation subkey,
HKEY_CURRENT_USE
R Registry key, 184

set command (Recovery
Console tool), 400

SetLocal command, batch
scripting, 428–429

Settings tab (Display
Properties), 20–21

setup.exe program, software
applications, 54

SFS (Simple File Sharing),
309–313

shared hard disks, 156
shared resources

caching settings,
managing, 322

file and folder ownership,
323–324

permissions, file and
folder, 314–318

permissions, NTFS,
320–321

permissions, share level,
320–321

printers, 327–330
SFS (Simple File Sharing),

309–313
shared folders, 311–313

shims, defined, 56
Show Media Information

option (Media 
Player 9), 74

Show on Start menu
command (Start
menu), 5

Show Playlist option (Media
Player 9), 74

Show Resize Bars option
(Media Player 9), 74

Show Title option (Media
Player 9), 74

Shuffle button (Media
Player 9), 74

shutdown options, system
shutdown, 111

signed device drivers, 128
simple disk volumes,

148–150
Simple File Sharing (SFS),

309–313
Simple Mail Transfer

Protocol (SMTP), 213
Simple Network Management

Protocol (SNMP), 213
sites. See Web sites
16-bit applications, 59
size

font size, selecting, 19
icon size, changing, 201
icon size, selecting, 5

Skin Chooser feature (Media
Player 9), 82

Skin Mode option (Media
Player 9), 74

SkinStudio 1.6 utility, 468
slideshows, digital photos as,

100
slow connections, dial-up

connections, 290
SMTP (Simple Mail Transfer

Protocol), 213
SnagIt utility, system startup,

110
snap-ins, 35, 195–197
SNMP (Simple Network

Management
Protocol), 213

software applications. See
also applications;
compatibility,
applications;
programs

installing and setting up,
54–55

lockups, 54
purchasing

considerations, 53
removing, 55

Software Restriction Policy
(Group Policy 
tool), 44

Software Settings node
(Group Policy 
tool), 40

songs. See Media Player 9
sound card requirements,

Movie Maker 2, 86
spanned volumes, 150–151
splitting clips, Movie Maker 2,

90–91
SSIDs (Service Set

Identifiers), 219
StarBand Web site, 280
start command, batch

scripting, 428

Start menu
All Programs command,

61, 87
Classic Start menu

option, 7–8
configuring, 50–51
Customize Start Menu

window, 5–7
folders, selecting, 7
icon size, selecting, 5
items, adding, 4
Log Off command, 111
overview, 1–2
Pin to Start menu

command, 3
Programs command, 55
Properties dialog box, 4
Show on Start menu

command, 5
taskbar options, 8–9
Turn Off Computer

command, 111
Unpin from Start menu

command, 3
Window item

components, list of, 4
starting

programs, 4
Recovery Console tool,

392–393
startup

Startup Cop utility, 110
startup data, control sets,

186
Startup tab (System

Configuration dialog
box), 110

system startup options,
107–109

stateful firewalls, 299
Stations option (Radio Tuner

feature), 81
Statistics option (Media

Player 9), 75
storyboard view (Movie

Maker 2 Work-
space), 92

strings, text, 177
striped volumes, 151–152
subnet mask, TCP/IP

addressing, 211
subtrees, Registry, 176–177
SuperSpeed Web site, 470
support. See help options
Switch to Skin Mode option

(Media Player 9), 74
Switch User option (Log Off

Windows dialog box),
111

switches, command line,
448–449
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Synchronize permission, 
316

syntax, command console,
461–462

system commands, batch
scripting, 430–434

System Configuration dialog
box, 108–110

System container (Windows
Components
container), 47–48

system failure. See backups
System Mechanic utility, 

468
system performance. See

performance
management

System Properties dialog box,
264

System Restore feature. See
also backups;
restoration

accessing, 109
disk space requirements,

385–386
outcome considerations,

391–392
running, 388–389

system shutdown options,
111

system startup options,
107–110

System State Data, backups,
348

systemroot command
(Recovery Console
tool), 400

T
tabs

Advanced (Customize
Start Menu window),
6–7

Advanced (Dial Up
Properties dialog box),
289

Appearance (Display
Properties), 18–20

Copy Music (Media
Player 9), 83

Desktop (Display
Properties), 14–17

Device (Media 
Player 9), 83

File Types (Folder Options
dialog box), 160

File Types (Media
Player 9), 85

General (Customize Start
Menu window), 5–6

General (Dial Up
Properties dialog box),
286

General (Folder Options
dialog box), 158

General (System
Configuration dialog
box), 108–109

Network (Media 
Player 9), 85

Networking (Dial Up
Properties dialog box),
289

Offline Files (Folder
Options dialog box),
160

Options (Dial Up
Properties dialog box),
287

Performance (Media
Player 9), 83

Performance (Task
Manager), 368

Player (Media 
Player 9), 83

Plug-ins (Media 
Player 9), 84

Privacy (Media 
Player 9), 85

Remote (System Properties
dialog box), 264

Screen Saver (Display
Properties), 16

Security (Dial Up
Properties dialog box),
288

Security (Media 
Player 9), 85

Services (System
Configuration dialog
box), 109

Settings (Display
Properties), 20–21

Startup (System
Configuration dialog
box), 110

Themes (Display
Properties), 13–14

View (Folder Options
dialog box), 159

Take Ownership permission,
316

Task Manager feature
accessing, 65
Performance tab, 368
priority options, 65–66

Task Scheduler feature, 45
Taskbar category (TweakUI

PowerToy), 408
Taskbar Magnifier PowerToy,

415

taskbar (Start menu)
buttons, grouping, 9
configuring, 50–51
hiding, 9
locking, 8
Notification area, 9

Taskpad views, MMC,
202–205

Tasks area (Movie 
Maker 2), 88

TCP (Transmission Control
Protocol), 213

TCP/IP. See Transmission
Control Protocol/
Internet Protocol

templates, Administrative
Templates container
(Group Policy tool),
44–48

Terminal Services option
(Windows Components
container), 45

text strings, 177
Themes tab (Display

Properties), 13–14
32-bit applications, 59
thumbnail views, digital

photos, 97
tile views, digital photos, 97
Timeline view (Movie Maker 2

Workspace), 93
titles, Show Title option

(Media Player 9), 74
toolbars

buttons, 160, 162
customizing, 161–162
locking, 161
Movie Maker 2, 88

Tracert utility,
troubleshooting
connections, 241

traffic, ICF, 304
transitions, Movie Maker 2,

93–94
Transmission Control

Protocol (TCP), 213
Transmission Control

Protocol/Internet
Protocol (TCP/IP)

configuring, 236–238
IP addresses, 211–213
protocol suites, 213

trimming clips, Movie
Maker 2, 92

troubleshooting. See also
problem solving

application lockups, 380
connections, 239–242
display drivers, 133
hardware installation, 121
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troubleshooting continued
help options, accessing,

381–383
Safe Mode feature,

384–385
Windows XP installation,

458
True Color (24-bit) scheme, 20
trust relationships, domains,

245
Tucows Web site, 471
TuneUp Utilities, 469
tunneling protocols, 260
Turn Off Computer dialog

box, 111
turning on

Remote Assistance
feature, 275–276

Remote Desktop feature,
264–265

TweakUI PowerToy, 406–409
24-bit (True Color) scheme, 20
type command (Recovery

Console tool), 400

U
UDF (Universal Disk Format),

135
UDP (User Datagram

Protocol), 213
unattended installation,

Window XP, 453–457
UNC (Universal Naming

Convention), 252, 325
Unicode Program Group

subkey,
HKEY_CURRENT_USE
R Registry key, 184

uninstalling device drivers,
128

Uninterruptible Power Supply
(UPS), 118

Universal Disk Format (UDF),
135

Universal Naming
Convention (UNC),
252, 325

Universal Plug and Play
(UPnP), 275

Unpin from Start menu
command (Start
menu), 3

unreadable display state,
dynamic disks, 145

updating
device drivers, 128
Registry feature, 190

UPnP (Universal Plug and
Play), 275

UPS (Uninterruptible Power
Supply), 118

user accounts. See also group
accounts

administrator accounts, 26
creating, with Computer

Management console,
29–31

creating, in Control Panel,
25–26

deleting, 32
discussed, 24
limited users, 26
passwords, 27–29
profile information, 182
program access, 67
renaming, 32
usernames, 25

User Datagram Protocol
(UDP), 213

user profiles, system
container options, 47

User Rights policy (Group
Policy tool), 41–42

usernames, user accounts, 25

V
VBScript language, 422
VGA (video graphic array),

385
video

adapters, display drivers,
132

importing and recording,
Movie Maker 2, 89

Video Size option (Media
Player 9), 75

and visualization views
(Media Player 9),
73–74

video cards
installing, 130
Movie Maker 2

requirements, 86
video graphic array (VGA),

385
View Full Screen option

(Media Player 9), 73
View tab (Folder Options

dialog box), 159
viewing

file information, 160
hard disk information,

153
playlists, Media 

Player 9, 73
Recycle Bin items, 10

Virtual Desktop Manager
PowerToy, 414

Virtual Private Networking
(VPN), 259–263

visualization and video views
(Media Player 9),
73–74

volumes, hard disks
simple volumes, 148–150
spanned volumes,

150–151
striped volumes, 151–152

VPN (Virtual Private
Networking), 259–263

W
wallpaper feature, desktop, 16
warn option, driver signing,

129
Web pages, adding to

desktop, 16
Web sites

DirecWay, 280
MagicTweak, 470
Microsoft, 267
StarBand, 280
SuperSpeed, 470
Tucows, 471
Windows XP, 87
Xdesksoftware, 470

Webcam Timershot
PowerToy, 418

WEP (Wired Equivalent
Privacy), 219

Wi-Fi networks, 218–219
windows, opening multiple,

198
Windows Components

container
(Administrative
Templates container),
44–47

Windows Installer feature,
46–47

Windows Settings node
(Group Policy tool),
40–44

Windows Task Manager
dialog box, 65

Windows Update button
(Control Panel), 54

Windows XP
activating, Product

Activation feature, 450
installing, attended

installation, 439–442
installing, from CD-ROM,

443–446
installing, from network

shares, 447
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installing,
troubleshooting
issues, 458

installing, unattended
installation, 453–457

installing, Winnt32.exe
setup program, 447

Web site, 87
Winnt32.exe setup program,

447
Wired Equivalent Privacy

(WEP), 219
Wireless Local Area Networks

(WLANs), 217
Wireless Metropolitan Area

Networks (WMANs),
217–218

wireless networks
configuring, 227
types of, 217–218
Zero Configuration, 219

Wireless Personal Area
Networks (WPANs),
217

Wireless Wide Area Networks
(WWANs), 218

wizards
Add Hardware, 120–121
Program Compatibility

Mode, 57–59
Restore, 354–356
Scheduled Task, 375–377

WLANs (Wireless Local Area
Networks), 217

WMANs (Wireless
Metropolitan Area
Networks), 217–218

workgroups. See also
networks

configuring, 224–227
DCC (Direct Cable

Connection), 215, 222
setting up, 221–224

Workspace (Movie Maker 2)
discussed, 89
storyboard view, 92
Timeline view, 93

WPANs (Wireless Personal
Area Networks), 217

Write Attributes permission,
316

Write Data permission, 315
Write permission, 317
WWANs (Wireless Wide Area

Networks), 218

X
Xcopy command, batch

scripting, 432–433
Xdesksoftware Web site, 470
XP SysPad utility, 469
X.25 networks, 287

Z
Zero Configuration, defined,

219
zipped files, compression,

170–171
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